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WHAT THIS GUIDE CONTAINS  

This end user guide contains essential information about MyCalls.  It illustrates the use of the 
MyCalls application and then provides steps to customize the application to end user requirements.  

 

WHO SHOULD READ THIS GUIDE  

This guide is for end users of a MyCalls installation used in conjunction with an NEC SV8100/SV9100 
PBX to assist with application customization and management. 
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Chapter 1 

Welcome to MyCalls 

Welcome to MyCalls, the Call Accounting and Management application which puts you in control of 
the communications into and out of your business. With MyCalls you can measure all aspects of your 
telephone system and ensure that the management of your telephone system is kept within the 
boundaries that you set. 

Not all features described in this manual are available for all versions of your telephone system, or are 
available in the features enabled within the product license. As an example, all ACD related features 
including Pilot Numbers are only available on the SV8100/SV9100 versions that have a MyCalls Call 
Centre license installed. 

For upgrades to your license, please contact your reseller. 

 

MyCalls Components 

Call Logging: See at a glance all the important information you need to manage and plan your 
telephone communication strategy. 

 

Call Costing: Set limits on call costs and staff costs associated with your calls. 

 

Comprehensive Alarm Functions: Manage by exception. This gives you more free time to attend to 
the important matters of your business knowing you will be alerted to problems only when they occur. 

 

Sophisticated Reporting: Gives you summary and detailed analysis of the telephone data, you can 
gather reports on call data, user activity, response, call volumes, comparisons of call data, Device 
usage, ACD, queuing and routing, in fact all aspects of your phone usage. You can also create 
completely customised reports showing any value calculated across any date and time filtered down 
to devices or users of your choice.    

 

Real Time Status: Monitor the immediate status of your devices, extensions and users, such as calls 
in progress, call queues and extensions not in use.   
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Statistics Windows: View current and historical data. View single values such as incoming or 
outgoing call counts, abandoned call rates, group activity and statistics specifically tailored to your 
business model. 

 

Call Logs, Alarm Logs and Lists of Unreturned Calls: all help you manage daily workloads. 

 

 

 

Key things that MyCalls will  do for you  

Traffic Analysis: MyCalls can help you monitor your telephone system's traffic. Traffic reports can 
show if you have too many trunks (paying for rarely used extra phone lines) or not enough trunks 
(current phone lines are busy most of the day). These reports can also show you which calls were 
routed over particular trunks. By monitoring your phone system's "call routing" ability, you can be 
certain the correct calls are being routed to the least expensive trunk. 

 

Reporting: You can generate the information you need, when you need it. For example, what is the 
most frequently dialled long-distance telephone number? How much money does your company spend 
making Premium Rate calls? How many times did your sales department call clients in London last 
week? Which calls were more than 30 minutes long?  

 

Toll-Fraud Alarms: MyCalls can provide you with a means of detecting toll fraud. There are numerous 
forms of toll fraud, with some of the most common forms including: 

 Hackers calling in on one trunk and accessing an outside phone line. 

 Excessive personal, long-distance calls made by employees. 

 Real Time ‘here and now’ view of the use of the telephone system and the activities of the 
staff using it. 
 

Billing: Hotels can take full advantage of MyCalls’ billing features. In this environment, the call 
accounting system can "cost" the calls differently for guest and administrative telephone calls. 

 

Staff Monitoring: MyCalls can be used to aid motivation and help improve staff performance by 
providing an objective measurement, rather than relying on subjective impressions. 

MyCalls can be adapted to any business environment, and the growing list of features is now allowing 
the application to integrate with many business activities beyond the traditional role of a call 
management system. 

  

Initial Configuration in the MyCalls A pplication 

All organisations will need to initially configure the following:  

 Trunks: For overall performance monitoring and call volume analysis. 
 

 Extensions: To analyse individual staff call performance. 
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 Extension Groups: To allow analysis by department. 
 

 Organisation: To implement call recording rules and production of reports by hierarchy of 
users rather than extension, essential if users tend to use more than one extension. 
 

 Call Recording: To keep track of the specifics of calls and improve staff training. 
 

 ACD and Agent Control: To measure queue performance and allow dynamic control of 
agent activities.  
 

 Alarms: Enable you to be alerted to problems continuously monitoring the system.  

Where do I start?  

Handling Incoming Calls 

Incoming call handling is focused around responsiveness. The first step is to formulate a telephone 
management strategy which takes into account the following major criterion: 

 What are your call volumes? 

 Do your staffing levels reflect demand? 

 Who answers your calls? 

 How quickly are calls answered? 

 How long does an average call take? 

 Can you tailor your resources to adapt to varying demands? 

 How long will callers wait for a call to be answered and why? 

 Can you differentiate between callers? 
 

Generating Basic Information About Call Volumes 

MyCalls can generate information to enable you to answer these and many other questions. Starting 
with the measurement of call volumes, MyCalls can provide you with all the relevant data. Once you 
have that information you can begin to formulate a call handling strategy, defining target answer times 
and call handling times. This information, in turn, will allow you to formulate service level values for 
each part of your organisation. 

 

Grouping Calls and Devices 

At this point you will need to break down your call handling into relevant groupings. Your organisation 
will probably already contain predefined groups of people handling the calls either by location e.g. 
first floor, second floor, or more likely by service function such as sales, purchasing, accounts etc. 
MyCalls allows you to create groups based around the type of device such as an extension.  

You can group together several ‘devices’ and view the data in real time on screen or generate a report 
showing how that group performs over a period of time. 

This is grouping at its simplest level and MyCalls supports several ‘devices’ all of which can be looked 
at individually or as grouped devices. Each type of device allows us to look at the same call data but 
from a different viewpoint.  
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Adding Flexibility with Users 

You can also look at the call data from a user’s perspective where each user performs a role within 
the organisation. Users can be organised into groups which reflect the organisation’s real hierarchy 
and provide more flexibility than devices alone including the ability for a user to log into any extension 
(hot desking) and the ability to control the access to call recordings.    

 

Using DIDs to Recognise Purpose of C alls 

Breaking down calls according to the purpose of call can be achieved by providing DIDs to your callers. 
Advertising campaigns often use this approach where a series of DID numbers are advertised, each 
number corresponding to a different advert or product range. The phone system can then route calls 
coming in on a given DID to a specific group of extensions or an ACD queue. If several calls dialling the 
same DID are waiting to be answered they are defined as being in a DID queue and MyCalls can provide 
statistics about these queues such as calls waiting in queue, longest wait, who answered the calls and 
what the call durations were etc.  

 

Managing calls using Automatic Call Distribution (ACD)  

ACD allows the distribution of calls to a group using a set of rules and generally ensures that calls are 
spread around in a fair and even manner. This ensures that no individual agent is answering calls 
more frequently than others. MyCalls can monitor the performance of ACD queues and break down 
call rates (the number of calls in a given period) and performance such as time to answer and service 
levels. 

Agent control allows supervisors to manage which agents are logged on to which queues at any 
given time and allows the monitoring of call queues and agents in real time. 

Real time status and statistics  

MyCalls provides a range of real time status screens which allow agents and supervisors to see what 
the current state of the phone system is. This can tell you information such as who is currently busy 
on calls, how long calls have lasted, who is logged on etc. You can also see queue status for DIDs and 
ACD queues i.e. how many calls are in queue and longest wait in queue etc. 

This kind of information gives an immediate snapshot of the system but for more meaningful 
information you will want to see statistics for the current hour or day or an hourly breakdown of the 
various performance parameters and call rates over the last 24-hour period. This is provided by a 
variety of real time statistics screens which can take the form of single value windows showing for 
example ‘the number of abandoned calls today’ or bar graph representations of the number of calls 
per hour.  

These statistics can be viewed either as individual statistics such as a specific extension or can look at 
the statistics for one or several groups of devices, users or queues. 

Developing your strategy using Reporting  

Real time information is great for immediate day to day management but to develop a successful call 
management strategy you need to have much more comprehensive historical information available. 
MyCalls reporting gives you a library of reports ranging from call metrics per individual device or 
user to group statistics and time profile information which breaks down information into what 
happened at any half hour interval on any given day.  
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If the standard reports are insufficient for your needs, you can generate customer specific reports 
where you define exactly what information is included in the report and the parameters are wide 
and exhaustive. 

Your reports can be filtered to specific groups, call types, DIDs, ACD groups in fact almost any 
combination of call information can be defined within your filter to give you the exact information 
you require. 

You can save your customised reports for later use and you can even schedule the reports to run at 
regular intervals. Scheduled reports give you the added advantage of being able to automatically 
distribute the reports to relevant people within the organisation. 

Management by exception  

One very big feature of MyCalls is the management by exception. This allows you to set up a series 
of rules which if broken create an alarm or alert informing you of the fact. These alarms can be used 
to indicate a wide variety of events and conditions such as: 

 Trunk lockup 

 IT System related issues  

 Toll Fraud and telephone misuse 

 Reduction in service levels 

 Excessive call costs being incurred 

There are many more available but ultimately this means that you can set up MyCalls to inform you 
when there is a problem and relieve managers of the need to continuously monitor the system 
themselves. 

The next step 

Once you have your call data you will be able to see how various aspects of your organisation are 
performing and you can use this data to refine and reformulate your strategy and fine tune up your 
operating parameters. The first thing then is to measure your call volumes and see how well you are 
handling your calls. 

 

Measuring Current Call  Volumes 

When you first install MyCalls, you will want to be able to use the data gathered to help quantify your 
current call volumes. Fortunately, you do not need to do anything special to enable you to run 
meaningful reports.  

The following examples refer to running of reports and display of real time statistics screens. The 
details of how these reports and screens are configured are covered in the relevant sections, but this 
detailed knowledge is not required in order to follow these examples.  

To make a useful forecast of call volumes you will need to know: Total number of calls in a given period 
(say 1 month). 

This can be derived from a summary of all calls report. If we run the report for incoming calls on all 
trunks and ensure that any transferred calls are consolidated* into single calls, we can see the total 
number of incoming calls for the reporting period along with other useful data such as average 
duration of calls and average ring times.  
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*normally a call which is connected and then transferred to another extension would be counted as 
two calls. Consolidating would treat them as a single call. 

 

 

 

Call Rates 

Using time profile reports, we can get a breakdown of call statistics for specific intervals during the 
reporting period. These intervals can show us how call rates vary for each day of the week or they can 
be very specific by analysing the call statistics for each Half hour of the day over the reporting periods. 
This particular report accumulates all the data for the respective intervals over the reporting period 
so if you were reporting on ‘Day of week’ the total calls for Monday would be the total calls for all 
Mondays in the period.  

The following graph is compiled from an exported MyCalls report showing genuine data for 1 month 
of calls. 

 

The next example shows the same 1-month period but shows the accumulated half hour of each 
day. 
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From the original group summary report then we can see we have to handle roughly 30,000 calls in a 
month of which about 3,000 (10%) are abandoned. From our time distribution reports we can see 
how these calls are spread over days of the week and how the calls are spread throughout the day. 
From this data alone we can start to estimate staffing levels and how these levels may need to be 
adjusted each day and throughout the day.   

 

Trunk usage 

Knowing the quantity of calls we need to handle and when these calls are occurring is a good start 
for us but to give the data a bit of context it would be useful to know what the trunk usage is. This 
helps us identify where we may be hitting bottlenecks due to insufficient trunks or conversely we 
may have far more trunks than we currently need. 

The following screenshot is a portion of a trunk usage report for the same period as the previous 
graphs. This indicates the times of day when the most trunks are in use are between 10:00 and 12:00 
and between 14:00 and 16:00. This ties in with our usage graphs above but we now also know how 
many trunks this may be using simultaneously in a given period. If this is approaching the maximum 
trunks available, then we may have to factor that in when we produce a forecast to avoid 
unnecessary busy signals due to the trunks operating at maximum capacity. 
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So far we have been able to develop a picture of  

Peak call times 

Trunk usage and capacity 

Busiest days and periods of the day 

In addition, we have figures for number of calls received and abandoned. 

 

The ‘Call comparison over the same interval’ report allows us to compare different types of calls. 
Let’s take a look at how the abandoned calls compare with the incoming calls overall. 

 

 

Even from this basic data we can get a more detailed picture of events. An obvious observation 
would be that Saturday shows a high rate of abandonment whereas the call volume is one of the 
lowest. If we compare the two sets of data showing the values as a percentage of the total 
respective calls (calls each day as a percentage of total calls for the week) the comparison becomes 
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clearer still. We can see for instance that Saturday has a high proportion of abandoned calls 
compared with the call volume for that day. 

 

 

 

The reasons for this may be due to lots of factors but you can see that with this relatively basic 
information from a few simple reports we can begin to make predictions about our call volumes, 
caller behaviour, trunk requirements and agent activity. 

 

Measure performance 

What to measure 

Looking deeper into the data by use of reports and real time statistical data we can begin to look at 
the information from differing perspectives. 

 

System perspective 

Trunk loading – how many trunks are required, when do trunks become overloaded resulting in busy 
signals. 

 

Customer perspective  

Wait times  

Call duration 

Call resolution (was the result of the call satisfactory) 

 

Staff Performance  

Number of calls answered 
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Number of calls abandoned 

Time to Answer (TTA or ring time) 

Average Time to Answer (ATA) 

Service Level  

Call duration 

After call work 

Breakdown of a call  

Let’s look at a diagram which represents the different stages of a call transaction. 

 

 

 

The diagram shows a typical call which will have several phases 

1. Ring Delay 

2. Time in queue and/or Ring on Extension 

3. Call talk time 

4. After call work (Wrap-Up) 

 

Ring delay is the time taken to initially answer a call. The length of this delay depends on the 
number of lines you have available and how the incoming calls are dealt with. If you are directing 
calls to an auto-attendant, then the ring delay should be short and the caller can be given the 
opportunity to pre-select the department they wish to be transferred to. If the incoming call is 
directed straight to a queue or an extension (group) then the ring delay will depend on the number 
of available agents. 

Time in queue is the delay experienced whilst waiting for the call to be picked up by an agent. 
There are a number of scenarios but essentially the call has been connected and you have been 
routed through to a queue. The delay in queue may be interrupted with announcement messages to 
help relieve the boredom factor.  

Call talk time or call duration is the time the agent spends on the phone handling the call. 

After call work is the time spent writing up the call afterwards. This is also referred to as wrap-up 
time. 

There are several parameters we can measure, but the following are probably the most important: 
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Time to answer (TTA): Also referred to as Ring Time, this is the time taken for an agent to pick up a 
call once it has been connected to the PBX. This includes any time the call is in queue plus any 
ringing time on the extension 

Average time to answer (ATA): This is the average TTA for an individual device or a group of 
devices. 

Call Duration: The actual talk time of a call. The average duration can also be calculated 

Time to Abandon: The time taken to abandon a call. The average time to abandon can also be 
calculated. 

Service level  

An absolute measurement such as Time to Answer (TTA) or Average Time to Answer (ATA) can give 
misleading results. This because the average time can be quite short but deeper analysis can reveal 
that some calls are taking far longer to be answered than the average value would suggest. It is not 
unusual to see ATA values of less than 20 seconds whereas the maximum time to answer can be in 
excess of 4 minutes. This can lead to a false conclusion that all your answer times are close to the 
average. To check the real TTA values you can run a ‘Call Summary Time Distribution’ report. The 
data shown below is an extract from such a report and shows the number of calls answered at 
various TTA’s ranging from less than 5 seconds up to 240 seconds or more. Whilst the vast majority 
of calls occur in less than 35 seconds there are still quite a number of calls occurring at well over 2 
minutes. 

ATA (s) calls answered 

 0 – 5 6,207 

5-10 7,067 

10-20 3,017 

16 – 20 1,090 

21 – 25 1,088 

26 – 30 1,294 

31 – 35 1,244 

36 – 40 912 

41 – 45 386 

46 – 50 311 

231 – 235 3 

236 – 240 1 

 > 241 10 

 

Using a service level value indicates the percentage of calls that are answered within the target 
answer time. This is a much better indicator than ATA because we can immediately see the 
percentage of calls which fall outside our desired answering times. We can report on Service level as 
well as setting alarms and viewing the values in real time on wallboards etc. 



Welcome to MyCalls 

  

 1510-002-010  Chapter 1-12   
 

A basic definition of service level is: 

𝑆𝑒𝑟𝑣𝑖𝑐𝑒 𝑙𝑒𝑣𝑒𝑙 =  𝑋 𝑝𝑒𝑟𝑐𝑒𝑛𝑡 𝑜𝑓 𝑐𝑎𝑙𝑙𝑠 𝑎𝑛𝑠𝑤𝑒𝑟𝑒𝑑 𝑖𝑛 𝑌 𝑠𝑒𝑐𝑜𝑛𝑑𝑠.  

This means If 90% of calls are answered within the target time to answer then the service level will 
be 90%. In order to set service levels, you will need to analyse time to answer (TTA), abandonment 
statistics and call durations. However, you will need to set realistic targets for these parameters and 
adjust them based on your ongoing results.  

From the data shown in the table above* we can make a rough calculation that approximately 
17,000 of a total of 23,000 calls fell within the 20 second answer time. This equates to a service level 
of around 73% which means that about a quarter of calls are taking more than 20 seconds to 
answer. MyCalls allows for considerably more accuracy in these calculations taking into account 
several other parameters. 

*for simplicity the whole table of data from which the service level was calculated is not shown. 

Valid calls and grace periods 

When configuring service levels, it is important to define what are considered to be valid ring times. 
If a call is abandoned very quickly it may be that the caller had misdialled or changed their mind 
about the call. These incidents should not be considered valid calls as it would be impossible to 
answer them. To eliminate this kind of call from the statistics you can set grace periods. Grace 
periods effectively ignore short ring times when marking a call as abandoned. 

What about the call durations? Again very short calls may indicate a caller has either misdialled or 
been put through to the wrong department etc. In this event we can define a minimum call duration 
below which the call is marked as a short call. Conversely we want to aim to complete calls within a 
specified period so we can mark calls lasting longer than a certain time as a long call.  

These parameters are configured as part of the operations settings under grace periods and grade of 
service settings. 

Reports to help with assessing your performance:  

 

Group Summary reports  show the total number of calls, ring times, durations, long and short calls 
etc. for any period and any device group. Group Summary by Member reports, will show overall 
statistics but can break down the group statistics by the members of each group.  

 

Call Detail reports will show a complete breakdown for each call and can be generated for all devices 
or limited to showing only certain groups of devices. This gives a call by call breakdown of activity so 
you would tend to use this report to home in on specific problems or areas of interest. 

If you want more detail you can generate customer specific reports which are available for group 
summaries and call details and offer over 120 individual parameters. 

 

User Availability reports can show agent activity. Agents can be in one of a number of states such 
as available, DND, wrap-up etc. Availability reports show the number of logins and duration of login, 
time spent in wrap-up, unavailable or in DND with average durations for each state. You can generate 
variations of this report which give a breakdown of unavailable codes. Availability detail gives a 
breakdown of the states for each user and availability profile reports show the maximum and 
minimum number of users in each state for a specified interval such as every hour. 
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Performance reports give breakdown of service levels at both group detail and group summary 
levels. Group details report the half hour periods where the service levels were not met. Group 
summaries provide overall statistics for the percentage of half hour intervals for which the grade of 
service targets were not met. 

Real-time statistics  

MyCalls can display a wide range of real time statistics which can be displayed on a desktop PC or 
wallboard display. You can organise your screens into pages and layout each page in any 
arrangement of statistics windows you like.  

The statistics windows are capable of displaying either status – which is the real time state of an 
extension, user, queue etc. or statistics - which displays accumulated values such as number of calls, 
service levels, and average call times, wait times etc. 

Real time windows can be used to show current performance levels and call rates to motivate staff. 
You can show calls in queue which help staff to recognise when things are particularly busy and can 
empower staff to log themselves onto a busy queue to help relieve the load. 

 

A guide to the statistics of most use in real time is as follows: 

Calls in queue (CIQ) these are likely to be changing quite rapidly and is most sensitive to real time 
changes in agent allocation. 

Longest current wait indicates the longest waiting call in the queue. This value in conjunction with 
the number of calls in queue can be a good indicator of current urgency. If the calls in queue are 
growing but the longest current wait is low, then the call durations are probably low thus keeping 
the wait times down. If the wait times begin to increase, then it may be indicating a downward trend 
and the need to increase the number of agents in order to clear the queue.  
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Service Levels, Answer times, Abandonment times. These can all be displayed in a single group 
statistics window.  

Agent or Extension status. Shows the current availability of agents or extensions. On its own this 
is not particularly useful and needs to be displayed in context with the current queue status.  

 

Real Time alarms.  

These can be used to indicate a wide variety of conditions such as when queue sizes are growing, 
wait times are increasing or service levels are dropping and call rates exceed certain values. These 
alarms can be sent to a specific group of Supervisors via an alarms distribution list. The distribution 
list has in it a set of supervisors to distribute the alarm to. If an alarm has no distribution list or a 
distribution list containing no supervisors, then everybody will receive it. The alarm will always be 
shown in the ‘Alarms’ tab in MyCalls. 

 

How to group on different devices  

Trunks 

 Examine overall usage of the phone system 

 Volumes of calls through different routes e.g. GSM gateway, ISDN, pots etc. 

Extensions 

 Fixed departmental stats 

 Breakdown by extension groups or individual extension 

Pilot ACD queues 

 Analyse performance of ACD groups 

 How well does my ACD grouping work? 

 Abandonment rates, durations, service levels 

DIDs 

 Distinguish reasons for calling 

 Tune responses to calls based on call type 

 Set different service levels for different DIDs depending on how long a caller is willing to wait 

Users 

 Can better reflect the organisation for reporting etc. 

 Enables call recording rules 

 Agent control is possible, more control over ACD handling 

Hot-Desking allows users to log onto different extensions and so tracks users across 
extensions 

 Supports subgroups such as sales/book sales or sales/music sales 
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Trouble shooting 

Several reports and alarms are provided to help trouble shoot the phone system.  Trunk reports 
allow you to analyse where certain trunks may be held in state for a long period, conversely if a 
trunk is not working correctly you can run an unused device report. You can run reports to indicate 
where extensions and other devices are unused. This may indicate wrongly configured devices. This 
is particularly important if those devices are enabled for real time statistics as this can use up a 
considerable amount of system resources.  

Reports 

 Trunks 

 Status reports 

 System reports 

 Unused devices 

Alarms 

 Alert you to problem areas 

 System – PBX activity and amount of disk space free 

 Usage/Performance/service levels etc. 

Emergency alarms indicate when emergency numbers are used 

 Call rates – set and monitor 

 Toll fraud and security 

Trunk utilisation – alarm on the number of concurrently busy trunks 

Device status – detects when devices are busy or free for extended periods or when an 
extension is off hook for an extended period 

User status – detects when a user goes into wrap-up, DND, or unavailable a specified 
number of times or for an extended period 

Queue status – detects when a queue (Trunk, DID or ACD) exceeds a certain length or the 
maximum wait time exceeds a specified period  

Hunt Groups and ACD queues  

Depending on the type of calls or volume of calls you may need to implement call queuing. You can 
use a queuing mechanism to attempt to keep callers on the line for longer using a mixture of tactics 
which include music on hold and injecting messages at regular intervals. 

 Call Routing can be implemented by the use of  

 Hunt Groups 

 ACD 

Hunt Groups 

Hunt groups are a rudimentary form of queuing where an incoming call is sent around a group of 
extensions. Incoming calls are allowed to roll over to the next available extension until the call is 
answered. The problem with hunt groups is that the logic is very simple and thus does not provide a 
particularly even distribution of calls across a group.   
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ACD Queues 

Automatic Call Distribution or ACD provides a number of queues programmed into the telephone 
system PBX. When a call comes in via a DID, Auto Attendant or Receptionist it can be routed to an 
ACD Queue (also referred to as a Pilot number in MyCalls). Logical rules for ACD routing attempt to 
ensure that agents are fed calls evenly in an attempt to spread the call load. 

Agent Control  

Agent control allows you to match your staff activities to the varying call volumes. You can manage 
logging staff onto ACD queues and monitor queue call statistics in real time.  

Agent Control can: 

 Log on and off queues   

 Define which queues your staff can log onto 

 Remotely log staff on and off queues 

 Monitor your staff’s queue activity and current status in real time 

 Manage wrap-up times 

 Unavailable codes give the reasons that staff are unavailable at specific times 

 Generate queue usage reports 

 Report on call activity based around ACD routing rules  

Using DID numbers  

It is useful to automatically route calls to extensions directly, whilst keeping the number of trunks to 
a minimum. This can be accomplished by the use of DIDs 

DIDs allow specific inbound numbers to be routed to private extensions without the need for an 
auto attendant or a call transfer.  DID is most useful on PRI or BRI trunks where several channels can 
be assigned as DID channels.  In this way a single PRI trunk group could handle hundreds of phone 
numbers using only 30 channels or less. An office with 80 extensions could have 80 corresponding 
phone numbers operating on a single PRI trunk. The PBX knows which phone extension to ring 
because the DID tells the PBX which extension is associated with a given number. 

Calls coming into DIDs can also be queued within the PBX. This allows a basic call queuing facility but 
does not have the advantages of intelligent routing offered by ACD. DIDs can be combined with ACD 
so that calls to a DID number are routed to an ACD queue.  

For analysis purposes DIDs offer a number of benefits. Organising your incoming calls by DID e.g. 
having a unique number for each type of enquiry, will allow you to analyse caller activity based on 
the number dialled. You can assign different response requirements to different DIDs based around 
department staffing or how long you believe a caller will wait.  

How long a caller will wait is dependent on a number of factors such as purpose of call, urgency of 
the call, time of day, time of year. Clearly a call to an emergency doctor service will wait longer than 
a casual enquiry.  

You can analyse call volumes across different times broken down into DIDs to give you a picture of 
your caller’s patterns of behaviour and then tune your response and staffing accordingly. 

Follow up unreturned calls  

It is inevitable you will miss some calls, but MyCalls enables you to ask under what circumstances 
and examine why you are missing calls. The most important issue however is when a call is missed, 
are you able to return that call. MyCalls automatically keeps a log of unreturned calls for you so that 
you can follow up missed calls.  
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Quick tip:  

Before you start to develop a strategy to increase the length of time callers are prepared to wait you 
need to be able to measure your call volumes at different times of day, days of week and seasonality 
over the months of the year. All this can be done using a variety of reporting mechanisms which 
Mycalls provides e.g. Call volume analyses, Line usage, DID analyses, call profiles over time of day, day 
of week etc, and these are all virtually one click operations using the built in report items, saving you 
time and effort to produce very in-depth information. Of course you may want to distribute these 
reports across the organization automatically using the MyCalls report scheduler. 

 

Handling outgoing calls  

Outgoing call metrics are clearly different to incoming. There are no ring times to consider and call 
routing is unnecessary.  

Timing of outgoing calls is important. Picking the optimal times to make calls depends on customer 
behaviour and also availability of trunks from your PBX. To develop the optimal call patterns, you 
can use MyCalls reporting statistics in a variety of ways. 

Measure call volume and trunk usage 

Profile Abandonment rates for outgoing calls on hourly and daily basis 

Compare Abandonment with durations for hour of day, day of week etc.  

Analyse call duration / talk time for extensions within various groups. Longer call times can indicate 
that the extension is taking longer to close a sale 

Look at average call durations and where specific calls are longer or shorter than this based on time 
of day and extension number etc. 

MyCalls provides a single system that can consolidate call traffic information for each site and allow 
easy comparisons between them. 

 

Out of hours’  operations 

If you operate out of hours or need to handle out of hours calls in a special way, MyCalls can be 
configured to give specific reports on this data. Like the routing of calls to out of office extensions 
you may have to program the PBX to enable some of the features.  

The ‘Out of Hours’ configuration may involve: 

Forwarding calls at specific times 

Voicemail routing 

Monitoring special ‘out of hours’ numbers 

Monitoring fraudulent use of extensions out of hours 

Monitoring known Emergency numbers and their usage 

What types of calls are being made out of hours, and can this be handled more economically? There 
may be a lot of mobile calls being made out of hours where an email would be just as effective and 
much cheaper. 
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Quick tip:  

NB: The configuration for out of office calls will vary between different PBX systems and may require 
some specific PBX setup to achieve complete integration. 

What do I want to improve on? 

MyCalls can be a central part of your strategy to improve many aspects of the way your business 
communications evolve. The phrase ‘If you can’t measure it, you can’t manage it’ applies particularly 
well to the management of telecommunications within an organisation.  

Here are some suggestions as to how you can improve various business areas using MyCalls analysis: 

Maintain available lines 

MyCalls reporting capabilities can be used to optimize telephone networks by monitoring trunk 
utilisation. By reviewing detailed facilities usage reports you can determine if the telephone network 
is being used as expected. For example, are expenditures for facilities equipment and services in line 
with the income generated by their use? Or, can savings be obtained through more efficient use of 
these services? 

MyCalls reports allows your business to determine the busiest hours and associated network usage. 
This information is essential to ensuring that employees always have access to outbound lines, and 
that customers can always reach support personnel. 

Reduce costs 

Analyse costing of Calls and Staff  

Quantify Inter departmental calls, mobile usage, minimise fraudulent phone use 

Staff focus and motivation 

Generate and display real time statistics so your staff can see their progress throughout the day  

Real time notifications let staff know where problems lie. For example, calls taking too long  

Regular posted reports showing weekly league tables or positive results gained 

Complaints handling 

Call recording can help improve complaints handling by listening to calls and working out ways of 
dealing with awkward customers or feeding back problems to product designers and sales staff 

Call recording can be used to improve coaching and training of staff, hold regular call reviews and 
pick out good and poor practices. Develop a complaints handling procedure and ensure all staff are 
involved in developing this procedure based on real call experiences 

Completion codes can be used to categorise the status of a complaint once the call has finished. 
These codes can be included in reports to analyse where complaints are handled successfully, are 
they passed on and dealt with and do you get back to the customer with a solution etc.  

Use reports statistics to determine how quickly complaints are being dealt with and if complaints are 
being routed to the right staff. You may need to provide more DIDs so that more choices are 
presented to the caller prior to connecting to a staff member.  

Manage returned calls by generating unreturned call reports or using the real time unreturned calls 
grid to ensure you are responding to these calls.  
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Generate new business, Improve customer retention 

Use Call Recording to review call content 

Use the statistical data generated from MyCalls to determine the best times to make specific types 
of calls. Experiment with different types of customer, your pitch and different times of day for the 
calls and use the resulting statistics in conjunction with call recordings to refine your campaign 
planning process  

Scheduling regular calls to existing customers 

Fast response to incoming enquiries 

 

What type of staff do I have?   

The telecom strategy you employ for responding to calls can be very dependent on the type of staff 
you employ. If you provide a very specialist service or product that requires in depth knowledge, 
then you will need to provide  

 Multi skilled people filling various roles 

 Departments geared around specific roles 

 Highly skilled or technical staff 

 

What type of business does MyCalls cater for? 

MyCalls can be configured to suit any size of business from a small 5-10 extension telesales business 
to a nationwide network of call centres. Mycalls has been deployed in virtually every market sector 
including: 

Banking & Financial 

Call Centres 

Motor Sales & Car Hire 

Insurance 

Legal and Accounting services 

Retail 

Telesales 

Brokerage 

Hotel and Leisure 

Doctors & Healthcare 

Airports 

Local Government 

Schools & Educational 

The following are just a few examples of how the software can be deployed to improve different 
business  
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Telemarketing Companies 

In telemarketing organisations, the sales or support results of individual employees can be compared 
to the number of calls completed. In addition, demographic data can be obtained from MyCalls by 
generating a customer specific report (custom call details) reporting on the locations (area codes) 
called in order to determine whether a specific telemarketing area is receiving too much attention or 
not getting enough.  

Managers can also use call accounting reports to compare the amount of time employees are 
spending on the phone versus the number of accounts that are being served or the new business 
that is won. 

DID reporting provide analyses of calls by the number used e.g. marketing companies, rebilling for 
customers. 

Professional service  

In most professional service organizations, employees are required to keep a manual running log of 
the time they spend on the phone with their clients, or on their client's behalf. Billing departments 
are then required to manually post the time and corresponding costs. With MyCalls, this entire 
process is automated. First, each active customer is assigned an account code, which is entered into 
the phone at the end of a telephone call and recorded by the call accounting system. Then account 
code or ad hoc reports can be run to verify the time spent on the telephone for that account. 

Brokerage 

Brokerage companies can use MyCalls to monitor the calling patterns of the sales staff, usually on a 
daily or weekly basis. Often, these call patterns are used in conjunction with a client's portfolio. If a 
broker has not made enough sales calls or is spending too much time with a client who has not 
purchased any stocks, a call this will be revealed. Another important use of MyCalls is the storage of 
historical call information. Suppose a client calls to order a particular stock and then the next day 
when the stock's value declines, the client denies purchase of the stock. For litigation purposes, 
companies can review the historical call records and retrieve a record of the actual call. 

 

Misuse of the telephone system 

Installation of MyCalls often has a significant effect on reducing employees' misuse of the telephone 
network. In fact, many companies see a large reduction in the number of personal telephone calls as 
soon as they make employees aware that a call accounting system is in use. 

To detect toll fraud, MyCalls can be set up to alert you when certain criteria do not follow what has 
been defined as normal calling activity. Alerts can be sent remotely by email or can display an alert 
immediately upon completion of any call that seems suspicious. Having access to this information 
gives systems administrators the opportunity to take preventive measures. 

You can use a variety of reports provided by a call accounting system to assist in managing 
employees. For instance, a manager can provide employees with a list of their calls on a daily, 
weekly or monthly basis. This list can help a manager determine if the employee is spending his or 
her time making business-related phone calls or excessive personal calls. Hopefully, it will also deter 
the employee from making personal long-distance calls at the company's expense. 
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Chapter 2 
The MyCalls Software Suite  

 

MyCalls Component Parts  

 

MyCalls provides you with a complete set of Call Management facilities all in one package. The key 
features of the MyCalls system include the following components. 

Call Logging Engine: 

The heart of the MyCalls system is its call logging engine. Developed using the latest software 
technology it provides a modular call collection and processing engine which includes a persistent 
call data storage mechanism at each stage of the call logging process, thus minimising potential for 
loss of calls, even in the event of system hardware failure. 

Display: 

 The comprehensive real time status and statistical windows available coupled with the ability to 
organise the screen displays into easily accessible screen pages gives you a convenient and very 
responsive view of the telephone system. You can allocate roles to agents which can limit the 
screens available to them and allows you to assign unchangeable layouts to users if required.  

Call Recording: 

Line-side call recording offers economical recording of all calls across an organisation. Recording is 
automatic and MyCalls matching algorithms are designed to provide maximum reliability whilst 
maintaining a flexible mechanism for applying recording rules to suit any organisation. 

Billing: 

A comprehensive call costing system allows complete billing of all call and associated handling costs 
to be configured. The billing system can operate worldwide and can handle most call types and 
costing scenarios. 

Alarms: 

MyCalls alarms manage the system so you don’t have to. It provides a huge range of alarm 
mechanisms for capturing and notifying almost any condition occurring within the system. This can 
include call durations, service levels, toll fraud, system failures, and ACD events to name only a few. 
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Alarms can provide a real time notification or can be distributed via Email or FTP to remote 
locations. 

Reporting: 

 MyCalls Reporting is amongst the most comprehensive in its class. Reports ranging from call details 
and summary data, time profiles, trunk usage, alarms, audit events, system problems, departmental 
and organisational data can all be configured into regular reports. All reports can be distributed to 
remote locations and can be scheduled to run at any time. 

ACD: 

 MyCalls ACD and Agent control gives you complete control over the management of ACD queues. It 
can show instant status of ACD activity on screen and you can control the login process remotely 
allowing supervisors to determine where and when an agent should be made available. Add to this 
the integrated Unavailable Codes and the ability to group users into different Agent Control groups 
and queues and you have a comprehensive system for ACD Management. 

MyCalls Desktop: 

As well as monitoring calls you can also make and answer calls using the screen controls available 
within MyCalls Desktop. Full call control is provided to allow easy access to complex operations 
involving hold, call parking and conferencing etc. 

Screen-Pop: 

Display the call details and related information regarding the person calling you so you are fully 
prepared to take the call and answer any questions immediately. Screen-Pop interfaces with a wide 
range of commercial applications and databases in the marketplace. 

Operator Console 

Allows a user to quickly and efficiently answer and transfer calls to their intended recipient. This is 
intended for use where there is a central point to which calls are routed and the user transfers the 
calls manually. 
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Chapter 3 

MyCalls User Environment 

Logging into the system 

Before you can use MyCalls you need to log in to the system. Initially you will not have configured 
any users therefore you will be able to start-up the system without a user login so you can start with 
a blank login by just clicking ‘OK’ until users have been configured. 

Logging into the system as a user requires that users with appropriate user types and passwords 
have been set up during the configuration of the application. For more details on this see the 
‘Organisation settings’ section. 

Normally a user will be associated with a default extension. If this is not the case, then you will be 
prompted to select your normal extension as detailed below.  

How to: Log into the system 

1) Click ‘User’ and then ‘Login’ 

 

2) Type in a name in User Name and type in a password, alternatively click ‘Browse’ to search for a 
name 

 

3) The following screen will appear if there is agent control in the license and the agent has not 
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logged into the ACD system. 

 

4) Enter the extension that you are working from. 

5) Click ‘OK’ 

Quick tip:  

At least one PBX administrator must be defined in the configuration otherwise you can’t 
create or alter any other user.  

Selecting your extension when logging on to MyCalls  

MyCalls now offers users a hot-desk facility. This enables a user to log onto any extension of their 
choice. Users must be specifically enabled for hot-desking otherwise they will be restricted to their 
default extension. In addition, extensions enabled for hot desking will appear in the list of available 
extensions as well as any extensions for which the user is marked as the default user when the user 
logs on to MyCalls or MyCalls desktop. 

To Summarise: 

 Only Users enabled for Hot Desking can select an extension other than their default 

 Any Extensions enabled for Hot Desking will appear in the list of available extensions when 
logging on as well as the extensions for which the user is the ‘default’ user 

Once the hot desking options have been enabled for both users and extensions then the user will be 
presented with the extension list whenever they log on to MyCalls. 

 

 

The user should select the extension that they wish to control which will then be the extension 
controlled from the call control toolbar etc. 
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Users can be enabled for hot desking in the user configuration dialog.  

 

Extensions can be enabled for hot desking in the extensions configuration dialog.  

 

For more details on extension configuration see the device configuration section. 
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The Main Display 

The main screen for MyCalls can display any combination of real time information windows you wish 
to create in any position. In addition to real time windows you can also view call logs and other 
information from the Grid Bar at the bottom of the screen.   

 

 

 

Common features of real time information windows  

The windows visible on the MyCalls main screen are individually configurable. Depending on the 
type of screen they may have a number of options available. 

Status and statistics screens all have the option to lock, Refresh and configure using the context 
menu which is viewed by right clicking the mouse whilst hovering over the window.  

Using the mouse, you can hover over any real time window and press the right mouse button to get a 
menu of window options. 
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The single parameter window menu has the following options available. 

Lock Position 

This allows you to lock a window in place on the screen layout so that it can no longer be re-sized or 
moved.  

 When a window is locked it loses its borders and if you right click on it again you will see a tick next 
to the Lock Position option.  To unlock a window, select the Lock Position option again to remove the 
tick and display the windows borders again.  You should now be able to resize and move the 
window. 

 

Refresh Data 

Data is automatically taken from the database at prescribed intervals  

You can select the refresh data option to force the data of the window to be updated. This will force 
a retrieval of the data. 

Configure  

This option allows you to configure existing window settings. The actual dialog presented will depend 
on the window type displayed.  (See ‘real time window configuration’ for more details.) 
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The View Menu 

The MyCalls main screen provides a blank area onto which you can arrange various real time 
windows. In addition to the Real Time windows you can also view popup windows to allow easy 
access to the various logs which are recorded within the MyCalls database. These Log windows 
include Calls, Unreturned calls, Alarms and Audit logs. 

To access the log windows, you can either select from the View menu where you will see selection 
checkboxes to show or hide the various log windows. Selecting either Call Records, Unreturned Calls, 
Alarms or Audit Log makes the associated window visible on the screen. 

 

In addition to the logs you can also enable the viewing of the main toolbar below the main menu at 
the top of the screen 

 

The Grid bar at the bottom of the screen 
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The Status window found at the bottom of the screen. 

  

 

Grid views 

 

  

The main call log windows are viewable as grids.  

The standard grids are:  

 Calls  

 Unreturned calls 

 Alarms 

 Audit Logs 

Each grid is selectable from the view menu or the tabs in the status bar of the application window 

 

These grids share the following features 

View the grid: Positioning the mouse over the appropriate icon in the bottom grid bar will cause 
the window to pop up. 

Pin the Grid: Allows the grid to be fixed in position by selecting the Pin icon to the top right of the 
window. 

  

If the grid is not pinned, then it will automatically hide (minimise) when the mouse is not positioned 
over the window. 

The window can be adjusted in height by hovering over and clicking the upper part of the window 
with the mouse and then dragging the window vertically. 

Adjusting the column width: Dragging a column divider with the mouse allows the column to be 
sized horizontally  

Ordering by column:  Selecting the column title will cause the grid to be ordered by that column’s 
content, e.g. clicking on a number column will sort the contents in ascending numerical order, 
clicking on a name column will sort the items in ascending alphabetical order of the name column. 

Grouping by column: Dragging a column to the grouping area (Drag a column header here to group 
by that column) will group records on that column. To ungroup simply drag the column name 
outside the window. 
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Column Chooser: Allows the grid to be customized by adding and removing different columns. To 
add a column, select it from the column chooser list and drag it to the grid. To remove a column, 
drag it from the grid and release the mouse button. To move the position of a column, drag the 
column horizontally along the grid. 

 
Refresh: allows you to manually refresh the calls in the view. 

Grid View Options 

Clicking on the options button allows you to display the following options: 
 

 

My calls only: This displays only calls related to the user currently logged onto the system. 

All calls for users in my Organisational Group on my PBX: Lists all calls for users in the logged 
on user’s group but only includes those extensions connected to the local PBX.   

All calls for users in my Organisational Group across all PBX’s: Lists all calls for users in the 
logged on user’s group irrespective of the PBX the extension is connected to.   

Custom:  Allows setting of specific period for calls. This can be a date range and can be further 
limited to a specific time period during each day. Extensions, DID filters etc. can also be applied. 

Quick Search Filtering: Set the grid filtering using the quick search fields. 
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The Calls View 

By default, the call record view now has consolidated extension and trunk columns as well as Caller, 
DID and Pilot name columns. Also, as the database that is in use gets larger, the automatic refresh 
rate of the calls view gets quicker to keep up with the larger amount of calls that are being 
processed. The calls visible in the calls view have some special features.  

Call Playback 

A speaker icon against a call indicates the call has been recorded, double clicking on the speaker icon 
will playback the call. 

Multiple call legs 

If the call includes transferred legs then the call will have an expansion symbol  indicating the call 
can be opened up to reveal the individual legs of the call. 

 

For multi-leg calls a summary call is displayed at the outer level and each of the legs of the call 
(transfers) at the inner level.  If a summary call has been filtered out (usually by extension) then call 
legs will appear at the outer level and may NOT be grouped together. 

Normal calls without transfers will appear at the outer level. 

 The layout of the call record view is incompatible with versions prior to MyCalls R-3.0.0.0.  This 
means that when upgrading from an earlier version the call record view layout will be set to the 
default layout. 

Using Call Notes 

Notes can be added to a call and notes do not require call recording in order to be used. To add a 
note right click on the call and select ‘Notes’. The Notes entry dialog will be displayed. You may then 
type in your notes and click ‘Save’. A note applies to a complete call; you cannot enter individual 
notes for each leg of a call. 

Once a note has been added to a call this will be indicated by a notes icon. Double clicking this icon 
will open the note dialog allowing you to add further notes to the call. 

  

Notes are also available as a selectable column from the column chooser. 

Using Call Tags 

Each call can be tagged with 1 of 4 different coloured tags. These can be used to easily identify 
certain calls for various reasons e.g. urgency.  
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To add a tag to a call, change a call's tag, Remove a tag from a call   

To add a tag 

Click the right hand mouse button in the box next to the required call 

Select a tag from the list 

To remove a tag from a call 

Click the right hand button of the mouse over the tag to be removed 

Select ‘Clear Tag’. 

To change a tag 

Double click on a tag to cycle through the available tag colours 

 

Using Quick Search  

 

 

Quick Search fields can be used to restrict the calls displayed to those meeting a range of criteria. If 
more than one search criteria are entered e.g. Period and Number, then only calls meeting both 
criteria will be displayed. This rule applies to all available filter controls so it is important to check 
carefully that only the required criteria have been selected.  

The available filter controls are: 

Period: 

Filter calls by the following periods 

 Today 

 Yesterday 

 This Week 

 Last Week 

 Last Seven days 

 Custom* 

*Custom allows the setting of a start and end date/time 

 

Number:   

Filters all calls by phone number. 
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DID:  

Filters all calls by DID. 

Extension:  

Filters all calls by extension. 

Call type: 

Select incoming (Inc), outgoing (Out), abandoned (Abd), internal (Int) or any combination of 
these call types. 

Maximum calls displayed (Max Calls): 

Limits the number of calls displayed up to a maximum of 500. It is recommended that this is 
kept to a maximum of 50 calls for normal operation to limit the loading on the database. 

Results must meet all criteria in the filter so be careful not to leave anything in the number box if 
you are only searching for calls related to an extension as any calls returned in the grid would need 
to match both number and extension.  

The ‘Tag Filter’, ‘Note Search Type’, ‘Note Filter’, and ‘Pilot Number’ options can be hidden in order 
to save screen space on the call records view and the unreturned abandoned call records view. 

Searching for calls using the additional filters 

 

When you click the ‘More Filters’ button some additional filters will appear:  

 

Tag Filter: 

 (None, Clear Tag, Red Tag, Yellow Tag, Green Tag, Blue Tag) – Finds all calls with a specified, 
coloured tag that you have selected 

Note Search Type:  

Matches Filter:  

Displays all calls with a note containing the word or phrase entered in the Note Filter box. 

Has a note:  

Displays all calls which have a note attached. 

No note 

Displays all calls that have no note attached. 

Note Filter:  

Type in a word or phrase contained in the call notes. Active when the Matches Filter option is 
selected. 

Pilot number:  

Filters all calls by extension. Pilot filters are only available when ACD is enabled. 
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Unreturned Calls View 

Unreturned calls are calls where the caller has abandoned and not been called back. The unreturned 
calls are automatically updated when a call is abandoned. Calls are automatically removed from this 
view when either: 

 A call is returned 

 The same caller calls again and the call is answered 
 

  

Unreturned calls can be searched using a quick search panel. This quick search allows you to search 
by number, DID, extension, tag, note search type, and notes 

Unreturned calls can also be displayed in a real time status window – See Real Time Status 

Exporting Unreturned calls 

Right clicking an unreturned call or multiple unreturned calls allows you to export the list of 

unreturned calls either to a file, clipboard or an email recipient. 
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Chapter 4 

Screen Layouts 

Introduction to Layouts  

Layouts are the view of MyCalls that you see when you run the application. A layout is made up of 
pages. A page contains a particular arrangement of parameter windows and can be stored under a 
specific page name as part of a layout. Changes to the arrangement of a given page is automatically 
stored and recalled when the application is closed and reopened. 

Layouts (along with their pages) can be saved as public layouts.  

Pages are normally arranged so that parameter windows relating to a particular set of information can 
be grouped and viewed together without the screen becoming overburdened with unnecessary 
information. This is especially useful if for example you want to create a grouped view of departmental 
statistics.   

Other elements of a layout which you can customize are the toolbars displayed on screen.  You can 
choose to hide or display the main toolbar, grid or status bars.  The MyCalls window can be 
repositioned on your desktop and resized so that the next time you open the application it recalls 
these settings and positions itself accordingly.    
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Public and Local Layouts  

Local layouts are views that you create on your local machine. They viewed only on the computer on 
which they were created   

To share your layout with other users you need to save it as ‘public’ in a location accessible by other 
users in the MyCalls database. Should you wish to share the layout with users on other sites or 
create a layout for general distribution then you can save the layout to a disk file. Agent Desktop 
users cannot open public Layouts or create their own layouts as they have a layout pre-assigned to 
them. 
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How to: Saving a public layout  

1) You can save screen layouts as public layouts in either the MyCalls database or to an external 
file.  This means that other users can load it and use it as a starting point to create their own 
layout. 

2) When you have finished configuring your layout as you want it be viewed, from the Layout menu 
select ‘Save Public’. 

 

3) You have two options for saving your layout.  You can either save it in the MyCalls database or 
you can choose a location on your computer or network and save it as a layout file (. lay file 
extension). 

4) To save to the MyCalls database select the option ‘Save to database’ and the Layout Name drop 
down list will become active.  Enter a new name for your layout to be identified by the system.  
If you wish to overwrite an existing layout in your database, then select an existing item name 
from the list. 

5) To save your layout to an external file select the option ‘Save to external file’ and the Layout 
Name field below will become active.  Enter a path into the field manually or click the ‘Browse’ 
button to select a location to save your file to.  Enter a name for your file in the File Name field 
as shown in the image below and then press the ‘Save’ button to return to the Save Screen 
Layout window. 

6) When you have entered the required information to save your layout press ‘OK’ 

 

Once saved a layout can be reopened and used as the current layout. Opening a public layout simply 
creates a local copy of the layout which you are then at liberty to change. The changes you make to 
your local copy do not affect the original public layout in any way.  

How to: Opening a Public Layout 

1) You can load a public layout that a user has saved to either the MyCalls database or an external 
file.  Opening a layout will permanently overwrite your current screen layout.  All user types 
except AGENT DESKTOP users can open public layouts. 

2) If you are not an AGENT DESKTOP user, then you can open a previously saved Public Layout from 
either a server or client machine. 

3) From the Layout menu select the option ‘Load Public’. 
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4) The Load Screen Layout window will be displayed.  If there are layouts saved in the MyCalls 
database, then the Load from database will be selectable but if there are not then you can only 
load a layout from an external file. 

 

5) In the Layout Name field manually enter the file path to the layout you want to load or 
alternatively use the ‘Browse’ button to locate the file from your computer or network location 
as shown below using the ‘Open dialog’. 

6) When you have located the layout file press the ‘Open’ button to return to the Load Screen 
Layout window and then press the ‘OK’ button to load the layout into the MyCalls window. 

You can also delete public layouts if required. This only affects the public layout and has no impact 
on any other layouts which may have used this public layout in the past.  

How to: Deleting a Public Layout from the Database 

1) You may delete a screen layout from the MyCalls database so that it can no longer be loaded by 
other users.  Users that have previously loaded a layout before it is deleted will not be affected. 

2) To remove a saved public layout from the MyCalls database, select from the Layout Menu the 
option ‘Delete Public’. 

3) You will be displayed with the Delete Screen Layout window. 

 

4) From the Layout Name drop down list select the name of the saved layout you want to delete. 

5) Press ‘OK’ to delete the layout from the database.  You will be prompted to confirm the deletion 
process, to confirm press ‘Yes’ or to cancel press ‘No’. 

Agent Desktop users have very limited access to MyCalls features and have no control over the 
layout. An Agent desktop will be assigned a layout by the supervisor and that layout will appear on-
screen as soon as the application is launched and the agent has logged in. 
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How to: Assign a Public Layout to an Agent Desktop User  

1) You can assign screen layouts to Agent Desktop users.  This means that the next time these users 
log on, they will view the layout assigned to them.  The Agent Desktop users are unable to 
modify the layout. 

2) To assign a layout to an Agent Desktop user select the ‘Assign’ option from the Layout menu. 

3) The Assign Screen Layouts screen will be displayed.  

 

4) Using the Layout Name drop down list you can select the name of the screen layout you want to 
assign to the Agent Desktop users. 

5) In the Assigned Users field you will see a list of all the Agent Desktop users configured within 
MyCalls.  You can assign the currently selected layout to the users by clicking the box to the left 
of the user’s name.  This will then display a tick to show that the user is assigned the currently 
selected layout.  You can remove the tick from a user to de-assign a screen layout from them. 

6) Press ‘OK’ to save the assign layout selection to the Agent Desktop users. 

Layout Pages 

Pages are the main component of a screen layout.  They enable you to display real time window 
information and arrange it in a way that best suits your organization.   

 

You can switch between saved pages of a layout by using the drop down list of pages within the 
main toolbar 
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 Creating New Pages  

How to: Creating new Pages  

1) From the layout menu select ‘Pages’ and click the ‘New’ option. 

2) You will be prompted to provide a name for your new layout page.  Enter a name and click the 
‘OK’ button. 

 

3) Your new page will now have been created and now be displayed on screen.  The page will have 
been added to the layout page selection tool in the main toolbar. 

 

4) You can now modify the page as per your requirements with real time window parameters 

Deleting Pages 

How to: Delete Pages 

1) Select a layout page you want to delete using the layout page selection tool on the main toolbar. 

 

 

2) From the layout menu select the Pages sub menu and then click ‘Delete’  

3) You will be asked to confirm the deletion of the currently selected page.  Press ‘Yes’ to confirm 
the deletion or ‘No’ to cancel the process. 

4) The page will now have been deleted and removed from the layout page selection tool on the 
main toolbar. 
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Save All Pages 

How to: Save all Pages 

If you have been making a number of modifications to different pages in your layout you can save 
the work you have done across all pages by clicking the ‘Save All’ option in the Pages sub menu of 
the layout menu. 

 Copying Pages 

How to: Copy pages 

1) You may wish to create a page that is similar to an existing page you have available.  To cut 
down the time it takes to setup a page layout you can use the Copy Page feature in the Pages 
sub menu of the layout menu. 

2) You will be prompted to provide a name for your copied layout page.  Enter a name and click the 
‘OK’ button. 

 

3) A copy of your existing page will now be displayed and available from the layout page selection 
tool.  This new page should have the name you previously provided and you can alter existing 
settings to your requirements. 

 Reloading Pages 

How to: Reload Pages 

1) If you have made significant changes to a layouts page, but decide that you preferred the pages 
the way they were before, then you can revert them back to their previous state so long as you 
have not saved the changes in the meantime. 

2) From the layout menu select the ‘Pages’ sub menu and then click on the ‘Reload’ option. 

3) Your pages will now be restored to their previous saved state without any unsaved changes you 
have made since. 

 View Screen as Agent Desktop User  

How to: View screen as an Agent Desktop User  

1) You can view your screen as an Agent Desktop user would see it by choosing the ‘View as Agent 
Desktop option’ from the Pages sub menu of the Layout menu. 

2) This will remove any real time window control boxes and lock the windows on the screen as they 
are positioned. 

3) To come out of the Agent Desktop view in order to move and re-size real time windows you can 
select the ‘Restore from Agent Desktop view’ from the ‘Pages’ sub menu of the ‘Layout’ menu. 
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Resetting Installation Defaults  

How to: Reset to installation defaults  

1) If for whatever reason, you have got to the point where you wish you could start over again, you 
can. 

2) From the Layout menu select the option ‘Reset to Installation Default’ and this will reset all your 
layouts and pages back to how they were when the application was first installed. 

Automatic viewing of multiple pages 

Having created a multiple page layout, you can then view a single page using the drop down menu 

on the main toolbar. 

 

Alternatively, by setting up a display sequence you can automatically display each page. The pages to 

be displayed are added into a display sequence. Your sequence can contain any or all of the pages 

you have created and they can be displayed in any order. There is also a timer for each page in the 

sequence so that you can vary the amount of time a particular page remains on screen. 

Set up the sequence as follows 

How to: Create a playback Sequence  

1) From the layout menu select ‘Screen Layout Pages->Display Sequence  
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2) Using the displayed dialog select each page you wish to display from the available pages’ list. As 
you select each page click the select  button to add the page to the selected pages list.  

3) For each page in the selected pages list you can change the number of seconds the page is to be 
displayed for. You can also alter the order in which the pages are to be displayed using the move 
up and move down buttons. 

4) To remove a page from the list click the deselect  button  

5) When you have made your selections click OK 

6) You can view the pages now by clicking the play icon from the main menu as shown below. 

 

 

Tools to help you layout your pages 

As seen in the previous chapter each page within a layout can be populated with various windows 
e.g. incoming calls, outgoing calls. These windows can contain statistical information, graphs, web 
content and other forms of data. To help us arrange this content on our pages MyCalls provides a set 
of alignment and sizing   tools. Initially you will need to create the windows to be placed on the page.  
Once you have your windows on the page you can change their positions and sizes. 

Manual alignment and sizing 

Any window placed on a page may be positioned by simply clicking and dragging the window to the 
new position. The windows can be resized by clicking on the frame of the window and dragging the 
window. Clicking on the side of a window will allow you to expand the window’s width and clicking 
on the top or bottom of a window will allow you to expand the window’s height. Clicking on a corner 
of a frame will allow the window to be expanded in both directions at once. 

Selecting multiple windows 

In order to align or resize multiple windows we must select the required windows on screen. To 
select multiple windows simply hold down the control (Ctrl) key on your keyboard and click on the 
windows you wish to include in the selection. Each window will be highlighted with a border. When 
multiple windows are selected the ‘format menu’ will be enabled. The automatic alignment and 
sizing tools operate on the first window selected, this means that if you were aligning two windows 
to the left, then both windows would align to the first selected window. 

Automatic alignment and sizing 

Several automatic alignment and sizing tools are available for you to use when designing your page 
layouts.  These tools are located on the top toolbar or can be accessed via the ‘format menu’.  
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The format menu and the alignment tools (shown above) are disabled unless multiple windows are 
selected.  The options available are as follows. 

Alignment: 

Align Windows left: Align all selected windows to the left hand edge of the first selected window 

Align Windows Right: Align all selected windows to the right hand edge of the first selected window 

Align Windows Top: Align all selected windows to the top edge of the first selected window 

Align Windows Bottom: Align all selected windows to the bottom edge of the first selected window 

Align Centres Horizontally: Align selected windows along the horizontal axis 

Align Centres Vertically: Align selected windows along the vertical axis 

Sizing: 

Make heights equal: Set all selected windows to the same height 

Make widths equal: Set all selected windows to the same width 

Make heights and widths equal: Set all selected windows to the same width and height 

Distribution: 

Make horizontal spacing equal: Space the selected windows equally across the width of the screen 

Increase horizontal spacing: Increase the distance between selected windows across the screen 

Decrease Horizontal spacing: Decrease the distance between selected windows across the screen 

Remove horizontal spacing: Remove spacing between selected windows across the screen 

Make vertical Spacing equal: Space the selected windows equally across the width of the screen  

Increase vertical spacing: Increase the distance between the windows top to bottom  

Decrease vertical spacing: Decrease the distance between the windows top to bottom 

Remove vertical spacing: Remove the spacing between the windows top to bottom 



Real Time Status 

  

 1510-002-010  -11   
 

 

Chapter 5 

Real Time Status 

What are Real Time Windows  

A real time window is an on screen display of a value that is calculated there and then, from 
information collected from the PBX.  These windows can be used to display information on the 
following single and group items. 

Single Items Groups 

DIDs 

Extensions 

Pilot Numbers 

Users 

Trunks 

Trunk Groups 

DID Groups 

Extension Groups 

Pilot Number Groups 

Account Code Groups 

Organization Groups 

There are four types of real time windows you can create to display call information; Real Time Status 
Windows, Real Time Statistics Windows, Single Value windows, and Combination Value Windows. 

How to: Accessing Real Time windows  

To access real time windows: 

1) On the main MyCalls screen click View –> Real time information 

2) This presents you with the following menu: 
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3) From this menu you can select the type of window you wish to view 

 

Real Time Status Windows 

A real time status window is one that displays a value that is derived from changes in state from the 
phone system. Configuring a Real Time Status window enables you to see immediate response to 
events which are occurring now, for example off hook, ringing and on hold conditions.  

These windows can be configured to show information relating to Users, Extensions, DIDs, Pilot 
numbers, trunks and Trunk groups. Users, extensions and trunks can give us device status information 
i.e. what state are they in at this moment.  

DIDs, Pilot Numbers and Trunk Groups represent queues of calls related to a particular DID, Pilot or 
Trunk group so the real time status associated with these items relates to the current number of calls 
waiting to be answered i.e. Calls in Queue (CIQ).  

A DID queue relates to the calls currently waiting which dialled that DID number. 

A Pilot queue relates to all calls which have been forwarded to a particular ACD queue (via a Pilot 
number). 

A ‘Trunk group’ queue represents the number of calls waiting to be answered at this moment in time 
for the trunks in that group or all trunks, if selected. 

Real Time Status Parameters 

A Real time status parameter is a value that is displayed in real time as a result of an event occurring 
in the telephone system.  

Real time status parameters can be displayed for the following types of devices and users:  

 Users 

 Extensions 

 DID’s 

 Pilot Numbers 

 Trunk Groups 

User status gives a real time visual indication of the current state of the extension a user is logged on 
to. Extension status view is also available for specific extensions. You can view the following states: 

 Idle/Available – The extension/user is available to receive calls 

 Off Hook – Receiver is picked up 

 Ringing – Incoming call is ringing the extension or user 

 Incoming connected – Incoming call has been connected, call in progress 

 Outgoing connected – outgoing call has been connected, call in progress  

 Hold – The extension has been put on hold or an extension has put another on hold  
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 Internal – Internal (extension to extension) call is in progress 

 DND (Do Not Disturb) – Extension is unavailable to receive calls  

 Unavailable – ACD User is unavailable to the ACD queues 

 Wrap UP – ACD User is wrapping up a call and is not currently available for a predefined time 

Real time status parameters for queues e.g. DID, Pilot Numbers and Trunk Groups include: 

 Caller 

 Trunk 

 Usage (trunk Groups only) 

 Calls in Queue 

 Longest Wait Time 

The following diagram shows how you might use real time status windows to look at calls being 
queued at different points in the telephone system. 
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User/ Extension Status views  

Detail, Summary and Overview views  

Real Time Status windows offer three ways of viewing extension or user status; Detailed, Summary 
and Overview.   

Detailed view   

This view is designed for the use of people in a supervisory role who may want to see the state of 
each extension or user and the amount of time they have been in that state. 

You can show combinations of states as each state is shown separately. The number of devices in 
any given state is shown e.g. Ringing (2) indicates 2 devices in the Ringing state. The devices or users 
in a given state are shown with the longest in that state at the top of the list. 

 

Summary view   

This view displays basic information relating to users or extensions. Only the currently active state is 
shown at any one time for each user or extension: 

 

Several types of information can be displayed in this view: 

 Group name 

 User/extension name 

 Extension number 

 Current status 

 Time in current state 

 Calling/Called number 

Overview view  

This view is useful for showing the state of many extensions in one screen. This view displays the 
Extension name/number or user name and a visual indication of the current state for each user that 
is included in the view. The current state of the extension or user is indicated by a colour coded 
indicator bar.  
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The indicator bar can be extended to reveal additional information: 

 Name of Extension or user  

 Number – Number being called or calling in 

 DID – DID that was called (Incoming calls only) 

 Pilot number – Pilot number that the call was assigned to 

 Caller – Calling in or being called 

 Code – Unavailable code  

 Time – Elapsed time in current state 

 Current status – current state of extension or user 
 

 
 

Creating User Status Views 

How to: Creating a new User Status view  

1) Click ‘Real Time Status’ 

2) Select the output you wish to create a new user status for e.g. user 

3) Click ‘Create a new user status view’ 

4) A new dialogue window will appear 
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5) You can select one or more organization groups from the organizational group’s selection box to 
include multiple group’s user statistics in the window.  Organisation groups are configured 
through the organization setup screen 

6) Select the window type i.e. detailed, summary or overview described previously 

7) With the detailed and summary variants of this window you can add additional column fields 
using the Column Chooser button.  Removing a column is simple by holding the left mouse 
button on the column header and dragging the column out of the window then releasing the 
mouse button.  The overview variant can have the Short Names option applied which will then 
display abbreviated name of the user (see user configuration) 

8) You can change the style of the font for the detailed and summary windows separately using the 
Edit Summary Font and Edit Detailed Font screens 

9) Click ‘OK’ 

 

Queue status and Queue group status 

When dealing with Users and Extensions we can only view their current status i.e. what is happening 
right now. When we are dealing with DIDs, Pilot numbers and Trunks however we want to see the 
amount of calls waiting to be answered.  

When calls are waiting to be answered we refer to them as queued calls.  

This can apply to the following situations: 

 Where multiple lines are calling in on a single number (DID for example) 

 Where multiple calls are incoming on multiple lines and waiting to be answered 

 When calls are being queued within the PBX as part of an ACD system 

Queue status windows can either give information for a specific queue e.g. ‘All Trunks’ or ‘Sales DID’ 
this is known as a queue status window. Alternatively, you can view one or more groups of queues in 
a single window. This is known as a queue group status.   

Queue status  

A real time queue status window represents a statistic calculated in real time as each event is 
processed for a given device i.e. DID, Pilot number or Trunk.  These windows are displayed as a current 
value such as the number of calls waiting to be answered at this moment in time. 
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The method for creating queue status windows is the same for DIDs, Pilot numbers and Trunks. The 
following is an example for the DID configuration. 

How to: Configure a DID queue status window 

1) From the ‘View’ menu select the option for ‘Real Time Information’ or select the  icon from 
the main toolbar. 

2) Expand the ‘Real Time Status’ section by clicking the + to the left of the text and then expand the 
DIDs section. Highlight the Queue Status option by clicking it and in the right side of the window  

3) Click the task ‘Create a New Queue Status View’  

4) The ‘Real time queue status’ configuration screen will be displayed 

 

5) If your MyCalls configuration is using more than one PBX then you can select between 
configured PBXs using the PBX drop down list 

6) Select a DID available from the DID drop down list 

7) You can change the style of the title font for the window by pressing the Edit Title Font button 
and configuring the various style options 
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8) In the visibility area of the configuration screen there are a number of options that can change 
the view of your queue status window.   

9) To enable any of them just click the box to the left of the option and ensure there is a tick in the 
box.   

10) To disable an option just remove the tick. 

11) Show Title: If enabled this will display in the window the device type and the device name. 

12) Show Caller: If enabled this option will display in the window the CLI of the next caller in the 
queue. 

13) Show Trunk: If enabled this will display in the window the trunk or line the next incoming 
queued call is being received from. 

14) Show Calls in Queue Label: If enabled this will display in the window the CIQ: label for the 
number of calls in queue value. 

15) Show Calls in Queue Value: If enabled this will display in the window the number of calls in 
queue value. 

16) Show Longest Wait Label: If enabled this will display in the window the Longest Call Waiting 
label for the longest call waiting value. 

17) Show Longest Wait Value: If enabled this will display in the window the longest call waiting 
value. 

 

18) When you have completed the configuration of your windows settings then press the ‘OK’ 
button and your window will be placed on the currently selected layouts page.   

19) Press ‘Cancel’ at any time to abort the setup. 

 

Queue-Group status  

If you want to display the number of calls that have not been answered and are currently waiting in 
queue for one or more groups, along with other head of queue information then a queue group 
status is required 
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Devices which support queuing should be grouped so that useful information can be obtained from 
them. Trunks could be grouped according to function e.g. Analogue trunks, GSM gateway trunks, BRI 
ISDN trunks.  

The following method shows how to configure a DID queue group status; however, the method is 
the same for DIDs, Pilot numbers and Trunks. 

How to: Create queue group status for DID groups  

1) Click ‘Real Time Status’ 

2) Select the output you wish to create a queue group status for e.g. DIDs 

3) Click ‘Create a New Queue Group Status View’, the following dialog will appear 

 

4) In the new dialogue window that appears, select the group or groups to include in the resulting 
window 

5) Click ‘OK’ 

 

Viewing Trunk Status  

It can be very useful to know what our trunk usage is at any point in time. Using a trunk status 
window, we can monitor usage for individual trunks and we can also display trunks in specific states 
such as busy, idle or ringing etc. Detailed, summary or overview views are available as with other 
real time status windows. 

Using Trunk Status 

The ability to view real time status gives you several ways of viewing the call activity within the 
organisation. Typical questions which can be answered include: 

How many calls are in a particular state right now e.g. on-hold, ringing, being answered, making an 
outbound call? 

Which trunks have been busy the longest? 

How many calls are ringing a specific DDI or put another way how many sales enquiries are waiting 
to be answered right now? 



Real Time Status 

  

 1510-002-010  Chapter 5-21   
 

     

How to: Create a trunk status view 

1) Select View->Real Time Information->Real time status->Trunk Status 

2) Click ‘Create a trunks status view’ 

  

3) Select the trunks to monitor from the ‘Trunks List’ 

4) Select the states to monitor by checking the appropriate boxes in the ‘Show trunks in these 
states’ list. 

5) Select the View style e.g. detailed, summary or overview. 

6) If required select a DID as a filter type and select the DID to filter results for in the filter device. 
This will ensure only calls for the specified DID will be displayed. 
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Chapter 6 
Real Time Statistics 

Real Time Statistics Windows  

Real time statistics allow you to calculate a wide range of statistical values for all the devices, users 
and groups. The groups can either be predefined system groups or user defined.  The system groups 
are automatically created and devices are assigned to these system groups according to the device 
type e.g. Digital Desk Phones. User defined groups are created by the application users according to 
how the devices and users are used in the organisation e.g. Sales, Accounts. Each statistics window 
has a ‘Drill-down’ open that can be used to display all calls that have contributed to the overall statistic 
shown within the window. 

Statistical periods and calculations  

Statistics can be calculated in various ways depending on how you want to view your data. Each of the 
statistics windows allow you to select the period over which the statistics are calculated. It is possible 
on Pro/Manager versions and above to have up to 3 different reset times per day across a week for 
the daily statistics 

Historical statistics 

These statistics are calculated differently depending on how you select the period. 

Daily: calculates a daily accumulated value or average which is reset each day at midnight 

Hourly: Calculates accumulated or averaged statistics for each hour of the day. All values are reset at 
midnight.  

Current statistics 

Last Hour: These values are calculated as a rolling statistic over the previous 1-hour period, for 
example if the time is currently 14:30 then the current value calculated will be that value between 
13:30 and 14:30 

Types of Real Time Statistics window 

There are four types of real time statistics accessible via the real time information menu; Real Time 
Statistics (Grid View) windows, Single Value windows, Combination value and Miscellaneous 
windows. 

 

Real time statistics (Grid View) windows display a user defined selection of statistics for one or more 
devices or groups. 
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Single value windows show an individual statistic in either a Numerical or Graphical format. 

Combination value windows show comparative statistics of different statistics on the same graph. 

Miscellaneous windows can display external data from XML, Database and other data sources and 
live web pages. 

Grid View Statistics windows:  

Select View -> Real Time Information -> Real Time Statistics from the MyCalls menu. 

This type of window allows you to view many statistics in the minimum screen area. You can configure 
group or individual statistics grid views. 

 

Real time statistics displayed in the grid view allows you to display cumulative call statistics on users, 
DIDs, extensions, pilot numbers, DID groups, extension groups, pilot number groups and trunk groups.  
Statistics included by default include answered calls, abandoned calls, grade of service and abandoned 
grade of service although more fields are available to be added to the view if required. 

Daily/Hourly Single Value windows:  

Single value windows provide numeric or graphical windows showing single value statistics based 
around Call Rate and Performance. Call Rate windows display numerical values only whereas 
performance statistics can display results as numerical values or graphical values.  

 

Numerical values appear as a single coloured window showing the parameter value and other 
associated information such as Title, Group, and the Interval over which the statistic is calculated e.g. 
daily, hourly. 
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Call Rate statistics show the cumulative counts for the various call types and you can elect to display 
these values over both historical (daily, hourly) periods and current (last hour) periods. 

Call Performance statistics are either cumulative totals e.g. number of long calls, or average values 
e.g. average wait time.  

The cumulative total statistics can only display values numerically and you can select both historical 
and current calculation periods. 

The Average value statistics can be displayed in both numeric and graphical format and the statistical 
period is limited to the ‘Today (by hour) option. If you elect to display the values in numerical format 
you will need to select the any other interval period in the configuration screen* and this option is 
only being available for the daily period.  

*See detailed configuration later in this section. 

 
Numerical View of average wait time statistic   

The graphical output displays the Min/Max values for the parameter as a bar and the average value 
is shown as a line graph over the 24-hour period. 

 

Graphical view of Average Wait Time (Today (by hour))  

Unreturned calls real time windows 

The unreturned calls operate differently to other real time statistics windows in that they can be 

displayed as a list format showing all unreturned calls currently active or they can be displayed as a 

single value window showing a total number of currently unreturned calls. 

You can create an unreturned calls window for each device type allowing you to show the 

unreturned calls for a specific group of devices such as extensions, DIDs etc. 
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How to: Create an unreturned calls  real time window 

Select View->Real Time Information->Single Value 

Select the type of device group you wish to filter the unreturned calls on so if you want to see all the 
unreturned calls coming into a group of DIDs then select DID groups -> call rate-> unreturned calls. 

Select Single Value or Call List depending on the display type you require  

Set the Interval period either to Today (by hour) or Today which shows calls from midnight previous. 

Select the device group either system or user created group 

Click OK 

 

Real time calls window configuration dialog 

The resulting windows look as follows: 

  

Unreturned calls single value window 



Real Time Statistics 

  

 1510-002-010  Chapter 6-27   
 

 

Unreturned calls list window 

Combination Value windows:  

Combination value windows provide graphical representation showing call volume histograms and the 
maximum and minimum number of calls mapped against average values. 

Combination values can only be displayed for historical statistics i.e. daily and 24hour and can display 
min/max bar charts for each hour and a line graph overlay showing the average values over time. 

 

Moving the mouse over the graph will show the Average and Min/Max values in a context window. 

 

The Combination values work best when looking at and comparing different call types such as 
Outgoing and Incoming calls. 
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Manipulating the Graphical displays 

Single value and Combination value windows can display results in graphical format. These graphs 
are easily manipulated to allow you to zoom into the area of interest as follows. 

How to: Manipulate the graph 

1) The original graph as seen above shows the activity over a 24-hour period, from midnight to 
midnight. Generally, the data you will be most interested in is during your working hours, for 
example from 9 till 6. MyCalls allows you to zoom in on these areas so that you don’t get a lot of 
space where there’s no activity. 

2) To zoom in on a selected area, click the mouse and drag across. For example, click the mouse at 
6am and drag to 6pm. 

3) A shaded area will appear over the selected area. 

 

4) Click to release, and a larger, zoomed in version will appear. 

 

5) Repeat this until you have the desired selected area. 

6) To return to the original graph click the minus  icon on the bottom left side of the graph. 
Click this several times. 
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Configuring Real Time Statistics w indows 

Group statistics windows 

You can view a wide variety of statistics for groups by configuring group statistics windows. You will 
need to create a separate window for each type of group from DID, Pilot, Trunk and Extension groups 
depending on what you want to view. Configuring the Group statistics window is the same in each 
case.  

The device groups are arranged under the menu options: 

 DID Groups 

 Pilot number groups 

 Trunk groups 

 Extension groups 

 

Individual statistics windows 

If you want to see statistics for individual devices or users, these can also be configured. You can view 
individual statistics for Extensions, Users, DIDs and Pilot numbers. You will need to configure a 
different window for each category and the method of configuration is the same in each case.  

Individual statistics are arranged under the menu options 

 Extensions 

 Users 

 DIDs 

 Pilot numbers 

 

Available statistics 

Once you have created your statistics window you can view a wide range of values by selecting the 
value from the column chooser. This gives a list of columns which can be dragged across to the 
statistics window. The available statistics are as follows: 

Average incoming duration 

Average duration for incoming connected calls 
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Average outgoing duration 

Average duration for outgoing connected calls 

Average total duration 

Average duration of all calls  

Average overflow duration 

Average duration for overflow calls. Overflow calls are waiting calls which have been moved from 
one ACD queue to another. 

Average overflow wait time 

Average wait time for overflowed calls  

Average abandoned call wait  

Average time which incoming abandoned calls were prepared to wait  

Average incoming call wait 

Average time which incoming connected calls were prepared to wait 

Average ring no answer (RNA) call wait time 

Average time which incoming calls had to wait before being answered when the intended extension 
did not answer in time and the call had to be forwarded to an alternative extension.  

Long Abandoned wait 

Number of abandoned calls where the ring time exceeded the ‘ABD Ring’ (abandoned ring time) 
defined in the Grade of Service for that specific device or group. The ABD Ring setting is specified for 
groups of devices or users in the operational grade of service configuration and can vary between 
different groups.  

Long incoming calls  

Number of connected incoming calls where the duration exceeded the ‘Inc/Overflow Call’ (maximum 
call duration) defined in the Grade of Service for that specific device or group. The Inc/Overflow 
setting is specified for groups of devices or users in the operational grade of service configuration 
and can vary between different groups. This statistic will include overflowed calls. 

Long incoming wait 

Number of connected incoming calls where the ring time exceeded the ‘Inc/Overflow Ring’ 
(maximum ring time) defined in the Grade of Service for that specific device or group. The 
‘Inc/Overflow Ring’ setting is specified for groups of devices or users in the operational grade of 
service configuration and can vary between different groups.  

Long overflow calls 

Number of connected overflow calls where the duration exceeded the ‘Inc/Overflow Call’ (maximum 
call duration) defined in the Grade of Service for that specific device or group. The Inc/Overflow 
setting is specified for groups of devices or users in the operational grade of service configuration 
and can vary between different groups.  

Long overflow waits 

Number of connected overflowed calls where the ring time exceeded the ‘Inc/Overflow Ring’ 
(maximum ring time) defined in the Grade of Service for that specific device or group. The 
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‘Inc/Overflow Ring’ setting is specified for groups of devices or users in the operational grade of 
service configuration and can vary between different groups.  

Overflow 

Number of connected overflowed calls.  

Ring no answer 

Number of ring no answered calls 

Total calls 

Total number of incoming and outgoing calls relevant to the specific group or device 

Total duration 

Total duration of connected incoming and outgoing calls calculated for a specific group or device 

Total abandoned calls 

The number of calls where the caller terminated the call before being answered by a group for a 
defined period 
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Current Shift Reset Times 

Real Time Statistics can be reset up to three times per day. This is ideal for companies that run 
different shifts. The following is an example of a business that would run three 8-hour shift, Monday 
to Friday.  

 

 

How to: Changing the Real Time Statistics Reset Times  

1) From the ‘Configure’ menu select the ‘Operational Settings’ and choose ‘Current Shift Reset 
Times’.  

  

2) From here, the statistics reset time can be changed. By default, they are set to reset once a day 
at midnight (00:00). These times can be altered to suit the needs of the users. Also, two more 
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reset times can be added per day.  

Note: if the same time features more than once in the same day, you will receive an error. To 
remove the duplicate time, select it and press the ‘Delete’ key. 

 

3) Once the appropriate changes have been made, click ‘OK’ and select ‘Yes’ to accept the changes  

 

Creating Grid View real time statistics windows  

Real time statistics windows can be configured to show groups of devices or individual devices. In 
operation grouped devices are very useful as they show an overall set of values across several 
devices or users.   

How to: Creating a group statistics window for Extensions  Groups 

1) From the ‘View’ menu select the option ‘Real Time Information’ or select the  icon from the 
main toolbar. 
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2) Expand the Real Time Statistics section by clicking the ‘+’ to the left of the text and then expand 
the ‘Extension Groups’ section. Highlight the Group Statistics option by clicking it and in the right 
side of the window click ‘Create a New Group Statistics View’.  

.  

3) If your MyCalls configuration is using more than one PBX then you can select between 
configured PBXs using the PBX drop down list. 

4) Group: Select an Extension Group or multiple groups from the list of available groups in the 
group list window.  By default, selections for All Desk Phones, All Digital Phones, All Extension 
Types, All Non PBX Phones, All System Phones, All User PBX Phones, All User Phones, All Voice 
Mail Ports and Unassigned Extensions will be available.  Additional entries are configured 
through telephone configuration. 

5) Display Values: You can select to display either historic of current values.  If you choose 
historical then the intervals available will be either Daily or Hourly.  Daily will display statistics for 
the current day whilst hourly will display the statistics for the current hour of the day.  If current 
only is selected, then the intervals available are Last hour and this is rolling time period for the 
previous 60 minutes from the current time. 

6) Interval Period: After selecting the display values in instruction 6 choose the interval period 
from the interval period drop down list. 

7) Refresh Time: You can set the refresh time for when you want the statistics in the window to 
refresh.  By default, this is set to 60 seconds. 
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8) You can change the style of the title and statistics fonts for the window by using either the Edit 
Title Font button or Edit Status Font button and configuring the various style options. 

9) When you have completed the configuration of your windows settings then press the OK button 
and your window will be placed on the currently selected layouts page.  Press cancel at any time 
to abort the setup.  

 

10) Once the window is created you can add additional columns to what is setup using the Column 
Chooser.  If you want to remove any columns from the window, then hold down the left mouse 
button on the column header you want to remove and drag the column out of the window area. 

Creation of individual device statistics window is a similar process to configuring a group window but  

How to: Creating an Extension statistics window 

1) From the toolbar click ‘View’ 

2) Select the option for Real Time Information or select the  icon from the main toolbar. 

3) Expand the Real Time Statistics section and then expand the Extensions section. Highlight the 
Extension Statistics option by clicking it and in the right side of the window click the task ‘Create 
a New Statistics View.’  

4) The real time extension statistics configuration screen will be displayed. (Note: in order for 
extensions to show up you need to enable real time statistics) 

 

5) PBX: If your MyCalls configuration is using more than one PBX then you can select between 
configured PBXs using the PBX drop down list. 

6) Extensions: Select Extensions from the list of available devices in the Extensions list window.  If 
your extension does not appear here, then it may need to be configured through telephone 
configuration. 
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7) Display Values: You can select to display either historic of current values.  If you choose 
historical then the intervals available will be either Daily or Hourly.  Daily will display statistics for 
the current day whilst hourly will display the statistics for the current hour of the day.  If current 
only is selected, then the intervals available are Last hour and this is rolling time period for the 
previous 60 minutes from the current time. 

8) Interval Period: After selecting the display values in instruction 6 choose the interval period 
from the interval period drop down list. 

9) Refresh Time: You can set the refresh time for when you want the statistics in the window to 
refresh.  By default, this is set to 60 seconds. 

10) You can change the style of the title and statistics fonts for the window by using either the Edit 
Title Font button or Edit Status Font button and configuring the various style options. 

11) When you have completed the configuration of your windows settings then press the OK button 
and your window will be placed on the currently selected layouts page.  Press cancel at any time 
to abort the setup.  

 

12) Once the window is created you can add additional columns to what is setup using the Column 
Chooser.  If you want to remove any columns from the window, then hold down the left mouse 
button on the column header you want to remove and drag the column out of the window area. 

 

Single Value Windows 

Single Value windows are designed to display a statistic that is calculated in real time as each call is 
processed.  These values can either be displayed as a current value or as a range of values over a 
defined time period or interval, such as number of calls answered in each hour. Single value windows 
can only display information relating to a whole group of devices or users including account code 
groups, DDI groups, extension groups, organization groups, pilot number groups and trunk groups. 
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Single Value windows – quick reference table  

 Account 
Code 

Groups 

DID 
Groups 

Extension 
Groups 

Organisation 
Groups 

Pilot 
Number 
Groups 

Trunk 
Groups 

Call Rate 

 

Incoming 
Calls 

            

Overflow 
Calls 

            

Outgoing 
Calls 

          

Internal Calls          

Abandoned 
Calls 

            

Performance 

 

Avg. 
Incoming 
Call Wait 
Time 

            

Avg. 
Incoming 
Call, Call 
Time 

            

Avg. 
Overflow 
Call, Wait 
Time 

            

Avg. 
Overflow 
Call, Call 
Time 

            

Avg. 
Outgoing 
Call, Call 
Time 
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Account 
Code 

Groups 

DID 
Groups 

Extension 
Groups 

Organisation 
Groups 

Pilot 
Number 
Groups 

Trunk 
Groups 

Avg. Internal 
Call, Call 
Time 

         

Avg. 
Abandoned 
Call, Wait 
Time 

            

Avg. General 
Service Level 

            

Avg. 
Abandoned 
Service Level 

            

No. Of Long 
Waiting 
Incoming 
Calls 

            

No. Long 
Waiting 
Overflowed 
Calls 

            

No. Of Long 
Incoming 
Calls 

            

No. Of Long 
Overflowed 
Calls 

            

No. Of Long 
Outgoing 
Calls 

          

No. Of Long 
Internal Calls 

         

No. Of Long 
Waiting 
Abandoned 
Calls 

            

Service Level             

Abandoned 
Service Level 
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How to: Creating a single value window 

1) Select the group you wish to show statistics for from the single value window list 

2) Select ‘Call Rate’ or ‘Performance’ 

3) Select the statistic that you wish to view from the list  

4) Click ‘Create a New Real Time Parameter Window’ 

5) In the dialog window that appears, you can alter the interval period, choose a group, alter the 
time and tick if you want to show a single value. 

 

6) The window will appear on the screen 

 

7) Click ‘OK’ 

Combination Value Windows  

A combination window displays several statistics at the same time.  These can be used to see how one 
value affects another, like a difference in call volume might result in customers receiving longer 
waiting times.  In this example more people are needed to answer calls to keep the wait time the 
same. 
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How to: Creating Combination Value Real Time Parameter windows  

1) Click to expand ‘Combination’ 

2) Select the group you wish to expand e.g. DIDs 

3) You are now presented with two options: clicking ‘call rate’ or ‘performance’ 

4) If you click call rate you will be presented with a call volume chart 

5) If you click performance, you will be presented with a chart of call wait time ranges. 

6) On both occasions the following window will appear: 

 

7) You can alter the interval period, the group and the refresh time. 

8) Click ‘OK’ 
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Removing a Real Time window  

To remove a real time window from your layout page, Press the  in the top right of the window 
and it will be deleted. 

How to: Configuring an existing Real Time window  

1) To change the configuration settings of a real time window, right click over the selected window 
with your mouse and select the ‘Configure’ option from the menu that appears near your cursor. 

2) You will then be presented with the configuration screen for that type of window and can 
amend the configuration settings to your requirements.  

 

3) Press ‘OK’ to apply the changes and view the newly configured window.   

4) Pressing the ‘cancel’ button at any time will abort the changes and revert back to the existing 
settings. 

Viewing External data  

From the ‘View->Miscellaneous’ menu we can configure windows to view web based information or 
information stored in XML files or data sources such as a database. 

External Data from an XML source 

Viewing external data from an XML file allows you to display XML content either as a single item or 
as a grid. The system verifies the XML is valid and is capable of monitoring (watching) the file for any 
changes which occur within the file and updating the window with the latest data. This allows you to 
monitor such items as daily sales figures for instance. Alternatively, you can set a timer which can 
update the window at preset intervals. 

The same principles apply to data extracted from a data source. Data sources can be conventional 
databases such as Microsoft SQL Server or ODBC based data sources such as spreadsheet files, 
accounts applications etc. 

Irrespective of whether you derive your data from an XML file or a data source the displayed 
information will be in tabular form (grid) or a single value.  
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External data displayed as a grid 

 

External Data displayed as a single value 

 

Using a Data Source for your data  

Where external data is derived from a data source the contents will be determined by an sql query. 
The query controls the source of the data and any ordering and filtering which needs to be applied. 
For a grid the column names will be determined by the column names of the query and the number 
of rows will match the rows returned from the query. It is reccomended that care be taken to ensure 
that the number of rows is kept to a small number to maintain performance. Where external data is 
displayed as a single value then the value displayed from a data source will be the first column of the 
first row returned in the SQL query.  

How to: Configuring an external data source window 

1) Select View->Real Time Information->Miscellaneous->External data 

2) Select ‘Create a New External Data View’ from the right hand panel  

3) Set up the configuration options as follows: 
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4) Import from: Data Source 

5) Display Type: select Single value or Grid dependent on the type of window required 

6) Database Type: Select SQL Server; OLE DB; ODBC; according to the type of data source you 
are deriving the data from. 

7) Refresh Time: determines the time interval between database queries.  

8) Connection String: Enter the text used to connect to your particular data source. 

9) SQL Statement: Enter your SQL query here 

10) Clicking the test button will check the connection and the query. If there is a problem then 
an error will be displayed, alternatively a message box will confirm the test was successful. 

11) Title: If ‘Single Value’ has been selected then you may enter a heading for the window here. 
This will be overwritten by the column name if the test button is clicked. 

12) Click ‘OK’ to view your external data window 

 

Example: Viewing the contents of an SQL Server database 

To view data from an SQL server database you will need to enter a valid connection string and SQL 
query. The details of the connection string vary according to requirements but as a guide the 
following string contains the essential requirements 

Data Source= [SERVER NAME]; Initial Catalog= {DATABASE NAME]; User ID=[USERNAME]; 
Password=[PASSWORD] 

The dialog below shows a typical setup.  
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Example: Viewing the contents of an Excel file  

Excel files can be used as a data source using an ODBC connection. You will need to generate a 
system ODBC connection using the windows ODBC data source utility (See Microsoft documentation 
on creating an ODBC connections). This defines the Excel file to be used as a data source. 

Having created the ODBC connection, you simply need to specify the DSN name you have created as 
the connection string as follows. 

DSN= [DSN NAME] 

The SQL query is specific to the excel data source but accessing a specific spreadsheet is as simple as 
specifying the following SQL 

Select * from [sheet1$] 

Where sheet1 is the name of the particular spreadsheet within the excel file. 
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Using an XML file for your data 

If you are going to use an XML file as a source of data for your external data window, then you will 
need to ensure that the file contains the correctly formatted and valid XML. The XML file can contain 
both single value data definitions and multiple column data definitions. 

The file must commence with a valid XML definition: 

<? xml version="1.0" encoding="utf-8”?>  

 All XML files must contain the following element 

<DataValues> 

If you are storing single values, then the file must contain the following element  

<SingleValue> 
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For each parameter which can then be viewed as a single value within a window you must define a 
<Param> Node as follows   

 

<Param> 

   <name /> 

   <value /> 

   <minvalue /> 

   <maxvalue /> 

  </Param> 

There can be one or more <param> nodes the sub-nodes are: 

Name: defines the name of the parameter.  

Value: defines the value of the parameter. 

Minvalue and Maxvalue: define the limits of the parameter value if the value is numeric 

 

The Single value definition would look like this: 

<DataValues> 
 <SingleValue> 
     <Param> 
         <name>Top Sales</name> 
         <value>Tom</value> 
         <minvalue>-1</minvalue> 
         <maxvalue>-1</maxvalue> 
     </Param> 
     <Param> 
         <name> Sales Value</name> 
         <value>1000</value> 
         <minvalue>-1</minvalue> 
         <maxvalue>-1</maxvalue> 
     </Param> 
     <Param> 
         <name>Number of Orders</name> 
         <value>31</value> 
         <minvalue>-1</minvalue> 
         <maxvalue>-1</maxvalue> 
     </Param> 
</SingleValue> 
</DataValues> 
 

The resulting display could look like this. 
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You could also create separate windows for’ Sales Value’ and ‘Number of Orders’ 

 

 

 

 

Multiple Column XML values 

Multiple columns must contain the following nodes 

First define the columns 

<GridValue> 

  <Param> 

   <name>Sales</name> 

     <columns> 

 <column minvalue=”-1” maxvalue=”-1” /> 

  <name>Operator</name> 

 </column> 
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 <column minvalue=”-1” maxvalue=”-1” /> 

  <name>Sales Value</name> 

 </column> 

 <column minvalue=”-1” maxvalue=”-1” /> 

  <name>Orders</name> 

 </column> 

     </columns> 

 Then define the row content 

     <rows> 

       <row> 

           <value>Tom</value> 

           <value>9200</value> 

           <value>7</value> 

       </row> 

       <row> 

           <value>Andy</value> 

           <value>8100</value> 

           <value>5</value> 

       </row> 

       <row> 

           <value>Wendy</value> 

           <value>5630</value> 

           <value>4</value> 

       </row> 

     </rows> 

  </Param> 

 </GridValue> 

 The resulting grid would look like this. 
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How to: Configure an XML external data window 

1) Select View->Real Time Information->Miscellaneous->External Data  

2) Select Create New External Data View 

 

3) Select the parameters in the dialog as follows: 

4) Import from: XML 

5) For a single value windows select the following settings 

6) Display Type: Single Value 

7) File Name: Browse for the XML file you are using as your data source 

8) Watch File: Select if you wish changes to the file to be reflected in the window 

9) Check File: select this if you want to refresh the file contents at intervals specified in the 
Refresh time setting 

10) Single Item to Display: Select the Item to display in the window. This will be one of the 
‘param’ names defined in the file. 

11) Title: Define the window title 
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For a multiple column grid select the following values 

1) Display Type: Grid 

2) File Name: Browse for the XML file you are using as your data source 

3) Watch File: Select if you wish changes to the file to be reflected in the window 

4) Check File: select this if you want to refresh the file contents at intervals specified in the 
Refresh time setting 

5) List to display: Select the list of values to display. The XML file may contain several 
<gridvalue> node sets. 

6) Click ‘OK’ 

 

Web Browser 

External Data Windows can be used to view websites which can be used to enhance the information 
visible on your wall board by displaying data from external websites or internal company intranets. 

Configuration is very simple and you can include basic navigation which allows you to go back to 
your home page or track backwards or forwards between pages you have visited. 

How to: Configure a web browser window 

1) Select View->Real Time Information->Miscellaneous->Web Browser  

2) Select ‘Create New Web Browser’ 

3) Home Page: Enter the web address of the page you wish to view  

4) Allow Navigation: displays back, forward and home navigation 

5) RefreshType: Automatic refreshes the page according to the refresh time setting, Manual 
requires user to manually refresh the page. 
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A Configured Web Browser window 
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Chapter 7 

Real Time Statistics Drill Down Windows and Reports 

 

Drill down analysis of telephony data 

When viewing a headline statistic, it is often desirable to examine the detailed data that makes up 
the statistic. A good way to present a headline statistic is by viewing a single value window displaying 
the number of calls for a particular parameter such as the number of calls handled by an extension 
group.  

From this level the user can drill down into the statistic to further examine the details of the data. 
The way in which the data is examined may vary according to the business function, for example a 
marketing department may wish to know if calls to a certain DDI or Pilot queue are being answered 
efficiently whereas a line manager may be more interested in the performance of specific individuals 
or departments.  

The ability to drill down from a headline statistic also makes the layout of a user screen simpler as 
detailed statistics do not need to be shown all the time if they are accessible via a click of the mouse. 

The drill down windows as described above are intended to be to be used for a temporary analysis 
of an interesting headline figure, for a more permanent record drill down reports are also supported. 

The report is generated using the configuration of the window it came from, so it will be for the time 
period the window is configured for and filtered to the relevant device types and devices. 

Drill down Real Time Windows 
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Single Value Statistics Drill  Down Window 

 

 
 

From this window there are one or two types of drill down window available depending upon the 
type of device the single value window has been configured as. 
For Account Code and Trunk Groups the only drill down available is to the details of the calls that 
were used to calculate this value.  
This drill down window can be accessed by either double-clicking anywhere in the window or using 
the right click mouse button and clicking on ‘Calls’. 

 

 

 

This would produce a real time call records view similar to below: 

 

 

For all other device types, the calls drill down window is available and also a breakdown of calls by 
the devices that are members of the configured group. The breakdown of calls by device drill down 
window can be accessed by using the right click mouse button and selecting the device type name. 
In the sample below, the drill down would be to show the calls for all the extensions in the selected 
group. 
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This would produce a device statistics window similar to below: 
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Device Group Statistics Drill  Down  Window 

There are two types of drill down window available from here. If the group name is clicked on, then 
a device statistics window for the selected device group will be shown. If one of the call numbers is 
click on, then a real time call records view filtered to the selected device group result as shown 
below: 
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Device Statistics Drill  Down  Window 
 

There are two types of drill down available from here, both resulting in a real time call records view 
being displayed.  
If the device name/number is clicked on, then a call records view filtered to all the calls that 
extension handled is produced. 
If any of the call numbers is clicked on, then a call records view filtered to the calls of that type that 
extension handled is produced. In the sample below if the number 17 was clicked on, a call records 
view for all the abandoned calls for extension 223 would result. 
 

 
 

Note that for Organisation based windows, the drill down capability is restricted to ensure users can 
only view calls in the statistics drill down windows that are appropriate to their position in the 
organisational hierarchy.  

The user security model is explained in the section on users in this manual. 

Drill  Down options  

The tables below show which statistics windows are available for Trunks, Extensions, DID's, Account codes and 
Users (Organisation). 
 

Single Value – Call Rate 
 
The follow table shows the drill down options available for the various configurations of the single value 
statistics windows.  
 
The default ‘Daily’ window configuration, it also applies to the ‘Hourly’ setting under the ‘Current’ option, the 
difference being that the Hourly stats only show the calls for the last hour. The ’24 Hour’ setting under the 
‘Historical’ option only the ‘Calls’ drill-down options apply. 
 

Statistic type Drill Down Options Group Member Statistics Call Statistics 

Account Codes 

Account Code – 
Incoming 

Calls  List of all incoming calls 
that make up the 

displayed value 

Account Code – 
Outgoing 

Calls  List of all outgoing calls 
that make up the 

displayed value 
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Account Code – Internal Calls  List of all internal calls of 
that make up the 

displayed value 

Account Code – 
Abandoned 

Calls  List of all abandoned 
calls that make up the 

displayed value 

DIDs 

DIDs – Incoming DID List of DIDs in the group  All calls for selected DID 
or statistic  

Calls  List of all incoming calls 
that make up the 

displayed value 

DIDs – Abandoned DID List of DIDs in the group  All calls for selected DID 
or statistic  

Calls  List of all abandoned 
calls that make up the 

displayed value 

DIDs – Unreturned   List of all abandoned 
calls that make up the 

displayed value 

DIDs – Ring No Answer DID List of DIDs in the group  All calls for selected DID 
or statistic  

Calls  List of all RNA calls that 
make up the displayed 

value 

Extensions 

Extensions – Incoming Extensions List of Extensions in the 
group  

All calls for selected 
extension or statistic  

Calls  List of all incoming calls 
that make up the 

displayed value 

Extensions – Outgoing Extensions List of Extensions in the 
group  

All calls for selected 
extension or statistic  

Calls  List of all outgoing calls 
that make up the 

displayed value 

Extensions – Internal Extensions List of Extensions in the 
group  

All calls for selected 
extension or statistic  

Calls  List of all internal calls 
that make up the 

displayed value 

Extensions - Abandoned Extensions List of Extensions in the 
group  

All calls for selected 
extension or statistic  

Calls  List of all abandoned 
calls that make up the 

displayed value 

Extensions – Unreturned   List of all abandoned 
calls that make up the 

displayed value 

Extensions – Ring No 
Answer 

Extensions List of Extensions in the 
group  

All calls for selected 
extension or statistic  

Calls  List of all RNA calls that 
make up the displayed 

value 

Organisation 
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Organisation – Incoming Users List of Users in the group  All calls for selected user 
or statistic  

Calls  List of all incoming calls 
that make up the 

displayed value 

Organisation – Outgoing Users List of Users in the group  All calls for selected user 
or statistic  

Calls  List of all outgoing calls 
of the select type that 

make up the displayed 
value 

Organisation – Internal Users List of Users in the group  All calls for selected user 
or statistic  

Calls  List of all internal calls 
that make up the 

displayed value 

Organisation – 
Abandoned  

Users List of Users in the group  All calls for selected user 
or statistic  

Calls  List of all abandoned 
calls type that make up 

the displayed value 

Organisation – 
Unreturned 

  List of all abandoned 
calls that make up the 

displayed value 

Organisation – Ring No 
Answer 

Users List of Users in the group  All calls for selected user 
or statistic  

Calls  List of all RNA calls that 
make up the displayed 

value 

Pilot Numbers 

Pilot Numbers – 
Incoming 

Pilot Numbers List of Pilot Numbers in 
the group  

All calls for selected 
pilot number or statistic  

Calls  List of all incoming calls 
that make up the 

displayed value 

Pilot Numbers – 
Outgoing 

Pilot Numbers List of Pilot Numbers in 
the group  

All calls for selected 
pilot number or statistic  

Calls  List of all outgoing calls 
that make up the 

displayed value 

Pilot Numbers – 
Abandoned 

Pilot Numbers List of Pilot Numbers in 
the group  

All calls for selected 
pilot number or statistic  

Calls  List of all abandoned 
calls that make up the 

displayed value 

Pilot Numbers – 
Unreturned 

  List of all abandoned 
calls that make up the 

displayed value 

Pilot Numbers – Ring No 
Answer 

Pilot Numbers List of Pilot Numbers in 
the group  

All calls for selected 
pilot number or statistic  

Calls  List of all RNA calls that 
make up the displayed 

value 

Trunks 
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Trunks – Incoming Calls  List of all incoming calls 
that make up the 

displayed value 

Trunks – Outgoing Calls  List of all outgoing calls 
that make up the 

displayed value 

Trunks – Abandoned Calls  List of all abandoned 
calls that make up the 

displayed value 

Trunks – Unreturned   List of all abandoned 
calls that make up the 

displayed value 

Trunks – Ring No Answer Calls  List of all RNA calls that 
make up the displayed 

value 

 
 

Single Value – Performance statistics  
 

 Avg. Incoming Call Wait Time 

 Avg. Abandoned Call Wait Time 

 Avg. Ring No Answer Call Wait Time 

 Avg. Incoming Call, Call Time 

 Avg. Outgoing Call, Call Time 

 Avg. Internal Call, Call Time 

 No. of Long Waiting Incoming Calls 

 No. of Long Waiting Abandoned Calls 

 No. of Long Incoming Calls 

 No. of Long Internal Calls 

 Avg. General Service Level 

 Avg. Abandoned Service Level 

 Service Level  

 Abandoned Calls Service Level  
 
 

Window Configuration Drill-Down Options 

  Group Member Calls 

Current Hourly   

Historical 24 Hour   

Historical Daily – Graphical   

Historical Daily – Single Value *  

*- Does not apply to Account Codes/Trunk windows  
 
 
 
Totals and Service Levels statistics windows offer the following options for drill down. 
 

Window Configuration Drill-Down Options 

  Group Member Calls 

Current Hourly   

Historical 24 Hour   

Historical Daily *  

* Does not apply to Account Codes/Trunk windows  
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Real Time Statistics windows  
Real time statistics windows display a list of selected groups along with group totals for all statistics. To drill 
down into the details you can select one of the groups or a specific statistic. Only groups and statistic which 
are displayed as underlined can be drilled into 
 

Window type Selected link Group level Calls level 

DID Group Statistics DID group List of DIDs with 
statistics in the group 

All calls for selected DID 
or statistic 

Statistic  List of calls that make up 
the displayed value 

Pilot Number Group 
Statistics 

Pilot group List of pilot numbers in 
the group 

All calls for selected pilot 
number or statistic 

Statistic   

Trunk Group Statistics Trunk group List of trunks with 
statistics in the group 

All calls for selected 
trunk or statistic 

Statistic  List of calls that make up 
the displayed value 

Extension Group 
Statistics 

Extension group List of extensions with 
statistics in the group 

All calls for selected 
extension or statistic 

Statistic  List of calls that make up 
the displayed value 

Extension Statistics Extension number N/A All calls for selected 
extension or statistic 

Extension name N/A All calls for selected 
extension or statistic 

Statistic N/A List of calls that make up 
the displayed value 

Users Statistics Name N/A All calls for selected user 
or statistic 

Statistic N/A List of calls that make up 
the displayed value 

DIDs Statistics DID N/A All calls for selected DID 
or statistic 

Name N/A All calls for selected DID 
or statistic 

Statistic N/A List of calls that make up 
the displayed value 

Pilot Numbers Statistics Pilot Number List of pilot numbers in 
the group  

All calls for selected 
extension or statistic 

Name List of pilot numbers, by 
name, in the group 

All calls for selected pilot 
number or statistic 

Statistic  List of calls that make up 
the displayed value 

 

Combination Values statistics windows  

 

Account Code Groups Daily Calls  All calls for selected 
group 

DID Group Daily Calls  All calls for selected 
group 

Extension Group Daily Calls  All calls for selected 
group 
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Organisation Group Daily Calls  All calls for selected 
group 

Pilot Number Group Daily Calls  All calls for selected 
group 

Trunk Group Daily Calls  All calls for selected 
group 

 

User configuration.  
 
Drill down capability is restricted to ensure users can only view calls in the statistics drill down windows that 
are appropriate to their position in the organisational hierarchy.  
 

User Level Drill Down window will show 

Administrators  All calls for all users in their group and any sub 
group 

Supervisors All calls for all users in their group and any sub 
group 

Users Calls belonging to that user only 

 
The user security model is explained in the section on users in this manual. 
 

 

Drill down Reports 

 

Single Value Statistics Drill  Down Reports  

 

   

 

 

From these windows the following reports are available: 
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 Call Detail 

 Group Summary 

 Group Member Summary 

 Group Summary Profile 

These are accessed using the right click mouse button as shown below: 

 

The profile report is broken down into time periods which are relevant to the time period of the 

window. 

In the example given, all the reports would be over a time period of today and the following 

information would be shown: 

Call Details – All the details of all the incoming calls for All Trunks for today. 

Group Summary -  A single line summary of all the incoming calls for All Trunks for today 

Group Member Summary – A summary of the all incoming calls for All Trunks for today by trunk. 

Group Summary Profile – A summary of all the incoming calls for All Trunks for today by hour 

Device Group Statistics Drill  Down Reports  

 

There are different reports available from this window, depending upon where in the window the 

click occurs. 
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If the mouse is right clicked anywhere in the actual body of the statistics display, then the following 

will be seen: 

 

Any report done from here will be filtered to just the call types shown in the window – in the 

example above internal calls would be filtered out. A group filter will also be applied – in the 

example above it would be an extension group flter. Specifically the report would be filtered to the 

group selected when the right mouse button was clicked. 

The profile report is broken down into time periods which are relevant to the time period of the 

window. 

In the example given, all the reports would be over a time period of today and the following 

information would be shown: 

Call Details – All the details of all the incoming calls for the selected extension group for today. 

Group Summary -  A single line summary of all the incoming calls for the selected extension group 

for today 

Group Member Summary – A summary of the all incoming calls for the selected extension group for 

today by extension. 

Group Summary Profile – A summary of all the incoming calls for the selected extension group for 

today by hour 

If the mouse is right clicked anywhere else in the window, then the following will be seen: 
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In the example given, the report would be over a time period of today and the following information 

would be shown: 

Group Summary for All  - A Group Summary report that includes all the groups contained in the 

window. 

Device Statistics Drill  Down Reports  

 

There are different reports available from this window, depending upon where in the window the 

click occurs. 

If the mouse is right clicked anywhere in the actual body of the statistics display, then the following 

will be seen: 
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Any report done from here will be filtered to just the call types shown in the window – in the 

example above internal calls would be filtered out. A device filter will also be applied – in the 

example above it would be an extension flter. Specifically the report would be filtered to the 

extension selected when the right mouse button was clicked. 

The profile report is broken down into time periods which are relevant to the time period of the 

window. 

In the example given, all the reports would be over a time period of today and the following 

information would be shown: 

Call Details – All the details of all the incoming calls for the selected extension for today. 

Group Summary Profile – A summary of all the incoming calls for the All Extensions group filtered to 

the selected extension for today by hour. 

If the mouse is right clicked anywhere else in the window, then the following will be seen: 

 

In the example given, the report would be over a time period of today and the following information 

would be shown: 
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Group Summary for each Member - A Group Summary for each Member report for the All 

Extensions Group filtered to the  extensions contained in the window. 

Call Volume Drill  Down Reports  

 

No matter where in the window the mouse is right clicked, the following will be shown: 

 

In the example given, all the reports would be over a time period of today and the following 

information would be shown: 

Call Details – All the details of all the incoming/abandoned/outgoing calls for All Trunks for today. 

Group Summary -  A single line summary of all the incoming/abandoned/outgoing calls for All Trunks 

for today 

Group Member Summary – A summary of the all incoming/abandoned/outgoing calls for All Trunks 

for today by trunk. 
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Group Summary Profile – A summary of all the incoming/abandoned/outgoing calls for All Trunks for 

today by hour 

Call Wait Time Drill  Down Reports  

 

No matter where in the window the mouse is right clicked, the following will be shown: 
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In the example given, all the reports would be over a time period of today and the following 

information would be shown: 

Call Details – All the details of all the incoming/abandoned calls for All Trunks for today. 

Group Summary -  A single line summary of all the incoming/abandoned calls for All Trunks for today 

Group Member Summary – A summary of the all incoming/abandoned calls for All Trunks for today 

by trunk. 

Group Summary Profile – A summary of all the incoming/abandoned calls for All Trunks for today by 

hour 
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Chapter 8 

Call Recording 

The MyCalls system provides access to call recordings using the Calls list on the front screen. From 
the calls list you can see at a glance any calls which have been recorded and you can playback these 
calls on the desktop simply by clicking the call playback icon (see below). 

Enabling Users for Call Playback 

Any MyCalls user can be enabled for call playback. By default, if no users are created in MyCalls, you 
will be able to playback all calls.  Once users have been created then anyone logging into MyCalls as 
a user will have certain rights and restrictions dependent on their user type and where they appear 
within the organisational hierarchy. 

The steps required to ensure call recording can take place for a given set of users are as follows: 

 Create your users and user groups* 

 Assign each user with a Role 

 Assign your users to their respective organisational groups 

 Assign each user a default extension 

 Assign each user a login/pin if required** 

 Enable the user for Call-Recording 

 Configure any Call-Recording rules 

The rules governing the playback of calls  

 Any users that are created and want to play back calls must be enabled for call playback 

A normal User can listen to their calls only 

An Agent Desktop user can listen to their calls only 

A Wallboard user can not listen to any calls 

A Supervisor can listen to any calls within their organisational group and any sub group 

An ACD Supervisor can listen to any calls within their organisational group and any sub group 

A PBX Administrator can listen to any calls on their PBX  

An Enterprise administrator can listen to any calls on all PBXs 
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The above rules can be overridden by applying call recording rules to Callers, Users, Extensions, 
Trunks, DIDs and call types.  

To ensure call recordings are only visible to users with appropriate permissions it is important to 
setup the organisational hierarchy correctly.  In the example below, the highest level group is called 
Office admin and in that group, there is a Supervisor (Mark).  The supervisor can playback any calls 
from office admin and customer service. 

The Supervisor in customer service (Sarah) however, can only playback calls in the customer service 
group. 

 

 

For the Hierarchal user structure to work correctly, the users must be assigned to extensions.  To 
assign a user to an extension, go to configure / telephone system and edit an extension. The user is 
only assigned to calls on that extension from the time the extension is assigned to them. 

How to: Enable a User for playback 

1) In Configure -> Organisation click ‘Create New User’ or ‘Edit an Existing User’ and then select 
‘Call Recording’ from the category list on the left. 

 

2) To give a user the ability to playback calls, check the ‘Enable Call Playback’ box 

3) To give the user the ability to export calls click ‘Enable Export of Recordings’ 

4) Click ‘OK’ to save any changes. 

 

*For more details on users and groups see the Organisation configuration section 

** For more details on login/pin configuration see the Telephone system device configuration 
section 

Restricting Call Playback  

To enable or disable the recording of certain types of calls or calls made to or from certain parts of 
your organization you can define recording rules. These rules enable or disable specific devices, 
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users and call types from being recorded. This allows you to override the normal rules governing 
users as described above. However, recording rules cannot enable a user to listen to a wider range 
of calls than their position in the organisation allows. For example, a user can only ever listen to their 
own calls however you could specifically disable calls on an extension within a group from being 
recorded.   

 

How to: Configure Call Recording Rules  

1) From the menu select - Configure -> Telephone system -> PBX -> Call Recording 

 

2) Select the ‘Edit Call Recorder’ Configuration 

3) The ‘Edit Call Recorders’ window will be displayed – select the ‘edit’ button for the recorder for 
which you wish to set rule 

 

4) From the call recording configuration page click ‘Recording Rules’ 
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5) The Recording Rules dialog is displayed and you can define rules for enabling or disabling calls. 

 

6) Extensions, DIDs, Callers, Trunks and Users can all be included or excluded from being recorded 
as required.  
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How to: Set up recording rules for Extensions  

  

1) Add devices to the ‘Selected’ list by selecting them in the ‘Available’ list and clicking  

2) Choose ‘Do not record the selected devices’ or ‘Only record the selected extensions.’    

You can also decide to include incoming only, outgoing calls only or both. 
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Using the Call Playback Interface  

Once logged into MyCalls the calls list will provide access to the recorded calls. The leftmost column 
of the calls list provides an Icon to indicate the call recording status. 

‘No Icon’ indicates there is no recording for that call 

‘A plain speaker icon’ indicates a recording has been matched to the call 

 

‘A greyed out speaker icon’ indicates a recording has been matched to the call but the recording has 
been disabled 

 

 ‘A speaker icon with a red cross’ indicates a recording has been matched to the call but the user is 
barred from playing back the call 

 

‘A speaker icon with a red cross and a green arrow’ indicates the call is a transferred incoming call, a 
recording has been matched to the call but the user is barred from playing back at least part of the 
call 

 

How to: Select and Playback a call  

1) From the ‘view’ menu select ‘Call Records View’ or select ‘Calls’ from the toolbar at the bottom 
left side of the screen: 

 

2) By default, the call records view will display the last 50 calls for the current day.  Calls that have 
been recorded will show a speaker icon meaning they have been recorded.   

3) To play a call that has been recorded, simply double click the speaker icon   located in the far 
left box to play the call. 
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4) After you have double clicked the speaker, the player will load and play the call. At the same 
time the new call will be added to the playlist. 

5) The currently playing call or call leg is displayed in Red. 

6) Right clicking on the calls view will also allow you to playback a call by selecting the Playback Call 
item from the menu. 

 

Multiple call selection 

You may select several calls from the calls view listing.  

To select a range of call, click on the first call required from the list and then hold down the shift key 
and click on the last call required. All calls between the first and last calls will be selected.  

 

To select several individual calls, click on each call whilst holding down the Ctrl key. 
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The Call Player 

MyCalls provides a desktop player specifically designed for call recording and playback. The player 
provides the following functions 

 Play/Stop 

 Fast forward/Rewind 

 Overall Volume 

 Adjust relative volume between each call participant   

 Change speed of playback without affecting pitch to clarify what was said 

 Create selections and store as sound clips 

 Set the start and endpoints of a selection as either a time or via mouse selection 

 Loop round selections or complete calls 

 View transfers as separate sections of a call 

 Navigate between sections of a call  

 Play next and previous sections of a call 

 Create playlists of complete calls 

 Play next/previous call in playlist 

 Create notes for calls 

 Auditing of playback and export activity 

 Export of audit logs 

 Export of calls 

Feature Configuration  

You may not have all the features of the player available. The call player feature configuration is 
determined by the license as follows. 

 

 Waveform 

Display 

Sound 
clips 

Section 
markers 

Single 
call 
recording 
export 

Bulk call 
recording 
export 

Volume, 

Balance, 

Playback 
Speed 

Call 
Audit 

Basic         

Enhanced             

Enhanced+Audit                 

 

Call Playback 

When a call is selected for call playback it is added to the playlist. Double clicking the speaker icon 
from the call records list launches the player and commences call playback. Control of playback is via 
the playback buttons. 
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Call Player Waveform 

 

 

The call player can display a waveform representing the recorded call. This option is licensable and 
only available with the enhanced call player.  If the product is licensed as a basic configuration, then 
a compressed waveform window will be visible but no actual waveform trace will be shown. With 
the enhanced player a full two channel waveform is visible. 

When a call is played a yellow cursor line will move across the waveform window indicating the 
position of the playback point. The cursor also displays the elapsed time in minutes and seconds 
from the start of the call. If the call length is greater than 1 hour, then hours and minutes will be 
shown. 

 

The bottom of the waveform window shows the time base of the call and this is scaled automatically 
to match the call length.  

The player can playback the whole call or selected parts of the call. Whether you are using the player 
in basic or enhanced configuration selections can be made from the waveform window in the same 
way. 
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How to: Make a selection in the waveform window  

To make a selection from the waveform window simply click and drag the mouse along the 
waveform window.  

The selected area will show up as a grey block. 

 Release the mouse and the selection will be displayed along with a selection control bar which 
appears as a white line with a grab handle at either end of the selection.  

Selecting the control bar in the centre will allow you to move the selection left or right.  

Selecting either of the grab handles will allow you to adjust the start or end point of the selection 
independently. 

Clicking within the selection but away from the selection control bar causes the playback cursor to 
move to the mouse position.  

 

Basic Player showing selection but no waveform 

To cancel a selection simply right click the selection and pick ‘Cancel Selection’ from the context 
menu. 

 

Creating a sound clip (Enhanced player only)  

Once you have created a selection it can be turned into a sound clip. Sound clips can be named and 
are automatically saved into a sound clip list when they are created. 

How to: Create a new sound clip  

To create a new sound, clip right click a selection and select ‘Add to sound clips’ from the context 
menu.  

This will place the sound clip into the sound clips list with a default name of ‘New Clip’.   

The name of the clip is displayed in the waveform window so each clip is easily identifiable.  

The name of the clip can be changed from the ‘sound clips list’ by selecting the name of the clip and 
typing the new name over the selected text (see ‘sound clip list’ section) 
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 A sound clip can be selected and manipulated just like a normal selection by right clicking over the 
sound clip and selecting “Select ‘New Clip’” from the menu (New clip is replaced with the name of 
the clip to be selected see below). 

  

Selecting a new clip 

 

Selecting a clip named ‘Intro’ 

To delete a sound, clip right click the sound clip waveform and select Delete [Clipname] from the 
menu. 

 

 

Enhanced player with full waveform and multiple sound clips 

Exporting Audio 

 

The waveform window provides a mechanism to export the call audio to either WMA or WAV file 
format. Right clicking on any part of the window will give you the option to export the whole call. 
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Right clicking on a selected area of the call will allow you to export the selection. 

 

Calls can also be exported directly from the Calls View list on the main MyCalls screen. 

If you have created a sound clip, then right clicking the sound clip allows you to export the sound clip 
as a WMA or WAV file. Sound clips can be exported from the sound clips grid using mouse right click 
and selecting ‘Export sound clip’ from the menu. 

  

Call audio can be exported by using the right-click menu in the following locations: 

 Main call list 

 Any Playlist 

 Sound Clip list 

 Waveform window 

Selecting either ‘Export Call Audio’, ‘Export Selection’ or ‘Export sound clip’ opens a dialog box and 
you can choose where to save the file and select the format. The default filename is determined by 
the call recording configuration. The file format can be selected from the ‘Save as type’ drop down 
box. 
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You can export audio for single calls or multiple calls. To export multiple calls simply select the 
required calls from the calls view or playlist, right click on the selections and click ‘Export Call Audio’. 
When exporting multiple calls, the dialog will be slightly different as shown below and export 
progress will be visible in the status bar for each call (the status is also visible for single calls but only 
usually visible on longer calls). 

 

Multiple selection export dialog 

 

Export Status 

Playback Controls 
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The playback controls are as follows: 

 Play/Stop: operates the playback of the call, click to start playback, click again to pause, 
playback will then continue from that point.  

 Rewind: Click and hold will rewind the cursor, single click will set the cursor back at the state 
of the call. 

 Fast Forward: Click and hold to fast forward the call. 

 Previous Section/Next Section: Calls contain various sections as follows: 

 Ring: This is at the start of the call and is determined from the ring duration 

 Answer: This is the main part of the call 

 Transfer: This is determined when a call is transferred to another extension 

NB: The sections of a call are determined from values within the SMDR and may not be available on 
all telephone switches. An option is available in the call recording configuration (see call recording 
configuration) to disable call sections, in which case these buttons are greyed out indicating they are 
disabled (as in the picture above). 

Waveform Enable: Enables or disables the display of the waveform. Disabling the waveform allows 
you to quickly scroll through a playlist without having to wait for the waveform display to update 
between each call selection. 

Loop Enable: Allows you to loop a complete call or a selection. 

Playlist controls: These buttons allow navigation of the playlist items and sound clip items (see 
playlist and sound clips section). 

Call Player Management Panel  

 

 

The call player management panel allows you to manage Playlist, Sound Clips, Notes and Audits. 
Select the type of item you wish to manage from the tabs below. 

 

Playlists 

Playlists contain a list of calls selected from the main call records list. A playlist will remain in the 
player as long as the MyCalls client application is running. When a call is selected and played it is 
added to the current playlist. Calls can be added to the playlist using one of the following methods: 

 Double click the speaker icon 

 Right click on the call and select ‘Playback Call’, this will automatically play the call as well 

 Right click on the call and select ‘Add to playlist’ 

 Click and drag a call from the call records to the playlist. The player needs to be open in 
order to use this method. 

Only calls with a valid speaker icon can be added to the playlist.  

Calls can be removed from the playlist by right clicking the call within the list and selecting ‘Remove- 
Selected’ from the context menu.  

Calls which contain multiple transfers (multi leg calls) are shown with a plus symbol next to the call. 
Clicking on the plus symbol expands the call and allows you to select a specific call-leg. 
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You can see in detail which extensions have participated in the call and how long each leg of the call 
lasted. 

Selecting either the main call record or any leg of the call will cause that call to be loaded into the 
player and played back from the start of the call. The currently selected call or call-leg is displayed in 
red. 

 

Right clicking a call in the playlist gives the following options 

Export Call Audio: In the same way as selecting this option from the waveform menu 

Copy: Copies the call details to the clipboard for pasting into a document or report 

Select All: Select all calls in the list 

Export to File/Clipboard/Email: exports the contents of the selection to a text file, clipboard or email. 
Email recipients must be configured into the application. 

Remove Selected, remove all: Remove items from the playlist. 

Sound Clips 

 

 

Any sound clips which have been created are listed under the sound clips tab. Each sound clip can 
have a name, description, start and end point, and a colour. There is also an option to show or hide 
the clip in the waveform window. 

Sound clips are associated with a specific call and will remain in the list until the associated call is 
deleted from the playlist. 



Call Recording 

  

 1510-002-010  Chapter 8-34   
 

How to: Edit Sound Clip Details  

Single click on the ‘Name’,’ Description’,’ Begin’ or ‘End’ column for the sound clip.  

This will select the sound clip within the waveform window and select the text or time value for 
editing. 

For text columns Name and Description simply enter the text required. For Begin and End times 
enter the times required.  

Colour selection can be changed for a sound clip by clicking on the colour column and selecting a 
new colour from the palette. 

 

Notes 

A note can be added to a call either in the playlist or from the call record view. The notes can be 
viewed by selecting the Note tab within the player. Any changes to the notes must be saved by 
clicking the save button. 

The Created by, created date and Last modified by fields are automatically populated based on the 
logged in user. 

Audits 

It is useful to know what has happened to a particular call after it has been recorded. The MyCalls 
playback audit system logs events associated with the following aspects of a call recording: 

 Playback: Logs activity every time a call is played back 

 Export: Logs all call export activity 

 Clip: Logs Sound clip creation, name changes, deletion. 

 Configuration Changes: Logs changes to the call recorder configuration 

Each Audit record is read only and contains the following information: 

 Start/Finish date and times of the audited activity. 

 Audit Type: Identified the type of activity e.g. Playback. 

 User: The logged on user who carried out the activity. 

 Description: A pre-defined description of the activity. 

Additional Controls  

Two other panels are available with additional controls.  

Selection and Sound control start and end times can be adjusted using the Begin/End controls 

Play Selected range/Sound Clip limits playback to the currently selected area of the waveform panel 
or the currently selected sound clip. 

Auto Move to Next Call causes the player to automatically load and play the next call in the playlist 
once the current call has finished playing. 
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Volume: Adjusts overall volume of the player. 

 Balance: Adjust the relative volume between the recording channels of the internal and external 
party can be adjusted.  

Playback Speed: Where 1X is normal playback speed and can be adjusted faster or slower + or –  

 

 

Finding Recorded Calls  

For fast retrieval of calls for playback you can use the quick search from the calls grid options.  Quick 
search is the easiest way to find a call by CLI, DID, Extension or Note-text.   

Quick Search 

From the ‘view’ menu, click ‘Call record view’.  The quick search is highlighted below; by default, it 
shows the last 50 calls for today.  To change the date to search on, select from the list in the ‘Period’ 
drop down menu.  To enter specific dates, choose custom and enter your dates and times as 
required.   

The next line down allows you to search for a particular telephone number, DID and extension. You 
can enter partial numbers to search on e.g. 01270 would find any number containing ‘01270’. 
Entering both a Number, DID and an Extension will search for calls containing all items in the one 
call.   

You can also search using the notes field. The Note search type can be set to one of the following: 

Matches Filter: Finds all notes where the note contains text matching whatever has been entered in 
the Note Filter textbox. 

Has a note: Finds all calls which have a note attached. 

No Note: Finds all calls with no note attached. 

You can also choose which call types to include and the maximum number of calls to display. 
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If you cannot see the quick search, click ‘options’ in the call records view and select ‘Quick Search’ 
from the options. 

Having found the call or calls of interest you can add the call to the current playlist or create a new 
playlist by double clicking the speaker icon for that call. For more information on playlists see the 
playlist section. 

Recordings which you cannot listen to  

Calls that show a speaker icon crossed out means the calls has been excluded from call recording in 
the recording rules configuration. 

 

 

Call Recording Configuration  

Trunk Configuration  

Configuration of call recording requires the correct configuration and licensing of trunks. Whilst this 
should be taken care of during the system installation, it is possible that the call recording 
configuration could change at some point due to licensing of additional trunks.  

In order to enable recording on specific trunks they will need to be assigned as call recording trunks 
within the call recording configuration. 

Access to the Call Recording c onfiguration 

How to: Access the Call-Recording configuration screen  

1) From the menu select - Configure -> Telephone system -> PBX -> Call Recording

 

2) Select the ‘Edit Call Recorder’ Configuration 
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3) The Edit Call recorders window will be displayed 

 

The Call recorder configuration screen allows the setting up of call recorder units, Licensing of 
Trunks and the editing of call recorder settings and recording rules.  

How to: Add Call Recorders to the MyCalls Configuration  

1) To add a new call recorder, click the ‘Add Call Recorder’ button. The window below will appear.  

 

2) Select the call recorder type from the drop down menu, and enter a name e.g. Crompton Road. 

3) Click ‘OK’ 

4) The call recorder will now appear in the ‘Installed Call Recorders’ section 
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5) Select the required call recorder and click ‘Edit’ 

6) The Call recording configuration screen will be displayed 

 

Recording Server Name: Enter the name of the call recording PC  

Playback Port, Archive Port, Playback Speed: These do not normally require changing 

Test Connection: Press this button to check the call recording PC is responding 

Additional Configuration options  
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File export settings. 

Default Filename Prefix: Defines the file naming for exported files. This can be freetext combined 
with pre-defined identifier names. Any identifier name must be surrounded by % characters with no 
spaces. MyCalls will substitute an identifier with the appropriate value for example %user% will 
substitute the logged on user name, %Date% will insert the current Date etc. 

How to: Insert an identifier into the filename prefix  

Set the cursor at the position in the prefix where you want to insert the identifier. In this example we 
have set the cursor at the end of the prefix. 

 

The available identifiers are available by clicking the  button. This will display the list of 
identifiers.  

Select the identifier and the new identifier will be added to the prefix. 

 

The prefix will now be pre-pended to the filename whenever a call recording file is exported. 

 

Enable Transfer Leg Navigation 

This option enables the ability to display the identification of transfer legs in the waveform window. 

Trunk Licensing  

Whilst trunk licensing is an installation operation, it may be necessary for a system administrator to 
adjust or configure additional channels of call recording.  

The call recorder is licensed to record a certain number and type of channels based on what the 
customer has bought. In order to know which of the channels are to be used, the trunks in MyCalls 
need to be set to the correct type and marked for inclusion in call recording.  

Only trunks that are marked as ISDN or AN4009 are listed. Trunks that are either BRI or PRI need to 
be marked as ISDN within MyCalls 
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Trunks that are analogue need to be marked as Analogue within MyCalls 

Remaining licenses for each type of trunk are indicated to the right of the Trunk Licensing grid. 

Licensed trunks need to be associated with the appropriate call recorder. If only one call recorder is 
installed, then selecting a licensed trunk checkbox will automatically select the call recorder. If there 
is more than one call recorder, then you will need to select the call recorder for each trunk. 

 

Backup Call Recordings 

Call recordings can and should be backed up to an area that can be taken off-site for security 
purposes. The call recordings when backed up are still encrypted and can only be played using the 
MyCalls system. The backup can be scheduled to occur at set times and split into different volume 
sizes for storage on to CD or DVD. The split volumes create a new directory for each split and 
increment a number at the end of the volume name to ensure they are unique. 

Once call recordings have been archived the system can remove the actual recording from the 
computer. If you wish to play back a call recording that has been archived and deleted from the 
system you will be instructed to insert the disk that hold the archived call recording. The system will 
then restore that call recording and can then be replayed. 

How to: Configure Call Recording Backups  

1) Select the Recording Backup button from the Call Recorder Configuration Dialog.  
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2) The backup folder MUST be one that is local (attached) to the call recording server.

 

 

How to: Manually Start a Call Recording Backup 

1) Select the Recording Backup button from Configure Call Recording Backup Dialog. 

2) Enter the dates for the backup to apply to and press the Backup button. 

 

How to: Cancel a Running Call Recording Backup 

1) Select the Recording Backup button from the Configure Call Recording Backup Dialog. 

 

2) Press the Cancel Running Backup, this will instruct the call recording server to cancel any 
scheduled or manually started backups that are currently running. 
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Chapter 9 
Stop/Start Recording  

The Stop/Start Call Recording feature has the ability to silence parts of a telephone call, for legal and 
personal reasons, using a set of conditions. For example, the exchange of card details over telephones 
happens on a daily basis. PCI compliance, the security of financial information, means that it is illegal 
to make a record of any card details shared over a telephone (i.e. card details are not allowed to be 
heard in call recording).  

The configuration of Conditions and Sets work on a creation of rules that are applied automatically to 
a telephone call and are based around any window and/or control selected that needs suspending 
from call recording, such as financial information. Furthermore, if the option is available to a particular 
user the call recording can be stopped/started manually at any point of a telephone call.  

 

How does Stop/Start Recording work?  

Once a user has Stop/Start Recording enabled and has started a telephone call which includes 
Conditions and Sets, the system detects user input in a particular window and/or control of the call 
recording which is then paused (the ‘Start Recording the current call’ indicator/button turns red in 
colour), as shown below: 

 

 

The recording will continue without pause once the user input has finished (the ‘Start Recording the 
current call’ indicator/button will go back to grey when the Condition States have been activated), as 
shown below:  

 

 

The Condition Sets which were included in this telephone call will now appear on the Call Recording 
in the Call Player as suspended periods and will be silent when played back, as shown below: 
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Enabling a User for Stop/Start Recording  

 

A user can be enabled to use ‘Stop/Start Recording Conditions’ and/or ‘Manual Stop/Start 
Recording’.  

 

 

See the ‘Organisation and Users’ chapter for more details on how to create/edit users. 
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Stop/Start Recording Client 

 

The stop/start recording indicator/button is integrated into the toolbar of the MyCalls, MyCalls 
Desktop and Operator Console client applications.  There is also a dedicated Stop/Start Recording 
Client application for users that only require the ability to stop/start call recordings. 

The application consists of a stop/start recording indicator/button that is located on the Windows 
taskbar. 

 

 

The indicator/button is used to show the current state.  The state can be as follows: - 

 Not connected 

 No active call 

 Recording the active call 

 Not recording the active call 

 

If you hover over the indicator/button with the mouse then a tooltip will show the current recording 
state, the MyCalls user that is logged on and the extension that the user is logged on with. 

 

 

If the user is enabled for manual stop/start recording, then recording of the currently active call can 
be stop/started by clicking on the indicator/button.  A small window will pop up above the taskbar 
and the user can stop or start the recording by pressing the button on the left (the button will be 
named as either ‘Stop Recording’ or ‘Start Recording’ depending on the current recording state). 
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Before a user can use the Stop/Start Recording Client their Windows User account details must be 
added to their MyCalls user configuration.  The user must also have a default extension configured. 

 

This is because when the Stop/Start Recording Client starts up it uses the Windows user name to 
work out which MyCalls user to log on as.  It also uses the default extension for the user to work out 
which extension to log on with.  This makes the application very easy to use because the user is 
automatically logged on using the correct MyCalls user name and extension. 

Condition Sets  

Condition Sets define one or more conditions that determine when recording will be suspended. 

NB: Sets are assigned to users using Stop/Start Recording Groups and so all users using Stop/Start 
must be added to a Stop/Start Group (see How to: Configure Stop/Start Recording Groups).  

How to: Configure Condition Sets  

New Conditions and Sets  

1) Go to ‘Configure’ and select ‘Telephone Systems’. 
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2) Once in the ‘Configure Telephone System’ window, select ‘Call Recording’ from the dropdown menu 
on the left-hand side: 

   

3) On the right-hand side of the ‘Configure Telephone System’ window under the ‘Call Recording’ 
header, click ‘Manage Stop/Start Recording Conditions’.  

 

4) Once the ‘Manage Stop/Start Recording Condition Sets’ window has opened, to create a new 
Condition Set click ‘New Condition Set...’. 

 

5) The Condition Set needs a Name that will describe all of the conditions created within that set.  
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6)  To create a new Condition, click ‘New Condition...’. 

 

The ‘Configure Stop/Start Recording Condition’ window should now appear, as shown above. 

7) Give the Condition a Name (e.g. ‘Card Details’ if the call recording is being suspended in relation to 
credit card data). 

8) Stop/Start Conditions then gives the user options to filter: Window Title, Application and/ or 
Focused Control. Within these filters, conditions can also have rules, including ‘equals; contains; starts 
with; ends with’. 

 

9) Select the filters and rules as desired for the window/ individual field that needs to be stopped 
when recording.  

Example:  

If the user needs to use certain websites such as PayPal, which require financial information, several 
rules can be created for a Condition Set which will allow selected information to be suspended from 
other users. 

1) The Condition Set Name is ‘PayPal’ so that several rules from the same website can be added under 
a common name.  
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2) Click ‘New Condition...’. 

 

3) Type the Condition Name for the desired field that has to be suspended. The chosen field in this 
example is ‘Card Number’ 

4) Add the Window Title that is shown on the website and set the rules to ‘equals; contains; starts 
with OR ends with’. 

5) Next, the Application (i.e. the website URL) can be filtered with the same rules.  

 

6) The Focused Control can also be filtered, once again with the same rules, except the user must click 
‘Select Window/ Control’. 
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Once the ‘Select Window/ Control’ has been selected, the user can click on any window or individual 
field that they wish to suspend when call recording is taking place. In this instance the ‘Card Number’ 
field was highlighted in PayPal: 

 

7) When the correct field has been highlighted, click ‘Select Window/ Control...’ again. There should 
now be a small screenshot of the ‘Card Number’ field shown below the Focused Control filter, as 
shown below: 

 

NB: To test if the Condition is working correctly and has been detected, click in the individual field on 
the website filtered for the ‘Focused Control’ (in this instance the Card Number field on PayPal). If the 
Condition is working, the Status of the Focused Control should change to ‘TRIGGERED’ and be 
highlighted in green, as shown below:   
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If the Condition is not working or has not been selected, the Status of the Focused Control will change 
to ‘Not Triggered’. 

8) Once everything on the window has been filled in as desired, click ‘OK’. 

9) Steps 2-7 can be repeated if other Conditions need to be added to the PayPal Condition Set. In the 
example below, Conditions were created for Expiry Month, Expiry Year and Security Code.  

 

NB: If any of the Conditions need to be edited, simply click ‘Edit’ and change accordingly.  

10) Once all Conditions have been created for the PayPal Condition Set, click ‘OK’.  
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Condition and Sets can be exported and imported. 

How to: Export and Import  Conditions and Sets  

Exporting Conditions and Sets 
 
The ‘Configure Stop/Start Recording Condition Set Editor’ is another application that can be run 
independently from MyCalls, free of charge, and is available as a separate download.  
 
The application allows users to try and create recording rules themselves, testing the Conditions that 
they create to confirm that Stop/Start Recording will work. Once complete, the application produces 
a file which can then be imported.  
 

 

See ‘How to: Configure Condition States’ to learn how to create new Conditions and Sets and how to 
test them. 

Once the Conditions and Sets have been tested and are successful, users can export the Conditions 
and Sets as a file by going to ‘Export Conditions...’. 

 

OR 

Users can go to ‘File’ at the top of the ‘Configure Stop/Start Recording Condition Set Editor’ and then 
go to ‘Save’. 
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These Conditions and Sets can now be imported onto the MyCalls application for use.  

Importing Conditions and Sets  
 
To import a Condition or Set within MyCalls, go to ‘Import...’ and once the file has been found click 
‘OK’. 
Importing a Condition: 

 

Importing a Set:  

 

The file containing Condition(s) and/or Set(s) is now usable in the Stop/Start Call Recording.  

 

Conditions and Sets can also be Edited.  

How to: Edit Existing Conditions and Sets  

To edit any existing Conditions or Sets simply go to ‘Edit’ and change as desired. 

Editing a Condition: 

 

Editing a Set: 

 

 

 

Conditions and Sets no longer of use can be deleted. 

How to: Delete Existing Conditions and Sets  

To delete any Conditions or Sets, go to ‘Delete’ and click ‘OK’. 

Deleting a Condition: 

 

Deleting a Set:  
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Stop/Start Recording Groups  

 

All users using Stop/Start Call Recording must be added to a Stop/Start Group. Users can only be 
placed into ONE group.  

How to: Configure Stop/Start Recording Groups  

1) In the ‘Call Recording’ window, click ‘Create or Edit a Stop/Start Recording Group’. 

 

2) The ‘Edit Stop/Start Recording Groups’ window should now appear. Click ‘Add new Stop/Start 
Recording Group’ at the bottom of the window: 

 

The ‘Configure a Stop/Start Recording Group’ section appears which includes: Group Name, Users 
and Selected Condition Sets. 
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3) Give the Group a Name. 

4) Select all the users that need to be added to the group by clicking the usernames individually and 
clicking ‘Add’. 

5) Select the Condition Sets desired by ticking the boxes next to the Condition Set Name.  

NB: All Groups can be edited: To add/ remove users, change the name of the group or add/ remove 
condition sets to the group, just click ‘Edit...’.  

 

 

Stop/Start Recording Call Player Window  

MyCalls provides a desktop Call Player specifically designed for call recording and playback. 

 

How to: Use the Call Player in Stop/Start Call Recording   

1) On the Call Record View at the bottom of the MyCalls application, ‘Calls’ holds a call history list. 

 

NB: Clicking ‘Refresh’ in the ‘Calls’ tab will make sure that the call history list is up-to-date. 

 

2) Double-clicking the Speaker icon   next to the desired call will open up the Call Player. The 
Speaker icon indicates a recording has been matched to the call but the recording has been disabled 

An example of a Stop/Start call record in the Call Player is shown below: 



Stop/Start Recording 

  

 1510-002-010  Chapter 9-14   
 

 

NB: MyCalls Basic users will not see the waveforms on the Call Player and therefore no events can be 
seen on the Player. MyCalls Advance users will be able to see this.  

The reason as to why the Conditions were placed is given at the top of the suspended periods. In the 
example used above, ‘Card Details’ was the reason given.   

For more information regarding Call Recording and the Call Player, see Chapter 8 of the MyCalls End 
User Manual.  
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Chapter 10 

 Telephone System Configuration 

Configuration options 

Before you can use MyCalls you will need to configure the application. To do so you will need to 
gather, at a minimum, the following information about your telephone system: 

Trunks: The type and number of trunks connected to the PBX switches that MyCalls will be 
monitoring. For example, are your trunks ISDN (BRI or PRI), analogue, mobile gateway etc. 

Extensions: An itemized list of extensions along with their groupings either by location or business 
function.  Ideally identify who is the regular user for each extension (Default User)   

DID Numbers: If your organization uses DID numbers, you will need a list of them and their function 
or the name of the person who will be receiving calls to that DID. In most cases it is better to specify 
a business function to a DID e.g. Sales enquiries, Support etc. 

If you are planning to configure organizational information such as users and user-groups, then you 
will also need to gather information about who will be using the telephone system and how their 
roles are organized. 
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Quick tip:  

Managing devices properly 

Setting up devices properly can sometimes prove difficult especially if you have a large 
configuration to deal with. Some tips for finding  and managing devices and groups are:  

Look for devices in their System groups as well as their logical groups. If you know a 
device is a specific type then look in the system group for that type.  

Make your groups as small as possible so making individual devices easier to locate 

Name your groups so they make sense to you and your users  

Only enable statistics for devices if you really need to as it impacts on system 
performance 

 Regularly check for unassigned devices and remove them from the configuration if  
possible 

Use device import as the preferred method of configuring your devices and users  

 

 

Accessing configuration options using the menu  

Using the MyCalls menu you can access the configuration screens using: 

Configure -> Telephone Systems -> PBXs  

To configure Devices, Call Recording Groups, call control or Agent Control, Double click the PBX (in 
most cases there will be only one). 

 

 

Configuration Essentials  

Accessing configuration options using toolbar shortcuts  

On the MyCalls toolbar Click on the  Icon 
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What to Configure 

Essential features 

In order to configure MyCalls you must be logged on as a PBX Administrator (for more details on 
user privileges see the section on Organisation and Users).  

The MyCalls Configuration menu provides the following configuration selections: 

Telephone System: Configure details for your PBX switches, Telephone extensions, Trunks, DID’s 
Account codes, Pilot numbers, ACD User Logins, PIN codes, call recording agent and call control. 

Organisation: Configure the users and departments within your organization and set user 
privileges. 

Callers: Define people who call you, or conversely people who you call on a regular basis. Identify 
callers according to organization or purpose of call e.g. business or personal callers and create your 
own caller groups so you can monitor how much time is spent dealing with various organizations. 

Costs: Configure a wide range of call costing parameters to allow you to track the costs incurred, 
specify least cost routing and deal with multiple carriers for your call routing. 

Alarms: Manage your business effectively by configuring alarms to alert you when an exception 
condition occurs. You can generate reports to show where and when these alarm conditions have 
occurred. You can monitor call rates, performance, emergency calls, disallowed calls etc. and assign 
these to; groups, devices and users. Alarms can be flashed up on the screen and distributed via 
email. 

System Settings: Allow setting up of an email and FTP server for distribution of alarms and reports. 

Operational settings: Grace periods allow you to ignore invalid ring times or call lengths and can 
be configured differently for each Group of devices. Grade of service settings allow you to specify 
when a call has lasted too long or when the ring time was too long.  

Minimum Configuration 

At the minimum you will need to configure: 

 Trunks:  Carry all calls to and from your organization and are the key mechanism employed by the 
application when recognizing calls.   

Extensions: These represent the physical telephones available in your organization. Extensions 
come in a wide variety of types ranging from traditional, analogue phones, digital phones, VoIP 
phones etc.   

DID’s: If you use DID numbers within your organization you will need to configure them so that 
MyCalls is able identify and group calls to each DID or DID group. 

Call recording: If you are using call recording then you will need to configure your call recording 
settings before you can match your calls against their recordings. 

Optional features 

Alarms: You will need to configure the alarm conditions relevant to your organization dependent on 
what you want to monitor 

Agent Control, Call control, Account Codes, Callers and Costing are also features that you may wish 
to configure once you have set up the basic system and properly configured and checked the 
essential items.  
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Automatic Device Configuration  

MyCalls will automatically configure devices as they become visible on the system. If a call appears 
on an extension, then that extension will be added to the list of devices if: 

 The device does not currently exist 

 The device has not been manually deleted from the list. 

The devices which can be automatically configured are: 

Extensions, DIDs, Account Codes, Trunks, Pilot numbers. 

Following an install of the system it may be advisable to allow a period of several hours whilst the 
system auto-configures the most regularly used devices. You can regularly check for devices which 
have been auto-configured by running the system report – ‘Auto Configured Devices’. However, 
don’t rely on Auto-Configuration, create them upfront if possible. 
 

Quick tip:  

Automatic configuration of devices  

MyCalls will automatically add new devices to its list of configured items if they appear as a result of a  
call. These devices will be added to the appropriate list of devices if the particular value does not already  
appear in the list. For example, any extension numbers which appear as a result of calls will be added to 
the extensions list. If you delete a particular instance of a device from the list, then it will not be added 
to the list in future. 

This applies to all devices but the information for that device must also be available from the PBX sw itch. 
For further details on which features are supported by your PBX switch please contact your switch 
maintainer.  

All devices added due to auto-configuration will have the type of ‘unassigned’ and a created user of ‘auto 
configuration’ 

General Configuration Tasks for devices  

Configuration of devices follows a similar set of operations for each type of device: 

 Decide on what devices you are going to configure 

 Arrange your devices into functional groups to allow more meaningful reporting or screen 
displays 

 Create the device groups 

 Create the devices 

 Assign an identifier to the device e.g. extension number or DID number, specify device 
specific information, assign users to the device and configure all device options. 

 Assign the devices to their respective groups. 
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Ranges of items 

How to: Creating an item or range of items 

1) From the device configuration window e.g. Configure -> Telephone systems ->Devices -
>Extensions select the ‘Create a range of’ option 

 

2) Select the number of devices to create 

3) Enter the start value for the device number e.g. create 100 extensions starting at 201 will create 
extensions 201 to 301 

Optional steps 

4) Assign a type to the device e.g. Digital Desk Phone 

5) Assign the devices to a group  

6) Add any relevant notes 

7) Click ‘OK’ 
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Deleting an item or range of items 

How to: Deleting an item of a range of  items 

1) Deleting an item or a range of items requires the same process for Extensions, Trunks, DIDs, 
Account Codes, and Pilot Numbers. The steps below will describe the deletion process with the 
example of extensions. 

2) From the MyCalls Telephone System Configuration screen, click ‘Extensions’ 

3) Click ‘Delete a Range of Extensions’ 

4) In the dialogue box that appears, select the extensions you wish to delete in the extension list.  
You can select multiple extensions by holding down the control key (ctrl) as you click on the 
rows.  

 

5) Click ‘OK’ to complete the deletion process.  Be aware that you will not be prompted to confirm 
this process once you press the OK button so please make sure you have the right codes 
highlighted before pressing OK to continue.  
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PBX Configuration 

Single PBX configurations  

 

PBX Configuration takes place during the system installation. The Application has been set up to 
recognise the PBX which controls your telephone system. MyCalls links to the PBX and records the 
telephone call data and for most installations there will probably be one PBX. 

How to: Alter the PBX configuration  

1) Select the PBX from the telephone system configuration. Configure->Telephone System -> PBXs -
>head office 

2) Click ‘Edit PBX Configuration’ 

 

3) You are presented with a dialog panel which allows the editing of various parameters (not all 
these parameters can be changed). 

 

4) PBX Code: (read only) Displays the PBX Code (name) assigned to the PBX. 

5) Area Code: your local area code allows MyCalls to recognize local calls. 

6) International Code: Enter your international code  

7) Country (read only) 

8) Edit Country numbering plan – (see next section) 

9) Admin User: Allows you to set a default admin user for the PBX as follows 

10) Click ‘Select’ – Select User dialog appears. 

11) Type the initial of the user you wish to set as the admin user 

12) Select the user from the list and click ‘select’ 

13) Click ‘OK’  

14) Setting an Admin user creates a default email address to which various admin level reports such 
as audit logs will be automatically sent. 
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Country Numbering Plans  

How to: Creating Country Numbering Plans  

1) To cater for numbering systems in different countries, MyCalls allows the entry of various parts 
constituting a telephone number.    

 

2) Costing Type: defines the country costing schema used for this PBX 

3) Trunk Prefix: First digit of a non-local number 

4) The minimum and maximum number of area code digits 

5) Minimum and maximum number of subscriber digits 

6) Specify whether the numbers are fixed format i.e. the same number of digits for all numbers 

7) Click ‘OK’ 

  

Device Configuration 

Types of devices  

Devices configurable within MyCalls are as follows: 

 Trunks 

 Extensions 

 DIDs – Direct Inbound Dial numbers 

 Account codes 

 User Logins/Pin Codes 

 Pilot Numbers 
 

Trunks 

Trunks (Lines) are devices that connect the PBX to other switching devices such as the PSTN or another 
PBX.  Trunks come in various types ISDN, Analogue, TCP-IP or Q-SIG depending on what the PBX is 
connecting to. 

 Organising and Naming Trunks      

We need to define trunks for the following reasons: 

 We can report on trunk usage.  

 Analysing overall performance of our telephone system helps us to identify weaknesses in 
the system at the physical level e.g. have we enough trunks. 
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 We can view the overall call statistics of our entire telephone system 

 Required to configure Call recording which is licensed on a trunk by trunk basis 

 Helpful when Identifying faults on your telephone system if, for example, a trunk is showing 
abnormally low usage 

 

Assigning and grouping Trunks  

Generally, the MyCalls installer would create the trunk configuration as they would know the types 
of trunks available in the telephone system. It is important that the trunks are assigned correctly as 
this will allow you to correctly configure your statistics windows and reports. In addition, your call 
recording configuration is assigned to record on specific trunks. 

For Example; You have a 30 trunk PRI connection, a 2 trunk BRI connection linked to a GSM gateway 
for mobile calls and 2 Analogue lines linked to the company fax machines.  

You could create several groups as follows 

 BRI group – contains all BRI trunks 

 PRI group – contains all PRI trunks 

 Faxes group – contains all analogue fax lines 

With this configuration you could report on usage in the following ways 

 Overall calls in and out on all trunks 

 Call statistics for the PRI trunks (main telephone traffic) only 

 Call statistics for GSM gateway (mobile) calls 

 Detect any mobile calls being routed via the PRI trunks 

 View real time call data for each group of trunks 

Creating and editing Trunks 

How to: Creating a single Trunk 

1) From the MyCalls Telephone System Configuration screen, click ‘Trunks’  
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2) Click ‘Create or Edit a Trunk’ in the Trunk configuration area.  The Edit Trunk screen appears.  

3) Click ‘Add New Trunk’.  

4) In the dialogue window that appears a number of fields are available for entry.  Some are 
mandatory fields* for successful setup whilst others are optional inputs as outlined below. 

 

5) Number*: Enter here the trunk number you wish to create.  This must be a valid trunk 
configured on your telephone system. 

6) Name*: Enter a name for your trunk to identify its use.  If left blank the system will populate this 
field with the number 

7) Trunk Group: You can select a trunk group to group this trunk number under.  The values in this 
list are configurable under Trunk Groups.  The default value is set as none. 

8) Type: Select a trunk type from the drop down menu 

9) Alternate Carrier: An alternate carrier can be assigned to a trunk.  This means that calls made on 
this trunk can have different costings applied to the standard one. 

10) Click ‘OK’ 

 

Creating a range of Trunks  

How to: Creating a range of Trunks 

1) From the MyCalls Telephone System Configuration screen, click ‘Trunks’ 

2) Click ‘Create a Range Trunks’ in the Trunk Configuration area. 

3) In the dialogue window that appears, a number of fields are available for entry.  Some are 
mandatory fields* for successful setup whilst others are optional inputs.  
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4) Number of trunks*: Enter the number of trunks you wish to create in the range.  

5) Start Trunk Number*: Enter the number to start your trunk range from here.   

6) Trunk Group: Select the trunk type from the drop down menu 

7) Alternate Carrier: Assign an alternate carrier to the trunk range.  This means that calls made on 
this trunk can have different costings applied. 

8) Click ‘OK’ 

 

A block of trunks will now have been inserted into the Configured Trunks list box. You should configure 
these trunks with appropriate name and options using procedures described later in this topic before 
clicking the ‘OK’ button to complete your trunk creation process.  Note that the trunks you create 
should correspond to those configured in the telephone system. 

Editing existing Trunks  

How to: Editing existing Trunks  

1) From the MyCalls Telephone System Configuration screen, click ‘Trunks’. 

2) Click ‘Create or Edit a Trunk’ in the Trunk configuration area. The Edit trunk screen appears. 

 

3) In the dialog box that appears click the ‘Edit…’ button to the right of the trunk you want to edit. 

4) In the second dialog box that appears, configure a Name for the trunk and if required, select a 
trunk Group, trunk Type and assign an alternate carrier. 

 

5) Click ‘OK’  

6) Repeat these stages for as many trunks as you need to configure. 

7) Click ‘OK’ to save all the changes you have made. 
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How to: Importing Trunks 

Browse to the import template under Start>Computer>C:>Program Files*>NEC 
Infrontia>MyCalls>Import.xls 

*If you are running on a 64-bit operating system, the correct folder will be ‘Program Files (x86) 

Click on the ‘Trunks’ tab at the bottom 

 

Copy and paste the headers into a new Excel spreadsheet. 

Enter the appropriate information under each header. These headers are: 

Number: The number of the trunk. 

Name: The name of the trunk. This is usually the name of the user or department that the trunk is 
assigned to. 

 

Once you have entered all of the required information, click ‘Save’ 

From the ‘Save as type’ drop-down menu box, select ‘CSV (Comma delimited) (*.csv)’ 

Give the file an appropriate name e.g. ‘Trunks Import File’ 

Save the file in a memorable location 
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Open MyCalls 

Log in as a pBX Administrator. 

Click ‘Configure’>’Telephone System’>’PBXs’>’Head Office’>’Devices’>’Trunks’ 

Select ‘Import Trunks’ in the right hand panel 

 

Browse to the CSV file  

Check the ‘First line contains column headers’ box 

Select the trunk type 

Click ‘Load’ 



Telephone System Configuration 

  

 1510-002-010  Chapter 10-14   
 

 

Click ‘OK’ 

Click ‘Create or Edit a Trunk’ in the right hand panel 
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Here you will see the trunks that you have imported.  
 

 

Click ‘Edit’ next to any of the trunks to change the information of the trunk. 

 

Extensions 

An extension (station) is setup to be a pre-defined type.  A user extension would be typically setup as 
a desk phone, cordless phone or cellular phone type.  A system installer also uses extensions to 
configure devices such as auto-attendants, voice mail ports, and announcement ports. 
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Creating and Editing Extensions  

How to: Creating a single Extension  

1) From the MyCalls Telephone System Configuration Screen Click on ‘Extensions’ 

2) Click ‘Create or edit an extension’. The edit Extensions screen appears. 

3) Click ‘Add new extension’   

4) In the dialog window that appears a number of fields are available for entry.  Some are 
mandatory fields* for successful setup whilst others are optional inputs as outlined below. 

 

5) Number*:  Enter the number of the Extension you wish to create.  This must be for a valid 
extension number configured on your telephone system. 

6) Name*: Enter a name for your extension to identify its use.  If left blank the system will populate 
this field with the Number.   

7) Extension Group: You can select an extension group to group this device under.  The values in 
this list are configurable under Extension Groups.  The default value is set as None.   

8) Enable real time statistics: This option should be enabled if you want call data collected from 
the telephone system for this extension to be included in the real time statistics.  It is good 
practice for extensions not used to have this option disabled so as to minimize unnecessary 
processing. 

9) Enable for Hot Desking: Makes the extension available for inclusion in list of available extensions 
when logging in to MyCalls 

10) Default User:  Specify a default user using the select button (See default user section). You can 
assign a default user to an extension to enhance reporting.  A default user is someone who 
regularly uses the extension.  

11) Type: Select the extension device type from the drop down menu.   

12) Voicemail Timeout: If the Type field is set to either auto attendant, voice mail or announcement 
port then setting a voice mail timeout will cause any incoming calls to the extension connected 
for less than the voicemail timeout to be marked as abandoned. 

13) Click ‘OK’ 
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How to: Creating a range of Extensions  

1) From the MyCalls Telephone System Configuration Screen Click ‘Extensions’ 

2) Click ‘Create a range of extensions’. 

3) In the dialogue window that appears a number of fields are available for entry.  Some are 
mandatory fields* for successful setup whilst others are optional inputs as outlined below:  

 

4) Number of extensions*: Enter here the number of extensions you wish to create in the range.   

5) Start Extension*: Enter the number to start your extension range from here.   

6) Extension Group: You can select an extension group to group this range under.  The values in 
this list are configurable under extension Groups.  The default value is None.   

7) Click ‘OK’ 

 

How to: Editing existing Extensions  

1) From the MyCalls Telephone System Configuration screen, click ‘Extensions’ 

2)  Click ‘Create or Edit an Extension’ in the Extensions configuration area. 

3) In the dialog box that appears click the ‘Edit…’ button to the right of the Extension you want to 
edit. 

In the 
second dialog box that appears, configure a Name for the Extension, and if required select an 
Extension Group and Extension Type. 
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4) Click ‘OK’  

5) Repeat these stages for as many Extensions as you need to configure 

6) Alternatively, you can edit the rows without clicking ‘edit’. Click in the name column and enter a 
name, click in type column and select a type from the drop down menu, and click in the group 
column and assign the person to a group. If you would like to enable statistics for a particular 
person, tick the box in the enable statistics column. 

7) Click ‘OK’ to save all the changes you have made 

 

How to: Importing Extensions 

Browse to the import template under Start>Computer>C:>Program Files*>NEC 
Infrontia>MyCalls>Import.xls 

*If you are running on a 64-bit operating system, the correct folder will be ‘Program Files (x86) 

Click on the ‘Extensions’ tab at the bottom 

 

Copy and paste the headers into a new Excel spreadsheet. 

Enter the appropriate information under each header. These headers are: 

Number: The number of the extension. 

Name: The name of the extensions. This is usually the name of the user that the extension is 
assigned to. 

Hot Desking: Whether or not the extension is enabled for hot desking. To enable hot desking, input 
TRUE into the field. If hot desking is not going to be enabled with this extension, input FALSE. 

Statistics: Whether or not the extension is enabled for statistics. To enable statistics, input TRUE into 
the field. If statistics are not going to be enabled with this extension, input FALSE. 

Computer: The name of the computer that the extension is assigned to. In order to work, the 
computer name needs to be complete with the network that he computer is connected to e.g. 
Kelmar-Software\Training1. This field is not mandatory and can be left blank. 

 

Once you have entered all of the required information, click ‘Save’ 

From the ‘Save as type’ drop-down menu box, select ‘CSV (Comma delimited) (*.csv)’ 

Give the file an appropriate name e.g. ‘Extensions Import File’ 

Save the file in a memorable location 
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Open MyCalls 

Log in as a user with administrative privileges. Otherwise, log in as ‘Installer’. 

Click ‘Configure’>’Telephone System’>’PBXs’>’Head Office’>’Devices’>’Extensions’ 

Select ‘Import Extensions’ in the right hand panel  

 

Browse to the CSV file  

Check the ‘First line contains column headers’ box 

If you wish to create basic users from this information, check the ‘Create Users for named 
extensions’ box 

Select the group that you wish to add the users to 

Click ‘Load’ 
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Click ‘OK’ 

Click ‘Create or Edit an Extension’ in the right hand panel 

Here you will see the extensions that you have imported.  

 

If there are any mistakes with the information, click ‘Edit’ next to any of the extensions to change 
the information of the extension. 

 

DIDs 

DIDs (Direct Inbound Dials) are numbers that customers dial to reach either an individual (personal 
DID) or a specific group.  DIDs can be published to customers and reports can be generated to identify 
which DIDs are the most effective. 
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Creating and Editing DIDs  

How to: Creating a single DID 

1) From the MyCalls Telephone System Configuration screen, click ‘DIDs’. 

2) Click ‘Create or Edit a DID’ in the DID configuration area.  The Edit DID screen appears. 

3) Click the ‘Add New DID’ button. 

4) In the dialogue window that appears a number of fields are available for entry.  Some are 
mandatory fields* for successful setup whilst others are optional inputs as outlined below. 

 

5) Number*: Enter here the number of the DID you wish to create.  This must be for a valid DID 
number configured on your telephone system 

6) Name*: Enter a name for the DID to identify its purpose. If left blank the system will populate 
this field with the Number.   

7) DID group: You can select a DID group to group this number under.  The values in this list are 
configurable under DID Groups.  The default value is set as None.   

8) Enable real time statistics: This option should be enabled if you want call data collected from 
the telephone system for this DID to be included in the real time statistics.  It is good practice for 
DIDs not used to have this option disabled so as to minimize unnecessary processing. 

9) Click ‘OK’ 

How to: Creating a range of DIDs 

1) From the MyCalls Telephone System Configuration screen, click ‘DIDs’ 

2) Click ‘Create a Range of DIDs’ in the DID configuration area. 

3) In the dialogue window that appears a number of fields are available for entry.  Some are 
mandatory fields* for successful setup whilst others are optional inputs 

 

4) Number of DIDs*: Enter here the number of DIDs you wish to create in the range.  

5) Start DID*: Enter the number to start your DID range from here.  This must be the starting 
number for a valid DID range configured on your telephone system. 

6) DID group: You can select a DID group to group this range under.  The values in this list are 
configurable under DID Groups.  The default value is None.   

7) Click ‘OK’ 
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A block of DIDs will now have been inserted into the Configured DIDs list box. You should configure 
these DIDs with appropriate names and groups using procedures described later in this topic before 
clicking the ‘OK’ button to complete your DID creation process.  Note that the DID numbers you create 
should correspond to those configured in the telephone system. 

How to: Editing existing DIDs  

1) From the MyCalls Telephone System Configuration screen, click ‘DIDs’ 

2) Click ‘Create or Edit a DID’ in the DID configuration area. The Edit DID screen will appear. 

3) In the dialog box that appears click the ‘Edit…’ button to the right of the DID you want to edit. 

4) In the second dialogue box that appears, configure a Name for the DID and if required select a 
DID Group and enable or disable the real time statistics option for this DID. 

 

5) Click ‘OK’ 

6) Repeat these stages for as many DIDs as you need to configure 

7) Click ‘OK’ to save changes 

 

Account Codes 

Account codes are numbers entered by the person answering the call and are usually assigned to a 
customer, a project, department, marketing campaign or any other business function.  Reports can 
then be run against these account codes to identify the calls assigned to that particular code. 

Create/Edit Account Codes  

How to: Creating a single Account Code  

1) From the MyCalls Telephone System Configuration screen, click ‘Account Codes’ 

2) Click ‘Create or Edit an Account Code’.  The Edit Account Codes screen appears. 

3) Click ‘Add New Account Code’. 

4) In the dialogue window that appears, a number of fields are available for entry.  Some are 
mandatory fields* for successful setup whilst others are optional inputs as outlined below. 
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5) Number*: Enter here the number of the account code you wish to create.  This must be for a 
valid account code configured on your telephone system. 

6) Name*: Enter a name for your account code to identify its purpose.  If left blank the system will 
populate this field with the Number.   

7) Account Code Group: You can select an account code group to group this code under.  The 
values in this list are configurable under Account Code Groups.  The default value is set to None.   

8) Click ‘OK’ 

 

How to: Creating a range of Account Codes  

1) From the MyCalls Telephone System Configuration screen, click ‘Account Codes’ 

2) Click ‘Create a Range of Account Codes’  

3) In the dialogue window that appears a number of fields are available for entry.  Some are 
mandatory fields* for successful setup whilst others are optional inputs. 

 

4) Number of Account Codes*: Enter here the number of account codes you wish to create in the 
range.   

5) Start Account Code Number*: Enter the number to start your account code range from here.  
This must be the starting number for a valid account code range configured on your telephone 
system. 

6) Account Code Group: You can select an account code group to group this range under.  The 
values in this list are configurable under Account Code Groups.  The default value is set to None.   

7) Click ‘OK’ 

A block of account codes will now have been inserted into the Configured Account Codes list box. You 
should configure these account codes with appropriate names and groups using procedures described 
later in this topic before clicking the ‘OK’ button to complete your account code creation process.  
Note that the account code numbers you create should correspond to those configured in the 
telephone system. 
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How to: Editing existing Account Codes  

1) From the MyCalls Telephone System Configuration screen, click ‘Account Codes’ 

2) Click ‘Create or Edit an Account Code’ in the Account Codes configuration area. 

3) In the dialogue box that appears click the ‘Edit…’ button to the right of the account code you 
want to edit. 

4) In the second dialog box that appears, configure a Name for the account code and if required 
select an Account Code Group. 

 

5) Click ‘OK’  

6) Repeat these stages for as many account codes as you need to configure 

7) Click ‘OK’ to save all the changes you have made 

 

Configuring ACD environment devices  

Pilot Numbers 

Pilot Numbers are the numbers that are dialled to reach either an ACD queue or a hunt group.  These 
are usually internal numbers to the PBX and calls to these pilot numbers are usually transferred from 
an auto-attendant or a DID. 
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Creating and Editing Pilot Numbers  

How to: Creating a single Pilot Number  

1) From the MyCalls Telephone System Configuration screen, click ‘Pilot Numbers’ 

2) Click ‘Create or Edit a Pilot Number’ in the Pilot Number configuration area.  The Edit Pilot 
Numbers screen appears. 

3) Click ‘Add New Pilot Number’ 

4) In the dialog window that appears a number of fields are available for entry.  Some are 
mandatory fields* for successful setup whilst others are optional inputs as outlined below. 

 

5) Number*: Enter here the number of the pilot number you wish to create.  This must be a valid 
pilot number configured on your telephone system. 

6) Name*: Enter a name for your pilot number to identify its use.  If left blank the system will 
populate this field with the Number.   

7) Pilot Number Group: You can select a pilot number group to group this pilot number under.  The 
values in this list are configurable under Pilot Number Groups.  The default value is set as None.   

8) Type: Assign the pilot number as either of type ACD Queue or Hunt Group. 

9) Enable Real Time Statistics: This option should be enabled if you want call data collected from 
the telephone system for this pilot number to be included in the real time statistics.  It is good 
practice for pilot numbers not used to have this option disabled so as to minimize unnecessary 
processing. 

10) Overflow: If overflow is enabled then the Overflow Destination dropdown list will be populated 
with all pilot numbers that already exist.  NOTE: The overflow destination and transfer time must 
match the overflow values configured in the switch. 

11) Predictive Abandonment: Predictive abandonment can be enabled for a pilot number.  The 
Refresh Period determines how often the predictive abandonment value is updated for the pilot 
number.  If ‘Include Wrapup Time’ is enabled, then the wrapup time is used when calculating 
predictive abandonment. 

12) Click ‘OK’ 
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How to: Creating a range of Pilot Numbers  

1) From the MyCalls Telephone System Configuration screen, click ‘Pilot Numbers’ 

2) Click ‘Create a Range of Pilot Numbers’ in the Pilot Number configuration area. 

3) In the dialog window that appears a number of fields are available for entry.  Some are 
mandatory fields* for successful setup whilst others are optional inputs. 

 

4) Number of Pilot Numbers*: Enter here the number of pilot numbers you wish to create in the 
range 

5) Start Pilot Number*: Enter the number to start your pilot number range from here.   

6) Pilot Number Group: You can select a pilot number group to group this range under.  The values 
in this list are configurable under pilot number Groups.  The default value is None.   

7) Click ‘OK’ 

A block of pilot numbers will now have been inserted into the ‘Configured Pilot Numbers’ list box. 
You should configure these pilot numbers with appropriate name, pilot number types and groups 
using procedures described later in this topic before clicking the ‘OK’ button to complete your pilot 
number creation process.  Note that the pilot numbers you create should correspond to those 
configured in the telephone system. 
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How to: Editing existing Pilot Numbers  

1) From the MyCalls Telephone System Configuration screen, click ‘Pilot Numbers’ 

2) Click ‘Create or Edit a Pilot Number’ in the Pilot Number configuration area. 

3) In the dialog box that appears click the ‘Edit…’ button to the right of the pilot number you want 
to edit. 

4) In the second dialog box that appears, configure a Name for the pilot number and if required 
select a Pilot Number Group, Pilot Number Type and enable or disable the real time statistics 
option for this extension. 

 

5) Click ‘OK’ 

6) Repeat these stages for as many pilot numbers as you need to configure 

7) Click ‘OK’ 

 

User logins and Pin Codes  

User Logins are the codes that users enter into their telephone handset to start receiving calls in an 
ACD environment.  They are sometimes referred to as PIN codes. This is the way that the system 
recognises that someone is at the extension and ready to take calls. Calls are then assigned to the 
logged in user rather than the default user. This can be called ‘hot desking’, where a person can change 
desks and still receive their calls. 
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Create/ Edit User logins and Pin Codes  

How to: Creating a single new User Login  

1) From the MyCalls Telephone System Configuration screen, click ‘User Logins/ Pin Codes’ 

2) Click ‘Create or Edit a User Login’ in the User Login configuration area.  The Edit User Login 
screen appears. 

3)  Click ‘Add New User’ 

4) In the dialog window that appears a number of fields are available for entry.  Some are 
mandatory fields* for successful setup whilst others are optional inputs as outlined below. 

 

5) Login ID: Enter here the User Login ID entered at an extension by the user. 

6) User*: Assign a user to a User Login ID to enhance reporting so you can run reports on the user 
no matter what extension they are logged in at.  To select a user, click the ‘Select…’ button to 
the right of the user field.  The Select User screen will appear.  

 

7) You can search for a user using the left field. As you type in a name, relevant matches will 
appear in the box below.  Once you have found your user, select them in this box and click the 
‘Select’ button.  They will appear in the ‘Selected User’ field.  If you wish to remove a selected 
user, then Press the ‘Clear’ button.  When finished press ‘OK’ to complete your selection. 

8) Click ‘OK’ 

How to: Creating a range of User Logins  

1) From the MyCalls Telephone System Configuration screen, click ‘User Logins/ Pin Codes’ 

2) Click ‘Create a Range of User Logins’ in the User Login configuration area.  

3) In the dialog window that appears a number of fields are available for entry.  Some are 
mandatory fields* for successful setup whilst others are optional inputs. 
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4) Number of Logins*: Enter here the number of User Logins you wish to create in the range.  You 
can use the arrow buttons to the right of the field to either increment or decrement the value 
using your mouse or enter the value using the keyboard. 

5) Start Login Number*: Enter the number to start your User Login ID number range from here.   

6) Click ‘OK’. 

A block of user logins will have now been inserted into the Configured User Logins list box. You 
should configure these user logins with appropriate name and options using procedures described 
later in this topic before clicking the OK button to complete your user login creation process.  Note 
that the user logins you create should correspond to those configured in the telephone system. 

How to: Editing existing User Logins  

1) From the MyCalls Telephone System Configuration screen, click ‘User Logins/Pin Codes’ 

2) Click ‘Create or Edit a User’ Login in the User Login configuration area. 

3) In the dialog box that appears click the ‘Edit…’ button to the right of the user login you want to 
edit. 

4) In the second dialog box that appears, configure a Login ID for the user login and if required 
select a User to associate with this ID. 

 

5) Click ‘OK’ 

6) Repeat stages 2 to 5 for as many user logins as you need to configure 

7) Click the ‘OK’ to save all the changes you have made. 

 

Group configuration 

Grouping devices allows you to monitor and report on overall performance of areas of your business 
rather than individuals. You can also analyse individuals within a given group and ignore other 
devices or compare one group against another. 

The first step in creating a group of devices requires you to gather information regarding groups of 
devices such as extensions or DIDs. Once you have done this, creating a group of devices is 
straightforward. 

Creating and organising your groups is similar regardless of the device type being grouped  

You can create and populate groups of any device type and name that group according to function 
e.g. Sales, or to location, e.g. Dave’s office or to indicate a device type e.g. BRI trunk 1. Some devices 
have some predefined groups namely Extensions (Analogue, Digital Desk etc.); Pilot numbers (ACD 
queues, Hunt Groups) and Trunks. Having predefined groups for these devices is a convenience but 
normally you will expect to create your own user defined groups 

A device can only be in one user defined group but will be a member of several system groups.  
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System groups 

A system group is a group of devices defined by their type rather than being assigned to a specific 
user defined group.  

Extension Groups 

All Extension types All extensions 

All Non PBX Phones Cellular phones, land lines or pagers where a bill can be imported 

All Voice Mail Ports All extensions which record messages left by callers 

Unassigned Extensions Any extensions with type set to unassigned 

Pilot Number Groups 

All Hunt Groups All pilot numbers assigned as hunt group type 

All ACD Groups All pilot numbers defined as ACD queue type 

All Pilot Numbers All pilot numbers 

Trunk Groups 

All Analogue Trunks All trunks connected as analogue lines 

All ISDN Trunks All trunks of type ISDN 

All Private Wires Trunks used to connect PBXs together 

All TCP/IP Trunks Trunks defined as TCP/IP 

All Trunks All trunks 

Unassigned Trunks Any trunks with type set to unassigned 

 

Viewing groups 

To view the members of a group, click on the Group required and select ‘View or Edit the group’. The 
group members are listed in a grid. You can sort the members in different ways by selecting the 
column header. For example, to list the extensions in an extension group in order of extension 
number click on the ‘Number’ column, alternatively to list by Name in alphabetical order click on the 
‘Name’ column and so forth. 

Identifying stray devices using ‘Unassigned’ groups  

It is good practice to assign you various devices to custom groups that you have created. Any devices 
that are not specifically assigned to a group will remain in the unassigned group. By viewing the 
unassigned group for a particular device or by running a report to list the unassigned devices you can 
quickly track down any devices that have not been accounted for. These devices may be either 
unused, incorrectly configured or have been automatically configured and not yet assigned. 

You can also identify infrequently used devices by running the system report designed for that 
purpose (See reporting). 
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User Defined Groups 

Creating a user defined group 

To configure Groups Double, click the Configure -> Telephone Systems ->PBX (in most cases there 
will be only one). Click on the ‘Groups’ icon and select the group type. 

 

The instructions of how to create a group are the same for extensions, trunks, account codes, pilot 
numbers etc. The following examples are with the use of extensions: 

How to: Creating a group 

1) From the MyCalls Telephone System Configuration screen, click ‘Extension Groups’ 

2) Click ‘Create an Extension Group’ in the Extension Groups configuration area.  The Create a New 
Extension Group screen appears. 

3) In the dialog window that appears, a number of fields are available for entry.  Some are 
mandatory fields* whilst others are optional as outlined below. 

 

4) PBX Code: This field is filled with the assigned name of the PBX currently being configured. (Read 
Only) 

5) Name*: Enter a name to identify the Extension group for reporting on. 

6) Click ‘OK’ 

Once the device group has been created you should add devices to it. You can either, open the 
group editing- view and add new devices or you will need to edit existing devices in order to add 
them to your new group. 

How to: Adding an existing device to a group 

1) From the MyCalls Telephone System Configuration screen, click to expand ‘Extensions’ 

2) Click on ‘Create or edit an extension’ 
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3) A dialog showing existing extensions will appear 

4) From the list of extensions find the extension you wish to add to the group 

5) Click in the group column and select the group you wish to add the extension to 

6) Repeat this for any other extensions   

7) Click ‘OK’ 

8) Your extensions are now assigned to the user defined groups 

 

Having added devices to a group you can then go back and edit the device attributes from within the 
group window. 

How to: Editing devices within a group 

9) From the MyCalls Telephone System Configuration screen, click to expand ‘Extension Groups’ 

  

10) Select the group you want to edit. Click ‘View or Edit the Group’ in the Extension Group 
configuration area.  

11) If the group already contains devices, then you can edit each device as described below. 
Alternatively, you can press the ‘Add New Device’ button and this will display the device 
configuration dialog as described previously. Once configured press ’OK’ and the new device will 
be added to the group. 

 

12) In the dialog box that appears you can change the extension name, choose the type of device, 
change group membership, edit the device and choose whether to enable statistics. 
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13) Clicking on the ‘Edit’ button allows you to modify the default user and set a voicemail timeout if 
the device is assigned a type of auto-attendant, voicemail or announcement port. 

 

14) If you have clicked ‘Edit’ to edit the device settings, then Click ‘OK’ to close the dialog 

15) Finally, once you have finished editing the devices within the group click ‘OK’ 

 

You may also wish to delete a group 

How to: Delete a group 

1) From the MyCalls Telephone System Configuration screen, click ‘Extension Groups’ and select 
the group you want to delete.  

2) Click ‘Delete Extension Group’ in the Extension Group configuration area.  

 

3) You will be prompted to confirm deletion of the selected group. 

4) Click ‘OK’ 

Quick tip:  

When a group is deleted all of the member devices of that group will have their user defined group set 
to ‘none’ 

When a group is deleted all of the member devices of that group will have their user defined group set 
to ‘none’ 

Alarms will be deleted if they are configured to a group that is going to be deleted 

System groups cannot be deleted 
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You can also remove a device from a group.How to: View or Edit group membership 

1) From the MyCalls Telephone System Configuration screen, click ‘Extension Groups’ and select 
the group you want to configure.  

2) Click ‘View or Edit the Group’ in the Extension Group configuration area.  

3) In the dialog window that appears you will see a list of group members which have already been 
created, alternatively you can create new members for the group by clicking on the ‘Add new 
extension’ button and creating a new member directly in the group. 

4) Each group member will show details of the member for example extension number, name, 
device type group and whether or not real time statistics are enabled. 

 

5) You can edit the Device Name, Type, Group, Enable statistics. You can also edit the default user 
for the device by selecting the ‘Edit’ button. Changing the group will remove the device from this 
group once the ‘OK’ button is selected. 

Miscellaneous configuration 

How to: Configuring colours  

1) The colours can be changed to represent the various extension states and call types. 

2) To change the colours click Configure -> Colours 

3) To alter the colours, click ‘Edit’ next to the section you wish to change, for example, logged off 
end colour. 
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4) Click ‘OK’ 

5) Colours apply to all users and are system wide. Colours for different call types tend to be similar, 
Reds for abandoned, Greens for incoming, Blues for outgoing, Neutral colours for ACD and User 
related status. 

System settings 

In order for reports and alarms to be distributed to various people in your organization you will need 
to configure one or more mechanisms to transport the information to the intended recipient. 

NB: You will normally require the assistance of an IT administrator to set up system related settings 

Email 

Information can be sent to one or more email address. To achieve this, the system needs to be set 
up with an email sending mechanism via an SMTP service.  

How to: Set up an Email server . 

1) SMTP mail server: name of your email sending server e.g. mail.myco.com or smtp.myco.com 

2) Email address of sender: This will appear in the ‘from’ field of any emails sent by the system. 
This should be a valid email address on the server and ideally will relate to MyCalls e.g. 
Mycalls@my.com. 

3) Login Username: username if required to access your SMTP service 

4) Login Password: password if required to access your SMTP service  

5) Test: this will send a test email to a known email address to check your system is capable of 
sending emails using the settings you have specified 

FTP 

Information can be deposited as a file on an FTP server for later retrieval by an FTP client application 
or web browser. 

How to: Set up an FTP server.  

1) Configuration -> System settings 

2) FTP server hostname: name of your ftp server e.g. ftp.myco.com  

3) Anonymous: Defines if the account on the ftp server is capable of handling uploads from an 
anonymous user in which case a username and password are not required 

4) Login Username: username required to access your FTP service 

5) Login Password: password required to access your FTP service  

6) Test: this will test the connection to the FTP server specified 

 SMS 

Alarms can be distributed to via text messages (SMS). To achieve this, an SMS provider must be 
configured 

Setting up an SMS provider account 
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For information on setting up an SMS Provider, please refer to ‘1510-006-MyCalls SMS Configuration 
Manual’. This shows the SMS Providers that are currently supported by MyCalls. To create an 
account with one of the supported providers, please select the like to the website, select the sign up 
options (sign up/register) and follow the step-by-step instructions to create a new account. 

How to: Set up an SMS provider.  

1) Configuration -> System settings 

2) SMS Provider: select a provider from the dropdown menu e.g. TextLocal  

3) Configure: Enter the User Name and Password of your SMS provider account (see 'Setting up an 
SMS account') 

4) Test: To create and send a test SMS to a specific number, enter the country code (this differs 
between providers), the rest of the number (not including the first digit), and the text that you 
wish to send. This is limited to 160 characters 

For more information on setting up an SMS Provider, see ‘1510-006-MyCalls SMS Configuration 
Manual’ 

 

Grade of service and Grace periods  

What is Grade of Service (GOS)  

You may specify the limits after which a call is treated as having rung or lasted too long. You can also 
configure the relative importance of these limits. Note that overflowed calls are regarded as 
incoming calls for the purposes of Grade of Service. 

General ‘Grade of Service’ is used to measure the percentage of calls which were answered within 
the target ring time for that department or group compared with the total number of answered calls 
for that department or group. The total number of calls can include long wait calls where the ring 
time extends beyond the target ring time configured.   

Long Waits = number of answered calls which rang for longer than the target maximum ring time  
 

𝐺𝑒𝑛𝑒𝑟𝑎𝑙 𝑆𝑒𝑟𝑣𝑖𝑐𝑒 𝑙𝑒𝑣𝑒𝑙 =
𝐼𝑛𝑐𝑜𝑚𝑖𝑛𝑔 𝑐𝑜𝑛𝑛𝑒𝑐𝑡𝑒𝑑 𝑐𝑎𝑙𝑙𝑠 − 𝑙𝑜𝑛𝑔 𝑤𝑎𝑖𝑡𝑠

𝐼𝑛𝑐𝑜𝑚𝑖𝑛𝑔 𝑐𝑜𝑛𝑛𝑒𝑐𝑡𝑒𝑑 𝑐𝑎𝑙𝑙𝑠
∗ 100 

   

Abandoned ‘Grade of Service’ measures the percentage of calls which were answered within the 
target ring time for that department or group compared the total answered calls plus the long 
abandoned calls.  

Long abandoned calls are those calls which were abandoned after the minimum abandonment time 
i.e. genuine abandoned calls. 

𝐴𝑏𝑎𝑛𝑑𝑜𝑛𝑒𝑑 𝑆𝑒𝑟𝑣𝑖𝑐𝑒 𝑙𝑒𝑣𝑒𝑙 =
 𝐼𝑛𝑐𝑜𝑚𝑖𝑛𝑔 𝑐𝑜𝑛𝑛𝑒𝑐𝑡𝑒𝑑 𝑐𝑎𝑙𝑙𝑠 − 𝑙𝑜𝑛𝑔 𝑤𝑎𝑖𝑡𝑠

 𝐼𝑛𝑐𝑜𝑚𝑖𝑛𝑔 𝑐𝑜𝑛𝑛𝑒𝑐𝑡𝑒𝑑 𝑐𝑎𝑙𝑙𝑠 + 𝐿𝑜𝑛𝑔 𝐴𝑏𝑎𝑛𝑑𝑜𝑛𝑒𝑑 𝑐𝑎𝑙𝑙𝑠
∗ 100 

Service levels can be displayed as single value performance statistic, included in customer specific 
reports and also set alarms based on call performance. 
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Long Calls 

The Grade of service configuration allows us to set the Incoming call duration limits, outgoing call 
duration limits and internal call duration limits. These allow us to define the limits for long calls. 

Long calls can be displayed as Single value performance statistics, included in customer specific 
reports and also set alarms based on call performance. 

To access grades of service and grace periods:  

Click ‘Configure’ -> ‘operational settings’ and then either ‘grade of service’ or ‘grace periods’. 

Grade of service configuration 

Grade of service can be configured across the whole organization or specified on a group by group 
basis. Within the Grade of service configuration screen, you add the groups required to the list of 
Active groups.   

Specify for each group the settings for the following: 

Incoming/Overflow ring time: If a call rings for longer than this period then the call will be treated 
as a long ring. 

Abandoned ring time: If a call was abandoned after ringing for more than this time then the 
abandoned ring will be treated as too long. 

Incoming/Overflow call duration, Outgoing and internal call durations: Specified the maximum 
length of call. Any call lasting longer than this time is considered a long call.   

How to: Configure Grade of Service:  

1) Configure -> Operational Settings -> Grade of Service 

2) Select the device from the ‘available’ list on the left side e.g. Extension 

3) Click ‘Add’. This will transfer the available device group to the list of active groups for which 
limits can be set. Each group defined for that device will be listed in the grid. You can then define 
a set of limits for each specific group. 

4) The’ Move up’ and Move Down buttons allow you to define which limits will be used for a call. If 
for example a call has both DID and Extension information, then the Grade of Service group 
higher up in the list will be used to calculate the Grade of Service for that call. 
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5) Click ‘OK’ 

6) To remove a device, simply select the device in the ‘active’ section on the right side, e.g. 
extension and click ‘remove’ 

7) Click ‘OK’ 

Grace periods  

What are grace periods? 

Grace periods allow you to specify the minimum ring time an abandoned call must have, and the 
minimum call time incoming, outgoing and internal calls must have, to be regarded as true calls. 
Only true calls will be used in the call statistics. 

You can define grace periods on the following 

 Abandoned Wait Time 

 Incoming Call Duration 

 Outgoing Call Duration 

 Intercom Call Duration 

Grace periods configuration 
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Chapter 11 

Highlighting 

Introduction to highlighting  

Real time status and real time statistics windows can use visual highlighting as a way of bringing 
operational issues to the attention of users, supervisors and the management team.   

Visual highlighting changes the background or foreground colour of a value when the value being 
displayed meets certain conditions. This allows you to change the window colour if the value 
exceeds or dips below a required performance level. 

The Highlighting can be configured to draw attention in the following ways: 

 Changing the foreground colour of a value 

 Changing the background colour of a window 

 Flashing a value or background colour 

Visual highlighting can be applied to both real time statistics and if available, real time status 
windows.   

The following table lists the types of windows which can be configured for highlighting: 

 

Status Type Window type Parameters Highlighted 

Users Detail, Summary, Overview 
Username,  

Time in state 

Extensions Detail, Summary, Overview 
Extension name 

Time in state 

Trunks Detail, Summary, Overview 
Trunk Name 
Time in state 

Trunk Group  
Queue Status 

Calls In Queue 
Longest Waiting 

Calls In Queue 
Longest Waiting 

Trunk Group  
Queue Group Status 

Calls In Queue 
Longest Waiting 

Calls In Queue 
Longest Waiting 
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DIDs 
Queue Status 

Calls In Queue 
Longest Waiting 

Calls In Queue 
Longest Waiting 

DIDs 
Queue Group Status 

Calls In Queue 
Longest Waiting 

Calls In Queue 
Longest Waiting 

Pilot Numbers Queue 
status 

Calls In Queue 
Longest Waiting 

Calls In Queue 
Longest Waiting 

Pilot Numbers Queue 
group status 

Calls In Queue 
Longest Waiting 

Calls In Queue 
Longest Waiting 

 

Real Time Statistics 

All Real Time Statistics 
Windows 

Current & Historical 
Numeric values only 

Statistic Value 

Single Value 

All Single Value 
Windows 

Current & Historical 
Numeric values only 

Statistic Value 

 

Setting Conditions  

In order for the system to provide the correct highlighting indications the various statistical values 
and states shown in the real time windows will need to have conditions applied to them. You set the 
conditions as part of the real time window configuration. 

Each condition will define: 

 When highlighting is to occur based on the value being displayed 

 Whether the Highlighting affects the text colour or the background colour 

 Which colour is to be used for highlighting 

 Will the value flash when highlighted? 

An example might be the length of time an extension has been on a call. We might decide that any 
calls lasting less than 5 minutes are displayed in Green whereas any calls which have been in 
progress for between 5 and 8 minutes will display in Amber and any calls lasting more than 7 
minutes need to be displayed in Red. 

We would start by setting up an extension status window which would display all the extensions we 
want to monitor and then set up the highlighting conditions.  

For this example, we would set up two conditions  

1. Calls with a duration of less than 5 minutes are displayed in Green 

2. Calls with a duration of 5 to 7:59 minutes are displayed in Amber 

3. Calls lasting 8 minutes or over are displayed in flashing Red 

Note: we cannot overlap our conditions so we cannot set condition 1 to read ‘less than 5 minutes’ 
and condition 2 to read ‘4 minutes or more’  
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For each condition you set a required colour and whether the colour is applied to the text or the 
background you can also define if the value is to flash.  

A typical set of state conditions might read as follows: 

Status Criteria Text Colour Flashing 

Call Duration Less than 5 minutes Green No 

Call Duration  5 minutes or over Amber No 

Call Duration 8 minutes or over Red Yes 

 

The above conditions produce the results illustrated below. 

 

Highlighting Real Time Status 

All types of status windows can be highlighted.  

Device status shows the various devices highlighting are used to alert users to the amount of time 
spent in a particular state, for example excessive ring times. The window can highlight the time and 
device name or user name. 

Examples of the three Real Time Status views are shown below: 

Summary – A list view of the status for the required extensions or users. The whole row can be 
highlighted (background) or the ‘Time in state’ can be highlighted (foreground text). 

 

 

Detailed – Shows in detail which extension or user is in which state, again the ‘Time in state’ can be 
highlighted or the complete background block.
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Overview – Shows the name of the extension or user and this can be highlighted. When expanded to 
reveal details of the device then the ‘Time in state’ is highlighted. 

 

How to: Configure highlighting for a ‘Real Time Status’ window  

From the MyCalls main screen, click View > Real Time Information 

Navigate to Trunks Status by clicking the ‘+’ symbol next to Real Time Status. 

Click ‘Trunks’.  

 

Click ‘Create a New Trunk Status View’ on the right hand panel. 

Select the PBX 

Select the trunk groups that you wish to include in the table. 

Select the status items that you wish to show. 

Click the ‘Highlighting’ button. 
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A new window will appear where you can start adding conditions.  

 

Select a data value from the drop down menu. This determines which parameter you set the 
highlighting conditions for. You can set separate conditions for each parameter. 

 

Click ‘Add new condition’  

 

The Edit Condition window will be presented. 
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Click the ‘Name’ textbox and enter a name for the condition (up to 15 characters). 

 

Select the condition operator (Type)  

 

Selecting ’Equal to’, ‘Greater Than or Equal to’ or ‘Less Than’ will cause a single box labelled ‘Value’ 
to appear. 

Enter your data value. 

 

If you select ‘Range’ two boxes labelled ‘To’ and ‘From’ will appear. Enter the start and end of your 
range in these boxes.  

 

Select which attribute of the parameter you wish to highlight. You can highlight the ‘Background’ or 
the ‘Value’. 

 

Click the colour ‘Edit’ button to select a colour for the highlighted item. This will bring up a colour 
editing panel.  
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Select the desired colour and click OK. 

Click the ‘Flash’ checkbox if you want the value to flash when this condition is true 

.  

You will end up with a condition set up similar to this. 

 

Click ‘OK’  

The condition windows will now display your newly created condition. Your condition will appear in 
the list of conditions for the selected parameter. 

 

If you wish to add another condition, for the same or different data value, repeat the process by 
clicking ‘Add New Condition’ 

Once you have added all of the required conditions, click OK  

Click OK to finish the configuration. 
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Queue status can be displayed for both DIDs and Trunks. The individual trunk or DID status queue 
windows are displayed as a single value style window displaying the device information for a specific 
Trunk or DID.  

 

Queue group status can also be displayed in a grid showing all trunks or DIDs in the groups.  

 

The dynamic information for these queue status windows i.e. the number of calls in queue and the 
longest call waiting can both be individually highlighted.  

 

How to: Configure ‘Device Group Queue - Group Status’ Highlighting  

From the MyCalls main screen, click View > Real Time Information 

Navigate to Queue Group Status by clicking the ‘+’ symbol next to Real Time Status, then click the ‘+’ 
symbol next to ‘Trunk Group’  

Click ‘Queue Group Status’.  

 

Click ‘Create a New Queue Group Status View’ on the right hand panel. 

Select the PBX 

Select the trunk groups that you wish to include in the table. 
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Click the ‘Highlighting’ button. 

 

 

A new window will appear where you can start adding conditions.  

 

Select a data value from the drop down menu. This determines which parameter you set the 
highlighting conditions for. You can set separate conditions for each parameter. 

 

Click ‘Add new condition’  
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The Edit Condition window will be presented. 

Click the ‘Name’ textbox and enter a name for the condition (up to 15 characters). 

 

Select the condition operator (Type) 

 

Selecting ’Equal to’, ‘Greater Than or Equal to’ or ‘Less Than’ will cause a single box labelled ‘Value’ 
to appear. 

Enter your data value. 

 

If you select ‘Range’ two boxes labelled ‘To’ and ‘From’ will appear. Enter the start and end of your 
range in these boxes.  

 

Select which attribute of the parameter you wish to highlight. You can highlight the ‘Background’ or 
the ‘Value’. 

 

Click the colour ‘Edit’ button to select a colour for the highlighted item. This will bring up a colour 
editing panel.  
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Select the desired colour and click OK. 

Click the ‘Flash’ checkbox if you want the value to flash when this condition is true. 

 

Click ‘OK’ to close the   

The condition windows will now display your newly created condition. Your condition will appear in 
the list of conditions for the selected parameter. 

If you wish to add another condition, for the same or different data value, repeat the process by 
clicking ‘Add New Condition’ 

Once you have added all of the conditions you need, click OK  

Your conditions will now have configured. 

Click OK to view the status window. 
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How to: Configure Real Time Status for Devices  

From the MyCalls main screen, click View > Real Time Information 

Navigate to Extensions by clicking the ‘+’ symbol next to Real Time Status and click ’Extensions’.  

 

Click ‘Create a New Extension Status View’ on the right hand panel. 

Select the PBX 

Select the extensions that you wish to include in the table. 

Click the ‘Highlighting’ button. 

 

A new window will appear where you can start adding conditions.  
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Select a data value from the drop down menu. This determines which parameter you set the 
highlighting conditions for. You can set separate conditions for each parameter. 

 

Click ‘Add new condition’  

 

The Edit Condition window will be presented. 

 

Click the ‘Name’ textbox and enter a name for the condition (up to 15 characters). 

 

Select the condition operator (Type)  

 

Selecting ’Equal to’, ‘Greater Than or Equal to’ or ‘Less Than’ will cause a single box labelled ‘Value’ 
to appear. 

Enter your data value. 

 

If you select ‘Range’ two boxes labelled ‘To’ and ‘From’ will appear. Enter the start and end of your 
range in these boxes.  
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Select which attribute of the parameter you wish to highlight. You can highlight the ‘Background’ or 
the ‘Value’. 

 

Click the colour ‘Edit’ button to select a colour for the highlighted item. This will bring up a colour 
editing panel.  

 

Select the desired colour and click OK. 

Click the ‘Flash’ checkbox if you want the value to flash when this condition is true. 

 

Click ‘OK’ to close the   

The condition windows will now display your newly created condition. Your condition will appear in 
the list of conditions for the selected parameter. 

If you wish to add another condition, for the same or different data value, repeat the process by 
clicking ‘Add New Condition’ 

Once you have added all of the conditions you need, click OK  

Your conditions will now have configured. 

Click OK to view the status window. 

 

  



Highlighting 

  

 1510-002-010  Chapter 11-15   
 

Highlighting Real Time Statistics  

Statistics windows which show single values or statistics windows displaying data in a grid view can 
be highlighted. There are no highlighting options for Graph based statistical windows. Single value 
statistics can be highlighted and miscellaneous data windows can also have values highlighted. 

The highlight colour can be applied to either the numeric value or the background of the window or 
in the case of a grid display the cell value or background. 

Windows displaying a single statistic have only one value whereas grid displays contain many 
statistical values and separate highlighting conditions can be set for each statistic. 

 

How to: Configure a ‘Trunk Group Statistics’ Highlighting  

From the MyCalls main screen, click View > Real Time Information 

Navigate to Trunk Group Statistics by clicking the ‘+’ symbol next to Real Time Statistics, then click 
the ‘+’ symbol next to ‘Trunk Group’  

Click ‘Queue Group Statuses.  

 

Click ‘Create a New Group Statistics View’ on the right hand panel. 

Select the PBX. 

Select the trunk groups that you wish to include in the table. 

Click the ‘Highlighting’ button. 
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A new window will appear where you can start adding conditions.  

 

Select a data value from the drop down menu. This determines which parameter you set the 
highlighting conditions for. You can set separate conditions for each parameter. 

 

Click ‘Add new condition’  

 

The Edit Condition window will be presented. 

 

Click the ‘Name’ textbox and enter a name for the condition (up to 15 characters). 

 

Select the condition operator (Type)  
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Selecting ’Equal to’, ‘Greater Than or Equal to’ or ‘Less Than’ will cause a single box labelled ‘Value’ 
to appear. 

Enter your data value. 

 

If you select ‘Range’ two boxes labelled ‘To’ and ‘From’ will appear. Enter the start and end of your 
range in these boxes.  

 

Select which attribute of the parameter you wish to highlight. You can highlight the ‘Background’ or 
the ‘Value’. 

 

Click the colour ‘Edit’ button to select a colour for the highlighted item. This will bring up a colour 
editing panel. 

 

Select the desired colour and click OK. 

 

Click the ‘Flash’ checkbox if you want the value to flash when this condition is true. 

 

Click ‘OK’ to close the   
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The condition windows will now display your newly created condition. Your condition will appear in 
the list of conditions for the selected parameter. 

If you wish to add another condition, for the same or different data value, repeat the process by 
clicking ‘Add New Condition’ 

Once you have added all of the conditions you need, click OK  

Your conditions will now have configured. 

Click OK to view the status window. 

Highlighting Single Value windows  

How to: Configure ‘Single Value’ Highlighting 

From the MyCalls main screen, click View > Real Time Information 

Navigate to Trunk Groups by clicking the ‘+’ symbol next to ‘Single Value’, then click the ‘+’ symbol 
next to ‘Trunk Groups’, ‘+’ symbol next to ‘Call Rate’.  

Click ‘Incoming Calls’.  

 

Click ‘Create a New Group Statistics View’ on the right hand panel. 

Select the PBX 

Select the trunk groups that you wish to include in the table. 

Click the ‘Highlighting’ button. 
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A new window will appear where you can start adding conditions.  

 

Click ‘Add new condition’  

 

The Edit Condition window will be presented. 

 

Click the ‘Name’ textbox and enter a name for the condition (up to 15 characters). 

 

Select the condition operator (Type)  

 

Selecting ’Equal to’, ‘Greater Than or Equal to’ or ‘Less Than’ will cause a single box labelled ‘Value’ 
to appear. 

Enter your data value. 
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If you select ‘Range’ two boxes labelled ‘To’ and ‘From’ will appear. Enter the start and end of your 
range in these boxes.  

 

Select which attribute of the parameter you wish to highlight. You can highlight the ‘Background’ or 
the ‘Value’. 

 

Click the colour ‘Edit’ button to select a colour for the highlighted item. This will bring up a colour 
editing panel.  

 

Select the desired colour and click OK. 

 

Click the ‘Flash’ checkbox if you want the value to flash when this condition is true. 

 

Click ‘OK’ to close the   

The condition windows will now display your newly created condition. Your condition will appear in 
the list of conditions for the selected parameter. 

If you wish to add another condition, repeat the process by clicking ‘Add New Condition’ 

Once you have added all of the conditions you need, click OK  

Your conditions will now have configured. 

Click OK to view the status window. 
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Chapter 12 

Organisation and Users 

Organisation view 

Companies are generally arranged in a hierarchical structure be it a complex one that has multiple 
sites, divisions, departments and teams or a simpler scenario where there are groups of people that 
are arranged in groups to reflect their functions. 

It is possible to emulate this structure within MyCalls and then run reports and gather statistics on 
how different areas of the business are performing and using the telephone system. The structure 
you create is intended to allow you to recreate business groupings rather than sometimes forced 
groupings when looking at the type of extension or the pilot group that the call came in on. These 
two approaches are intended to complement each other and allow you to produce reports on 
exactly what you want to see.  

The organisation is created as a series of groups and users within those groups. There are no limits 
on the number of users, groups or levels of groupings that can be created. 

The organisation configuration can be shown by selecting the Organisation option from the 

Configure menu or by pressing the icon  from the main toolbar. 

 

Under the item "Organisation" the hierarchical structure is shown. Expand each item to see the 
other sub-groups that form part of the selected group.  

Under the item "All Users" the users are grouped by their role within the MyCalls system. 

Why Configure Users 

Whilst it is permissible to only configure MyCalls to use devices e.g. extensions, in order to track and 
report calls it is always advisable to create a user configuration for several reasons 
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Users can be organised hierarchically thus reports can group information in terms of groups and 
subgroups. For example, if you have several sales groups then a hierarchical view will allow you to 
create several subgroups under an overall group called Sales. Reports can then be performed on the 
overall performance of sales as well as each sales group within the sales department. 

Users can be responsible for more than one extension thus reports can be generated to record the 
user rather than the extension activity. ACD requires the creation of users for logging on and off 
queues. 

Understanding User Roles  

Assigning the appropriate roles to users will allow control of the system to be carefully governed and 
thus reduce the risk of untrained users making damaging configuration changes or running reports 
that they should not see. 

 
Desktop 
User 

WB 
User 

User Supervisor ACD Supervisor PBX Admin 
Enterprise 
Admin 

View Agent Desktop 
Layout               

Create Real Time 
windows 

             

Save/ Load screen 
layouts 

             

View Live Call 
Records/ Alarm/ 
Audit Entries 

             

ACD Real Time          

Configure/ Run 
Reports 

           

ACD Reports         

Configure Collectors          

Configure 
Telephone System/ 
Organisation/ 
Callers/ Costs/ 
Alarms 

         

Backup/ Restore 
database 

         

Remove unwanted 
information 

         

Import Bill          

Re-Cost Calls          
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Organisation Group Configuration  

Organisational Groups are the logical groups of employees that exist within the organization.  They 
are arranged in a hierarchy and groups can exist within other groups.  It is typical that an 
organization be split up into different departments and then maybe different teams. 

How to: Creating a new Organisation group 

1) From the Organisational Groups Configuration screen, click ‘Organisation’ 

 

2)  click ‘Create a New Group’ 

3) In the ‘Create a New Organisational Group’ window you must enter a name for the group, and 
you can enter notes to describe the group. 

4) Name*: Enter a name to describe the organisation group you are creating. 

5) Click ‘OK’ 

How to: Editing organisation group configuration  

1) From the Organisational Group Configuration screen, click to expand ‘Organisation’ and select 
the group you want to edit. 

  

2) Click ‘Edit Organisation Group’ in the Organisational Group Configuration area 

3) In the ‘Edit an Organisational Group’ window that appears you can enter notes to describe your 
selected group.  In the Group Members window, you will see members currently assigned to the 
organisation group.  If you have sub groups below this group, then you can include those 
members by selecting the ‘Include Sub Groups’ option.  If members are displayed in this window, 
then you can choose whether to collect real time statistics on the member in the group by 
selecting the ‘Enable Statistics’ option. 

 

4) Click ‘OK’ 
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Deleting Organisation Groups  

How to: Delete Organisation group configuration  

1) From the Organisational Configuration screen click to expand ‘Organisation’ 

2) Select the group you want to delete e.g. office admin. 

 

3)  Click ‘Delete Group’ in the Organisational Group configuration area.  

4) You will be prompted to confirm deletion of the selected group. 

5) Click ‘OK’ 

 

User Configuration  

Users are generally people employed by the organization.  By configuring users, it will be possible to 
report on the activity of people rather than extensions.  This is very useful where a person may move 
between several desks and telephones. 

How to: Creating a new User 

1) At the Organisational Configuration screen, click ‘Create a New User’. 

2) The Create a New User screen is displayed.  The configuration is split into 8 categories that can 
be selected from the list on the left.  The General category will be pre-selected. 

3) In the dialog window that appears a number of fields are available for entry.  Some are 
mandatory fields* for successful setup whilst others are optional inputs as outlined below. 
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Name*: Enter the name that will be used to identify the user in the system. 

Abbreviation: If the user has an abbreviated name or nickname they would like to be known by then 
you can enter it here in this field. 

Job Title: Enter a job title to describe the users’ position within the organization.  

User Role*: Select a user role for your user from the pre-defined list.   

Email Address: You can enter an email address for your user so that if they are configured as an 
Administrative User of an organization group then they receive reports and alarms on that groups 
activity directly. 

Password: If the user is required to enter a password to login then enter one in here. 

User Image: Use the Browse button to initiate selection of a graphical image file. 

Enable Real Time Statistics: For real time statistics to be collected for the user this option needs to 
be enabled.  If you no longer wish to collect info on the user, then turn this option off.  

Enable for Hot Desking:  User will need to select an extension at login.  

4) Select the Call Recording category and the associated settings will be shown on the right. 

 

Enable Call Playback: To allow call playback by the user this option must be selected. 

Enable Export of Recordings: To allow call recordings to be exported by a user this option must be 
selected. 

Enable Stop/Start Recording Conditions: To enable Stop/Start recording conditions to be used by 
the user. 

Enable Manual Stop/Start Recording: To enable the user to manually Stop/Start recording. 

5) Select the Operator Console category and the associated settings will be shown on the right. 

 

Enable Operator Console: Allows the user to use the Operator Console. 

For the information about the rest of these settings please look at the Operator Console chapter. 

6) Select the Instant Messaging category and the associated settings will be shown on the right.   
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Enable Instant Messaging: This setting must be enabled to allow the user to use Instant Messaging. 

See the Instant Messaging chapter for more information. 

7) Select the Presence category and the associated settings will be shown on the right. 

 

See the Presence chapter for full details on how to setup a user for Presence. 

8) Select the Windows User category and the associated settings will be shown on the right. 

 

Allows a MyCalls user to be mapped to their Windows user account. 

9) Select the Call Control category and the associated settings will be shown on the right. 

 

Call Control: Allows the level of Call Control to be selected. 

Call Control Group: Allows a Call Control Group to be selected. 

10) Select the Notes category and the notes entry field will be shown on the right. 



Organisation and Users 

  

 1510-002-010  Chapter 12-7   
 

 

Notes: Allows notes to be added about the user. 

11) Click ‘OK’ to save the new user configuration. 

12) The user should now be visible in the Configure Organisation Structure window. 

Once a user has been created there needs to be at least one PBX administrator created as these are 
the only users that can do further modifications to the configuration. If you do not create a PBX 
administrator, then contact your maintainer who can fix it for you. 

How to: Editing an existing User 

1) From the Organisational Configuration screen, click ‘Organisation’ 

2) Select the user you want to edit by expanding the group the user is in and clicking on the user. 
E.g. If you want to edit Max, select Max from the organization hierarchy. 

3) Click ‘Edit User Configuration’ in the Users configuration area. 

4) The ‘Edit a User’ dialog works in a very similar way to as described in the ‘Create a new user’ 
section above. 

 

How to: Deleting a User 

1) From the Organisational Configuration screen expand ‘organisation’ 

2) Select the group that the user you want to delete belongs to and select the user 

3) Click ‘Delete user’  

4) You will be prompted to confirm deletion of the selected User. 

5) Clicking ‘Yes’ will delete the user whilst clicking ‘No’ will cancel the action. 
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How to: Assigning Users to a group 

1) If you have configured User Groups, then you can group individual users within a group to 
enhance real time statistics and make reporting easier. 

2) The easiest method to assign a user is to simply drag and drop them from the organization 
structure to the group.  From the Organisational Configuration screen, select the user you want 
to assign to a group and drag across to the group and release the left mouse button. 

3) You can also use the ‘Edit User Configuration’ window to change the organisation group. 

 

4) Click ‘OK’ 

How to: Removing a User from a group 

1) The easiest method to remove a user from a group is to drag them from the group they are in 
and drop them in another group in the organizational hierarchy. Simply select the user by 
hovering over them and clicking the left button on the mouse, drag them over to the group you 
want to move them to and release the left mouse button. 

2) If you want to remove the user from all groups, you can put them in the top level of the 
hierarchy by hovering over the Organisation group and releasing the mouse. 

3) You can also use the ‘Edit User Configuration’ window to change the organisation group.  

4) Select the user you wish to remove from a group 

5) Click ‘Edit User Configuration’ 

 

6) In the window that appears simply use the drop down menu ‘group’ and assign them to a 
different group. 

7) Click ‘OK’ 
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Importing users:  

You can import a csv (comma separated values) file directly into MyCalls to speed up user setup.  This 
file should include the following columns Name, Abbreviation, Password, Email Address, Job Title, 
Login PIN, Default Extension in that order to be imported successfully. 

How to: Importing Users 

Browse to the import template under Start>Computer>C:>Program Files*>NEC 
Infrontia>MyCalls>Import.xls 

*If you are running on a 64-bit operating system, the correct folder will be ‘Program Files (x86) 

Click on the ‘Users’ tab at the bottom 

 

Copy and paste the headers into a new Excel spreadsheet. 

Enter the appropriate information under each header. These headers are: 

Group: This is the organisational group that the user will be assigned to* 

Name: The name of the user 

Abbreviation: A shortened version of the username, usually their initials*  

Password: The password that the user will use to logon* 

Email: The email address of the user* 

Job Title: the name of the role in which they play within the company* 

ACD PIN: If ACD is enabled, this is the number that the user will enter into the phone to login* 

Default Extension: The extension number that will be assigned to the user first 

Enable Statistics: Choose whether or not you will be able to see the call statistics of the user 
(True=On, false=Off) 

Enable Call Playback: If call recording is enabled, select if the user will be able to listen to their calls 
(True=On, false=Off) 

Enable Call Control: If call control is enabled, select if the user can use it (1=On, 0=Off) 

User Hot Desking:  Select whether or not the user is enabled for hot desking (True=On, false=Off) 

Extension Hot Desking:  Select whether or not the users default extension is enabled for hot desking 
(True=On, false=Off) 

User Type: Select what type of user the person will be. This will limit their abilities within MyCalls 
(0=User, 1=Supervisor, 2=PBX Administrator, 4=Agent Desktop User, 5=ACD Supervisor) 

Windows Username: The username that the user logs onto their computer with* 

Enable Auto Login: If you have entered the users Windows Username, you can set it so that the user 
logs MyCalls automatically when they login on their machine* 

*These fields are not mandatory 
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Once you have entered all of the required information, click ‘Save’ 

From the ‘Save as type’ drop-down menu box, select ‘CSV (Comma delimited) (*.csv)’ 

Give the file an appropriate name e.g. ‘Users Import File’ 

Save the file in a memorable location 

 

Open MyCalls 

Log in as a user with administrative privileges. Otherwise, log in as ‘Installer’. 

Click ‘Configure’>’Organisation’ 

Select ‘Import Users’ in the right hand panel 
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Browse to the CSV file  

Check the ‘First line contains column headers’ box 

If the site has multiple PBXs, select which PBX the users will logon to 

Click ‘Load’ 

 

Click ‘OK’ 

Click the ‘+’ symbol next to ‘Organisation’ and you will see all of the other groups. If you click the ‘+’ 
symbol next to these, you will be able to see all of the created users in the list in their corresponding 
groups 

 

You can edit any of these users by clicking on their name and select ‘Edit User Configuration’ in the 
right hand panel 
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Chapter 13 
MyCalls Desktop 

 

Desktop call control provides a range of functions allowing users to control their phone operations 
directly from the screen. As well as the ability to dial out, answer calls and transfer you will have 
instant access to advanced phone features such as forwarding, call-back, call parking and brokering. 
Call control uses a real time event stream from the telephone system to monitor both your own 
extension and other extensions in the system. 

Call control is an optional extra to the MyCalls application and can, when purchased, be integrated 
into the main MyCalls application or run as an independent program called the MyCalls Desktop. 

It is possible to run MyCalls Desktop with any of the MyCalls products, Basic, Call Manager, Call 
Centre, Enterprise or Recorder. 

Architecture of the call  control system  

Call control is based around the principle that a MyCalls user, logging on to the system, is able to 
control an extension of their choice. Each user created in MyCalls can be enabled for call control by 
the PBX administrator. When a user logs in to MyCalls they will normally be associated with an 
extension automatically. If a user does not want to control their default extension they will be 
allowed to choose an extension to control. It is possible that a user may be the default user for more 
than one extension in which case the user is given a choice of extensions to control. 

Having selected an extension to control the user is presented with a call control toolbar. This toolbar 
can be docked in the MyCalls application or can be undocked and positioned anywhere on the 
desktop. The toolbar can be locked in place and if space is a premium it can be displayed in a 
compact format. 

In addition to the call control toolbar the call control functionality also includes an Actions screen 
and an Address Book. These are described in more detail in the appropriate sections. 

MyCalls Desktop 

MyCalls Desktop is a stand-alone application which provides all the call control and screen-pop 
functionality of MyCalls without the call management capabilities. 
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If you are using the MyCalls desktop application you will have access to the call control capabilities, 
the actions and contact address book as well as screen-popping and basic call logs. If the user is 
enabled for call playback, they can listen to their recording directly from MyCalls Desktop. The 
following information refers to the MyCalls integrated application and where the MyCalls Desktop 
product differs, this is highlighted. 

MyCalls Desktop Lite  

MyCalls Desktop Lite is a basic version of MyCalls Desktop. It contains the following functionality. 

       MS Outlook® screen - pop 

         Highlight and Dial 

         Basic Call Control 

 Dial 

 Answer 

 Hangup 

 Transfer 

 Hold 

 Recall 

         Personal Call Statistics 

         Call List 

         Internal Database synchronised with ABB Dials (see scheduled configuration import) 

        1 page, 10 Action buttons (BLF/Speed Dial) 

Configuring a user for Call Control  

1) At the Organisational Configuration screen, click ‘Create a New User’. 

2) The Create a New User screen is displayed.  

3) Select the ‘Call Control’ category on the left. 

4) In the dialog window that appears a number of fields are available for entry. 

 

5) To enable the user for Call Control, select either ‘Basic’ or ‘Advanced’ from the ‘Call Control’ 
drop-down menu 

6) Once you are happy with the changes you have made, click ‘OK’ 
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Logging on to the MyCalls Call Control /Desktop Environment 

MyCalls now offers call control users a hot-desk facility. This enables a user to log onto any extension 
of their choice. Users must be specifically enabled for hot-desking otherwise they will be restricted 
to their default extension. In addition, extensions enabled for hot desking will appear in the list of 
available extensions as well as any extensions for which the user is marked as the default user when 
the user logs on to MyCalls or MyCalls desktop. 

To Summarise: 

 Only Users enabled for Hot Desking can select an extension other than their default 

 Any Extensions enabled for Hot Desking will appear in the list of available extensions when 
logging on as well as the extensions for which the user is the default user 

Once the hot desking options have been enabled for both users and extensions then the user will be 
presented with the extension list whenever they log on to MyCalls. 

 

The user should select the extension that they wish to control which will then be the extension 
controlled from the call control toolbar etc. 

Users can be enabled for hot desking in the user configuration dialog.  
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Extensions can be enabled for hot desking in the extensions configuration dialog.  

 

For more details on extension configuration see the device configuration section. 

MyCalls Call Control Toolbar  

The Call Control Toolbar is displayed as a separate screen element which can, if required be docked 
into the main MyCalls application. From this toolbar you can manage the call control features such 
as dialling, answering, transfers etc. as well as basic call control and screen-pop configuration.  

The toolbar can be made visible from the ‘View’ menu within MyCalls 

 

How to: Dock the toolbar  

Click on the MyCalls Control Toolbar 

Drag over the MyCalls Application 

Release the mouse button and the toolbar will automatically dock onto the application 
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How to: Undock the toolbar    

Click on the dotted docking area of the toolbar 

 

Drag outside the application window 

Release the mouse button to drop the toolbar onto the desktop 

To re-dock the control toolbar simply drag the toolbar over the MyCalls application and release the 
mouse  

 

Using the MyCalls Control toolbar functions  

 

Dial – Call another phone by entering a number in the dropdown box and either clicking the ‘Dial’ 
icon or hitting the enter key. 

 

Alternatively clicking on the Dial Icon pops a dialogue asking for the number to dial. Simply enter the 
number and click ‘OK’ to initiate the call. 

 

Answer – simulates picking up the extension handset. Depending on the phone type the external 
microphone and speaker may be enabled. 

 

 Hold/Recall  – Puts the extension on hold or recalls a call currently held.   
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Transfer – Allows supervised or blind transfer operation. Supervised will keep the phone connected 
until the transfer target extension is answered and you specifically complete the transfer. A blind 
transfer automatically hangs up your extension once the transfer target is dialled and begins to ring. 

 

How to: Make a Supervised transfer  

Once the call is connected click the Transfer Icon 

Enter the number to transfer the call to in the ‘Transfer to’ box 

1 - Click Start to initiate the transfer; this will call the number you wish to transfer the call to. 

 

 

2 - Once you have established a connection select ‘Complete’ 

 

3 - Hang up your phone, the transfer is complete 

If you wish to establish a blind transfer, then simply select ‘Blind’ rather than Start in step 1 above 
and hang up your extension.  

Park and Retrieve – The system provides a number of orbits into which you may park a call whist 
attending to other business such as answering another call or attempting to ring another party.  You 
may park an active call in an orbit of your choice.  

When you press the ‘Park’ icon the orbit dialogue appears. Simply select the orbit into which you 
wish to park the call and click ‘OK’, the call is then parked. Retrieval is the complimentary operation 
to parking. Select retrieve and then select the orbit you wish to retrieve the call from. The retrieved 
call then becomes active on your extension. You may have several calls parked at once. If you forget 
to retrieve a parked call, then the phone system will automatically ring your extension and 
reconnect you to that call after a preset delay. 

NB: there may be restrictions in which orbits can be used dependent on the setup of your phone 
system. 
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Forward – Various Forward options are available:  

 

 All – Forwards all calls to another extension or number 

 Busy – forwards calls when your extension is busy 

 No Answer – Forward calls when you do not answer your extension 

 Busy/No Answer – Forward calls when busy or no answer occurs 

 Clear – Reset any forwarding settings 

 

Do not disturb (DND)  – Various DND options are available: 

 

 All – Extension will not respond to any calls 

 External – Extension will not respond to external calls 

 Internal – Extension will not respond to internal calls 

 Transfer – Extension will not respond to transferred calls 

 Clear – Reset any DND settings 

 

Hang-up – Hangs up the phone 

 

 

Callback (Camp on/off) – If an extension is busy you can set a call-back on that extension so that 
when the extension becomes free you will be automatically called back. This operation is also known 
as ‘camping on’ the extension.  To set a call-back, simply click the call-back icon whilst the extension 
is ringing and then hang up. You may only set one call-back at a time. 
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Barge in – Join an existing conversation. This can be as a passive listener or an active participant 
dependent on the PBX settings.  

 

 

Broker – Allows you to switch between an active call and a held call. once you have both calls 
ongoing then simply click on the broker icon to switch between them. 

 

 

Conference – Allows you to easily add other parties to your call.  

 

How to: Set up a conference call  

Having set up a two-way conversation additional parties can be added into the call by selecting 
conference and specifying the extension or external number to add.  

 

This will dial the required number and once connected you can then add the new party to the 
conference by clicking ‘Add’ and Repeat for other parties you wish to include in the call. 
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Toolbar Options 

The toolbar options Icon provides a list of options which can control the operation of the call control.  

 

 

Always on top – Ensures the Call Control toolbar is always visible on the desktop. 

Compact Display – reduces the toolbar size to minimise space taken up on the screen. 

Quick dial  button – provides a button which can be placed anywhere on the screen and allows the 
user to select a number from any application visible on the desktop such as a website or 
spreadsheet. Pressing the quick dial button then immediately dials the selected number. 

When enabled the quick dial button icon will appear on the screen at all times and can be positioned 
in any convenient location. In order to dial a required number, you will need to locate the 
application displaying the number to dial, select the number and then press the quick dial button.  

Tool Buttons  

 

The tool buttons which appear on the call control toolbar are configurable from this option. You can 
specify which functions are available by checking the appropriate checkbox in the buttons list. 
Moving the buttons in the list up move the respective icon to the left of the toolbar and moving the 
button down in the list moves it to the right.  

You can also define hot key sequences for each button. There are already default hot keys defined 
however you change the hot key for a given toolbar button. 

 How to: Change a hot key assignment  

Select the button in the buttons list 

Place the cursor into the ‘Press new hot key’ textbox 

Press the sequence for the hot key e.g. ctrl alt D 

Press the assign button 

Your hot key is now assigned 
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If you are running Agent Control in an ACD environment you can also enable the agent control 
functions to appear on the toolbar as well. In order to see any agent control buttons you will need to 
enable Agent Control from the View menu and enable the required buttons from the Tool Button 
Configuration described above by selecting Agent Control in the Category drop down box (see 
diagram below). 
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Call Control Preferences  

Call control preferences allow you to specify two items. How the transfer is processed when 
selecting transfer from the user or extension status windows or from a status action button. This can 
be set to Supervised or Blind. 

You can also define when the toolbar becomes visible when a call is triggering a response from the 
call control system.  

The toolbar can be brought to the front in the following conditions: 

 Never 

 On Ring – when an incoming call rings your extension 

 On Incoming Connect – Once an external incoming call has been picked up 

 On Internal Connect – Only when internal calls are picked up 

 On Outgoing Connect – When an outgoing call is connected 

 

Toolbar status indicators  

The toolbar contains a status indicator, mini statistics counts and a screen-pop results indicator. 

The status indicator shows the call type and changes colour to indicate this whilst the call is in 
progress, for example if the default colour scheme is in operation then it would change to green for 
an incoming call, blue for outgoing etc. The extension being controlled will be displayed; time in the 
current state e.g. ringing, hold, off-hook; and the calling number or number dialled  

 

The mini statistics indicator shows the daily total for each of the basic call types; incoming, outgoing 
and abandoned. To the right of these statistics you can view the current caller or if the caller is not 
found in the database then ‘No contact found’ will be displayed. If the screen-pop search returns 
more than one result, then ‘Multiple Contacts Found’ will be displayed and again clicking on this will 
display the screen-pop viewer. 

 

Clicking on the caller name will pop the details for that caller into the MyCalls screen-pop viewer 
(see the section on screen-pop for more details). 
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MyCalls Desktop as a standalone product  

If you are running the MyCalls Desktop standalone product, then you will be presented with a 
different interface to the normal MyCalls with Call Control. 

The interface whilst similar to the main MyCalls product lacks the majority of the call management 
features and focuses only on the features related to operation of a call control desktop application. 

The features available are as follows 

 Call Control Toolbar 

 Call Logs 

 Unreturned Call Logs 

 Actions Panels 

 Address Books 

 screen-popping 

The operations of the above features are as described in the preceding section of this manual. With 
the desktop only product you can view the interface as toolbar only or by selecting the Expand 
option from the toolbar options you can view the main panel and status tabs which enable the other 
features. 

 

The MyCalls Desktop interface 

The Toolbar options icon contain some additional options (shown here) which allow configuration of 
the personal screen-pop settings and personal address book settings. These allow access to the 
creation of personal screen-pop interfaces and address books as described in the configuration 
section for the normal MyCalls product. 
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Expand – Desktop only option allows the user to view the call logs, unreturned calls, action screens 
and address books in addition to the call control toolbar. 

Save, Delete and Assign public action layout - Available to Supervisors or PBX administrators. A 
public action layout contains a complete layout of action buttons. It is available to all users within 
the organisation.   

How to: Create a public actions page 

From the toolbar options select ‘Select Public Action Layout’ 

Type in the name of the new layout or select one from the list if any exist. Selecting an existing 
layout will overwrite that layout with the current layout you have set up 

 

Click OK 

How to: Assign a public layout to an agent desktop user  

From the toolbar options select ‘Assign public layout’ 

From the dialog select the Agent desktop user and from the Action button layout column select the 
layout you wish to assign to that user. 

 

Click ‘OK’ 

The assigned agent desktop user can now only use the assigned actions panel(s) 

Public action layouts allow you to save your action button layouts and have them assigned to agent 
desktop users. Alternatively, ordinary users can load a predefined public action layout if required. 
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 Users can then load these public layouts by right clicking on an action panel. This menu also allows 
an action panel to be named to something more relevant such as ‘Sales Actions’ or for a new action 
panel to be created by selecting ‘Create New Page’. 

 

How to: Load a public action panel page into the current action panel  

Right click on the actions panel tab 

Select Load Public Page 

 

Select a public action panel from the list 

Click ‘OK’ 
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The Actions Panel  

The actions panel allows you to configure a series of buttons and status indicators to simplify control 
and monitoring the phone system. 

The Actions panels are accessed from the bottom tabbed area just above the status bar. There can 
be up to 10 actions panels created and each panel can contain up to 100 buttons. 

 

The Actions panel screen provides a grid where the various buttons and status indicators can be 
placed.  

To create more actions panels, right-click on the Actions tab and select ‘Create New’ from the 
context menu. You may also ‘Rename’ and ‘Delete’ an actions window from the same context menu. 
There must be at least one Actions panel available therefore you cannot delete the last remaining 
actions panel and the delete option is disabled in that instance. 

The actions panel operates in two modes Normal and Edit Mode. When operating in normal mode 
the right click context menus will show only the telephony options available whereas in Edit mode 
you will also see configuration options allowing the configuration of the various buttons. 

Configuring individual items on the actions panel  

By default, the actions panel cannot be edited. In order to edit the action buttons on each actions 
panel you need to right click on the panel (or a button on the panel) and select the edit option.  

 

To exit the edit mode simply right click the actions panel and click ‘Edit’ 

 

Actions Panel              
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The actions panel appearance will change (a series of header boxes appear along the top of the 
panel as seen below) and this indicates the various buttons can be created or edited. 

 

Quick tip:  

When in edit mode moving the column headers will allow the size of the buttons to be changed  

 

Once editing has been enabled additional context menu items, accessible by right clicking either a 
button or a blank area of the action panel, are available. 

The configuration requirements of individual items on the actions panel will vary depending on the 
type of item created. If you right click on a blank area of the panel in a position where you want to 
create the button and click ‘create’ this will bring up the button configuration dialogue (see ‘Action 
Button Configuration’).  

How to: Place an item or range of items on the actions panel  

Right Click on the actions panel and select ‘Edit’ then do one of the following actions 

Right click on the position in the actions panel where you want the item to go  

Select ‘Configure’ to configure a single item  

Select ‘Create Range’ to create more than one item in a block 

Select ‘Clear’ to delete a button or ‘Clear All’ to delete all buttons on the panel 
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How to: Move a button 

Right Click on the button you want to move 

Select ‘Cut’ 

Move the mouse to where you want the new button to appear 

Right Click and select ‘Paste’ 

Buttons can also be dragged and dropped from one location to another. If the control key is pressed 
whilst the drag drop is taking place, the button will be duplicated in the new location instead of 
being moved there. 

Action Button Configuration  

 

Use the Button type drop down menu to select the type of item to create 

Items placed on the actions panel can be selected from the following: 

 Speed Dial 

 Service Code 

 Status 

 Label 

 Run Program 

 Run Macro Script 

 

Speed Dials: Allow one click dialling to external and internal numbers. It is not necessary to specify 
external access digits as these are defined in the call control configuration.  

 

 

Service Codes: Can be used to perform advanced functions within your telephone system. The 
service codes available to you will vary dependent on the PBX configuration and generally any 
available service codes will be automatically imported into MyCalls when the system is installed. 
There may be exceptions to this and MyCalls allows you to define service codes to suit your 
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requirements as long as they are supported by the telephone system (see service code 
configuration). 

 

 

Status indicators: Provide real time indication of the current activity for a specified extension or 
ACD user.  

If displaying user status, the user will be associated with an extension when that user logs on to the 
ACD system (on ACD enabled MyCalls Call Centre systems only), otherwise the user shows as 
‘Logged Off’. This should not be confused with logging on and off MyCalls Clients at start up. 

Tracking the status of non ACD users and extensions is accomplished through extension status 
buttons only. 

Both speed-dial buttons and status buttons permit you to dial out. Speed-dials can be associated 
with any number external or internal. Status buttons can only be associated with internal extensions 
or in a multi-PBX network any other extension on that network.  

If you configure a Status button associated with your controlled extension, then you will have a 
selection of other functions available. These additional functions reflect the call control toolbar and 
will change according to the current state of your extension. To access these other functions right-
click the status button for your controlled extension. You will see the context menu is split into 
telephony functions and more general configuration functions.  

The telephony functions can include: 

 Answer 

 Hold 

 Park 

 Hold/Recall 

 Retrieve 
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Status buttons also provide instant feedback on the state of any given extension or user. The states 
which can be shown are detailed in the following table. 

Button State Description Indication 

Idle The extension is not in use 

 

Off Hook The extension is in use but not dialling or 
receiving an incoming call  

Ringing The extension is ringing due to incoming 
call  

Connected - Outgoing External outgoing call in progress 

  

Connected – Incoming External incoming call in progress 

 

Connected - Internal Internal call in progress 

 

On Hold  Extension is in hold state 
 

ACD unavailable The ACD user is unavailable  

ACD Wrap up The ACD user is in wrap-up  

DND The extension is in DND mode 
 

Forward The extension is in forward mode 
 

 

Labels: Provide simple visual labels to help when you are arranging the actions panel as in the 
example shown below. 

 

 

Run Program: Allows you to set up a button to run an application directly from your actions panel. 
This can simply invoke an application or you can add a parameter to the application e.g. a filename.  

Typical uses of this might include; 

 Providing a link to a route mapping website so you can advise on directions 

 Having a link to your email application or website 

 Link to a price list or range of product brochure documents 
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Run Macro Script: Allows you to set up a button to run a macro script directly from the action 
panel. This allows you to create custom scripts to work with 3rd party CRM applications that are not 
supported by the Mycalls CRM screen-pop library. 
 

 
 

Creating an action button  

Before you can configure an action button you must first put the action panel into edit mode by right 
clicking on the action panel and selecting ‘Edit’.   

Creation of an action button is accomplished through right clicking the actions panel and selecting 
configure from the context menu.  This will bring up the action button configuration dialog. 

 

 

 See the how-to sections below for more details on configuring the various action button types. 

How to: Create a Speed-Dial button 

Select the ‘Speed Dial’ option as the button type
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Enter a button name – This will appear as label identifier on the button face 

Select a colour if required 

Enter the number to dial – ignore any line access codes   

Click ‘OK’ 

 

How to: Create a Service-Code button    

 Select the ‘Service Code’ option as the button type 

 

Enter a button name 

Select a colour if required 

Select the required service code from the list of service code types 

Enter any additional parameters if required such as extension 

Click ‘OK’ 

 

NB: Service codes have to be created or imported into the application. Creation of service codes 
would be carried out by the PBX administrator.  
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How to: Create a Status button  

Select the ‘Status’ option as the button type 

 

Enter a button name 

Select a colour if required 

Specify whether the button will show an extension status or a user status 

If ‘User Status’ is selected specify the user via the user selection button 

If Extension status is selected specify the PBX and Extension number 

Click ‘OK’ 

How to: Create a Label  

Labels are used to identify columns, rows or blocks of items created on the action panel and can be 
placed anywhere on the panel. Labels provide no interactive functionality and only act as visual 
indicators. 

 

Select the ‘Label’ option as the button type 

Enter a label name 

Select a colour if required 

Click ‘OK’ 



MyCalls Desktop 

  

 1510-002-010  Chapter 13-24   
 

How to: Create a Run-Program button 

Run Program allows an external application to be invoked from the actions panel. For example, you 
could invoke Microsoft Word and bring up a specific document. 

 

Select the ‘Run-Program’ option as the button type 

Enter a Button name 

Select a colour if required 

Enter or browse for the program to be invoked 

Enter any optional program data such as the filename. This must be a complete path e.g. 
c:\mydata.doc 

Optionally select the request extra data’ option. This will pop up a dialogue when the button is 
pressed to prompt the user for additional information such as a filename. 

Click ‘OK’ 

How to: Create a Run Macro Script button  

Run Macro Script allows an external application to be invoked from the actions panel. For example, 
you could invoke Microsoft Word and bring up a specific document. 
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Select the ‘Run Macro Script’ option as the button type 

Enter a Button name 

Select a colour if required 

Click the ‘Edit Macro Script’ button 

The following window will be displayed 

 

Enter a macro script into the ‘Macro Script’ box 

When the script has been entered, click ‘OK’ 

Click ‘OK’ again 

Full instructions regarding development of macro scripts are available in the MyCalls Macro script 
user guide. 

Creating Ranges of Action buttons  

In many situations you will want to create a range of buttons for a range of extensions or users etc. 
You can display a range of Extensions or Users and these can be selected individually or from a 
specified group. If extensions are to be displayed, then you also have the option to display a range of 
extensions starting from a given extension number. 

When specifying a range of buttons, you have the option of specifying a block running from left to 
right (Horizontal) or from top to bottom (Vertical). You can also specify the number of rows and 
columns to use. When specifying a custom block, the number of buttons required to display your 
selected range of values will be shown and if the block is not large enough to show all the values this 
will be indicated in red. 



MyCalls Desktop 

  

 1510-002-010  Chapter 13-26   
 

How to: Create a range of Action buttons  

Right click in the grid at the position you wish the block of buttons to appear and select ‘Create 
Range’ 

 

From the Dialog box: 

Select the type Extensions or Users 

Select Members, Groups or Range (Extensions type only) 

From the resulting list either select the required Extensions/Users, the Group or specify a range. 

If specifying a range, select the PBX and select the start extension followed by the number of 
extensions required 

For the Alignment, specify horizontal or vertical and optionally select a custom grid specifying the 
number of rows/columns required. 

Click ‘OK’ 
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Using Call Control functions from other MyCalls windows  

Call Control functions are also available from status and call log windows. Real time status windows 
can be configured to display extensions activity.  

Using Call Control with Real Time Status windows  

If you have real time status enabled, then you can access call control functions directly by right 
clicking the extension in the status window. If the extension is the one you are controlling then right 
clicking that extension gives you all the core telephony functions such as answer, hang-up, hold etc. 
The exact functions will depend on the state of the extension at the time.  For example, if your 
extension is ringing then you can answer or hang-up the call.  

   

If the extension is not the one you are controlling then you can carry out operations such as dialling 
that extension, pick up a call ringing on it, set call-back on that extension etc. 

 

Using Call Control with the Call Log window  

The Call Log and Unreturned Calls Log windows offer the facility to right click and dial. Simply point 
the mouse over the record in the list and right click. You can then select dial for the required number 
from the context menu.  

This context menu also allows you to search and popup the contact details or adds a new personal 
contact for that caller if one does not exist.    
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Call Control configuration 

Prior to configuring MyCalls call-control you will need to install a TAPI service provider driver. This 
can be installed on the MyCalls server or any other server on the network.  

Call control is configured on a per PBX basis so if several PBX’s are configured then a call control 
configuration will be needed for each. Configuration of call control requires that you specify a TAPI 
server and associated information such as external dialling digits, minimum number of extension 
digits and a list of exceptional numbers e.g. 999 

How to: Configure the Call Control Server  

From the menu select Configure->Telephone System->PBX->Call Control 

Select ‘Configure Call Control’ 

Select the required control type protocol. This will normally be ‘Generic TAPI’ 

Click ‘Edit’ 

 

From the resulting dialog box enter the name of the PC hosting the TAPI server 

Enter the other values or outside Line Access, Number of digits representing an internal call and add 
any require special numbers to be dialled externally regardless of number of digits such as 
emergency numbers 112, 999 etc. 

You may select to auto hang-up calls when the call is complete.  
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Click ‘OK’ 

NB: when you enter a number whose total digits are less than or equal to the maximum number of 
digits specified for internal calls the call will be treated as an internal call and line access codes are 
not added, with the exception of the ones specified in the list which are always treated as externally 
dialled calls. 

Call Control Groups.  

Creating a call control group requires you to configure your users so that they have call control 
capabilities. This is done as part of the user configuration. When creating or editing a user simply 
select the ‘Call Control’ drop down option for that user and set it to basic. This means when the user 
logs on they will be given the option to control an extension.  

A Call control group defines what its members can do with regard to call control. The functions 
which may be assigned to a group of call control users are as follows; 

 Answer Calls 

 Make Calls 

 Pickup a call ringing on another extension 

 Allow Call Forwarding  

 Allow Do Not Disturb (DND) 

 Allow Operator Functions (see operator section) 

 Allow Barge In 

Typically, you would create groups for different types of users. For example, reception staff may 
need to access all functions including call brokering, parking calls, conferencing etc. whereas sales 
agents 

May only need to answer, make and transfer calls from the screen.  By putting users into groups 
several users can have their call control environment defined from one configuration screen. A user 
can only belong to one call control group. 
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How to: Configure a Call Control group  

From the main menu Configure-> Telephone System->PBX->Call Control 

Select ‘Create or Edit a call control group’ 

Either click ‘Add a new call control group’ or if an existing group is already configured you may edit 
the group by clicking the ‘Edit’ option displayed alongside the group name 

 

In the dialogue you may specify a group name and add users to the group by specifying the user 
name, selecting the user(s) and clicking the ‘Add’ button. Only users enabled for call control will be 
available in the Users list. 

 

To remove a user from the group; select the user from the included users box and click ‘Remove’ 

Specify the call control functions which can be assigned to this group of users by checking the 
appropriate box e.g. Allow Answer Calls, Allow Make Calls, etc. 

Click ‘OK’ 
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Operator Functions 

Setting members of a call control group as operators gives them special privileges to carry out 
operations other than the extension they are currently controlling. These privileges are intended for 
use by reception operators where they may need to forward calls from an extension or set DND 
modes on other extensions. 

The operations which an operator can control on other extensions are: 

Set Forward 

Set DND 

This allows operators to carry out forwarding and DND on extensions on behalf of the users or if an 
extension is known to be unavailable due to meetings or the user being out of the office. 

Service Code Configuration  

Service codes can be configured by importing from the switch using the config import utility. This 
utility is only available to switch maintainers and details of this can be found in the installer manual. 
Alternatively, a PBX admin user can manually add a service code.  

A service code consists of the code itself usually a 3 or 4-digit number and this can, depending on the 
service code’s functionality, be associated with data values. 

The service codes when activated are sent via a network connection to s service code port on the 
switch. If required, the data value, or in some cases multiple data values, can be sent before the 
service code itself is sent to the switch or after the service code is sent. The service code 
configuration dialog allows up to two data values to be defined as shown below.   

How to: Add or Edit a service code entry  

Select Configure->Telephone System->PBX->Call Control from the menu 

Select Service Codes 

Select ‘Create or Edit service codes’ 

If the service you require is already in the list select the associated ‘Edit’ button, alternatively select 
‘Add a new Service Code’ 
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In the Service Code dialog specify the Name and the service code value 

Specify and data values and select whether to send these values before or after the service code 
value. 

 

Click ‘OK’ 
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Chapter14 
Screen-Pop 

MyCalls provides a screen-pop capability so that incoming and outgoing calls can be identified by 
matching the calling number to possible entries in a personal contact manager or corporate 
database. The system can be configured to search multiple databases and contact lists and these can 
be a mixture of personal data and system wide data. 

The main difference between a personal and a system database is that personal data is managed by 
each user on the system whereas a system database would be managed by the system 
administrator.  

Screen-pop groups 

Because contacts are likely to call your company for different reasons users within your organisation 
can be set up to search databases appropriate to their job function. For example, accounts staff 
would want to search for contacts in the accounts data whereas sales staff would want to search in 
the sales contact data. This can be accommodated by setting up different screen-pop groups 
depending on the function of the members of the group. This is dealt with in more detail in the 
screen-pop configuration section. 

Quick tip: 

Dependent on the database employed you may need to have a copy of the application e.g. Act! Outlook 
etc. installed and running on your PC before you are able to show the contact data.  

 The Screen-pop sequence 

If you have screen-pop installed and configured, then you will be ready to use the screen-pop 
system. The screen-pop operates in a specific sequence depending on whether the call is incoming 
or outgoing and also dependent on the configuration of the screen-pop. 

Incoming calls 

Initially the system will detect an incoming call ringing on an extension. Once the system detects the 
caller’s number (CLI) for the call the client associated with that extension will pop up a contact 
window. The popup window will either indicate a single result for the incoming call in which case the 
basic details for the caller are displayed, or if multiple contacts share the same CLI then a list of 
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several contacts may appear. The user can select any one of the contacts and inspect the contact 
details prior to answering the call or whilst the call is in progress.  

The screen-pop viewer 

 

The screen-pop viewer appears when the CLI or OLI for a call is matched to a number in the contact 
database(s). The viewer shows information regarding the caller and the actual fields shown can be 
configured from a list of available fields held within the CRM or contact database.  

The viewer gives the option to pop the complete contact details in the actual application where the 
contact was found, for example if the contact was found in a personal contact list such as outlook 
then the outlook application will be invoked and the appropriate record displayed as shown in the 
example below.   

 

 Once the call has been completed the screen –pop viewer can either automatically close or be set to 
allow you to close it manually. Incoming calls can pop the contact viewer when the call rings your 
extension or when the call is actually answered and this behaviour can be set for each screen-pop 
group. 
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Outgoing calls 

The sequence is the same as for incoming calls except that the screen-pop viewer will not appear 
until the call is answered. 

screen-pop configuration 

A link to an external database is created when you configure that database for use within MyCalls. 
Such a link called a screen-pop interface and you can configure one or more interfaces into your 
MyCalls system. MyCalls supports interfaces to a variety of industry standard database products 
including; 

 Sage Accounting 

 Act 

 Maximiser 

 Goldmine 

 Microsoft Outlook 

Whilst each supported product operates in a different way the configuration of the MyCalls screen-
pop is very similar for each. This makes the configuration of the database interfaces very similar 
irrespective of the actual database itself.  MyCalls presents a uniform set of dialogues for all the 
supported interfaces. Configuration of the Interfaces requires the following steps: 

 Add the interface to the list of configurations 

 Specify the connection properties – in some cases this will be selecting a folder in others it 
may require login details, passwords etc. 

 Specify which fields contain phone numbers for searching 

 Decide which fields you want to see in the screen-pop viewer 

 Specify the format(s) of telephone numbers stored in the database 

 Determine if the database contains companies, contacts, or both and decide which of these 
you want to search. 

 

Once configured the screen-pop system will automatically search any interfaces you have 
configured. If you have configured multiple interfaces you can prioritise the order in which they are 
searched. 

MyCalls supports the concept of personal and system interfaces. A personal interface would be 
configured on an individual PC client and would only be able to view details of contacts local to that 
user. The individual owner of the personal interface(s) can configure that interface to suit their own 
requirements. 

A system interface allows a PBX administrator to configure an interface which can be accessed by 
multiple users. Multiple system interfaces can be configured and these can be accessed by different 
groups. As an example a CRM database could be configured so it can be accessed by the sales 
department, in addition an accounts database could also be configured to be accessed by the 
accounts department. 

The ‘Macro Script Language’ allows you to create custom scripts to work with 3rd party applications 
that are not supported by default, such as web applications. This means that applications such as 
Microsoft CRM 2013 call be used for Screenpop in MyCalls. It allows a user to create a script which 
automates the process of looking up the customer’s details. The script will run automatically when a 
call occurs and will be provided with the caller’s number. The script will then activate the CRM 
application and carry out a series of mouse and keyboard actions as if the user were accessing the 
application manually.  
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 Configuring Personal screen-pop databases 

Personal screen-pop interfaces can be configured individually for each MyCalls user.  Whilst any 
database can be defined as a ‘personal’ interface they are usually reserved for applications such as a 
local MS-Outlook or similar contact management application where the data is stored on a specific 
PC rather than a central server. 

Selecting Configure->screen-pop from the main menu will display the screen-pop configuration 
screen. 

 

For a personal screen-pop you need to configure the screen-pop databases and the screen-pop 
groups which define permissions for each database in your list. 

How to: set up a personal screen-pop interface 

Select Configure->screen-pop->Personal screen-pop from the menu.  

Select Create/Edit screen-pop 

The screen will show your currently configured interfaces. 

 

Click ‘Add new database’ 

Name the screen-pop interface and select the application e.g. Outlook, from the list 
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Click ‘OK’ 

The resulting dialog box presents a number of configuration areas specific to your interface. Each of 
the areas are similar between different contact databases (though not all identical) and the 
configuration is described below (see screen-pop interface dialogue box) 

 

Having configured the screen-pop interface and mappings you then need to configure a personal 
screen-pop group. This allows you to set up your personal database group.  

Click ‘OK’ 

Click ‘Edit your personal screen-pop group’ 

  

Select a screen-pop interface from the available Databases box and click the [->] button 

This adds the interface to the Selected Databases box 

Repeat for each of the databases configured 

Select each of the selected databases in turn (in the Selected Databases box) and then select the 
properties for the interface e.g. pop on incoming/outgoing etc. 
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The screen-pop interface dialog box 

This dialog is split into several areas. An example shown below is for Microsoft CRM but each 
database application will have its own configuration screen. Refer to the 3rd party configuration 
guide for details.  

 

 

Server Configuration/Data Folder: Specify the data location, Contact folder, Catalogue or 
Database name for the interface. In some cases, this will be a database name and in other it may be 
a path to a data file or network share. 

Username and Password:  In some cases a username and password is required. This is specific to 
the database or contact manager application being employed. 

Search Option: Search Contacts, Accounts or both 

Return single or multiple contacts: For larger databases you may wish to only return the first 
contact found or limit the number of contacts found to increase performance of the screen-pop 
search. 

Number Masks: Depending on the CRM or contact manager application numbers to be searched 
may be stored in various formats. The number masks allow you to specify number formats which can 
be searched on. For example, a format such as #### ##### would search for a sequence of 4 digits 
followed by a space character followed by 5 digits. Excessive need for number formats can cause the 
search process to slow down considerably. 
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Number format examples 

 

Format Example Description 

# 01342559561 Any number of digits, no 
spaces 

##-###-#### 01-800-3456 Digits separated by – symbol 

+##(#####)# +44(1606)541237 International + with 
parentheses in the number 

 

Search Fields: Lists the fields in the contact database which could potentially contain telephone 
numbers. These are the fields which the screen-pop will search in order to match the target call. The 
fewer fields searched the faster the search will be. 

Assigning fields for the screen-pop viewer: The Unassigned Contact Manager fields list shows all 
the fields in the target database which have not been assigned to the screen-pop viewer. These 
fields will not be shown when the call is shown in the viewer. 

The Assigned Contact Manager dialogue contains two lists, on the left there is the contact data list, 
containing the available MyCalls call viewer fields. These consist of twenty-one fixed and ten custom 
fields. The fixed fields include Name, Address, telephone, notes, record ID etc. The custom fields are 
freeform fields which you can use to display application data as required e.g. credit limit or account 
status. 

The right hand list ‘Database Field’ lists the fields from the CRM or Contact manager database. These 
can be assigned to one of the internal contact viewer fields. It is likely that the 3rd party database will 
contain many more fields than those available for the viewer, therefore any fields not assigned to 
the viewer are marked as ‘not mapped’.  

Any fields which have been assigned will be visible in the viewer, but only if there is information 
present for that field in the data returned from the search for that call. If for instance the caller’s 
address is missing from the database, then the viewer will not display any reference to the address 
fields. 

Custom Fields 

The wide range of CRM and Contact databases available within MyCalls Desktop may have fields 
which do not readily have an association with the standard contact fields defined for the contact 
viewer. To accommodate this MyCalls allows the creation of custom fields. Custom fields can be 
given any name to identify the data, e.g. Credit Rating, Customer Category and any of the available 
CRM or contact manager fields can be assigned to this field. 
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How to: Mapping a Field  

Select the required field from the ‘Unassigned Contact Manager Fields’ using a left mouse click 

 

Select the field to which this data will be assigned in the ‘Contact Data’ list  

Click the assign button (->) 

The assigned field will appear in the ‘Database Field’ list alongside the Contact field to which it has 
been assigned. Contact data refers to the local Contact viewer field and the Database Field refers to 
the raw database field found in the CRM or contact manager application 

Any field marked as ‘not mapped’ will not appear in the screen-pop viewer 

 

Selecting the assigned field in the assigned field list and clicking the un-assign button (<-) will remove 
the mapping of the field and revert to ‘Not Mapped’ state 

How to: Assign a Custom screen-pop Field 

Select the Unassigned data field 

Select the required Custom field from the assigned field list 

Using the ‘Custom Field Label’ textbox enter a name to the custom field 

Click the assign button (->) 

The Custom field will now appear in the Contact viewer and display the assigned data 
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System screen-pop interfaces 

Configuration of a system interface is identical to the configuration of the personal interfaces as far 
as configuring the list of interfaces is concerned. Because a system interface can be used by many 
users you also need to configure group access settings which define who within the organisation can 
access which interfaces and the privileges members of those screen-pop groups will have. 

The basic operation requires that any users (enabled for call control) can be assigned to one or more 
interfaces. If a user is to be assigned access to more than one screen-pop interface (database) then 
you will also need to configure your screen-pop interfaces into groups. This is done in two separate 
operations. 

Configuration of screen-pop database groups  

A screen-pop database group can contain one or more databases from the list of system screen-pop 
databases. In order to pop information from a system database it must be added to a screen-pop 
database group.   

Once added to a group then permissions can be set as follows: 

Pop Contact: Brings up the Client application screen if a contact is found rather than the built in 
contact viewer. 

Use Built in Viewer: Use the internal screen-pop viewer or only pop the screen-pop-client 
application. 

Auto Close: Close the viewer automatically once the call has completed. 

 

Screen Pop Database group configuration dialog 

Several databases can be assigned to a single screen-pop database group and their collective 
behaviours can be defined on the same configuration screen. This allows definition of the search 
order of the databases within a group and their pop behaviour.  Once you have defined the screen-
pop database groups then you can users to these groups using the screen-pop database assignment 
configuration screen.  
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Configuration of screen-pop database assignments  

 

This dialog allows users to be associated with the groups of screen-pop databases you have already 
defined in the previous step. You can assign organisational groups or individual users to search the 
various database groups. Assigning a user to a database overrides any group assignments which may 
have been made.  

For example, if an organisational group called Sales has been created and the Sales group has been 
associated with the company’s Sales database, then any member of the Sales group could 
automatically be presented with contacts from the Sales database when receiving a call.  

However, if a member of that team, Bob, is associated with a special ‘Book Sales’ database then Bob 
will only be presented with Book Sales contacts and Sales contacts even though Bob belongs to the 
organisation group ‘Sales’.  

 

Users or groups of users can be assigned to a system screen-pop database group.  
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Chapter15 

Contacts and Address Books 

MyCalls Desktop provides an inbuilt address book for storing your company and personal contact 
lists. These address books are intended to be populated from: 

 screen-pop databases (both system and personal)  

 MyCalls callers list 

 Manual entry 

System versus Personal address books  

As with the screen-pop databases, MyCalls address books can be set up as system wide or personal. 
The System address book is set up by the PBX administrator and contains contacts available to all 
users. Initially the system address book is populated with the details imported from the PBX ABBdial 
list during the configuration import carried out at installation time.   

Personal address books are set up by each user and are specific to that user. 

Whilst it is possible to add contacts manually the address books are intended to contain copies of 
existing contacts maintained within MyCalls.  

Quick tip:  

This allows faster searching if an external contact database proves too slow and provides a central 
location from which to dial any contact contained within your address books.  

Using the address books  

The address books can be used for quickly searching for a contact, viewing contact details and 
dialling a contact from the screen. 

Searching for contacts  

Using the address book search bar, you can enter initials or telephone number of the contact to 
search for. You can limit the search to system, personal or both and you can order the results on 
first, last or company, name. 
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Any search results are limited to the first 100 matches; however, you can continue to narrow down 
the result set by entering more characters for the search. If you were searching for a name such as 
‘Davis’, for example, simply entering a ‘d’ could return over 100 results but entering ‘da’ would 
return significantly less. 

Viewing contact details  

Having located a contact, you can view their details by selecting the contact in the list 

 

Edit an address book entry  

To change any details, select the contact using the right mouse button and select ‘edit’ from the 
context menu. You can then edit the contact details panel. 

 

 

Dialling from the address book entry  

Select the entry using the right mouse button and select dial from the context menu.  For many 
contacts there will be more than one phone number defined so you will need to select the phone 
number to dial before dialling using the left mouse button. 
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How to: Edit several contacts  

Contacts can be edited via the Address book configuration menu. 

Select Configure->Address Book and select personal or system address books  

 

Select ‘Edit your Personal Address Book’ 

 

You can modify many values directly in this screen or click edit to bring up the contact details screen. 

This window also allows you to add a new contact and to delete contacts. You can select one or 
more contacts and delete the selection, delete all contacts or delete unassigned contacts. 
Unassigned contacts are those not associated with an existing screen-pop database as a result of 
that database having been deleted from the configuration. 

Importing from screen-pop databases 

Normally you will add contacts to an address book by importing from an external source.  

Before you can import your contacts the external contact database must be configured either as a 
system or personal screen-pop database. System databases can only be managed by a PBX 
administrator.  
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Quick tip:  

Import your most used contacts from an external database where possible. This speeds up searches 
and reduces loading on network resources etc. 

How to: Importing a personal screen-pop database 

Select configure->Address Books 

Select Personal in the top left dialogue, then select import your personal contacts 

 

From the import panel select the database to import using the drop down list 

Select Start and the import will commence 

Once complete click ‘OK’ 

Configuring Address books using MyCalls Desktop 

The same operations can be carried out within MyCalls desktop by selecting the toolbar options 

 

Select ‘Personal address book->Import’ 

 

Manual entry of contact data  

New entries can be added by selecting ‘Add New Contact’ from the contact search bar.  

Selecting this will display the Contact details dialogue. Enter the contact details and click ‘OK’ 



Contacts and Address Books 

  

 1510-002-010  Chapter15-5   
 

 

Managing System Contacts  

The operations described for personal address books and contacts apply equally to system contacts. 
The only difference is that configuration and importing of system contacts can only be carried out by 
the PBX administrator. When importing system address books only the screen-pop databases 
defined for the system will be shown in the selection list of databases to import from. 

Configuring the internal contacts lists for screen -pop purposes 

Quick tip:  

One reason for importing your external contacts into MyCalls would be to speed up 
searching. By importing the data the contacts would be held in the internal MyCalls 
database and any searches would be highly optimised rather than relying on the  
performance of third party software clients.  

To enable the system to screen-pop on the imported address book rather than searching the 
external data you need to perform the following tasks: 

 Configure the internal contacts as a screen-pop database. 

 Add the internal data to a screen-pop group 

How to: Configure an internal contact screen-pop 

Select ‘Configure->screen-pop’ from the main MyCalls menu 

Select either personal or system* 

Create/Edit screen-pop databases  

Add a new interface and select ‘Internal’ from the drop down list 

Click ‘OK’ 

NB: The internal contacts list requires no additional configuration and therefore does not present a 
configuration screen 
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Having added the internal contacts to your list of screen-pop databases you will need to set up a 
screen-pop group to include the internal contacts list. See Configuring screen-pop groups for more 
details. 

 

*only available if you are a PBX administrator 

Call Control Configuration: Summary.  

Basic Installation  

Ensure the TAPI driver is installed (Installation) 

Ensure MyCalls is licensed for Desktop use and that the license is registered (License Manager) 

Users and extensions  

Create users and assign call control to those users. (User configuration) 

Enable Users for hot desking if required 

Configure extensions and assign default users to extensions 

Enable required extensions for hot desking 

Call control  

Configure Call Control  

Configure Call Control groups 

System screen-pop 

Configure screen-pop interfaces for system databases 

Configure system screen-pop database groups 

Assign organisation users and groups to the various system screen-pop groups 

Personal screen-pop 

Configure personal screen-pop interfaces e.g. outlook 

Configure screen-pop database groups 

Address Books  

Import required external database contacts into the internal address book 

Configure internal contacts database (Your address book contents) as a personal screen-pop 
interface if required 
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Chapter 16 

Callers 

Introduction to Callers  

 

Within MyCalls people or companies external to the organisation that you call or who call you, are 
referred to as callers. Callers can be categorised by a type as either: 

 Business Callers 

 Personal Callers 

 Unassigned Callers 

Callers can also be placed into user groups, so all the contacts within a particular company can be 
grouped together. Personal numbers can also be placed into a user group, such as "Terry Breen’s 
Personal Callers". Setting the type of caller and placing them into a user group allows reports to be 
generated that are filtered to only show those callers, and thereby identifying if someone is taking or 
making too many personal calls. 

The caller’s configuration screen can be shown by selecting the ‘Callers’ option from the ‘Configure’. 

menu or by pressing the callers icon   from the main toolbar. 
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Creating and editing callers  

How to: Creating a new Caller  

 

1) At the Configure Callers screen, click ‘Create or Edit a Caller.’ The Edit Callers screen appears. 

 

2) Click ‘Add new caller’ to begin adding a new caller. 

3) The Create a Caller screen is displayed. 

4) In the dialogue window that appears a number of fields are available for entry.  Some are 
mandatory fields* for successful setup whilst others are optional inputs as outlined below. 

 

5) Number*: Enter the callers’ main incoming number here that will be used to identify them. 

6) Alternate Number: If the caller has different incoming and outgoing numbers, as DID for 
instance, then use the alternate number field for this. 

7) Name: Enter a name for your caller to identify them clearly on real time windows and reporting. 

8) Type*: You can choose whether a caller is a Business or Personal caller by selecting the option 
from this field.  If you wish to create the caller but not assign them as either of the above, then 
you can use the final option Unassigned until you decide on the most suitable type for the caller. 

9) Caller Group: You can select a caller group from this field to group the caller with in order to 
enhance real time statistics and reporting.  Caller groups are created by users and tailored to the 
organizations requirements.  Default is set to None. 

10) Notes: Use the notes field to log any useful information about the caller for other users to see. 

11) Click ‘OK’. 

12) The caller should now be visible in the caller list of the Edit Callers window. 
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How to: Editing an existing Caller  

1) From the Callers Configuration screen, click ‘Create or Edit a Caller’ 

2) In the Edit Callers window that appears click the ‘Edit…’ button to the right of the Caller you 
want to modify. 

 

3) In the ‘Edit’ window that appears, you can modify the following fields; Alternate Number, Name, 
Type, Caller Group and Notes.  You cannot change the Number field as this is the main identifier 
of the caller.  To change this, you would have to create a new caller record and delete this 
record if necessary. 

 

Click the ‘OK’ button when you have completed making your changes. 

Click the ‘OK’ button on the Edit Callers window to save the changes you have made. 

Deleting callers  

How to: Delete a single or a range of Callers  

1) From the Callers Configuration screen, click ‘Delete a Range of Callers’. 

2) In the window that appears, select the callers you want to delete in the callers list.  You can 
select multiple callers by holding down the control key (ctrl) as you click on the rows. 

 

3) Press ‘OK’ to complete the deletion process.  Be aware that you will not be prompted to confirm 
this process once you press the ‘OK’ button so please make sure you have the right callers 
highlighted before pressing ‘OK’ to continue.  

Importing Callers  

You can import a csv (comma separated values) file directly into MyCalls to speed up caller setup.  This 
file should include the following columns: Number, Alternate Number, and Name, in that order to be 
imported successfully. 

For more detailed information, see the section on importing data. 
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Caller Groups 

Caller groups are groups that contain callers that are related in some way within a business.  By 
using Caller Groups, it is possible to report over a range of callers such as all business callers or all 
personal callers. 

 

System and User defined groups  

User defined groups are custom groups that have been created by users, whilst system groups are 
those that are pre-installed with the application and cannot be removed.  There are four system 
groups that can be used which are: 

 All business callers - Holds callers that are of type Business 

 All Callers - Holds all callers defined in the system. 

 All Personal Callers - Holds callers that are of type Personal. 

 Unassigned Callers - Holds callers where their type has not been specified. 

How to: Creating a new Caller group  

1) From the Callers Configuration screen, click ‘Create a Caller Group’.    

2) In the ‘Create a New Caller Group’ window that appears, a number of fields are available for 
entry.  Some are mandatory fields* for successful setup whilst others are optional inputs as 
outlined below. 

3) Name*: Enter a name to describe the caller group you are creating. 

4) Notes:  Enter here any relevant details you wish to save about the caller group  

5) When you have entered the necessary information click the ‘OK’ button to create the caller 
group. 

How to: Editing Caller group configuration  

1) From the Caller Group Configuration screen, click ‘Caller Groups’ and select the group you want 
to edit. Click ‘Edit Caller Group Configuration’ in the Caller Group configuration area.  

 

2) In the ‘Edit a Caller Group’ window that appears you can enter notes to describe your selected 
group. 

3) Click ‘OK’ to save your changes. 
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How to: Delete Caller group configuration  

1) From the Caller Configuration screen, click ‘Caller Groups’ and select the group you want to 
delete.  

2) Click ‘Delete Caller Group’  

3) You will be prompted to confirm deletion of the selected group. 

4) Click ‘OK’ 

How to: View or Edit group membership  

1) From the Callers Configuration screen, click ‘Caller Groups’ and select the group you want to 
configure.  

2) Click ‘View or Edit the Group’   

3) In the ‘Edit Group Membership’ window that appears you will see a list of callers in the group 
which will have been configured using the methods described in the manual, sections 6.1.1, 
6.1.2 or 6.1.4 or by clicking on the ‘Add new caller…’ button and creating a new caller directly in 
the group. 

4) You can edit the Alternate Numbers and Names of the callers in this group.  Select a new Type 
using the Type Column.  And you can also change group membership for a member by selecting 
another available option in the Group field. 

 

5) Press ‘OK’ to close the window and save any changes you have made. 

How to: Assigning Callers to a group 

1) If you have configured Caller Groups, then you can group individual callers within a group to 
enhance real time statistics and make reporting easier. 

2) On the Edit Callers window that is displayed you can either click ‘Edit’ next to the caller you wish 
to edit the group for and alter the group in the window that appears, or you can do it here by 
selecting a new group in the Group column.  You can change as many callers as you wish before 
saving your changes. 

 

3) When you are happy with your callers selected groups press the ‘OK’ button to save your 
changes. 
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How to: Removing a Caller from a group  

1) From the Callers Configuration screen, click ‘Create or Edit a Caller’  

2) On the ‘Edit Callers’ window that is displayed you can either go to the Edit a Caller window to 
change the callers group to or you can do it here by using the ‘Group’ column. Select the option 
‘None’ to remove the caller from any previously selected groups. You can change as many callers 
as you wish before saving your changes. 

 

3) When you are happy with the changes you have made and want to save them press the ‘OK’ 
button. 

Deleting a Caller group  

How to: Delete a Caller group configuration 

1) From the Caller Configuration screen, click ‘Caller Groups’ and select the group you want to 
delete. Click ‘Delete Caller Group’ in the Caller Group configuration area.  

2) You will be prompted to confirm deletion of the selected group. 

3) Click ‘OK’ 
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Chapter 17 

Alarms 

Managing by exception using the MyCalls Alarm System 

We believe that people should not have to spend a long time analysing report information just to find 
that everything is OK. This has historically been the case in companies that use call accounting or other 
telephone management software for many years. 

MyCalls is designed to be used with management by exception. That is, the system is configured to 
watch for specific conditions and only inform users when one of those conditions has been broken. 
This then leaves the supervisors and PBX administrators free to do other activities. 

Specify when Alarms are active:  

To facilitate the automated notification of alarm conditions MyCalls is provided with an alarm 
scheduler, which allows you to specify when alarms can be active. You can create as many alarm 
schedules as required e.g. Daytime, Night time, Weekends and apply the schedules to the different 
alarms that you create. For example, you may want to activate alarms from certain extensions out of 
hours to catch any unauthorised usage. 

Specify who receives Alarm notifications: 

Generating alarms is only one part of the equation. In order to make the MyCalls system really work 
for you the alarms need to be sent to the people in the organisation who need to know about it. 
MyCalls provides distribution lists to do just that. You can set up multiple distribution lists which 
allows you to specify different recipients for different types of alarms. For example, System alarms 
may be sent to your IT specialists (possibly outside the organisation) whereas Fraud Alarms may be 
sent to supervisors. The alarms can be sent in a number of ways. These include email, specific 
computers, external programs, and SMS (as long as a supported carrier is used). 

Alarm Categories 

MyCalls currently has the following different types of alarm with more added on each release of 
software. 

System Alarms:  

These are triggered when either no data is received from the PBX for a certain period or if the free 
disk space on the disk that the database is situated on is below a specified level. 
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Call Rate Alarms:  

Measures the rate at which calls have been handled in a one-hour period. This can occur if there are 
either too few or too many calls handled. Too few indicates that calls are taking too long and too many 
indicates that calls may too short. There are several types of call rate alarm: 

 Abandoned Call Rate Alarms:  

 Outgoing Call Rate Alarms:  

 Incoming Call Rate Alarms:  

Overflow Alarms:  

An overflow alarm indicates when an overflow situation has occurred. This happens when a call has 
been transferred between ACD Groups before being answered. For other PBX types, Overflow is 
defined as a call that has been transferred between ACD Queues (Pilot Numbers) before being 
answered.  

Wait Time Alarms:  

Determined by what is an acceptable minimum and maximum average wait time for a one-hour 
period. An average wait time that is less than the minimum value can indicate that you have too many 
free staff and they are just waiting for the phone to ring. An average wait time that is more than the 
maximum value indicates that there may not be enough staff available. Wait time alarms include: 

 Incoming Wait Time Alarms 

 Overflow wait time Alarms 

 Abandoned Wait Time Alarms 

Call Time Alarms:  

Determined by what the acceptable minimum and maximum average call times should be in a one-
hour period. An average call time that is less than the minimum value can indicate that you may be 
rushing your calls. An average call time that is more than the maximum value indicates that the calls 
are taking too long and you may need to speed up the conversation. 

 Overflow Call time Alarms 

 Outgoing call time Alarms 

Service level alarms 

General Service Level Alarms: Are triggered when the general service level drops below the defined 
minimum service level setting for the alarm. A value below the minimum average can indicate that 
there are not enough staff members available to take all of the calls. Conversely, if the value is above 
the maximum value it might indicate that there are too many people available to answer calls. 

Abandoned Service Level Alarms: Are determined by the minimum and maximum average 
Abandoned Grade of Service (GOS) in a one hour period.  

Emergency Alarms: These are triggered when a call is made to an emergency number.  You 
can specify what constitutes an emergency number.  

Toll Fraud Alarms: These alarms are used to detect misuse of the phone system. These 
alarms can detect if a call is too expensive or lasts for too long or is to/from a specific 
destination which is considered to be unauthorised. 

Caller Alarms:  

These alarms are used to determine if a caller has been contacted within a specified time period. 
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Queue Status Alarms: These alarms are used to determine the acceptable number of calls 
in a queue, and also the acceptable amount of time that a call can remain in a queue 
before being answered. 

User Status Alarms: These alarms are used to determine the maximum allowable number 
of times a user may go into each of the Unavailable/Wrap up/DND states in a logged on 
period. Also determines the maximum length of time a user is allowed to remain in that 
state. 

Viewing the alarms in the Mycalls Client 

Alarms List 

When an alarm is triggered, an alarm record is generated and stored in the database. These can be 
seen in the Alarms List.   

 

Alarms Pop Up 

Alarms will pop up on MyCalls client screens in the following format: 

 

By default, these pop up alarms will appear on all running Mycalls client screens, however it is possible 
to specify which screens the alarms will appear on by defining Supervisors in your organisational 
settings and assigning supervisors to a distribution list. That distribution list can then be associated 
with the relevant alarms. 

An alarm icon  is also displayed in the system tray when an alarm is triggered. This icon will remain 
in the system tray until the alarm window has been clicked with the mouse button, to indicate it has 
been viewed. 

javascript:kadovTextPopup(this)
javascript:kadovTextPopup(this)


Alarms 

  

 1510-002-010  Chapter 17-5   
 

Audible alarms 

Audible alarms can be configured on a severity level; Information, Warning, Severe, Critical. 

When an alarm is triggered, if a sound has been assigned to the severity of the alarm, then that sound 
will be played. The sound can be configured to be played repeatedly until either an alarm of a higher 
severity is triggered, or until the alarm window has been clicked on with the mouse button, to indicate 
it has been acknowledged. 

Accessing Alarm Options  

Using the MyCalls menu you can access the alarm screens using: 

Configure –> Alarms –> PBXs 

OR, you can click the alarm icon in the toolbar  

Configuring Real Time Alarms 

MyCalls alarms are generated in real time. You can have the alarms pop up on screen to warn 
operators of alarm conditions as they occur. Alarms are also recorded in the Alarms grid accessible 
from the toolbar at the bottom of the main screen. 
When you configure an alarm you will invoke an alarm configuration wizard. The wizard will require 
you to enter the name for the alarm and select both a distribution list and an alarm schedule. The 
distribution lists will ensure the alarm reaches the appropriate people and the schedule limits the 
time periods when the alarm is active so before you can configure an alarm you will need to have set 
up your alarm schedules and distribution lists. These topics are covered in more detail toward the 
end of this section. 

System Alarms 

System alarms monitor the status of the system. This falls into two parts: 

 PBX data monitoring 

 Disk space monitoring 

PBX Data Monitoring 

The MyCalls system regularly receives call data from the PBX. If MyCalls does not receive data from 
the PBX it could mean, there is a fault on the PBX. This alarm checks to see how long ago the last call 
record has been received from the PBX. This can indicate that the link between the PBX and the call 
processor has failed. 

Setting this alarm to be active on an alarm schedule which covers only the working hours, will mean 
that this alarm is not triggered in the middle of the night when there are likely to be no calls anyway. 

Disk Space Monitoring 

A minimum amount Disk apace is required for correct operation of the operating system and the 
MyCalls-database. This alarm checks the current disk space available. 
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Call Rate Alarms 

Call rate alarms are triggered if the number of calls is either lower than a specified value or higher 
than a specified value for the last hour. 

The call rate alarms can be set up for both: 

 Incoming calls 

 Abandoned calls 

 Overflowed calls 

 Outgoing calls 

The wizard allows you to set minimum and maximum calls per hour for Trunks, Extensions, DIDs, 
Pilot Numbers, Organisational groups. You can specify all the device groups of a particular type 
e.g. ‘All Trunks’ or you can select individual device groups. 

 

Performance Alarms 

Performance alarms are designed to measure the effectiveness of the people answering or making 
the telephone calls.  

Performance alarms can be set for: 

 Incoming Wait Time 

 Overflowed Wait Time 

 Abandoned Wait Time 

 Incoming Call Time 

 Overflowed Call Time 

 Outgoing Call Time 
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 Abandoned Call Time 

 General Service Level 

 Abandoned Service Level 

 

The setup of these alarms is identical to the call rate alarms described in the previous section. You 
select which alarm type you wish to generate e.g. wait time, call duration etc. and specify the device 
or user groups to which this alarm applies. You can only specify one of each device group per alarm 
setup but you can set as many of each type of alarm as required.  For example, to set a wait time 
alarm for the extension group called ‘Sales’ with different wait times to the extension group called 
’Service’ then you would need to create two wait time alarms, each with different settings, which 
you could call ‘Sales’ and ‘Service’ to easily identify each alarm. 

Incoming Wait Time Alarm 

These alarms can be set to trigger if the average wait time for answered calls over the last hour was 
too low or too high. 

Answering a call too quickly can mean that you may have too many people available to answer the 
phone or that you customers may perceive that you are just waiting for the phone to ring. It is usual 
for people to expect to wait 2-3 seconds before the phone is answered. 

Answering too late can mean that you do not have enough people to answer the phones and may 
risk calls being abandoned.  

Overflowed Wait Time Alarm 

These Alarms can be set to trigger if the average overflow time for answered calls over the last hour 
was too low or too high. 

Having too high an overflow wait time could mean that calls are being transferred between too many 
queues before being answered. This may indicate that not enough people are answering the calls in 
the primary groups. An alarm triggered on a low overflow wait time would not normally be used. 

Abandoned Wait Time Alarm 

These alarms can be set to trigger if the average wait time for abandoned calls over the last hour was 
too low or too high. 

If you base your staffing on the fact that your customers will wait a certain amount of time, then this 
alarm can tell you if your assumptions are correct or not.  

If the alarm is triggered because the average has fallen below the minimum value, then your 
customers will not wait on average as long as you think, and you may need to either answer the phone 
quicker or employ more people. 

If the alarm is triggered because the average has risen above the maximum value, then your customers 
are prepared to wait longer than think they will and you may not need as many people to answer the 
calls. 

Incoming Call Time Alarm 

These alarms can be set to trigger if the average time taken to handle incoming calls over the last 
hour was too low or too high. 
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Overflowed Call Time Alarm 

These alarms can be set to trigger if the average time taken to handle overflowed calls over the last 
hour was too low or too high. 

Outgoing Call Time Alarm 

These alarms can be set to trigger if the average time taken to handle outgoing calls over the last 
hour was too low or too high. 

General Service Level Alarm 

These alarms can be set to trigger if the average service level over the last hour was too low or too 
high. 

Setting a maximum value of 99% rather than 100% can be useful, a 100% value can mean that the 
people handling the calls are not fully occupied. A definition and configuration guide to Service 
Levels is covered under Grade of Service configuration. 

 Abandoned Service Level Alarm 

These alarms can be set to trigger if the average abandoned service level over the last hour was too 
low or too high. 

It is quite normal to have a minimum value of 97% and a maximum value of 100%. It is widely 
accepted that you should not expect to have more than 3% of your calls abandon outside of the 
acceptable wait time. 

 

Emergency Alarms 

Emergency alarms are triggered whenever a call is made to an emergency number. 
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Toll Fraud Alarms 

Toll fraud alarms are designed to trigger if a call has been made that breaks one of your calling policies. 
The policies available are. 

 Calls that are longer than a specified amount time 

 Calls that ring for more than a specified amount time 

 Calls that cost more than a specified amount of money 

 Calls to certain numbers or types of call 

 Calls to/from certain caller groups 

 Calls that have a specific account code 

The toll fraud alarm can be set to be active on extensions, pilot numbers and users.  

One alarm can be set to be active on all groups, a specified group or all except a specified group. 

Specifying an alarm to be active on all except a specified group is useful if you only want for example, 
to have one group that can make international calls and the others cannot. 

Specifying Outgoing Numbers 

When setting up a toll fraud alarm you will probably need to define a set of numbers to identify the 
calls that you wish to trap within the alarm conditions. For example, calls to mobiles beginning with 
07 or calls to a specific area code or even call outside a specified set of area codes. When setting these 
conditions (see example below) you will need to enter either complete or partial numbers.  

A number can be specified in the full such as 01260519221. 

Partial numbers can either be with one or more specific digits and entered with a '?' or as a starting 
number followed by any digits and entered with a '*' 

012607230?2 will trigger on 01260723002, 01260723012, 01260723022, 01260723032 ... 
01260723092 

01260* will trigger on any number beginning with 01260. 

International numbers from the United Kingdom can be detected by 00*. 

Example Restricting Personal Mobile Calls 

Problem: Create a toll fraud alarm that has incoming and outgoing calls selected and traps any non-
Business calls to a mobile number. 

Create a new Toll Fraud Alarm and name it ‘Mobile Calls’ – Click ‘Next’ 

 

Specify the Alarm Schedule associated with this alarm type, in this case we only want to monitor these 
calls during the daytime so we associate the alarm with the schedule ‘Daily Alarms’. You can also 
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associate the alarms with an Alarm Distribution List to define who will receive notification of this 
alarm. For this example, we choose the Managers list.  

 

Next you need to specify which Extensions, Users and Pilot numbers you wish to include or exclude 
from these rules. In this example we exclude Reception and Customer Service from the alarm list. This 
is because these groups may well make legitimate calls to mobiles during the day. You may need to 
reconsider how you have organised your groups as any extension can only belong to one group. You 
may need to split the groups into smaller units for example Customer Service Staff and Customer 
Service Mobile Callers so that you can ensure only the Customer Service supervisors can call out to 
mobile numbers. 

 

You can specify full or partial numbers to include in the alarm conditions. At this point you are only 
specifying the numbers list. How these numbers are used to determine an alarm condition is defined 
in a later step. However, the number list can only be used to either: 

 Generate the Alarm if the Number appears in the list 

 Ignore the alarm if the number appears in the list 

This means that all the numbers in the list need to have the same purpose. In this case we want to 
generate an alarm if any mobile numbers are called or received. So we specify a list of numbers which 
represent all the possible number combinations. We specify that any numbers beginning with 07 are 
mobile numbers there may be other combinations of course.  
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In the next screen we specify any caller groups that we wish to include in the alarm conditions. Again 
we can either specify that the alarm be generated if the calls are going to or received from the caller 
group or we can specify that the alarm is to be ignored if the call is to or from the specified caller 
group.  

Click ‘Next’ and a similar screen is displayed to allow the inclusion of a list of account code groups.  

Having specified our groups to include or exclude from the alarms, our lists of Numbers to identify and 
our lists of Callers and Account codes we can then specify the Conditions for the alarm based on these 
settings.  

Clicking ‘Next’ displays the final screen of the wizard. 

 

First configure which call type we wish the alarm to trap, in this case incoming and outgoing calls are 
included: 

 

Then specify timing or costing conditions for the alarm. You can specify the maximum ring time* 
beyond which an alarm will be generated, the maximum call duration and the maximum call cost. To 
set any or all of these limits simply select the appropriate checkbox and using the numeric setting 
specify the time in seconds.  
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*Ring time alarms only apply to incoming calls. 

Next we can specify how the Number list, Caller list and Account code list affect the alarm generation. 
For an alarm to occur the conditions must be met for all three lists. 

For list parameter we can specify: 

Never alarm on items in the list – effectively ignore this list. 

Alarm if the item is in the list  – your list should only contain members on which you want to include 
for alarm purposes. This means you have created a list of prohibited members e.g. any member of the 
list is not allowed to make mobile calls. 

Alarm if the item is not in the list – The list should only contain members which you wish to ignore 
for alarming purposes. This means you have created a list of allowed members e.g. anyone in the list 
is allowed to make mobile calls. 

And for numbers only.  

Alarm on any number or no number (the default value) - Generate an alarm irrespective of the 
presence or absence of a number in the call. This ensures that if any of the three lists; Numbers, 
Callers, Account Codes are used then the alarm will still be active.  

NB: If you set ‘Never alarm on numbers’, ‘Never alarm on callers’, ‘Never alarm on account codes’ all 
at once the alarm will not be generated. 

 

Finally, once you are happy with your settings you can click ‘Finish’ which will save the new alarm you 
have created. The new alarm will now appear in the Toll Fraud alarm list. 
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Caller Alarms 

Caller alarms allow you to define an alarm that will trigger if a caller has not contacted you or you have 
not contacted them within a specified time. 

The check can be made on a recurring basis as either on a specified day in a week at a specified time 
or on a specific day in a month at a specified time. 

Calls that are too short in length can be excluded, for example if a call was answered by voice mail or 
answer phone.  

 

Status Alarms 

Status alarms are triggered if the number of calls waiting to be answered or the amount of time they 
have been waiting has exceeded an acceptable limit. They are also triggered if a user has entered any 
of the rest states too many times between logging on and logging off, or if they stay in a rest state for 
too long a period.  

Status alarms can be set for 

 Queue Status 

 Longest Wait 

Queue Status Alarm 

These alarms can be set to trigger if the number of calls waiting to be answered is too high, or if the 
wait time of the longest waiting call is too high. 
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User Status Alarm 

A user status alarm can be set to trigger if any of the users in a set of groups has entered any of the 
rest states (unavailable, wrap up, do not disturb) too many times since the last time they logged on. 
These alarms can also be set to trigger if the user stays in any of these states for too long a period. 
Note that the unavailable alarm can either apply to all unavailable states or just the state indicated by 
the unavailable code. Note that this feature is not available on all PBXs. 

 

Alarm Schedules  

An alarm schedule is a named configuration that allows you to specify when an alarm will be active. 

Alarms schedules can be configured to be: 

 Active for all dates or for a fixed date range 

 Active for all times of the day or for a fixed period of time 

 Active for all days of a week or for a selection of days 

 

It is very useful to create alarm schedules for out of hours’ times as well as alarm schedules for working 
hours. This allows you to configure multiple alarms of the same type but with different schedules so 
they act differently. For example, you may desire that calls cannot last more than 60 minutes during 
a week and no outgoing calls out of hours. In this case there would be three alarm schedules created; 
one that covers the working week 08:00 to 18:00, one that covers out of hours during the week and 
one that covers weekends. The toll fraud alarm with a 60-minute call duration alarm would be 
assigned the working week alarm schedule and the toll fraud alarm with a 0-minute call duration 
would be assigned the out of hours and weekend schedules.  
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Alarm schedules can also be configured to trigger every time the condition is triggered or when alarms 
are triggered a multiple number of times, useful if you have an operating value that is very close to an 
alarm limit and the operating value quite often exceeds the limit.  

Alarm schedules can also be limited to a fixed amount of notifications per hour. 

 

Alarm Distribution Lists 

Alarm Distribution Lists determine who should be informed if an alarm condition is triggered.  

The following mechanisms exist for distributing alarms when triggered. 

 Email 

 Computer 

 Process 

 Supervisors 

 SMS 

Email 

 

Make sure that you have set up the mail server configured correctly in the System Settings. See System 
Settings. 

Each email address added will get an email describing the alarm condition that has been broken 
including the current parameter value and the trigger point value. For example, a system alarm that 
monitors free disk space and triggers when it is lower than 10GB would send a mail 

Subject: MyCalls Real Time Alarm: <Alarm Name> 

The free hard disk space on your system drive has fallen below 10GB (7GB) 
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Computer 

 

Each computer name entered will receive a "net send broadcast message" describing the alarm 
condition that has been broken. 

Process 

 

Any number of external applications can be invoked when an alarm condition has been broken. The 
application is passed as a single parameter the string of the alarm message. For the example above 
the command line for the application would be:  

pageralert.exe "The free hard disk space on your system drive has fallen below 10GB (7GB)" 

This is very useful if you wish to implement some extra functionality that is not available within MyCalls 
yourself. Examples of this may be that you run an application that calls a pager or sends an SMS 
message to a cell phone. 

Supervisors 

When an alarm occurs then, by default, all running MyCalls clients will be informed. A preferable 
scenario may be to only inform certain supervisors when specific alarms occur and this can be 
achieved by specifying individual supervisors in the distribution list.  

 

All users are selected to receive the real time alarms by default. Additional users can be added to the 
list of people to receive the alarms when they are sent. If there have been no supervisors set up, the 
alarm will be broadcast to all configured users. Each user that has been sent the alarm will receive 
message describing the alarm condition that has been broken within the ‘Alarms’ tab of MyCalls. 
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Configure Supervisors as follows:  

1. Enter the Supervisor name into the textbox labelled 'Type part of a name here:' 

2. Select the Supervisor from the list of available users on the left hand window 

3. Click the >> button to add these supervisors to the included users list 

4. When complete click Next or Finish 

SMS 

An SMS distribution lists allows you to send out any alarm indications that occur within MyCalls to a 
list of telephone numbers that have been configured in the distribution list. This allows people to see 
alarms that have been generated even when they are not in the office.  

When adding a call to the distribution list you will need to insert the country code and the number, 
without the first digit, into the designated box. 

Note: The country code may differ between SMS Providers e.g. Text Local = 44, TextPort=GB 

 

Make sure that you have set up the SMS provider configured correctly in the System Settings. Each 

SMS Recipient number entered will receive an SMS Message describing the alarm condition  

 Date  

 Time  

 Distribution Group Name 

 Alarm Condition description 

 Current Alarm Value 

For example, a system alarm that monitors free disk space and triggers when it is lower than 10GB 
would send a mail. 

<Date> <Time>: <Distribution Group Name>: The free hard disk space on your system drive has fallen 
below 10GB (7GB) 

Alarm Severity Levels  

Not all alarms need to be problem alarms that you must act on immediately. It is useful to be given a 
warning that if this persists then the problem will escalate. 

MyCalls supports four levels of alarm severity: 

 Information 

 Warning 

 Severe 

 Critical 
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The meaning of each of these is up to the company. An example of how these may be used is when 
looking at the Grade of Service. It might be useful to generate an Information alarm if the average 
Grade of Service drops below 95%, a warning alarm if it drops below 90%, a severe alarm if it drops 
below 85% and a critical if it drops below 80%. 

Each alarm can be configured to do something different. For example, the information alarm may send 
a message to each of the users. A warning alarm may send an email to a supervisor. A severe alarm 
may run a report and email it to a supervisor. A critical alarm may run an external program that has a 
paging interface and pages the alarm details to the President of the company. 

 

Real Time Notifications  

You can notify specified users of given call events (Ring, Incoming, Outgoing) in real time.  

You can either: 

Send a message to the configured users by typing in the message contents. You can use special 
placeholder codes  

%1% - Insert the DID present on the call 

%2% - Insert the ACD queue the call was directed to 

%3% - Insert the caller 

%4% - Insert the extension 

%5% - Insert the time the call rang before connection 

Show a web page: A locally available web page can be invoked in a browser. 

Go to this web address: Invoke a web URL for display in a browser. 
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Chapter 18 

Call Costing 

Call Costing in MyCalls can seem quite daunting at first. But in fact they can be as simple or as complex 
as you wish to make them.  It simply depends upon the needs of your organization. 

The cost of a phone call can be broken down into four parts: 

Actual cost = telephony call cost + fixed costs + handling costs + taxes 

In its simplest form the telephony call cost will be the only one used as the other parts are set to zero 
if they are not configured. 

Profit margins can be added to each call and added to the actual cost of a call. This profit margin can 
be expressed as either a fixed amount or as a percentage of the actual call cost. 

For each call record the costs are broken down into three values, call cost, handling costs (which 
include the fixed costs) and profit. Reports can then be run and filtered to show the information that 
matches any of the three value types. 

Fixed Costs 

Fixed costs are costs that are allocated to capital expenditure items such as extensions and trunks. 
Each type of extension and trunk can carry its own fixed cost. In addition to the cost types, an 
individual extension or trunk can be assigned an additional cost, which can be used to cover any other 
costs that the type costs do not cover. 

Fixed costs are not call dependant, as the cost of running an extension or a standing charge on a trunk 
still applies whether there are any calls on that trunk or extension. As such these do not appear on call 
detail type reports. 
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Editing Fixed Trunk Type Costs  

Trunk types can be assigned a fixed cost. The amount entered can be specified as an amount for a 
period defined as hourly, daily, weekly, monthly, quarterly or yearly. The fixed cost amount will always 
apply regardless of whether or not the trunk received or made any calls and will be shown on reports 
as a pro-rata figure.   

 

How to: Editing fixed Trunk type costs  

1) Select the ‘Costs’ option from the Configure menu or click the  icon on the toolbar 

2) Expand the ‘Fixed Costs’ category in the left pane of the window.  This will display all available 
PBXs in your enterprise.  Then expand the PBX you want to configure costs for. 

3) Select the ‘Trunk Type Costs’ option.  

 

4) Click ‘Edit Fixed Trunk Type Costs’ 

 

5) You can configure the costs for the different trunk types configured on the system including 
Analogue, ISDN, Private Wire, TCP/IP, and any unassigned trunks.  To configure a cost for a trunk 
type, enter a costing value in the Cost (£) column and then select one of the costing periods 
from the Cost Period column.  Periods selectable are hourly, daily, weekly, monthly, quarterly 
and yearly.  

6) Click ‘OK’ 
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Editing Fixed Extension Type Costs  

Extension types can be assigned a fixed cost. The amount entered can be specified as an amount for 
a period defined as hourly, daily, weekly, monthly, quarterly or yearly. The fixed cost amount will 
always apply regardless of whether or not the extension received or made any calls and will be shown 
on reports as a pro-rata figure.   

How to: Editing fixed Extension type costs  

1) Select the ‘Costs’ option from the Configure menu or click the  icon on the toolbar 

2) Expand the ‘Fixed Costs’ category in the left pane of the window.  This will display all available 
PBXs in your enterprise.   

3) Click ‘Extension Type Costs’ 

4) Click ‘Edit Fixed Extension Type Costs’  

 

5) You can configure the costs for the different extension types configured on the system including 
Analogue Desk Phones, Analogue System Phones, Analogue User Phones, Announcement Ports, 
Auto Attendant, Cordless Phones, Digital Desk Phones, IP Desk Phones, Non PBX Phones, 
Operator Consoles, Voicemail and Unassigned extensions.   

6) To configure a cost for an extension type, enter a costing value in the Cost (£) column and then 
select one of the costing periods from the Cost Period column.  Periods selectable are hourly, 
daily, weekly, monthly, quarterly and yearly.   

7) Click ‘OK’ 
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Editing fixed Additional Costs  

Fixed additional costs are any other user configured cost that may apply to a trunk or extension device 
types. This could be to include premiums for feature phones over normal phones for example.  
Additional costs must be configured with a unique name.  You can enter negative additional costs that 
will be subtracted from any other costs.  The amount entered can be specified as an amount for a 
period defined as hourly, daily, weekly, monthly, quarterly or yearly.    

How to: Editing fixed additional costs  

1) Select the ‘Costs’ option from the Configure menu or click the  icon on the toolbar 

2) Expand the ‘Fixed Costs category’ in the left pane of the window.  This will display all available 
PBXs in your enterprise.  Then expand the PBX you want to configure costs for. 

3) Click the ‘Additional Type Costs’ option. 

4) Click ‘Edit Additional Costs’  

5) This window will list all existing additional fixed costs in the system.  To add a new additional 
cost click ‘Add’.  

6) Enter a unique name at the next screen for the new additional cost item. 

7) The new additional costing item will appear in the listing of cost items.  

 

8) Enter a costing value in the Cost (£) column and select one of the costing periods from the Cost 
Period column.  Periods selectable are hourly, daily, weekly, monthly, quarterly and yearly.   

9) You can continue to add further additional costs or edit the existing costs.   

10) To remove an additional cost item, you have created, select the item from the list of additional 
costs and click ‘Remove’. 

11) Click ‘OK’ 
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Editing Fixed Trunk Costs  

Fixed trunk costs are the total cost associated with the trunk’s type and one other user defined 
additional cost if you wish to apply it also to the overall costing of the trunk.   

How to: Editing fixed Trunk costs  

1) Select the ‘Costs’ option from the Configure menu or click the  icon on the toolbar 

2) Expand the ‘Fixed Costs’ category in the left pane of the window.  This will display all available 
PBXs in your enterprise.  Expand the PBX you want to configure costs for. 

3) Click the ‘Trunk Costs’ option. 

4) Click ‘Edit Fixed Trunk Costs’ window. 

 

5) This window will list all trunk line numbers along with their, names and their defined trunk type 
as set through the telephone configuration or auto learned from the PBX.  You can select one of 
the additional costs from the drop down list which can be accessed for each trunk in the 
Additional Cost column.  These will need to have been previously created through the Additional 
Costs under Fixed Costs.  

6) Click ‘OK’ 
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Editing Fixed Extension Costs  

Fixed extension costs are the total cost associated with the extension type and one other user defined 
additional cost if you wish to apply it also to the overall costing of the extension.  For example, you 
could put in an additional cost which could be applied to desk phones with a larger screen.  

How to: Editing fixed Extension costs  

1) Click the ‘Costs’ option from the Configure menu or clicking the  icon on the toolbar. 

2) Expand the ‘Fixed Costs’ category in the left pane of the window.  This will display all available 
PBXs in your enterprise.   

3) Click ‘Extension Costs’ 

4) Click ‘Edit Fixed Extension Costs’  

 

5) This window will list all extension numbers along with their, names and their defined device type 
as set through the telephone configuration or auto learned from the PBX.  You can select one of 
the additional costs from the drop down list which can be accessed for each extension in the 
Additional Cost column.  These will need to have been previously created through the Additional 
Costs under Fixed Costs.  

6) Click ‘OK’ 

Handling Costs  

Handling Costs are costs that can be attributed to a call that are based on the labour costs involved in 
handling it. It is also possible to add further handling costs for each account code, DID or pilot number. 
These handling costs allow calls taken on different account codes, DIDs or pilot numbers to be charged 
differently, which can be useful if you operate a bureau service for other companies and wish to charge 
your customers differently. 

The labour costs involved with handling calls still apply to incoming calls as well as outgoing calls. The 
handling costs can be configured to include incoming calls as well as outgoing calls. This can be useful 
to do when you wish to see the how much it is actually costing you for your staff to take personal calls. 

Editing User Costs  

User Costs are the labour costs involved when employing an individual user.  Each user can be 
configured to have an associated user cost.  

Applying a user role of "user" or "supervisor" to most users would be very beneficial if user costs are 
defined, as these roles do not allow users to view or edit the configuration and hence see the 
handling rates entered for each person. 
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How to: Editing User costs  

1) Select the ‘Costs’ option from the Configure menu or clicking the  icon on the toolbar. 

2) Expand the ‘Handling Costs’ category 

 

3) Click ‘User Costs’ 

4) Click ‘Edit User Handling Costs’  

 

5) This window will list all users along with their job titles and organisation groups as set through 
the organisation setup.  In the Hourly Cost (£) column you can assign per user a pro-rata hourly 
rate.  You can copy a value to multiple users by right clicking the mouse button and copying, 
then selecting and pasting onto the other users. 

6) Click ‘OK’ 

Editing Handling Rules 

Handling Rules are used to specify when handling costs are applied.  You can choose to apply 
configured handling costs to incoming answered calls, outgoing calls or both. 

How to: Editing Handling rules  

1) Select the ‘Costs’ option from the Configure menu or click the  icon on the toolbar. 

2) Expand the ‘Handling Costs’ category in the left pane of the window.  This will display all 
available PBXs in your enterprise.  Expand the PBX you want to configure the rules for. 
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3) Click the ‘Handling Rules’ option. 

4) Click ‘Edit User Handling Rules’  

 

5) This window will give you the option to select and apply handling costs to incoming answered 
calls, outgoing calls or both.  By default, both options are enabled but to de select an option 
remove the tick in the option box to the left of the text.  

6) Click ‘OK’ 

Editing Extension Handling  Costs  

Extension handling costs are used to specify pro-rata hourly rates that will be applied and charged to 
an extension whilst handling a call. 

How to: Editing Extension handling costs  

1) Select the ‘Costs’ option from the Configure menu or click the  icon on the toolbar 

2) Expand the ‘Handling Costs’ category in the left pane of the window.  This will display all 
available PBXs in your enterprise.  Expand the PBX you want to configure the costs for. 

3) Click the ‘Extension Costs’ option. 

4) Click ‘Edit Extension Handling Costs’ 

 

5) This window will list all extension numbers along with their, extension names, defined device 
type and extension group their associated with, as set through the telephone configuration or 
auto learned from the PBX.  In the Hourly Cost (£) column you can assign per extension a pro-
rata hourly rate.  You can copy a value to multiple extensions by right clicking the mouse button 
and copying, then selecting and pasting onto the other extensions. 

6) Click ‘OK’ 
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Editing Account Code Handling Costs  

Account code handling costs are used to specify pro-rata hourly rates that will be applied and 
charged for an account code whilst handling a call. 

How to: Editing Account Code handling costs  

1) Select the ‘Costs’ option from the Configure menu or click the  icon on the toolbar 

2) Expand the ‘Handling Costs’ category in the left pane of the window.  This will display all 
available PBXs in your enterprise.  Expand the PBX you want to configure the costs for. 

3) Click the ‘Account Code Costs’ option. 

4) Click ‘Edit Account Code Handling Costs’  

 

5) This window will list all account codes along with their, account code names, and their account 
code groups as set through the telephone configuration or auto learned from the PBX.  In the 
Hourly Cost (£) column you can assign per account code a pro-rata hourly rate.  You can copy a 
value to multiple account codes by right clicking the mouse button and copying, then selecting 
and pasting onto the other account codes.  

6) Click ‘OK’ 

Editing DID Handling Costs  

DID handling costs are used to specify pro-rata hourly rates that will be applied and charged for a 
DID number whilst handling a call. 

How to: Editing DID handling costs  

1) Select the ‘Costs’ option from the Configure menu or click the  icon on the toolbar 

2) Expand the ‘Handling Costs’ category in the left pane of the window.  This will display all 
available PBXs in your enterprise.  Expand the PBX you want to configure the costs for. 

3) Click the ‘DID Costs option’. 

4) Click ‘Edit DID Handling Costs’ 

 

5) This window will list all DID numbers along with their, DID names, and their DID groups as set 
through the telephone configuration or auto learned from the PBX.  In the Hourly Cost (£) 
column you can assign per DID a pro-rata hourly rate.  You can copy a value to multiple DIDs by 
right clicking the mouse button and copying, then selecting and pasting onto the other DIDs.  

6) Click ‘OK’ 
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Editing Pilot Number Handling Costs  

Pilot number handling costs are used to specify pro-rata hourly rates that will be applied and 
charged to a pilot number whilst handling a call. 

How to: Editing Pilot Number handling costs  

1) Select the ‘Costs’ option from the Configure menu or click the  icon on the toolbar 

2) Expand the ‘Handling Costs’ category in the left pane of the window.  This will display all 
available PBXs in your enterprise.  Expand the PBX you want to configure the costs for. 

3) Click ‘Pilot Number Costs’ option 

4) Click ‘Edit Pilot Number Handling Costs’  

5) This window will list all pilot numbers along with their, pilot name, pilot type, and their 
associated pilot number group as set through the telephone configuration or auto learned from 
the PBX.  In the Hourly Cost (£) column you can assign per pilot number a pro-rata hourly rate.  
You can copy a value to multiple pilot numbers by right clicking the mouse button and copying, 
then selecting and pasting onto the other pilot numbers.  

6) Click ‘OK’ 

Location Specific Costs  

Location Specific Costs are additional costs that are dependent on the location of the PBX where the 
outgoing calls will be made from. These include the following: 

 Local Area Codes 

 Carrier Associations 

 Profit Margins 

 Taxes 

Edit Local Area Codes  

Local Area Codes are the area codes that will incur a local rate call charge.   They are dependent on 
the location of the PBX, and by default are governed by the area code entered for the PBX when it 
was created. 

The system will automatically assign the local area codes for you when the PBX is created.   If, 
however, these are incorrect for you then they can easily be modified manually. 

Area codes must be specified without the trunk access code. 

The list of local area codes can also be imported from a file, which can be easier if you have the 
information available from another source. The format of the file is very straight forward, one area 
code on one line followed by carriage return: 

1270 

1260 

1606 
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United Kingdom Local Area Codes  

The United Kingdom defines its local area codes by the area codes that are adjacent to the one that 
is specified for the area code of the exchange the PBX is connected to. 

How to: Editing Local Area codes  

1) Select the ‘Costs’ option from the Configure menu or click the  icon on the toolbar 

2) Expand the ‘Location Specific’ category in the left pane of the window.  This will display all 
available PBXs in your enterprise.  Expand the PBX you want to configure the costs for. 

 

3) Click the ‘Local Area Codes’ option 

4) Click ‘Edit Local Area Codes’ 

 

5) The displayed area codes are those that can be dialled from the location of the PBX incurring just 
a local charge. You can add a new local number by clicking ‘Add’ or import a local number by 
clicking ‘Import’ 

6) Click ‘OK’ 

Edit Carrier Associations  

Carrier associations are the rules by which the correct carrier for each outgoing call type is 
determined.  A carrier can be directly specified which means that the same carrier will always be 
used for those types of call, or least cost routing could be specified which means that the carrier will 
be automatically selected using the least cost routing digits.  If least cost routing is specified as the 
carrier but no match is found in the least cost routing numbers then the call will not be costed. 

javascript:kadovTextPopup(this)
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How to: Editing Carrier associations  

1) Select the ‘Costs’ option from the Configure menu or click the  icon on the toolbar 

2) Expand the ‘Location Specific’ category in the left pane of the window.  This will display all 
available PBXs in your enterprise.  Expand the PBX you want to configure the costs for. 

 

3) Click ‘Carrier Associations’ option. 

4) Click ‘Edit Carrier Associations’  

 

5) This window will list all the call types used by the system and for each call type the carrier being 
used to provide the costing information.  You can select pre-installed carrier information which 
by default will include BT Business and Least Cost Routing.  If additional carriers are required, 
then they will have to be configured through the carrier setup screen. 

6) Click ‘OK’ 

Edit Profit Margins 

A profit margin can be applied to a call for each class of call type.  The profit margin is calculated 
after the call costs and handling costs have been applied. The margin can be specified as either a 
fixed amount or as a percentage of the total cost. 

How to: Editing profit margins 

1) Select the ‘Costs’ option from the Configure menu or click the  icon on the toolbar 

2) Expand the ‘Location Specific’ category in the left pane of the window.  This will display all 
available PBXs in your enterprise.  Expand the PBX you want to configure the costs for. 

3) Click the ‘Profit’ option. 

4) Click ‘Edit Profit Margins’  
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5) This window will list all the call types used by the system and for each call type you can enter a 
‘Profit’ value in the Profit column.  Then you can select from the ‘Apply as’ column whether you 
want to apply the profit as a percentage of the calls total cost or as a fixed amount. 

6) Click ‘OK’ 

Edit Taxes  

The taxes that are applied to calls are intended to be used when invoice styled reports are generated 
to be used to bill external customers.  The cost of a call that is subject to taxes is the call cost + 
handling cost + profit. Up to four separate taxes can be defined and are added together and applied 
to all calls.  

How to: Editing Taxes 

1) Select the ‘Costs’ option from the Configure menu or click the  icon on the toolbar 

2) Expand the ‘Location Specific’ category in the left pane of the window.  This will display all 
available PBXs in your enterprise.  Expand the PBX you want to configure the costs for. 

3) Click the ‘Taxes’ option. 

4) Click ‘Edit Taxes’  

  

5) This window will give you four entries to define four separate taxes.  You can provide a 
description for each tax entry and also the rate of taxation as a percentage. 

6) Click ‘OK’ 

Carriers 

Carriers are also known as operators, and are the telephone companies that provide the telephone 
service to your company. It is possible to have multiple carriers supply a single company. Each carrier 
is responsible for connecting one or more types of calls. It is quite common to have one carrier supply 
your local calls and another that supplies your national calls. 

If when you make a call you do not prefix the number you are dialling with another series of digits, 
then you will be using Carrier Pre-Select where the carrier is set for that type of call at the exchange. 

If you prefix the number you are dialling with another series of digits, then you will most likely be using 
Least Cost Routing. It is possible to have several Least Cost Routing carriers handle calls for the same 
call type. The carrier used is determined by the prefix entered before the number. 

MyCalls supports both Carrier Pre-Select and Least Cost Routing, and any number of carriers can be 
configured. 
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Add a New Carrier  

How to: Add a new Carrier  

1) Select the ‘Costs’ option from the Configure menu or click the  icon on the toolbar 

2) Select the ‘Carriers’ option. 

 

3) Click ‘Add Carrier’ in the right pane. 

 

4) In the window that appears you can enter a name for the carrier, the country and the least cost 
routing digits. You can enter multiple sets of least cost routing digits by separating with a comma 
and leaving no spaces. 

5) Click ‘OK’ 

Import a Carriers Settings 

You can use the import carrier wizard to import a carrier and its settings from a previously exported 
or created carrier file. 

How to: Import a Carriers setting  

1) Select the ‘Costs’ option from the Configure menu or click the  icon on the toolbar 

2) Select the ‘Carriers’ option. 

3) Click ‘Import Carrier’ in the right pane 

 

4) You will be presented with a screen that allows you to browse to the carrier configuration file 
saved in a location on the local computer or a network location.  If the carrier details in the file 
already exist, the carrier in MyCalls will be updated otherwise a new carrier will be created and 
listed under the Carriers area of the Configure Costs window. 

5) Click ‘OK’ 
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Edit an Existing Carrier  

You can use the edit carrier wizard to modify the country the carrier is in and the least cost routing 
digits the carrier uses. 

How to: Editing an existing Carrier  

1) Select the ‘Costs’ option from the Configure menu or click the  icon on the toolbar 

2) Click ‘Carriers’ 

3) Select the carrier you wish to edit e.g. BT Business 

 

4) Click ‘Edit Carrier’ in the right pane. 

 

5) You can change the name, modify the country the carrier is in and modify the least cost routing 
digits the carrier uses. You can enter multiple sets of least cost routing digits by separating them 
with a comma, but leaving no spaces. 

6) Click ‘OK’ 

Delete a Carrier  

You can delete an existing carrier at any time by following this procedure: 

How to: Delete a Carrier  

1) Select the ‘Costs’ option from the Configure menu or click the  icon on the toolbar 

2) Expand the ‘Carriers’ option and select the carrier name of the configuration you want to delete. 

3) Click ‘Delete Carrier’  

4) You will be asked to confirm deletion. 

5) Click ‘Yes’ to confirm, ‘No’ to cancel 
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Duplicate a Carrier  

You can duplicate an existing carrier in order to customise its configuration settings but leaving the 
original configuration as it is. 

How to: Duplicate a Carrier  

1) Select the ‘Costs’ option from the Configure menu or click the  icon on the toolbar 

2) Expand the ‘Carriers’ option and select the carrier name of the configuration you want to 
duplicate. 

3) Click ‘Duplicate Carrier’  

4) Click ‘OK’ 

Carrier Costing Periods 

Carriers offer different tariffs for calls dependent on the time of day the call was made. The number 
of time bands provided by a carrier varies from carrier to carrier though there is usually some form 
of daytime, evening and weekend rate. The daytime rate tends to be more expensive as that is when 
most business calls are made. 

The time bands used by carriers never overlap and together they must cover a complete week. 

MyCalls can have any number of time bands for a carrier. The system will automatically check if 
there are any overlapping time bands and flag an error if any overlap. 

How to: Editing Costing Periods  

1) Select the ‘Costs’ option from the Configure menu or click the  icon on the toolbar 

2) Expand the ‘Carriers’ option and select the ‘Costing Periods’ option under the carrier you want 
to configure the settings for. 

3) Click ‘Edit Costing Periods’  

 

4) In this window by default you will have periods pre-defined for Daytime, Evening, Morning and 
Weekend.  You can modify the values for each period including the period start time, period end 
time and the days the costing period will apply on.  To change the days, click the box in the 
column of the day you want to configure and if a tick is filled then the day is enabled otherwise 
the day is excluded from the period. 

5) You can add further costing periods by clicking the ‘Add’ button which will prompt you to 
provide a unique name for the new period.  
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6) Enter the new costing period name and click ‘OK’.  The new costing period will now appear in the 
Editing Costing Period window for you to configure the period values as explained earlier.  

 

7) If you want to remove a costing period, then simply select it from the list to highlight it and click 
‘Remove’.  You will not be prompted to confirm and the costing period will be deleted from the 
system 

8) Click ‘OK’ 

Carrier Rates  

Carrier Rates are the calculations used by carriers to determine the cost of a call. 

MyCalls has two types of carrier rates, System and User defined. The system defined rates are Local, 
National, International and Special Numbers. These rates cannot be deleted and by default, calls will 
be costed according to these rates when a carrier is added. It is quite rare that carriers will have such 
a simplistic costing structure and the user is generally required to create rates that match those 
provided by their carrier. 

When adding a new carrier rate, make sure the costs have been entered into all of the periods, 
otherwise calls in those periods will be costed at nothing. 

If the tariff has only one price and it does not vary by the length of the call, then you must use the 
‘There after’ charging period.  

How to: Add or Import a new Carrier Rate  

1) Select the ‘Costs’ option from the Configure menu or click the  icon on the toolbar 

2) Expand the ‘Carriers’ option and select the ‘Carrier Rates’ option under the carrier you want to 
configure the settings for. 

3) Click ‘Add or Edit Carrier Rates’  

 

4) To add, click ‘Add’ and enter a name for the carrier rate 

5) To Import, click ‘Import’ and select the file you wish to import 

6) Click ‘OK’ 
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How to: Delete a Carrier Rate  

1) Select the ‘Costs’ option from the Configure menu or click the  icon on the toolbar 

2) Expand the ‘Carriers’ option and select the carrier name of the configuration you want to delete 

3) Select the ‘Carrier Rates’ option under the carrier you want to configure the settings for. 

4) Click ‘Delete Carrier Rates’ 

 

5) Select the carrier rates you wish to delete. You can select multiple carrier rates by holding down 
control (Ctrl) while you select with the mouse. 

6) Click ‘OK’ 

How to: Edit Carrier Rates  

1) Select the ‘Costs’ option from the Configure menu or click the  icon on the toolbar 

2) Expand the ‘Carriers’ option and select the carrier name of the configuration you want to edit 

3) Select the ‘Carrier Rates’ option 

4) Click ‘Add or Edit Carrier Rates’ 

 

5) To edit the carrier rate you can either select the row (as shown above) or edit by selecting each 
column and altering the data. 

6) Alternatively, you can click the ‘Edit...’ button to the right of the carrier rate you want to edit. 

7) The ‘edit a carrier rate’ window appears, where you can alter the rate name, period name, 
minimum costs, initial cost, first and second charging periods and thereafter charging periods. 
You can select whether the charges are fixed or not. 

 

8) Click ‘OK’
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Chapter 19 

Agent Control 

Agent Control and Automatic Call  Distribution (ACD)  

Agent-Control allows you to manage which agents are made available to handle incoming calls, from 
ACD queues within your organisation. 

Agent Control and ACD will enable you to do the following: 

 To ensure calls are distributed fairly, so that no individual is overloaded whilst others are 
kept idle 

 Allow members of a lightly loaded department can assist a heavily loaded department on 
demand 

 Agents can be empowered to log onto call queues as necessary 

 Reasons and times when agents are unavailable can be recorded 

 Completion Codes can be entered after each call to identify the purpose and actions taken 
for each call. 

Users can be grouped together according to their primary skills and automatically logged on to the 
appropriate queues when required 

 Because call volumes can vary enormously throughout the day, you will need to be able to respond 
quickly to fluctuations in requirements.  Agent Control is one way you can do this directly from your 
MyCalls screen. 

Call Queues 

Call queues are queues within the PBX switch which can hold incoming calls.  

 Prior to being placed in a queue a call may go via one of the following routes. 

 The call is answered by an auto-attendant which will direct the call to the most appropriate 
queue by asking the caller to enter a series of digits from the handset 

 The caller may have dialled a DID number which is automatically associated with a call queue 

 A live receptionist may route your call to a queue using a Pilot number 

A queue can be in the form of either a Hunt-Group or an ACD queue.  

Hunt groups are a defined set of extensions which will respond to calls in either a collective ring (all 
phones ringing simultaneously) or a sequential ring (each phone rings in turn). Collective rings can 
lead to indecisiveness if more than one agent is available. Sequential rings can lead to longer wait 
times as the call has to wait at each extension in the group in turn.  
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ACD queues are more sophisticated and allow calls to be routed according to a set of well-defined 
rules. In general, the rules will route calls to an appropriate extension based on who has been idle 
the longest within the group. Each ACD group consists of a number of agents who can log on and off 
the queues as required. In addition, agents can be allowed to log onto more than one queue at a 
time and can enter a variety of states such as unavailable or wrap-up when they are busy with other 
activities. 

MyCalls manages Agent control at various levels  

 Linking users to queues appropriate to the user’s skill-set or other criteria 

 Associating a user with a pin code 

 Associating users within an ACD group with a set of unavailable codes 

 Providing real time information regarding queue status 

 Reporting on performance 

Operating Agent Control  

The agent control toolbar is displayed as a separate movable toolbar and provides the following 
functions. 

 

Login: Allows a user to login to one or more queues. The queues available from the drop down menu 
will show the queues configured for that user. The user can elect to login to specific queues or all 
login queues marked as primary queues for Agent Control group to which a user belongs.  

 

When a user logs in they will be prompted for the number of the extension which thay are currently 
using. This allows the ACD system to correctly locate the user when routing calls. 

 

Logout: logout of one or more queues. 

Wrap-up Start/Stop: A user can enter wrap-up or exit wrap-up state. The icon toggles state when 
clicked. 

 

Unavailable: A user can specify that they are unavailable and select an unavailable code. 
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Completion Code Entry: A user can enter a completion code or codes for the previous call. This is 
only available between the end of a call and the end of the next call to the same extension. 

For more details on using the completion codes see the Using Completion Codes section. 

Options: Options to set the following: 

 

 Lock Toolbar 

 Always keep the toolbar on top of other windows 

 Set visible tool-buttons and shortcut keys 

 

Viewing Agent activity  

Prerequisites: For the queue status described below to show any activity you will need to have 
configured users for Agent control and users must have logged in. For our example we have created 
an ACD queue called sales and allocated two users to that queue Mark and John. See later in this 
section for details regarding configuration of the queues and users. 

To view queue activity, you will need to configure a real time queue status window. Full details of 
this are described in the Real time status section of the manual but a summary is described here.  

From the MyCalls menu select View->Real time information->Real time status->DID Status->Queue 
Status. 

Select the ‘Detailed’ view and click ‘OK’. 

A queue status window will be displayed on the screen showing the current status of any users 
logged into the queue. 

Call States 

As calls are made to the incoming pilot number the activity of the users can be viewed. The possible 
states are: 
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Available 

 

Off Hook 

 

Hold 

 

Incoming 

 

Ringing 

 

Other ACD: A user is on a call from another ACD queue than the one which You are logged into. This 
is useful if you, as a department manager, want to know that a user is busy on another call and that 
the calling party is legitimate 

 

Non ACD: this could be an intercom call or a personal call etc. 

 

Unavailable: shows which users are unavailable and why 

 

 Wrap up: The user has finished a call and is wrapping up the call details 
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Agent control configuration  

There are several steps to configuring ACD and Agent control 

1. Set up users: Users will need to be assigned a default extension, and a user role (See user 
configuration for details) 

2. Assign the users an ACD login/pin code: This allows the users to log in to the phone system 
via MyCalls and makes them available to answer calls. The Login code is an arbitrary code 
assigned to each user which informs the phone system to make a logical link between a user 
and their current extension. This means that when a queued call is to be routed the users 
associated with that queue can be correctly located.   

3. Configure ACD queues: Via the Pilot number configuration 
4. Configure Unavailable codes: Identifies a set of unavailable codes which can then be 

assigned to an agent control group. Only available users can take calls therefore the ACD 
system needs to be aware if users are available or not at any time. 

5. Configure the Agent control: Assign users and ACD queues to Agent control groups so that 
the users can be associated with a given queue or set of queues. This allows a given user to 
automatically login to one or more queues 

6. Configure a real time status window: To view the queue status as described in the previous 
section 

Set up users  

Users are created within the MyCalls environment and you must be logged in as a user in order to 
run the MyCalls application. Users can be given different roles and privileges within the application. 
For more detailed information about users see the relevant section of this manual.  

Dynamically associating a User with an extension 

In order for staff members to log into and out of ACD queues we must relate our staff members 
(users) with the extension that they are currently using.  Relating a user to an extension is 
accomplished via the login/pin code configuration which is also covered in the Device Configuration 
section in this manual. 

Creating ACD queues using Pilot numbers  

Within MyCalls Pilot numbers and ACD queues are effectively synonymous. In order to define an 
ACD queue we create a Pilot number and assign it a type of ‘ACD Queue’. The screenshot here shows 
2 queues have been created, ‘sales’ and ‘returns’.  
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Unavailable Code configuration  

There are two areas where Unavailable codes are configured. Firstly, you need to define the 
Unavailable Codes. In order to use these codes, you will need to define sets of Unavailable Codes 
which can be applied to different groups of ACD users. 

How to: Creating/Editing Unavailable Codes  

1) Select Configure->Telephone System->Agent Control->Unavailable codes from the menu 

 

2) Select ‘Create or Edit Unavailable Codes’ 

 

3) From the list of codes click ‘Edit’ Or click ‘Add a new Unavailable Code’ 

4) In the dialog enter Code Number, Name and a Short name (2 digits) 

 

5) Click ‘OK’ 
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Creating Unavailable Code groups  

It is important to keep track of who is available to answer calls at any given time. Equally it is 
important to be aware of the current status of any staff currently unavailable. Unavailable codes 
enable us to do this. When a member of a team becomes unavailable they must specify a reason via 
the unavailable code selection from their agent control toolbar. One problem that may be 
encountered is that of providing different sets of unavailable codes for different groups of staff.  

Supervisors for example, may be able to attend meetings or review calls whereas telesales staff may 
not. To accommodate this requirement, we can create groups of unavailable codes. 

Typical group settings may be: 

Supervisors Codes: Break, Refreshments, Meetings, Call Query 

Sales Agents Codes: Break, Refreshments, Call Parts Dept 

 How to: Creating / Editing an Unavailable Codes group  

1) Select Configure->Telephone System->Agent Control->Unavailable Code Groups from the menu 

 

2) Select ‘Create an Unavailable Code group’ 

3) Enter the name of the new Unavailable Code group in the dialog 

 

4) Click ‘OK’ 

5) The new group will be added to the Unavailable Code menu 

 

6) Select the newly created group and select ‘Edit Unavailable Code Group configuration’ 

7) From the list of Unavailable Codes select the ones to include in your group by clicking the 
appropriate ‘Included’ checkbox. The codes selected will be the only codes a user allocated to 
this Unavailable Codes group can choose from. 
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8) Click ‘OK’ 

Creating Agent Control  Groups  

Associating users with ACD queues is accomplished via the ‘Agent Control’ group configuration. We 
create an ‘Agent Control’ group to identify a group of users and associate them with a set of ACD 
queues and ‘Unavailable Code’ groups. A given user can only be a member of one ‘Agent Control’ 
group but that group can be associated with several ACD queues. An ACD Queue can be included in 
as many ‘Agent control’ groups as required. 

 Automatic wrapup can be applied to each individual agent control group. This allows the amount of 
time that the agents within the group can spend in wrapup to be set to a specific amount, and once 
this time is up, the phone will automatically be taken out of wrapup and able to receive calls again. 
This can be assigned to each individual ACD queue that has been selected for an agent group. 

 How to: Creating an Agent Control group 

1) From the Agent Control menu select ‘Create or Edit an Agent Control Group’ 

2) Either click ‘Edit’ for a group you want to modify or click ‘Add a new Agent Control group’ 

3) Specify a name for the group  

4) Select users to include in the group, type part of the user’s name for the user(s) to appear in the 
available box and click ‘Add’ to move the user to the included users box  

NB: Any user can only belong to one Agent Control group, you will get a warning message if the user 
already belongs to another group asking if you wish to move the user to this new group. If you click 
‘Yes’ the user will be removed from the other group 
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5) Select the required ACD queues from the Available list and add them to the Included ACD 
Queues list and specify an automatic wrapup timer if one is needed 

6) Select the ‘Unavailable Code Group’ appropriate for this group of users 

7) Select whether to ‘Allow user login’, ‘Allow User Unavailable’, ‘Allow User Wrapup’. These 
options limit these options for users within this Agent Control group.  

8) Click ‘OK’ to save your settings. 

That should complete the Agent Control configuration and you should now be able to log into the 
ACD system. 

Completion Codes 

Completion codes are used to identify important information about calls. By using the MyCalls 

completion codes agents can quickly add information to the call data using pre-defined codes. 

Columns can be defined in the calls grid to display the completion codes. In addition to the basic 

completion codes, two additional levels of related codes can be defined.  

An example might be a sales organisation dealing in various categories of goods such as Computers, 

Cameras, DIY equipment and Garden tools. These might form the primary completion codes. We 

might also define a secondary code to indicate a successful sale e.g. Sale Completed or No Sale, 

finally we could gather some basic marketing information by asking the customer where they heard 

about the company and add a third level code e.g. Newspaper advert, Website etc. 
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The first two levels of completion code i.e. Category of goods and success of sale would be 

mandatory whereas the third level would be optional as not all customers would necessarily answer 

the question. 

Entering the completion codes  

To make entry simple and foolproof the completion code entry dialog consists of a set of selectable 

items. 

How to: Set the completion codes for a call  

 When a call is completed the Call Completion Code icon will become enabled in the Agent Control 
toolbar.  

 

Click the Icon to display the completion code entry dialog 

 

Select the appropriate entry for each level from the drop down lists 

Click OK 

 Once entered the completion codes will become visible in the call logs although this may take time 

to appear depending on the screen refresh period. 
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Completion codes configuration  

This requires 3 steps 

 Define the completion codes 

 Create completion code groups and add the codes to them 

 Define which completion code groups apply to which agents 

 

How to: Defining Completion Codes  

Select Configure Telephone system->PBXs->Agent Control 

Click on ‘Completion codes’ 

Click ‘Edit Completion Codes’ 

 

From the dialog displayed click inside the Name column and enter the completion code name. 

Repeat this process until the list is complete and add codes for the other levels if required. 

Codes can also be imported from a comma delimited file. 

 

Click OK. 

The completion codes created in the previous step are a complete list of all possible codes but not all 
agents want to select a code from a long list of codes. The agents need a short list of codes 
applicable to their department of job function. To accomplish this, we need to create sets of 
completion codes which can then be assigned to agents. To do this we create completion code 
groups. 
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How to: Creating a completion code group 

From the Agent control configuration menu select Completion code group 

 

Click Create a new completion code group, Select the PBX (if required) and enter a name for the 
group and click OK. 

Select the newly created group from the left hand menu 

For each level select the required completion codes appropriate to the group 

 

For levels 2 and 3 specify if these are compulsory items by clicking the checkbox 

Specify the prompt behaviour for incoming and outgoing calls by selecting the incoming and 
outgoing prompt points. These can be Manual, Automatic or Disabled. 

Click OK 

The final stage is to Add the newly created completion code group to an agent control group. To do 

this open up an agent control group dialog and select the appropriate Completion Code Group from 

the dropdown list in the bottom left hand corner. 

 

This will ensure that the agents within the selected group are able to select the appropriate 

completion codes when presented with the completion code dialog following a call. 
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Chapter 20 

Skill Based Routing 

An explanation of Skill  Based Routing 

Skill Based Routing is a mechanism employed by ACD (automatic call distribution) to ensure that calls 
are routed to the staff best qualified to handle them. The basic ACD distributes calls to agents based 
on the amount of time they have been idle. In this scenario, the agent who has been idle the longest 
receives the next call. This mechanism ensures calls are distributed fairly but it does not take into 
account the abilities of the agents when fielding calls from a particular queue.  

One way of dealing with this would be to ensure that only staff capable of dealing with a particular 
type of call, are assigned to the appropriate queue. In this scenario only sales people would be 
assigned to the sales queue, which would ensure that any sales call would be answered by a sales 
person, but if there are no salespeople available then there is a danger that the call would not be 
answered at all.  

An alternative solution would be to assign all agents to all queues but this would mean that many 
calls could be answered by staff with the wrong skills.  

Skill based routing solves this problem.   

 With skill based routing you can assign each agent a score for each of the skills they possess.  

 As calls enter a queue they are then distributed to agents based on their level of skill in 

handling calls from that queue.  

 Agents who are highly skilled in a particular discipline will handle most of the calls from the 

relevant queue, but at peak times, calls will still be answered by staff having some 

knowledge in the subject. 

Let’s look at an example.  

Assume we have two queues ‘Sales’ and ‘Technical’ and we have three users Anne, Janet and Tom. 
Anne can only handle sales calls Terry is responsible for answering technical calls, Janet is ok to field 
calls on sales and technical but she is not as knowledgeable as either Anne or Terry.   

Using a skill based routing approach Anne (sales) would be first choice for sales calls and Terry 
(technical) would be first choice for technical queries but if either were busy then Janet would be 
called thus ensuring the calls were answered.  
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Skill  Sets.  

Skill based routing requires various skill-sets to be defined. Skill-sets describe the level of skills in 
each discipline based on a rating of 1 to 7, where 1 is highly skilled and 7 indicates no knowledge in 
that area.  

 The table below shows how you might set up the skill sets for an organisation. Skill sets are created 
by defining a name for the skill-set and assigning an appropriate skill level to each queue.  

 

 

 

 

 

 

 

 

 

 

 

In this example Sales-only, Support-only and Admin-only would be for Sales, Support and Admin 
staff respectively. Sales/Support would be assigned to staff that are primarily sales with some 
support knowledge and Support/Sales would be assigned to staff who are primarily support with 
some sales expertise.  

The skill sets are created within Mycalls and the Mycalls administrator can create up to 512 skill sets. 

NB: The pilot queues that can have a skill assigned to them have to be enabled for skill based routing 
within the PBX this cannot be changed within MyCalls (See your reseller for information regarding 
this).  

Once the skill-sets are defined they need to be assigned to the various users. Users are associated 
with the ACD system via a user login code which is used by the agent control system to log agents 
into their extensions (see the previous chapter on Agent-Control for more details). When skill based 
routing is enabled the user login configuration allows assignment of a user login to a skill set.  

A typical set of assignments might look like this: 

Login ID User Skill Set 

101 Anne Sales only 

102 Terry Support only 

103 Janet Sales/Support 

104 Tom Support/Sales 

 

 Queue (Pilot Number) 

Skill Set Sales 
Queue 

Support 
Queue 

Admin 
Queue 

Sales Only 1 7 7 

Support Only 7 1 7 

Admin Only 7 7 1 

Sales / Support 2 4 7 

Support / Sales 4 2 7 
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Switch Synchronisation  

The information for Skill Based Routing, such as skill levels and skill sets, is stored within the switch. 
In order to read this information, MyCalls synchronises with the switch every time a change is made 
to make sure that all information is up to date and correct.  

Summary of required configuration for skill  based routing  

The procedure for the correct configuration of skill based routing requires the following steps: 

1. Configure users and assign them to the various organisational groups. 

2. Configure Pilot numbers (Queues) and name them. 

3. Configure the required Skill Sets assigning the required skill levels to each queue 

4. Configure the user logins, assigning each user a skill set 

Note that, in order for skill based routing to work, agent control must be enabled in the MyCalls 
license and fully configured. 

Configuring Skill  Based Routing  

How to: Edit Skill Sets  

From the MyCalls main screen, click Configure > Telephone System.  

Navigate to Skill based Routing by clicking the ‘+’ symbol next to PBXs, then the ‘+’ symbol next to 
Head Office and then the ‘+’ symbol next to Agent Control. 

Click ‘Agent Control’.  

Click ‘Skill Based Routing’ and then click ‘Edit Skill Sets’ in the right hand panel.  

 

Assign an appropriate name to each skill set e.g. Sales Only, Support/Sales etc. 
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Set the skill levels of each Queue in the skill set.       

 

Click the ‘Only Show skill sets assigned to users’ to hide any skill sets which currently have no users 
with that skill set. 

Note that skills sets that are not in use have a grey background. 

Click OK. 

 

How to: Create or Edit a User Login  

From the MyCalls main screen, click Configure > Telephone System 

Navigate to Skill based Routing by clicking the ‘+’ symbol next to PBXs, then the ‘+’ symbol next to 
Head Office and then the ‘+’ symbol next to Agent Control. 

Click ‘Agent Control’.  

Click ‘Skill Based Routing’.    

 

Click ‘Create or Edit a User Login’ in the right hand panel. 
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You will see a list of currently defined logins. 

 

Adding a new login to the list. 

Click ‘Add new User Login’         

 

Assign the login ID  

Assign a user to the login ID 

Assign a skill set to the login ID by selecting from the ‘Skill Set’ drop down menu   

 

Click OK 

The newly added login ID will appear in the list of logins. 
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Editing an existing login 

You can edit a user’s login details directly from this panel or via the ‘Edit’ button. 

Assign a user to each login ID using the drop down menu 

 

Assign a skill set to each login ID using the drop down menu 

  

Once all changes have been made, click OK. 

Using the ‘Edit’ button 

Click ‘Edit’  
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This will display the user login edit details dialog. 

 

The Login ID cannot be changed 

To change the skill set for the user select the appropriate skill set from the drop down menu  

To change the user assigned to this login ID click the ‘Select’ button. This will display the user 
selection dialog and is useful when there are a lot of users in the organisation. 

 

Type the first few initial letters of the user’s name, any users whose name matches the letters typed 
will appear in the list box on the left.  

Select the user from the list box on the left (there may be only one) 

Click ‘Select’ to transfer the user to the ‘Selected user’ box 

Click ‘OK’ to confirm or ‘Cancel’ to ignore any changes 

The amended user login details will appear in the user login list                  

Click ‘OK’ to confirm changes 
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How to: Create a Range of User Logins  

From the ‘Skill Based Routing’ panel 
    

 

Click ‘Create a Range of User Logins’ in the right hand panel. 

When creating a range of logins, you specify the start value of the first login and the number of logins 
required. The new logins will be numbered consecutively from the start value. 

Enter the number of logins that you want to create or click the spin button selection arrows. 

Specify the start login number that you want create e.g. 101  
 

 

Click OK 

The logins will be created but there will be no users or skill sets assigned. You will need to specify 
these manually. See the previous section on creating or Editing user logins for a full description 
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How to: Delete a Range of User Logins  

From the ‘Skill Based Routing’ panel     

 

Click ‘Delete a Range of User Login’ in the right hand panel 

Click on the login ID that you wish to delete, or, 

Click on the first ID, press shift and click on the last login ID that you wish to remove 

 

Click OK.  
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Chapter 21 

Reporting 

MyCalls provides a comprehensive reporting facility. The reports can be run manually or scheduled 
and automatically distributed. Whilst having on-screen statistics is useful for daily activities, for more 
detailed planning and monitoring you need to use the reporting engine. MyCalls offers a large 
selection of pre-defined reports that can be configured to look at every aspect of your call usage. 
There are two main types of report: 

 Lists: Display individual call details, showing the time, date, CLI and other information relating 
to the call. 

 Summaries: Display the number of calls totalled up as well as other statistics. 

 The reports can be easily renamed, copied and customised. 

 

Report Viewer 

Once a report has been generated it is presented in the report viewer. The viewer has the following 
options available from its toolbar: 

 

1 2 3 4 5 6 7 8 9 10 11 12 

 

1. Print 
2. Export 
3. Save 
4. Edit 
5. Zoom in/Zoom out 
6. Current Zoom 
7. Fit Width 
8. Fit Page  
9. Single Page View 
10. Continuous View 
11. Multipage View  
12. Page Selector  
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Typical Report  

Reports can be either run in an ad-hoc manner where they are configured and run as they are required, 
or as a saved report item. Saved reports can be run on demand or grouped together and run as a 
report schedule at a specified time.  

An example of a typical report that can be run is a Group Summary report. Group Summary reports 
provide a summary of the volumes and handling time of different call types for any given type of 
device.  

 

1 Report Title, Configurations and Filters  

At the top of the page is the title of the report, e.g. ‘Group Summary’. Below the title, the date and 
time that the report was created is displayed. Below this, the covering period of the report can be 
configured to run over a changing period or a fixed time. The report can then optionally be filtered to 
only include calls that match a selected criteria.   
 

  

2 Report Summary 

The report summary compiles the total number of calls on the Group Summary and separates them 
into 3 types of call: answered, abandoned and outgoing. This is then broken down further to show out 
of these calls, which ones had the: minimum duration, maximum duration, minimum ring, maximum 
ring time, average duration and average ring time.  
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3 Report Details  

The report details display the device types selected on configuration of the report, and cover the 3 call 
types: Answered, Abandoned and Outgoing. Displayed beneath these are statistics for: total calls, 
average duration, average ring, transfer in, transfer out and total cost of the calls.  
 

 

4 Optional Charts 

The charts, which are optional, can display call breakdowns by type, ring duration or costing type for 
Answered, Outgoing and Abandoned calls.  

 

    

 

Report Templates  

Report templates are the definitions that form the basis of all reports. The report templates are 
organised into categories of: 

 Availability: Used in conjunction with ACD to track the availability of users. 

 Drill Down: Used to specify the report layout of drill down reports that can be assigned to the 
group reports to alter the appearance.   

 Performance: Used to show general performance indicators such as grade of service and 
responsiveness.   

 System: Details alarms, audit logs, auto-configured devices and unused or infrequently used 
devices. 

 Usage: Wide ranging reports showing phone system usage grouped and filtered by any 
combination of parameters. Reports can contain itemised details or summarised data. 

Available Report Templates  

Availability 

 User Availability 

 User Availability Detail 

 User Availability Profile 

 User Presence Details 
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Drill Down 

 Call Details  

 Custom Call Details 

 Custom Group Summary for each Member 

 Custom Group Summary Profile 

 Group Summary for each Member 

 Group Summary Time Profile 

 User Availability 

 User Availability Detail 

 User Availability Profile 

Performance 

 Grade of Service Group Detail 

 Grade of Service Group Summary 

 Response Times 

System 

 Alarms Raised 

 Auto Configured Devices 

 System Audit 

 Unused or infrequently used Devices 

Usage 

 Call Details 

 Call Summuary over same Inteval 

 Call Summary Time Distribution 

 Call Type Summary Comparison 

 Custom Call Dteails 

 Custom Group Summary 

 Custom Group Summary for each Member 

 Custom Group Summary Profile 

 Director’s Report 

 Group Summary 

 Group Summary for each Member 

 Group Summary Time Profile 

 Most Frequent Calls 

 Playback Audit 

 Top Calls 

 Trunk Utilisation 

 Unreturned Abandoned Call Details 

Quick tip:  

Whilst you can configure and run a report template directly it is not the recommended approach. The 
correct way to configure a report is to take a report template and save it as a report item first. This 
allows you to configure a variant of the template with specific configuration parameters. The report 
can then be rendered at any time. 
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How to: Run a Report Template Immediately  

1) Click the ‘Configure and Run Now’ link in the right pane of the reporting area. Note: you will have 
first had to select the relevant report you wish to run in the left pane of the configure reports 
window to make it the active report. 

2) Configure the report options before the report is ran and displayed in the report viewer. 

 

Report Items 

Report Items are report templates that have been customised and saved. They are created from the 
‘Create Saved Report Item’ option from the report template. Each report item must be uniquely 
named and once created they can be:  

 Run in the same way as a template report. 

 Edited, Copied, Renamed or Deleted.   

 Moved to a different or a new group.  

 Placed into report schedules and run at a predefined time. 

 

When MyCalls is installed, by default it will have a number of pre-configured report items available to 
be run. The report items available will depend on the version of MyCalls being run, being either the 
Basic or Call Manager version. 

Pre-Defined Report Items 

Custom reports 

Daily Agent Activity: Provides a summary set of values for all the members of a group for any given 
type of device. The information included on the report is user selectable, along with the headings and 
widths of the columns used to display the information. 

Daily Costs by Telephone Number: Provides a list of detailed calls that are grouped by a specified 
device type, such as extension or account code. The report can be further filtered so it only applies to 
a certain range of devices, such as a specific extensions group or organization group. The information 
included on the report is user selectable, along with the headings and widths of the columns used to 
display the information. 

Daily Incoming Abandoned Calls: Provides a list of detailed abandoned calls that are grouped by a 
specified device type, such as extension or account code. The report can be further filtered so it only 
applies to a certain range of devices such as a specific extensions group or organization group. The 
information included on the report is user selectable, along with the headings and widths of the 
columns used to display the information. 
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Daily Incoming Performance: Provides a summary of a set of values for any given type of device. 
The information included on the report is user selectable, along with the headings and widths of the 
columns used to display the information. 

Daily List Misdialled Outgoing Calls: Provides a list of misdialled outgoing calls that are grouped by 
a specified device type, such as extension or account code. The report can be further filtered so it only 
applies to a certain range of devices such as a specific extensions group or organization group. The 
information included on the report is user selectable, along with the headings and widths of the 
columns used to display the information. 

Daily List of Personal Calls: Provides a list of detailed calls that are grouped by a specified device 
type, such as extension or account code. The report can be further filtered so it only applies to a certain 
range of devices such as a specific extensions group or organisation group. The information included 
on the report is user selectable, along with the headings and widths of the columns used to display 
the information. 

Daily Outgoing Call Performance: Provides a summary of a set of values for all the members of a 
group for any given type of device. The information included on the report is user selectable, along 
with the headings and widths of the columns used to display the information. 

Daily Summary All Call Including Internal: Provides a summary of a set of values for any given 
type of device. The information included on the report is user selectable, along with the headings 
and widths of the columns used to display the information. 

Daily Summary of ACD Group Performance: Provides a summary of a set of values for all the 
members of a group for any given type of device. The information included on the report is user 
selectable, along with the headings and widths of the columns used to display the information. 

Daily, Weekly and Monthly Reports  

Below is the list of report items that may be applied to one, or all of the Daily, Weekly or Monthly 
reports. The applicable reports are in bold at the end of the item descriptions:  

 List: Most Dialled Numbers: Provides a list of numbers that were most frequently dialled or 
answered. The list can be filtered to a specific type of call such as incoming or abandoned, or to 
devices such as the extension group that handled the call or the trunk group. All the device types 
can be used to provide very detailed filtering. The results can then be ordered by the total length 
of calls for that number, the call cost for the number or the call handling cost for that number 
(Daily, Weekly, Monthly). 

 List: Most Frequent Incoming Callers: Provides a list of callers that were most frequently dialled 
or answered. The list can be filtered to a specific type of call such as incoming or abandoned, or 
to devices such as the extension group that handled the call or the trunk group. All the device 
types can be used to provide very detailed filtering. The results can then be ordered by the total 
length of calls for that number, the call cost for the number or the call handling cost for that 
number (Daily, Weekly, Monthly). 

 Summary: All Calls: Provides a summary of the volumes and handling times of different call types 
for any given type of device (Weekly, Monthly). 

 Summary: All Calls by Costing Type: Provides a summary of the volumes and handling times of 
different call types for any given type of device (Daily, Weekly, Monthly). 

 Summary: All Calls by Extension: Provides a summary of the volumes and handling times of 
different call types for all the members of a group for any given type of device grouped by 
extension usage (Daily, Weekly, Monthly). 
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 Summary: All Calls by Trunk: Provides a summary of the volumes and handling times of different 
call types for all the members of a group for any given type of device grouped by trunk usage 
(Daily, Weekly, Monthly). 

The list of report items below only apply to Daily Reports:  

 List: All Calls: Provides a list of detailed calls that are grouped by a specified device type, such as 
extension or account codes. The report can be further filtered so it only applies to a certain range 
of devices such as a specific extension group or organisation group. 

 List: All Calls by Telephone Number: As stated above. 

 List: All Calls to Voice Mail: As stated above. 

 List: All Outgoing Calls: As stated above. 

 List: Calls to International Numbers: As stated above. 

 List: Calls to Mobile Numbers: As stated above. 

 List: Calls to Special Numbers (Premium): As stated above. 

 List: Calls Under 1 Minute Long: As stated above. 

 List: Call Costs by Most Expensive Call: Provides a list of calls that are ordered by either their 
duration, call cost, handling cost, ring or held times and above a certain level, such as calls over 
ten minutes long. The report can be further filtered so it only applies to a certain range of devices 
such as a specific extension group or organisation group. 

 List: Grade of Service: Provides a list of the 30-minute interval periods that did not meet the 
specified grade of Service. 

 Summary Profile: All calls by Half Hour: Provides a summary of the volumes and handling times 
for any collection of device groups, split into time intervals. 

 Summary profile: ANS/ Abd Calls by Ring Time: Lists the number of calls that have a time 
parameter within a specified time period. By using a Ring Time Parameter on abandoned calls this 
report can show at what point most callers abandon their calls. 

 Summary: All Calls by Account Code: Provides a summary of the volumes and handling times of 
different call types for all members of a group for any given type of device. 

 Summary: All Calls by ACD Group: As stated above.  

 Summary: All Calls by Agent: As stated above. 

 Summary: All Calls by DID: As stated above. 

 Summary: All Incoming Calls: As stated above. 

 Summary: All Outgoing Calls: As stated above. 

 Summary: Overflowed Calls by ACD Group: As stated above. 

 Summary: Grade of Service: Provides a summary of the percentage of 30 minute intervals for 
which the Grade of Service exceeded a specified value. 

 Usage: Trunk usage by Half Hour: Lists the number of trunks that were concurrently busy for each 
interval. The total duration of all the calls for that time interval and a percentage of the trunks 
busy against the number of trunks available are also shown. This report allows you to identify 
times where your lines are being used most and whether you have too many or too few lines 
available. 
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Using Report Items 

How to: Create a Report Item 

1) Select ‘Report Template’ on the left side of the configure reports window. 

2) Select ‘Create Saved Report Item’ in the right pane. You will be asked to provide your report with 
a name and choose a destination directory to save the report in. You can choose a pre-defined 
report group from the drop down list or you can enter a new report group manually. 

3) Next you will need to configure the report options before the report item will be saved and 
available to run from the report group you saved it in.  

How to: Edit a Report Item 

1) Each report item can be edited as required and the resulting changes saved. 

2) Open the report item by clicking ‘Edit Report Item’. 

3) Go through the report wizard and make the required changes to the report. 

4) Click ‘Finish’. Your changes have now been saved. If the changes to the report are extensive it is 
recommended that you copy the report item first and then rename the copy and edit that. 

How to: Create a Report Item Group 

1) Click ‘Reports’. 

2) Click ‘Report Items’ on the left side of the configure reports window. 

3) Select the item you wish to create a group for e.g. Daily Agent Activity. 

4) Click ‘Change Group’ in the right side of the configure reports area. 

 

5) Enter the name of the new group you wish to create. 

6) Click ‘OK’. 

How to: Move a Report Item to a Different Group 

1) Click ‘Reports’. 

2) Click ‘Report Items’. 

3) Select the item that you wish to move. 

4) Click ‘Change Group’ in the reports configuration area. 
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5) Select the group you wish to move the item to from the drop down menu. 

6) Click ‘OK’. The item will now be in the new group. 

How to: Copy an Existing Report Item as the Basis for Your New Report 

1) Click ‘Reports’. 

2) Click ‘Report Items’. 

3) Click ‘Copy Report Item’. 

 

4) Enter the report name e.g. Daily Incoming Performance. 

5) Click ‘OK’. The report will have been copied. 

How to: Customise a Copied Report Item 

1) Click ‘Reports’. 

2) Expand ‘Report Items’. 

3) Select the item that you wish to customise, e.g. Daily Reports - ‘List: All Calls to Voicemail’. 

4) It is recommended that you copy the report item first. Click ‘Copy Report Item’. 

5)  This item, once copied, will appear in the list. Select this newly copied report to edit. 

6) Click ‘Edit Report Item’.  

7) A new window will open where you can change the settings. Click ‘Next’ to navigate through and 
click ‘Finish’ when you have made the changes. 

How to: Delete a Report Item 

1) Click ‘Reports’. 

2) Click ‘Report Items’. 

3) Select the item you wish to delete. 

4) Click ‘Delete Report Item’. 

5) Click ‘Yes’. 

General Operations for Configuring Report Templates and Report Items 

In order to create a report item, you will need to configure the report so it renders the information 
you require. There are a number of steps involved and the exact sequence is dependent on the specific 
report, and also on the selections you make during the configuration process. Additionally, there are 
a number of operations common to many of the report templates, such as setting the reporting 
period, filtering etc. that are accomplished via the report wizard.  
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The Report Wizard 

Creating and editing report items will involve using the report wizard. The wizard takes you through 
various pre-defined steps and allows you to construct your report.  Each step deals with a distinct 
aspect of producing the report, and whilst the details of each step will vary depending on the specific 
report being produced, the general type of information being configured fall into the following 
categories:  

 Reporting Period: Defines the time period for which the report collates data. This can be for 
as small a period as a few hours to a complete report covering a year or more. 
 

 Grouping: Define the way in which the report groups the results. For example, you may wish 
to break down your report by extension or extension group, you may wish to break down the 
report by grouping together calls of a specific type such as outgoing or incoming. 
 

 Ordering: The report can be ordered by a particular type of value and you can limit the number 
of items on the report.  
 

 Consolidation of Transferred Calls: Each segment of a transferred call (either incoming or 
outgoing) can be logged as a separate statistic. When viewing a call as a whole, it may be 
preferable to collect all the call segments and present the call statistics as a single call. This 
allows you to decide which way you want to see the call statistic for transferred calls.   
 

 Filtering: When setting up a report you may not want to see all the possible information 
relating to a particular aspect of the call data. If you are viewing extension statistics, for 
example, you might want to see only a particular range or group of extensions or even an 
individual extension. To accomplish this, you can specify a set of filters for the report. The 
exact filtering available depends on the type of report being generated. 
 

 Call Type Selection: By selecting specific call types, it is possible to produce very detailed 
reports. For example, selecting only Incoming Abandoned will only list calls that the caller 
hung up on before the call was answered. Note that the Answered and the Abandoned 
columns in the report will include both interal and incoming calls if selected.  
 

Most reports contain these steps, plus in most cases additional report specific screens  

Quick tip:Detailed reports covering long time periods can result in delays whilst the 
reports are generated. Scheduling reports to run out of hours is recommended.  

The Reporting Period  

Specifying the reporting period is defined as the first stage of the report creation wizard, and will 
appear for all report configurations. There are various parameters available dependent on the 
complexity of the required report. The different forms presented by the wizard can include the 
following settings:  
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1. Regular Reporting Period 

In order to access a regular report period, select the appropriate period from the drop-down menu. 
The time periods are as follows: 

 Today: Reports on data received today. 

 Yesterday: Reports on data received yesterday. 

 This Week: Reports on data received from Monday of this week. 

 Last Week: Reports on data received between Monday and Sunday of the previous week. 

 This Month: Reports on data received from 1st to the current day of the month. 

 Last Month: Reports on data received from 1st to the last day of the previous month. 

 This Year: Reports on data received from 1st day to the current day of the year. 

 Last Year: Reports on data received from 1st to the last day of the previous month. 

 Last 7 Days: Reports on data received within the last 7 days.  

 Last 28 Days: Reports on data received within the last 28 days. 

 Last Defined Period: Reports on data received within the last period. 

 

2. Custom reporting Period 

The reporting period can also be customised to specify the Start/End date and times. Clicking on the 
Date displays a calendar control to make selection of Dates easier. 

 



Reporting 

  

 1510-002-010  Chapter 21-12   
 

3. Define Periods  

Certain reports allow the setting of up to two periods e.g. 9:00 – 12:00, 14:00 – 18:00. This allows you 
to include or exclude certain periods during the day e.g. Shift periods, Lunch breaks etc.  

4. Include Calls for the Following Day  

A series of check boxes allowing you to select which days of the week are included in the report. 

Limiting the Report Length 

You may specify the maximum number of records a report can contain or specify that you wish to see 
all records matching the criteria defined in the report configuration. To limit the number of items, 
simply type the number of desired items into the textbox. 

 

Ordering Results  

You can specify how you wish the results to be ordered in the report. Specifying ‘Time of call’, for 
instance, will display your results in order from the earliest time through to the latest time; 
alternatively, specifying ‘Duration’ would display calls from the shortest to the longest call. 

 

Grouping Results  

Grouping results allows you to specify which results need to be kept together in the report. The 
grouping options depend on the type of report being produced.  

Example: Grouping by Extension 

You wish to report on extensions showing the number of calls made by each extension within a certain 
group. Group by extension means that each extension will be shown with all the calls associated with 
that extension listed in a group below it.  

Extension 2462 is shown with two calls, 2471 has 1 call, 2578 has 2 calls and 2541 has 4 calls. Calls are 
ordered by ascending ‘time of call’ (earliest first). 

Types of Grouping Screens Found in The Reporting Wizard 

Different report templates provide varying levels of grouping complexity or format, dependent on the 
type of report. The simplest type of grouping comprises a drop-down menu of device types. More 
complex reports allow you to select the device and select groups and types of device. 
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Grouping in ‘Call Detail’ Reports 

The simplest type of grouping allows you to select the grouping item from a drop-down menu. 

 

Grouping in ‘Group Summary’ Reports 

More advanced grouping gives you the option to select a group of devices, Extensions, DIDs etc. and 
then pick from the list of groups defined for that device. If you select Pilot Numbers for example, then 
a list of the Pilot groups will appear, from which you may select one or more for grouping purposes. 

 

Filtering Results 

The initial filter screen will allow you to specify groups of devices or data that you wish to filter on. 
Once this has been completed, you will then be presented with a series of screens which allow you to 
specify detailed filtering information.  

Setting the Filter Groups 

To ensure the reports you are configuring only produce the information you require, you will need to 
apply filters to the results. Filters allow only the specified information to be processed in the final 
report. 

For example, you may want to produce a report grouped by class of call i.e. incoming, outgoing etc. 
but only detailing the calls to and from the sales department. To accomplish this, you would require a 
call detail report specifying the class of call i.e. Incoming, Outgoing etc., as the grouping field but 
applying an extension group filter and selecting the sales group in the filter details. 

Setting Filters is a Two-Stage Process 

1. Specify which devices, users, call types etc. you wish to apply filters to. 
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2. Select the detailed information for each of the types of filtering selected in Stage 1. Each of 
the device filters defined in the first stage will cause a detail filter screen to be displayed. This 
detailed screen will appear as part of the sequence of screens for configuring the report and 
will present you with the detailed information relating to that device. For example, the 
screenshot shown below illustrates the detailed selections for extension devices. 

 
The detailed filter screens are similar in operation. You choose which groups of device to include in 
the report and/or individual devices to include in the report. So in the example above you could 
include a complete group or a single extension. Any items not included in the filter are excluded from 
the report. 

Deleted Devices 

The option to include deleted devices enables correct reporting of historical data, in the event that a 
report is required for some period in the past and devices had been deleted since then. 

Including an Individual Device 

With reference to the screenshot above, type a part of the extension you wish to include until you can 
locate the extension(s) required from the individual extension list. Select the extension(s) required 
and click the ‘Add’ button. The extensions to be included in the report will appear in the right-hand 
‘Included Extensions’ box. Click the ‘Remove’ button to remove the extensions if they are not required. 

Specifying Call Types to Include in a Report 

Many of the report templates allow you to specify call types for inclusion in the reports. This means 
you can analyse only Incoming call types or only Outgoing call types, or even down to specific types of 
call such as Incoming Abandoned, Outgoing Transferred etc.  

For more detail on available call types see the detailed list in Appendix A. 
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You can select the call types from the list of ‘Call Types to Include’. This list includes a breakdown of 
all the possible call types available, or you can simplify the list by deselecting the ‘Show Advanced call 
types’ checkbox. 

Alternatively, you can select the three basic call types; Incoming, Outgoing and Internal by checking 
the appropriate ‘Call Type Group’ checkbox. 

 

Configuring the Call Types for Comparison 

When configuring reports which compare call types for specified intervals (see next section), you are 
asked to provide call type information for two sets of call types. This is exactly the same procedure as 
for defining call types described above (see ‘Specifying Call types to include in a report’), with the 
additional requirement to select two sets of call types. Typically, you might want to compare incoming 
versus incoming abandoned or incoming versus outgoing.  

 

The available MyCalls usage reports include: 

 Detail and summary reports 

 Time distribution and profiling  

 Frequent calls 

 Top Calls 

 Trunk Utilisation 

 Custom reports 

Availability Reports  

The following sections describe the specific report templates and any special report specific 
configuration screen. 

User Availability 

Displays a summary of number of times and average time spent in various states: 

 Logins  

 On-Call 

 Wrap  
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 Unavailable 

 DND 

  

User Availability - Detail  

This report provides a more detailed chronological report of the various states of availability on a 
per-user basis. 

 

This report shows a profile of various availability states at defined time intervals. Time intervals can 
be set to multiples of the following: 

 Minute 

 Hour 

 Day 

 Week 
 

The example screenshot has a reporting period limited to the hours of 09:00 – 18:00 with a time 
interval of 1 hour. If the reporting period was set to the whole 24 hours then the out-of-hours results 
(16:00 – 09:00) would show zeroes, which would be unnecessary for the report. 
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Performance Reports 

Grade of Service Group Detail  

This report shows a breakdown of the percentage of groups which met or exceeded target grade of 
service for duration and abandoned calls in half hour intervals throughout the reporting period.  

 

 

Grade of Service Group Summary 

This report shows a summary of the percentage of groups which met or exceeded target grade of 
service for duration and abandoned calls. 

 

Response Times 

Lists for each extension the number of answered calls, abandoned calls and a relative percentage of 
how each extension response time compares with the rest of the group. 
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System Reports  

Alarms Raised 

A list of Alarms raised during the reporting period, can be filtered by PBX and Organisation/User. 

The Organisation/User filter will filter alarms where specific supervisors have been associated with 
specific alarms. 

 

Auto Configured Devices 

A report showing any devices automatically configured during the reporting period. 

 

System Audit  

This report shows a record of system audit entries for the duration of the reporting period. Audits are 
generated by the system when an event occurs such as starting or stopping of a service. 

  

Unused or Infrequently Used Devices 

Allows you to keep track of devices which are infrequently used.  
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Usage Reports  

Detail and Summary Reports  

Call detail and Group summary reports produce individual detailed statistics or cumulative statistics 
for calls over a defined reporting period. The standard reports can be grouped and filtered to give 
whatever calls or subsets of calls you require. 

Call Detail reports give a breakdown of individual calls grouped by device or user and filtered as 
required. 

 

Group Summary reports show cumulative information on device groups or user groups by call type 
and filtered as required. 

 

Group Summary by Member shows cumulative call information for each member of a group or groups 
and filtered as required.                     

 

How to: Configure a Call Details or Group S ummary Report 

1) Select the report item or template. 

2) Configure the reporting period. 

3) Configure the grouping and ordering settings according to the specific report being configured.  

4) Configure the filtering settings. 

5) ‘Save’ and run the report. 

Call detail reports show the following statistics: 

 Time of call 

 User 

 Call type 
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 Total Duration* 

 TFR** 

 Caller Name 

 Dialled Number 

 Location 

 Ring time 

 Handling cost 

 Call cost 

 Total cost 

*Total Duration shows duration of each leg of a transferred call. If transfers are consolidated, then this 
indicates the cumulative total of all transfers for that call. 

**TFR indicates the leg of the transferred call where the initial leg of the call is TFR=1. If the transfers 
are consolidated, then this column indicates the count of transfer legs. 

Group Summary reports show the following statistics : 

 Number of calls: Answered, Abandoned, Outgoing, Transferred 

 Average Duration: Answered, Outgoing 

 Average Ring time: Answered, Abandoned 

 Number of Long waits 

 Number of long calls 

 Number of short calls 

 Costs: Call costs, Taxes, Fixed costs, Handling costs, Total costs, Profit 

Reports Involving Time Intervals and P rofiles 

Several report templates have been specifically designed to provide statistics broken down and 
analysed in definable time periods. 

There are three basic report templates which do this:  

 Summary Time Distribution 

 Summary over same time interval 

 Summary comparison 

Time Intervals vs Reporting Period 

The reports for time distribution, time interval and profile require two distinct settings related to time 
intervals. 

The reporting period: Defines the start and end date during which the data for the report was 
recorded. For example, we may want to view a report for the month of August or for the past six 
months or for the past two days. These are all reporting periods and they are configured as the first 
part of the report wizard, as described in the relevant section above. 

The statistical interval(s): describe the intervals of time over which the summarized results are 
calculated. An example might be where we show a breakdown of incoming calls for each day for the 
month of August. The statistical interval would therefore be ‘Daily’, whereas the reporting period 
would be 1st to 30th of August. 

More specific detail on the interval periods employed are explained in the following sections which 
describe the configuration of each type of report.  
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Call Summary Over Same Interval  

This report gives a comparison of two call types. The example here shows Incoming and Incoming 
Abandoned for the same period split up into day of week totals. The reporting period is over 1 month 
so the totals for each ‘Monday’ represent a total of all calls received on all Mondays during the 
reporting period. 

 

Configuring the call types and interval periods requires you to select two sets of call types. Each set of 
call types can have more than one call type selected, but the resulting totals will add all values for the 
selected call types into one total e.g. if you select incoming and incoming transferred these calls will 
be added together to produce a single total value for the call-type-set. 

The Interval period e.g. Day of Week is selected from a drop-down menu during configuration of the 
report and includes: 

 Minute of Hour: 1-60 

 Half Hour of Day:  00:00 – 00:30, 00:30 – 01:00 etc. 

 Hour of Day: 0-1, 1-2, 2-3 etc. 

 Day of Week:  Mon, Tue, Wed etc. 

 Day of Month:  1-31 etc. 

 Day of Year:   1-365 (6) 

 Week of Year: 1-52 

 Month of Year:  1-12 

 

Selecting the call-type sets and Interval 

Ordering The Results 

 
Setting the order of results 
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Ordering of the resulting report can be adjusted by selecting one of the order by values. This means 
that the results are no longer determined by the time interval but by the field specified in the group 
by box. This can result in confusing results if you are not aware of the purpose for the ordering. If you 
were to select ‘Number from First Call Type’ as the order by column and ‘Day of week’ as the interval, 
then the first result in the report will be the day of week with the most calls recorded. This means that 
the days of the week will probably appear out of order as example below. 

  

Call Summary Time Distribution Report  

In many cases, you may have a set of markers which define what the minimum, maximum and 
optimum times are for ring time, held time and duration of calls. You may wish to analyse how many 
of your calls fall inside and outside these time slots. You can use the ‘Time Distribution’ report to do 
just that. 

The Time Distribution report allows you to define a set of time slots starting at a particular value e.g. 
10 seconds and repeating up to a final value e.g. 60 seconds at 5 second intervals. This would give you 
time slots as follows: 

10-15 seconds 

16-20 seconds 

21-25 Seconds 

26-30 seconds  

And so on up to 60 seconds 

This report will then tell you how many calls over a given reporting period fall into each of these time 
slots. Obviously this allows you to determine what our current operating times are and if we are 
operating in the target times. If not, then you can use other reporting tools to determine if your target 
times are realistic or not. 

 



Reporting 

  

 1510-002-010  Chapter 21-23   
 

To set up the above report, we would set the configuration shown. 

 

Call Type Summary Comparison 

This report allows comparison of two different call types at regular intervals. The intervals can be 
multiples of: 

 Minute 

 Hour 

 Day 

 Week 

The report collates statistics for the specified intervals for the duration of the reporting period.  

 

Configuration requires you to set the Interval Count and the Interval Value. For example, an interval 
count of 4 and an interval setting of Hour will give a report statistic calculated every 4 hours. 

Ordering can be based on: 

 The specified interval (Default) 

 Number from 1st or 2nd call type 

 Maximum ring from 1st or 2nd call type 

 Maximum Duration from the 1st or 2nd call type 

 Average duration from 1st or 2nd call type 
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Group Summary Time Profile 

This report gives a group summary presented at specified time intervals. The time interval settings are 
specified as the Interval Count and the Interval Value (as per the previous ‘call type summary 
comparison’ report). 

The difference with this report is that you specify a group of devices to report against, as shown below. 

 

 

Special Usage Reports  

Director ’s Report 

This report gives a general summary of call activity for Daily, Weekly and Monthly periods.  

How to: Create a Director’s Report  

1) Select the ‘Reports’ option from the configure menu or click the  icon on the toolbar. 

2) Select ‘Report Templates’. 

3) Expand ‘Usage’ and select ‘Director’s Report’.  

4) Click ‘Configure and Run Now’.  
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5) Configure the reporting period, i.e. regular or customised.  

6) Click ‘Finish’. 

The report includes the Number of Calls, Average Duration and Average Ring Time statistics along with 
the Longest Waiting periods for Incoming and Incoming Abandoned calls, as well as the Most 
Expensive Call made during the period. 

  

Playback Audit 
This report will provide a list of playback activity audits over a given reporting period.  
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The report is configured using the wizard screen above. 

 Included Organisation Groups: Define the groups of users you wish to see the audits for. 

 Include sub-groups of Selected Groups: Includes all users belonging to sub groups of the 
groups you have selected. 

 Group According to: Results can be grouped together based on either the user who performed 
the operation or the user whose calls were listened to or exported. 

You can define the type of audits to be included by selecting the appropriate checkbox. 

There is also an option to eliminate calls which were listened to for less than a specified amount of 
time which can be expressed as a percentage of the call length or as an absolute time in hours, minutes 
and seconds. 

  

Trunk Utilisation Report 

Provides statistics on trunk utilisation over specified time intervals during the reporting period. 

Statistics displayed are: 

 Interval Period: set in the configuration. 

 Maximum Trunks: Maximum number of trunks used at any one time during the interval. 

 First Time at Maximum: When the maximum number of trunks was first reached. 

 Total Duration: Total call duration across all trunks included in the report. 

 % Utilisation: Percentage usage of trunks for the interval versus total trunks. 
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Most Frequent Calls 

Gives details of which numbers have been handled most frequently for both incoming and outgoing. 

You can specify a minimum number of calls before a number is included in the report. 

 

Statistics for these calls in the report are: 

 Caller Name 

 Call type 

 Number 

 Location 

 Amount 

 Total duration of calls to and from that number 

 Cost and total cost of calls to that number 

  

Top Calls  

Provides information listing the calls with Duration, held time or Ring time greater than a defined value 
or calls with a call cost or handling cost of greater than a defined value. 
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Statistics for these calls in the report are: 

 Time of call 

 PBX 

 Extension 

 User 

 Duration 

 Dialled Number 

 Location 

 Ring Time 

 Call Cost 

 Handling Cost 

 Total Cost 

 

Customer Specific  Reports  

What is a Custom Specific Report? 

A customer specific report allows you to specify precisely what information you want to include in the 
report fields. For example, if you require a report which does not show costing information in a call 
details report then a customer specific report can be configured to accomplish that. 

The majority of the configuration process for customer specific reports follows the standard report 
template for that type of report. There are customer specific reports available for the following 
template types:  

 Custom Call Details 

 Custom Group Summary   

 Custom Group Summary for each Member 

 Custom Group Summary Profile 

Where a customer specific report differs is in the choice of fields which can be shown.  
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How to: Create a Customer specific report  

1) Create a report item based on the customer specific report template required. 

2) Configure the reporting period. 

3) Configure the Device Groups and devices. 

4) Configure the unavailable codes if required – The example screen shows the configuration for 
the Group Summary customer specific report. 

 

5) Click on the ‘Available information’ button and Specify your custom fields using the menus and 
submenus, click on the required fields to add them to the report. 

 

6) Drag the columns to define their order from left to right on the report.  

7) If you wish you can preview the report at this time by clicking the ‘Preview Report’ button. You 
will see a resulting report which shows the columns configured but the data will not be accurate. 

8) Complete the configuration of the rest of the report i.e. Filtering, Transfer consolidation and call 
types. 

9) Save the report item. 

Customer specific report  Parameters 

Customer specific reports, by definition, can contain a very wide range of parameters in the various 
report columns. Depending on the purpose of the report you will select parameters from one or more 
main categories. The actual parameters available for your customer specific report will differ 
depending on the customer specific report template you have chosen to base your report on. 
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Parameters can be selected from the ‘Available Information’ option in the customer specific report 
configuration wizard. 

 

The following is a summary of the various report parameters. A detailed definition of each parameter 
is to be found at the end of this section. 

Customer specific report  Parameters Fall into The Following Main Categories 

For custom summary reports: 

 Call Durations 

 Costs 

 Call Counts 

 Call Count Percentages 

 Users 

 Performance 
 

For custom detail reports: 

 General 

 Trunks 

 Extension 

 DIDs 

 Pilot numbers 

 Account codes 

 Callers 

 Costs 

 Times 

 Completion Codes 
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Custom Summary Reports - Call  Durations 

Call durations show you how long a specific type of call or how long a particular phase of a call has 
taken.  

Call Durations -  General  

The call durations are broken down into: 

 Absolute Durations: e.g. a call lasted 10 minutes or the longest call for a given extension 
lasted 25 minutes.  

 Average Durations: e.g. the average incoming call lasted 5 minutes. 

 Ranges of Durations: Minimum, Maximum etc. 

The values available are: 

 Abandoned ring 

 Average abandoned ring 

 Average held 

 Average incoming 

 Average incoming + outgoing 

 Average incoming ring 

 Average outgoing 

 Average ring no answer ring time 

 Held 

 Incoming 

 Incoming + outgoing 

 Incoming ring 

 Longest abandoned ring 

 Longest incoming ring 

 Longest ring no answer ring time 

 Max call time 

 Min abandoned ring 

 Min incoming ring 

 Min ring no answer time 

 Outgoing 

 Ring no answer time 

Call Durations -  Time to Answer  

Gives the ‘Time to Answer’ a specific percentage of calls e.g. how long did it take to answer 50% of 
calls. 

Custom Summary Reports - Costs 

General 

 Call costs 

 Fixed Costs 

 Handling costs 

 Max incoming call 

 Max incoming handling 

 Max outgoing call 
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 Max outgoing handling 

 Overall cost 

 Profit 

 Taxes 

 Total incoming call 

 Total incoming handling 

 Total outgoing call 

 Total outgoing handling 

Category Counts, Category Totals, Category Averages 

 Free 

 In state 

 Incoming 

 International 

 Local 

 Local toll 

 Long distance 

 Mobile 

 National 

 National (Generic) 

 Not defined 

 Special 

 Unknown 

Custom Summary Reports - Call  Counts 

Call counts for different types of calls as follows: 

 Abandoned Incoming 

 Abandoned Outgoing 

 Handled 

 Held 

 Incoming 

 Incoming + outgoing 

 Incoming conference 

 Incoming intraflow 

 Incoming network 

 Incoming overflow 

 Long calls 

 Long waits 

 Offered 

 Outgoing 

 Outgoing conference 

 Outgoing network 

 Picked up 

 Ring no answer 

 Short calls 

 Transfer count 
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Ring Distributions  

Call count ring distributions provide a way of reporting how many calls were answered in specific time 
ranges e.g. how many calls were answered inside 6 – 10 seconds as opposed to 11-15 seconds. There 
are two distributions: 

 Incoming ring times: Calls which were answered. 

 Abandoned ring times: Calls which were abandoned. 

Custom Summary Reports - Call  Count Percentages 

Call count percentage values show how many calls rang up to a specific time and how many calls rang 
over a specific time. You have a choice of Incoming calls and Abandoned calls e.g. how many calls rang 
for up to 20 seconds? 

Call count percentage ring distributions split the call count percentages into time intervals as follows: 

 Below 5 seconds 

 5-10 seconds 

 6-10 seconds 

 11-15 seconds 

 And every 5 second interval up to 60 seconds 

 Over 60 seconds 

This allows analysis of the percentage of incoming and abandoned ring times falling into a given time 
interval. 

Custom Summary Reports - (ACD) Users 

A series of ACD related parameters.  

Percentage (%) values, Total Values or Average values for: 

 Time busy 

 Time DND 

 Time Free 

 Time Unavailable 

 Time Wrapup 

Login information: 

 First login time 

 Last login time 

 Logged in max 

 Logged in min 

 Number of logins 
 

Custom Summary Reports - Performance 

 Abandoned Grade of Service 

 Grade of Service 
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Custom Detailed Reports –  General  

Various parameters for which usage can be calculated. 

 Call ID 

 Call type 

 Costing type 

 Grouping details 

 Least cost routing digits 

 Location name 

 Location state 

 Long call 

 Long wait 

 PBX code 

 Short call 

 Telephone number 

 Time of call 

 Total transfers 

 Transfers to this part of the call 

 User name 

Custom Detailed Reports –  Trunks 

Values relating to the trunk usage. 

 Destination trunk name 

 Destination trunk number 

 Source trunk name 

 Source trunk number 

 Trunk name 

 Trunk number 

Custom Detailed Reports –  Extension 

Values relating to the extension usage. 

 Destination extension name 

 Destination extension number 

 Source extension name 

 Source extension number 

 Extension name 

 Extension number 

Custom Detailed Reports –  DIDs,  Pilot Numbers, Account Codes,  Callers  

Values for these various devices. 

 Name 

 Number 
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Custom Detailed Reports –  Costs 

 Call costs 

 Handling costs 

 Overall costs 

 Profit 

 Taxes 

 Total call cost 

Custom Detailed Reports -  Times 

 Held time 

 Ring time 

 Talk time 

 Total duration 

Custom Detailed Reports –  Completion Codes 

 Completion Code level 1 

 Completion Code level 2 

 Completion Code level 3 

Report Distribution List  

What is a Report Distribution List?  

Report Distribution Lists are the way by which a Report Schedule sends its results to the outside world. 
You can send the results via emails and FTP servers. You can also send the results to a specified folder 
location. 

How to: Create a Report Distribution List 

1) Select the ‘Reports’ option from the configure menu or click the  icon on the toolbar. 

2) Select ‘Report Distribution Lists’.  

3) Click ‘Create a New Report Distribution’. 

4) In the window that appears enter a name and click ‘Next’. 

5) Specify which email addresses the reports will be sent to, click ‘Next’. 

6) Specify whether to send the reports to the system FTP server, click ‘Next’. 

7) Select a folder on the server (a network path) where a file containing the report may be stored. 

8) Click ‘Finish’. 

How to: Edit Configuration of a Report Distribution List  

1) Select the ‘Reports’ option from the configure menu or click the  icon on the toolbar. 

2) Expand ‘Report Distribution Lists’.  
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3) Select the applicable report template. 

4) Click ‘Edit Report Distribution List Configuration’.  

5) A new window will open where you can change the settings. Click ‘Next’ to navigate through and 
click ‘Finish’ when you have made the changes. 

How to: Delete a Report Distribution List  

1) Select the ‘Reports’ option from the configure menu or click the  icon on the toolbar. 

2) Expand ‘Report Distribution Lists’. 

3) Select the applicable report template. 

4) Click ‘Delete Report Distribution List’. 

5) Click ‘Yes’. The report will have been deleted.  
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Drill Down Reports  

What is Drill  Down? 

Drill Down is the term used to describe the way a new report can be run from an original report 
using most of the filtering from the original report, plus some additional filtering depending upon 
where in the original report the drill down took place. 
There are various parts of this report that drilldown is available from. All drill down reports would 
inherit the original report’s reporting period and device type filtering. 

On some reports there is a summary section that appears similar to below. 

 

This section of the report summarises the entire report. Drill down is available on any of the values.  
Inc, Abd, Out values drill down to a call details report filtered to the appropriate call type. 
Max and Min values drill down to a call details report filtered to the appropriate time duration. 
Ave values drill down to a call details report containing the calls that made up that average value. 
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Call Details/Custom Call Details Reports 

The only drilldown available for these reports is drill down from the summary section of the report 
as described above. 

Group Summary/Custom Group Summary Reports 

 

If the clock icon at the left hand side of a row was clicked on, then a Group Summary Profile report 
would be run using the original reporting period. It would be filtered to one of the groups ‘All 
Extension Types’ or ‘Sales’, in this case, and the profile period would be appropriate to the original 
reporting period. 
For example if the original report was run over a year, then the profile would be months. If it was 
months it would be weeks, if it was weeks it would be days etc. 

If the group name was clicked on, then a Group Member Summary report would be run for that 
particular group. In the example give it would produce a report for one of the extension groups ‘All 
Extension Types’ or ‘Sales’ using the original reporting period. 

If the numbers under the headings Inc/Abd/Out/Tfr are clicked then a calls details report will be run 
for the original reporting period filtered to the call type appropriate to the number that was clicked 
on. In the example above, if the number ‘100’ was clicked on, then a call details report filtered to 
extension group ‘All Extension Types’ and incoming calls only would be run. 

Drill down is also available from the charts. 

If any of the bars are clicked then a details report with appropriate filtering will be produced. For 
example if the section 

 

is clicked, then a details report for the original reporting period, filtered to extension group ‘All 
Extensions’ and with a ring time time filter of 0 to 5 seconds will be produced. 

If a pie chart section is clicked then a details report appropriate to whatever that pie section relates 
to is produced. In the example above, clicking on the green section would produce a details report 
for the original reporting period filtered to incoming calls only. 
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Group Member Summary/Custom Group Member Summary Reports 

 

If the clock icon at the left hand side of a row was clicked on, then a Group Summary Profile report 
would be run using the original reporting period. It would be filtered to one of the group members 
‘Martin’ or ‘Andy’, in this case, and the profile period would be appropriate to the original reporting 
period. 
For example if the original report was run over a year, then the profile would be months. If it was 
months it would be weeks, if it was weeks it would be days etc. 

If the group member name was clicked on, then a Call Details report would be run for that particular 
group member. In the example give it would produce a report for one of the group members 
‘Martin’ or ‘Andy’ using the original reporting period. 

If the numbers under the headings Inc/Abd/Out/Tfr are clicked then a calls details report will be run 
for the original reporting period filtered to the call type appropriate to the number that was clicked 
on. In the example above, if the number ‘9’ was clicked on, then a call details report filtered to 
extension ‘Martin’ and incoming calls only would be run. 

Drill down is also available from the charts. 

If any of the bars are clicked then a details report with appropriate filtering will be produced. For 
example if the section 

 

is clicked, then a details report for the original reporting period, filtered to extension ‘Andy’ and with 
a ring time time filter of 0 to 5 seconds will be produced. 

If a pie chart section is clicked then a details report appropriate to whatever that pie section relates 
to is produced. In the example above, clicking on the green section would produce a details report 
for the original reporting period filtered to incoming calls only. 
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Group Summary Profile/ Custom Group Summary Profile Reports 

 

If the clock icon at the left hand side of a row was clicked on, then a Group Summary Profile report 
would be run using the original reporting period. It would be filtered to the group specified in the 
header of of the section the row was a member of. In the example above this would be group ‘All 
Extension Types’ , and the profile period would be appropriate to the reporting period specified in 
the selected row. For example if the selected row specified a week (as above) , then the profile 
would be days. If it was days it would be hours etc. 

If the numbers under the headings Inc/Abd/Out/Tfr are clicked then a calls details report will be run 
for the reporting period specified for the selected row and to to the call type appropriate to the 
number that was clicked on. In the example above, if the number ‘22’ was clicked on, then a call 
details report for time period 08/02/2017 to 15/02/2017, filtered to extension ‘Martin’ and incoming 
calls only would be run. 

Drill down is also available from the charts. 

If any of the bars are clicked then a details report with appropriate filtering will be produced. For 
example if the section 

 

is clicked, then a details report for the reporting period 22/02/2017 to 01/03/2017, filtered to 
extension group ‘All Extension Types’ and with a ring time time filter of 0 to 5 seconds will be 
produced. 

If a pie chart section is clicked then a details report appropriate to whatever that pie section relates 
to is produced. In the example above, clicking on the green section would produce a details report 
for the original reporting period filtered to incoming calls only. 
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Trunk Utilisation Report 

 

The example shows the trunk utilisation over a month profiled by week. Drill down is available from 
the date ranges or the chart. Either will drill down to a trunk utilisation report with a reporting 
period of wherever the drill down was done from. The profile interval will be appropriate to the 
reporting period. A monthly reporting period by week will drill down to a weekly reportig period by 
day and that would drill down to a daily reporting period by hour etc. 
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User Availability Report 

 

If the clock icon at the left hand side of the row is clicked, then a User Availabilty Profile report for 
the original reporting period filtered to the selected user will be produced. It will have a profile 
interval appropriate to the original reporting period. If the original reporting period was a month, 
then the profile interval would be a week. If the original eporting period was a week it would be a 
day etc. 

If the users name is clicked, then a User Availability Detail report for the original reporting period, 
filtered to the selected user will be produced. 

If the call based values are clicked on then a details report for the original reporting period filtered to 
the selected user will be produced. The same applies if the call based chart is clicked. 

If the Logins/Wrapup/Unavailable/DND values are clicked then a User Availability Detail report for 
the original reporting period, filtered to the selected user and the selected activity type will be 
produced. The same applies to the user based charts. 
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User Availability Profile Report 

 

If one of the time periods in the main body of the report is clicked, another User Availability Profile 
Report for the period specified in the selected row will be produced. It will have a profile interval 
appropriate the to reporting period selected. If the reporting period in the selected row is months, 
then the profile interval in the drill down report will be weeks. If the reporting period is weeks, then 
the profile period will be days etc. 

If the call based values are clicked on then a details report for the selected row reporting period 
filtered to the selected cll type will be produced. The same applies if the call based chart is clicked. 

If the Logins/Wrapup/Unavailable/DND values are clicked then a User Availability Detail report for 
the select row reporting period, filtered to the selected activity type will be produced. The same 
applies to the user based charts. 
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Grade of Service Group Summary Report 

 

If any of the report fields are clicked on, then a Grade of Service Group Detail report is produced for 
the selected PBX/Group 

Response Times Report 

 

If the PBX or Extension fields are clicked on a call details report for the original reporting period 
filtered to the selected PBX and Extension is produced. 

If the any of the answered fields are clicked on a call details report for the original reporting period 
filtered to the selected PBX and Extension and incoming calls is produced. 

If the any of the abandoned fields are clicked on a call details report for the original reporting period 
filtered to the selected PBX and Extension and abandoned calls is produced. 

Call Summary Time Distribution Report 

 

If the interval period is clicked on, a call details report for the original report period, including the call 
types that are shown in two columns, filtered to either the call duration or ring duration (whichever 
was specified when the original report was run) being within the selected interval period. 

If either of the call type columns is clicked on, a call details report for the original report period, 
including the call types that is shown in the selected column, filtered to either the call duration or 
ring duration (whichever was specified when the original report was run) being within the selected 
interval period. 
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Call Type Summary Comparison Report 

 

If the interval period is clicked on, a call details report for that period, including the call types shown 
in the two columns is produced. 

If the number of calls in either of the columns is clicked on, a call details report for that period, 
including the call types shown in the selected column is produced. 

If the max ring time in either of the columns is clicked on, a call details report for that period, 
including the call types shown in the selected column, filtered to a ring time of that clicked on is 
produced. 

If the max duration in either of the columns is clicked on, a call details report for that period, 
including the call types shown in the selected column, filtered to a duration of that clicked on is 
produced. 

If Avg Ring time or Avg Duration in either of the columns is clicked on, a call details report for that 
period, including the call types shown in the selected column is produced. 
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Directors Report 

 

If any of the Numbers of Calls fields are clicked, a call details report for the original report period 
filtered to the selected call type is produced. 

If any of the Average Duration or Average Ring Time fields are clicked, a call details report for the 
original report period filtered to the selected call type is produced. 

If any of the fields for the Longest Waiting Incoming Call are clicked, a call details report showing 
that particular call is produced. 

If any of the fields for the Longest Waiting Abandoned Call are clicked, a call details report showing 
that particular call is produced. 

If any of the fields for the Most Expensive Call are clicked, a call details report showing that 
particular call is produced. 

Frequent Numbers Report 

 

If any fields on a particular row are clicked, a call details report for the original report period, filtered 
to the Dialled number on the selected row will be produced. 

Top Calls Report 

The only drilldown available for this reports is drill down from the summary section of the report as 
described above. 

Unreturned Abandoned Calls Report 

 

If the Calls field is clicked an Unreturned Abandoned Calls Report showing all the unreturned 
abandoned calls is produced. 

If the Min Ring or Max Ring fields are clicked an Unreturned Abandoned Calls Report showing all the 
unreturned abandoned calls that had the ring time that was selected is produced. 

If the Ave Rings field is clicked an Unreturned Abandoned Calls Report showing all the unreturned 
abandoned calls is produced. 
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Drill  Down Templates 

From the above section it is clear that reports can be drilled down to several different types. These 
types are: 

Call Details 

Group Summary for each Member 

Group Summary Time Profile 

Custom Call Details 

Custom Group Summary for each Member 

Custom Group Summary Profile 

User Availability Detail 

User Availability 

User Availability Profile 

Trunk Utilisation 

 
It is possible to modify the default drill down templates or to create further copies of them that can 
be modified in different ways. 

This can be useful because it allows drill down report to show different sets of charts or, in the case 
of the custom reports, a different set of report data altogether. 

How to: Create a New Drill Down Report Template 

1) Select the ‘Reports’ option from the configure menu or click the  icon on the toolbar. 

2) Expand ‘Report Templates’.  

3) Expand ‘Drill Down’ and click on the applicable report template. 

4) Select ‘Copy Drill Down Report Template’.  

5) In the window that appears enter a name and click ‘OK’. 

6) Configure the template appropriately. Note that the report period and device type selection are 
not present as that information is passed down to the drill down report from its parent. 

7) Click ‘Finish’. 

 

How to: Edit a Drill Down Report Template 

1) Select the ‘Reports’ option from the configure menu or click the  icon on the toolbar. 

2) Expand ‘Report Templates’.  

3) Expand ‘Drill Down’ and select the applicable report template. 

4) Click ‘Edit Drill Down Report Template’.  
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5) A new window will open where you can change the settings. Click ‘Next’ to navigate through and 
click ‘Finish’ when you have made the changes. 

How to: Rename a Drill Down Report Template  

(not available for default Drill Down Templates)  

1) Select the ‘Reports’ option from the configure menu or click the  icon on the toolbar. 

2)  Expand ‘Report Templates’.  

3) Expand ‘Drill Down’ and select the applicable report template. 

4) Click ‘Rename Drill Down Report Template’.  

5) Enter a new report name. 

6) Click ‘OK’. 

How to: Delete a Drill Down Report  

(not available for default Drill Down Templates) 

1) Select the ‘Reports’ option from the configure menu or click the  icon on the toolbar. 

2) Expand ‘Report Templates’.  

3) Expand ‘Drill Down’ and select the applicable report template. 

4) Select the item you wish to delete. 

5) Click ‘Delete Drill Down Report Template’. 

6) Click ‘Yes’. The report will have been deleted. 

 

How to: Assign a Drill Down Report Template to a Report  

1) Select the ‘Reports’ option from the configure menu or click the  icon on the toolbar. 

2) Either expand ‘Report Templates’ and ‘Configure to Run Now’ a report template or expand 
‘Report Items’ and Edit it 

3) On one of the wizard pages a section for Drilldown Templates will be shown that will include 
some or all of the items below 

 

4) Select the appropriate drill down templates for the report. 
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5) Click ‘Finish’ when you have made the changes. 

Favourite Reports  

What is a Favourite Report?  

A favourite report is one that can quickly accessed from the menu bar of the main client 

 

The first ten of them can be accessed by the shortcuts Atl-0 to Alt-9. Any additional ones will need to 
be selected by using the mouse. 

How to: Select/De-Select Favourite Report Items 

1) Select the ‘Reports’ option from the configure menu or click the  icon on the toolbar. 

2) Select ‘Report Items’. 

3) Select a report item. 

4) In the right hand window, one of the the following will appear. 

   

5) If a gold star is showing then that report has already been selected as a favourite. If a silver star 
is showing then that report has not been selected as a favourite. 

6) Clicking the star will alternate the report from being a favourite to not being a favourite. 

How to: Manage Favourite Report Items  

1) Select the ‘Reports’ option from the configure menu or click the  icon on the toolbar. 

2) Select ‘Favourites’. 

3) Click Manage Favourite Report Items. 

4) In the dialog box that appears, existing report items can be added/removed from the favourites 
list and the order in which they appear in the main client can also be altered. 

5) Click ‘Finish’ when you have made the changes. 

If the report items are expanded it is very easy to see which have been selected as favourites, as 
they are all marked with a gold star. 
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Bespoke Report Templates 

What is a Bespoke Report Template? 

In some circumstances, the included reports templates may not exactly meet the customers needs.  
A Bespoke Report Template is one created by the customer that can combine various data sources 
into a single report which they can lay out to their specification. 
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How to: Create a new Bespoke Report Template 

1) Select the ‘Reports’ option from the configure menu or click the  icon on the toolbar. 

2) Select ‘Report Templates’. 

3) Select ‘Bespoke’. 

4) In the right hand window click ‘Edit Bespoke Report Templates’, the report editor will appear. 

5) Select ‘Open’ from the File menu. 

6) Select ‘Load from external file’. 

7) Click the ‘Browse’ button and select ‘SampleCustomReport.rdlx’. This loads up a report 
demonstrating how to access the configuration parameters that are passed through when a 
report is run. 

8) Modify the report accordingly. 

9) Select ‘Save’ from the File menu. 

10) Select ‘Save to database’. 

11) Enter a suitable name and description and click ‘OK’. 

12) The editor will close and the new report will appear under ‘Bespoke’ under ‘Report Templates’. 
 

How to: Edit an existing Bespoke Report Template  

1) Select the ‘Reports’ option from the configure menu or click the  icon on the toolbar. 

2) Select ‘Report Templates’. 

3) Select ‘Bespoke’. 

4) Select the relevant bespoke template. 

5) In the right hand window click ‘Edit Template’, the report editor will appear. 

6) Modify the report accordingly. 

7) Select ‘Save’ from the File menu. 

8) Select ‘Save to database’. 

9) The Template Author and description may still be modified. Click ‘OK’. 

10) The editor will close. 

How to: Delete an existing Bespoke Report Template  

1) Select the ‘Reports’ option from the configure menu or click the  icon on the toolbar. 

2) Select ‘Report Templates’. 

3) Select ‘Bespoke’. 

4) In the right hand window click ‘Delete Bespoke Report Templates’. 
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5) In the dialog box that appears, select the templates to be deleted. 

6) Click ‘OK’. 

 

Scheduled Reports 

What is a Scheduled Report?  

Report Schedules are the means by which a set of report items can be configured to be run 
automatically and sent to various destinations at a certain time. Note that you must have configured 
at least one Report Distribution List before you can configure any report schedules. 

How to: Create Scheduled Reports  

6) Select the ‘Reports’ option from the configure menu or click the  icon on the toolbar. 

7) Select ‘Report Schedules’. 

8) Click ‘Create a Report Schedule’. 

9) In the box that appears enter a name and click ‘Next’. 

10) In the next window you can schedule how often a task occurs from the drop down menu. 

11) Click ‘Next’. 

12) Select the report items to include by selecting them and clicking ‘Add’. 

13) Click ‘Next’. 

14) Specify the format in the next window. 

15) Click ‘Finish’. 

How to: Edit a Scheduled Report  

1) Select the ‘Reports’ option from the configure menu or click the  icon on the toolbar. 

2) Expand ‘Report Schedules’.  

3) Select the applicable report template. 

4) Click ‘Edit Report Schedule’.  

5) A new window will open where you can change the settings. Click ‘Next’ to navigate through and 
click ‘Finish’ when you have made the changes. 

How to: Delete a Scheduled Report  

1) Select the ‘Reports’ option from the configure menu or click the  icon on the toolbar. 

2) Expand ‘Report Schedules’.  

3) Select the applicable report template. 
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4) Click ‘Delete Report Schedule’. 

5) Click ‘Yes’. The report will have been deleted. 
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 Chapter 22 

System Utilities 

System configuration 

System configuration menu provides a selection of system related utility functions 

To access the menu, click ‘System’ and select the required function from the drop down list 

 Automatic Database Backup 

 Backup Database 

 Database Information 

 Remove Unwanted Information 

 Import Bill 

 Re-cost Calls 

 Import File 

 Area Code Import 

 Active Clients 

 Installed Clients 

Automatic Backup 

Create automated schedules for database backup. There are two databases which can be backed up 
Configuration and Calls. It is suggested that a regular backup of both databases is scheduled to 
eliminate problems if your system fails. 

How to: Automatic Backup 

1) Click ‘System’ 

2) Select ‘Automatic Backup’ 
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3) In the window that appears, you can alter the time of daily automatic backup along with how 
many days of historical copies to preserve. 

4) Optionally you can also back up the calls database, by clicking the option ‘Backup Calls’ 

5) Click ‘OK’ 

Manual Backup 

Alternatively, you can manually backup the databases 

How to: Back up the Database 

1) Click ‘System’ 

2) Select ‘Backup database’ 

 

3) In the window that appears, select the database that you want to back up and enter the file 
name to use for the backup. 

4) Optionally, you can provide a name and description for the backup: The filename MUST be a file 
local to this PC, backup CANNOT be made to network shares or UNC paths. 

5) Click ‘OK’ 

Database Information  

To access the database information, select ‘System’ and click ‘Database Information’ 

The window that appears provides all the information you need to know about the current state of 
your databases. 

 

Removing unwanted information  

You will from time to time need to remove information from the calls, alarms, audit entries, events 
or deleted devices lists. Deleted devices prevent those devices from being automatically 
reconfigured so be aware that removing them would allow the devices to automatically reconfigure.  
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How to: Remove unwanted information  

1) Click ‘System’ 

2) Select ‘Remove Unwanted Information’ 

 

3) In the window that appears, select the date and time range that you wish to delete the 
information up to and the select the types of information to delete, e.g. alarm entries, calls 

4) Also you can select whether to remove calls to all extensions or calls to specified extensions. 

5) Click ‘OK’ 

Removal of unwanted information will result in a new audit entry being created detailing the fact 
that information has been removed. This audit entry cannot be removed. 

Importing a Telephone bil l 

How to: Import a Telephone bill  

1) Click ‘System’ 

2) Select ‘Import Telephone Bill’ 

 

3) In the window that appears, you can import the calls that appear on an employee’s home 
telephone bill. To do this you must set up a template so MyCalls knows how to read the bill. 

4) Select the PBX, area code and phone number the bill is for 

5) After the bill has been processed, a list of calls will be presented for approval. 

6) If they are correct click the ‘Send to Database’ button 

7) Click ‘OK’ 
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Re-costing calls 

How to: Re-Cost calls  

1) Click ‘System’ 

2) Select ‘Re-cost Calls’ 

 

3) In the window that appears you can re-cost calls over a specified time period, you may want to 
do this if a mistake was made entering call tariffs, taxes or profit margins. You can do this by 
altering the start/ end date and time. 

4) Optionally, you can re-cost the actual call charges and/ or the handling charges by clicking the 
boxes. 

5) The taxes and profits will always be recalculated. 

6) Once you have altered the information click ‘Re-cost Calls’ 

7) Click ‘OK’ 

 

Area Code Import  

To import new area codes or change existing ones select the System -> Area Code Import option. 
This option will also allow you to modify the geographical coordinates for an area code if your 
country costs calls based on distance.  

Quick tip:  

Only countries that are not covered by the country code 01 (North America) and 44 (United 
Kingdom) can be imported or edited. 
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How to: Import Area Codes  

1) Click ‘System’ 

2) Select ‘Area Code Import’ 

 

3) In the window that appears Select the country you wish to import or change. 

4) Select Load from Database. The area codes for the selected country will be shown in the grid. 

5) Either select Import or Export the current area codes for the country. 

6) If exporting, then the file will be saved in a .CSV format, use an editor such as Notepad to make 
any changes. Use the import option to bring the new version back into the system. 

7) Click ‘OK’ the new area codes will be saved back to the database 

 

Quick tip:  

When upgrading the system to a different version, any changes you make to the area codes will 
need to be re-imported! 
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Chapter 23 

Importing Data into MyCalls  

Configuration data can be imported from a comma delimited file (CSV files). CSV files can be 
generated from programs such as excel spreadsheets. 

Import is supported for the following types of entity: 

 Account codes 

 DDIs  

 Extensions 

 Pilot numbers 

 Trunks 

 Callers 

 Users 

The steps required to import a set of values are very similar for all the various entities. Devices all 
share the same import format. Callers and users have different formats. 
 

Importing devices   

Device Import formats  

All devices follow the same format of Number, Name although Extension has some extra fields. This 
is easily produced in either a text editor or any application which creates CSV files such as Microsoft 
Excel. Simply enter the list of values and export the list as a CSV file. 

 

The following example shows the process for importing extensions. Extensions are the most complex 
device to import; other devices follow the same series of steps but with fewer items to specify. 
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How to: Import a set of Extensions  

1) Generate the CSV file (See formats below) 

2) Navigate to the respective configuration screen Configuration->Telephone system->PBX-
>Extensions 

3) Click the ‘Import Extensions’ option 

 

4) From the ‘Import’ screen use the ‘Browse’ button to select the file containing your extensions to 
be imported. 

5) If you are assigning all extensions as a specific type, then select it from the ‘type’ menu 

6) If you are importing these extensions to a specific extension group, then select that group from 
the ‘Import to extension group’ menu 

7) Clicking the ‘Create users for named extensions’ option creates organisational users for each 
extension (see section on organisation users) 

8) Click ‘Load’ 

9) The ‘Extensions to import’ grid will populate. You can now make final decisions as to which of 
these to import.  

10) To edit an entry, click on the field in the grid and simply type in the edited value 

11) To delete an extension, select the row and press your ‘delete’ key 

12) If you make a mistake or delete a row unintentionally simply click the ‘Load’ button to reload the 
file 

13) Once you are happy with your imported list click ‘OK’ 

14) Your extensions are now imported into the configuration 
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Importing Callers  

Callers are treated in the same way as devices (see example above). Simply load the CSV file and 
select the caller type to import. You can edit the loaded list prior to committing the import, in the 
same way as for devices. 

Callers’ CSV files have three fields, namely;  

 Number – Numeric no spaces,  

 Alternate Number – Numeric no spaces,  

 Name. 

Importing Users  

By setting up a user based import file you are able to configure most user and extension related 
information which makes configuration of MyCalls much easier than configuring everything 
manually. Users are imported into organisational groups. The field format for Users allows more 
values to be specified in addition to the User Name. 
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Group The organisation group that the user will belong to. If left blank, then the user 
will be added to the top level group. Groups will be created automatically and 
nested groups, such as Sales\Internal Sales will create two groups, one called 
Sales that is under the top level group and another called Internal Sales that is 
under the Sales group. 

Name The name of the user that you wish to add. Note that apostrophe's are not 
valid. 

Abbreviation The abbreviated form of the user’s name. 

Password Password the user will log on to the application with. 

Email Address Email address for the user 

Job Title Job title of the user in the organisation 

ACD Login PIN The number entered by the user onto the telephone to identify them when 
logging them in the ACD system. If ACD is not enabled or supported on your 
telephone system then leave this field blank. 

Default 
Extension 

The extension number this user will normally use. This will allow calls from the 
extension to be assigned to this user if ACD is not used or if hot desking clients 
from the application are not configured. 

Enable Call 
Playback 

Set to 'true' if this user is going to be allowed to listen to call recording. 
Otherwise set to 'false'. 

Enable Call 
Control 

Set to '1' if call control for this user is to be enabled, otherwise '0'. If call control 
is not available on your system or has not been purchased, leave this field blank. 

Enable User 
Hot Desking 

This is used to present the user with a list of extensions to use if they can hot 
desk when they run the application client. Set to 'true' if this user can to use 
other extensions for their work. If they will use the same extension, set this to 
'false'.  

Enable 
Extension Hot 
Desking 

This is used to specify if the extension created in the default extension can be 
used by multiple people in a hot desking environment or only by one person. 
Set to 'true' if the extension is to be made available for multiple users, 
otherwise set to 'false' 

User Type Specifies the role within the application that the user will adopt and the 
features available. Use one of the following values: '0' - User, '1' - Supervisor, '2' 
- PBX Administrator, '4' - Agent Call Control User, '5' - ACD Supervisor. 

Windows 
Login 

The username that user logs onto Window with. 

Auto Login If a Windows Login has been specified for the user, you can select whether or 
not they login to MyCalls as soon as they login to Windows. Set to 'true' if this is 
to happen. If not, set this to 'false'. 

Operator 
Console 

Set to ‘true’ if user should be enabled for the operator console. 
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How to: Importing Users 

1) From the organisation window (Configure->Organisation) select ‘organisation’ or one of the 
‘organisation groups’. If you have specified certain groups for the users to be added to that does 
not exist, the groups will be automatically configured upon import.  

2) Select ‘Import users’ 

 

3) Specify the file to import, load and import the users in the same way you load devices (see 
previous section) 

4) Edit the values if required and click ‘OK’ 

5) The data will be imported into MyCalls 

Example Files 

There is a sample file ‘import.xls’ which is preconfigured with several examples of import data and 
this file can be found in your MyCalls installation folder. 

Instant 
Messaging 

Set to ‘true’ if user should be enabled for instant messaging. 

Presence 

 

Set to ‘true’ if user should be enabled for presence. 

Calendar Sync Set to ‘true’ if should use Outlook calendar with presence. 

Stop/Start 
Recording 

Set to ‘true’ if user should be enabled for stop/start recording. 

Call Recording 
Override 

Set to ‘true’ if user should be enabled for manual stop/start recording. 
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Chapter 24 

Scheduled Configuration Import  

 

Scheduled configuration import allows you to apply certain aspects of the current PBX configuration 
to MyCalls such as extensions, trunks etc. The scheduling provides synchronisation at predefined 
intervals to keep all information within MyCalls as up to date as possible. Data is only read from the 
PBX to MyCalls changes made within MyCalls cannot be reflected back into the PBX.  

Parameters which can be imported  

The following parameters can be imported: 

 Account Codes 

 Callers (Abb Dial) 

 Carriers 

 DIDs  

 Extensions 

 Pilot Number 

 Service Codes 

 Skill Based Routing 

 Trunks 

For each of the above you can select the following options: 

Allow Import:  Allow information to be imported for that parameter. 
 
Allow Add: Allow new instanced of the parameter or device to be added to the existing list e.g. new 
extensions. 
 
Allow Update:  Allow updates to parameters within MyCalls to be updated if their values have 
changed within the PBX. 
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Allow Delete:  Allow instances of the parameters to be deleted from MyCalls if they have been 
deleted within the PBX. 
 
Allow Update Name:  Allow the name of the parameters to be updated. Any name changes made 
within MyCalls to devices such as extensions, will be lost if this option is enabled. 

Editing the Configuration Import Schedule  

Open the Configuration Import wizard by clicking ‘Configure ‘> ‘Telephone Systems ‘>’ PBXs' Select 
the required PBX e.g. ‘Head Office’ and select ‘Edit Configuration Import Schedule’ 

  

Check the ‘Enable Scheduled Import’ box 

   

Set the ‘Import Interval’ 

 

Check the boxes to suit your needs 

 

Once all information has been appropriately selected, click OK. 
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Chapter 25 

 

Instant Messenger 

Instant messaging offers a closed, real-time communication tool for individual users and 
administrative management of groups that exist within the organisation, allowing for enhanced 
collaboration.  

An example of a typical Instant Messaging screen that users will be faced with is shown below: 

 

To begin Instant messaging, users and organisational groups must be created. 

How to: Configure Organisational Structure and User Roles 

Click ‘Configure’ and then ‘Organisation’ OR use the shortcut located in the toolbar, as indicated by 
the red box: 

  

For more details, see the creating new groups and setting users section.  
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Assigning Correct User Roles  

 

User roles can be edited as well as deleted where necessary by Administrators.  

  

NB: When assigning a user role, selecting the ‘Instant Messaging’ tab and ticking the ‘Enable Instant 
Messaging’ box will allow the user to invite and participate in Chat. This feature is automatically 
disabled for all new users.   

Instant Messaging Preferences  

User Preferences enable individuals to change their Image from a file or the use of WebCam Capture. 

This Image will be used as the user’s personal Image, indicating to others when browsing users in the 

organisation who that particular user is. The chosen Image will show next to the user’s Name on the 

Chat preface. 

How to: Change a Personal User Image 

1) Click ‘Instant Messaging’ in the toolbar and select ‘Instant Messaging Preferences’. 

 

2) A ‘User Preferences’ box should appear like the one below: 
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3) If a user already has an Image saved, click ‘Browse’ and find the Image desired.  

OR 

4) If an Image does not exist of the user but a WebCam has been set up, simply make sure the user’s 
profile is in the WebCam Capture window and click ‘Capture’.  

NB:  Ideally the Image should be as square as possible, otherwise only the central square will be 
captured as the Image will be downsized to a thumbnail-scale icon.  

5) Alert sound on incoming messages can also be enabled or disabled as desired.  This feature is 
automatically enabled for all new users. 

6) Once all preferences have been completed, click ‘OK’. 

Chat Setup 

The user can now start Chat setup by clicking Instant Messaging in the toolbar and selecting ‘Start 
Chat’. 

 

 

 

Other users can be invited into conversations by browsing the organisation list, searching for a specific 

user name, looking through Recent Users or the Buddy List. 

All users in the organisation will have: a name, presence and show an Image icon making it easier to 

differentiate. Any users who do not appear Online cannot be Invited to Chat. 

How To: Invite to Chat Using Browse 

1) Select the Browse tab on the Invite dropdown menu (the book icon highlighted below). 

 

2) Scan through all other users of Instant Messaging in the organisation. 

3) Select the user(s) you wish to Invite. 

4) Click ‘Invite’. 
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How to: Invite to Chat Using Search 

If Chat Invitation is needed between another user that has not been contacted before, or is 
unknown to the user, there is a Search tab at hand.  

1)  Locate the Search tab under the Invite dropdown menu (the magnify glass icon highlighted 
below). 

 

3) Using the Search box, start to type the name of the required user. A list of names should appear. 

NB: The Invite feature has enable/disable for ‘Online only’ users on Search Results which is 
automatically enabled. Any users not Online cannot be Invited to Chat. 

3) Find the contact desired in the Search results. 

4) Select the user. 

5) Repeat steps 2-4 if other users need to be found. 

6) Click ‘Invite’.  

How to: Invite to Chat Using Recent Users  

Recent Users (i.e. other users which have been contacted by the user recently) can be selected and 
Invited again for a new Chat. 

1)  From the Invite dropdown menu, locate the Recent Users tab (the clock icon highlighted below). 

 

2) Select the user(s). 

3) Click ‘Invite’. 
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How to: Invite Groups to Chat  

Selected groups within the organisation can be invited to Chat. 

1)  From the Invite dropdown menu, locate the Browse tab (the book icon highlighted below). 

 

2) Select the desired group(s). 

3) Click ‘Invite’. 

How to: Invite to Chat Using the Buddy List 

Users can Invite other users onto their ‘Buddy List’, making it easier to select and invite desired users 
that need to be contacted on a regular basis.  

1) Locate the Buddy List tab under the Invite dropdown menu (the three silhouettes icon highlighted 
below). 

 

2) Select the user(s). 

3) Click ‘Invite’. 

Managing Buddy List: Adding a Buddy 

1) Click the ‘Manage Buddies’ link on the Invite dropdown menu. 

2) Select the user(s) from Available Users/ Groups. 

3) Click the ‘- >’ link to add the user(s) as a Buddy. 

4) Click ‘OK’. 

Managing Buddy List: Removing a Buddy 

1) Click the ‘Manage Buddies’ link on the Invite dropdown menu. 

2) Select the user(s) from Buddies. 

3) Click the ‘< - ‘to remove the user(s) from the list. 

4) Click ‘OK’. 
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How to: Accept a Chat Invitation  

1) A pop-up window will appear in the bottom-right of the screen, allowing the user to either Accept, 
Dismiss or Call this User from the Invitation (the telephone icon shown below): 

 

2) Click ‘Accept’ to start Chat with the user  

OR 

Click ‘Dismiss’ if the Chat is unwanted 

OR 

Click the telephone icon for a telephone call with the user. 

Chat Accepted: 

1) When the Chat Invitation has been Accepted, the user screen will leave a message telling the 
user(s) that they have joined the conversation: 

 

2) The Participants dropdown menu in the Chat box should now show the user(s) in the Chat and still 
allow the user to call the other user if required: 

 

3) Once the Chat Invitation has been Accepted, the conversation can begin. 
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How to: Start a Conversation and Use Chat  

1) The user should type the message they wish to send into the box containing the message ‘Type 
your message here...’ as shown below:  

 

2) Once the desired message is written out, click ‘Send’.

 

 3) When the other user is writing a reply to the user’s message, a keyboard icon above will appear 
above the ‘Type your message here...’ Chat box, with the name of the user and the message ‘is 
typing a Message’, as below:  

 

4) Users can also send out hyperlinks whilst in Chat, as shown below:  

 

NB: When written out, the hyperlink must contain: ://   

5) Multiple-line messages can also be created by pressing ‘Shift-Enter’ on the user’s keyboard, 
producing spacing as shown below:  

 

NB: A character limit can be reached when sending messages in Instant Messenger. There is also a 
limit to the amount of people within a set group (10 max.) allowing for minimal confusion and ease 
of use.   

6) If a user needs to leave a conversation, the other user(s) receives a message in Chat indicating 
that they have left, as shown below: 
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7) If the same user wishes to return to the Chat, the other user must send them another Invite. Once 
the Invite is Accepted, the user will be entered into the Chat once again, as shown below:  

 

8) A user may wish to change their Presence state when in Chat (i.e. If they are available or not, and 
if not how long they will not be available for). 

When a user is online and available to chat, the blue profile icon below will show in the Participants 
dropdown menu: 

 

Broadcasting Messages  

Users can broadcast a message to one or more users, without needing a reply (e.g. for sending out 
deadline targets). 

How to: Broadcast a Message 

1) Click Instant Messaging in the toolbar and select ‘Start Broadcast Message’. 
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2) Manually write the entire message, or use a Template and tokens when dealing with a message 
regarding a current call (see Templates subsection).  

An example message using a Template and a Current Time token is shown below:  

 

3) When the message has been written, click ‘Send’.  

How to: Respond to a Broadcast Message  

1) The Broadcasted message will appear as a pop-up window on the bottom-right of the screen, as 
shown in the example:  

 
2) The user can then reply to the Broadcasted message by selecting ‘Chat...’ 

OR 

 If a reply is not needed, select the ‘Dismiss’ button. 

Multiple Invitations 

Users can get several invitations for several different Chats around the same time. These will stack 
up where invitations are usually found with arrows to go back and forth through the invitations (in 
the bottom right-hand corner of the screen), as shown below: 
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Templates 

Templates can be sent to specific groups, users or Buddies, allowing shortcuts and avoiding lengthy 

and/or repetitive text to one or more recipients saving you time. 

How to: Define Templates and Use Tokens  

Defining the Template enables users to create a Name, Subject and Content as shown below: 

  

1) Locate the Templates dropdown menu and select ‘Manage Templates’. 

2) Using the right-click menu, tokens relating to a current call can be inserted, including: 

Recipient Name 

Sender Name 

Caller Details 

Caller Number 

Current Date 

Current Time 

Templates also mean that a message can be sent whereby a reply is not needed by the contacts, for 
example when broadcasting and setting a team deadline for the organisation. 

How to: Manage of Templates  

Management of Templates also includes editing and deleting previously made Templates as 
necessary.  

1) Locate the Templates dropdown menu and select ‘Manage Templates’. 

2) Select the desired Template Name from the list. 
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An example of a list of Template Names is shown below: 

 

3) To edit a Template (i.e. the name, subject and content), click ‘Edit Template...’ 

OR 

To delete a Template, click ‘Delete Template...’ 

Removing from Chat 

All users can remove themselves out of a conversation. However, if a user initiates a Chat, that user 

also holds the power to remove others. This is a helpful feature when the wrong users have been 

added to a Chat.  

How to: Remove Users from Chat 

1) Locate the Participants dropdown menu and right-click the username that needs to be removed 
from Chat. 

 

2) Click ‘Remove from conversation...’ 

3) A pop-up box will then ask if the user is sure that the removal of desired user from the 
conversation is correct. An example of this is shown below: 

 

4) If the removal is correct, click ‘Yes’ 

OR 

If the removal is incorrect, click ‘No’. 
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History 

Conversations are saved automatically and can be located via the History dropdown menu by clicking 

‘Search’, allowing users to find and view past conversations using date range, user name or text.   

 

Administrators have the ability to select, view and delete conversations from all users. 
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Chapter 26 
Presence 

Presence enables individual users to set specific Presence States and allows administrative 
management of groups that exist within the organisation to be defined under a common Presence. 

An example of a typical Presence screen that users will be faced with is shown below:  
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In order to use Presence, a user must firstly be assigned with Presence enabled. 

How to: Assign a User with Presence Enabled 

1) Click ‘Configure’ and then ‘Organisation’ OR use the shortcut located in the toolbar, as indicated 
by the red box: 

 

2) Select ‘Create a New User’. 

 

3) Once the ‘Assign the correct user role’ pop-up window has appeared, go down to ‘Presence’ and 
select the ‘Enable Presence’ box. 

Click ‘OK’. 

How to: Configure Presence Groups 

To begin using Presence, Administrators have to set up Presence Groups. 

1) Click ‘Configure’ and then ‘Presence’.  

A pop-up screen should appear, as shown below: 
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2) Click ‘Configure Presence Groups’. 

Once again, a pop-up screen should appear, as shown below: 

 

3) Set a ‘Presence Group Name’. In the example above, ‘Sales’ was chosen. 

4) Next, search and select the desired Available Users/ Groups that you wish to add into the Presence 
Group and click the ‘- >’ button. The chosen Available Users/ Groups should appear in the ‘Group 
Members’ box. 

If a user has been selected which is not meant to be in the new Presence Group, simply select the 
Group Member’s name and click the ‘< - ‘button. 

 

5) Presence States can be made available for users of a specific group, as not all States are necessarily 
needed (e.g. some groups do not need Business Travel, they stay in the Office).  

Presence States define the availability of users at a particular time which can use an associated image 
as well as other properties. 

6) Scroll down and select from the list on ‘Available Presence States’.  

OR 

As well as having Available Presence States, Administrators can set Default Presence States either 
‘From Calendar’ or with a ‘Specific State’. 

NB: See ‘Presence Calendars and Calendar Integrations’ subsection further on in the manual for more 
information. 

‘From Calendar’: Allows a user’s Presence State to change according to what has been added into their 
calendar, either through an administrator of their Group or on the user’s own personal calendar (e.g. 
An administrator may set up a Calendar slot on every Monday morning for a group meeting which will 
tell other users that this particular user is ‘In a Meeting’ at this point in time and the user’s State will 
change back to ‘In the Office’ after the meeting time has ended). 

‘Specific State’: Allows users to select a particular State which will become their default State when 
using Presence. This is automatically set to ‘In the Office’ on Presence. This setting can be completed 
for individual users as well as groups. 

For now, keep the ‘Specific State- In the Office’ selected. 
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7) Leave ‘Keyboard / Mouse Activity Settings’ as they are for now as only a basic Presence set-up is 
needed for now. 

8) Click ‘OK’. 

9) A pop-up box, as shown below, should now appear on-screen containing any Groups which have 
been created: 

 

This is where Presence Groups can be edited or deleted accordingly. 

10) Click ‘Close’. 

The basic rights for the users within that group have now been set-up and the Presence States will 
change according to the features allowed by the Administrators of that group. 

Presence States 

Presence States determine the availability of users at a particular time which can use an associated 
image as well as other properties. Presence States are useful for users as it is possible to set their 
status for any given situation that may arise in or outside of the organisation.  

First of all, Presence States must be configured. 

How to: Configure Presence States  

1) Click ‘Configure’ and then ‘Presence’. 

2) Click ‘Configure Presence States’ from the ‘Configure Presence’ popup box. 

3) Another pop-up box will appear, as shown below: 
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Default Presence States 

The Default Presence States which come with Presence are: 

In the Office 

Away from Desk 

In a Meeting 

Out of Office 

Business Travel 

Sick 

On Holiday 

At Lunch  

Training 

4) These default States can be edited by clicking ‘Edit...’ and changing the image and/or selecting the 
values desired, as shown below: 

 

Administrators and individual users can also create new Presence States, either from scratch or by 
using default States as a template.  

How to: Set-up to Add New Presence States 

1) Whilst on the ‘Presence States’ pop-up window (see earlier), click ‘Add new Presence State’. 

A pop-up box will appear asking the user to select a State that have either already been made (i.e. 
the Default States) or ‘None’ (i.e. a completely blank State with no features) as a template for the 
New Presence State. 

How to: Add New Presence States (No Template)  

1) Select the State ‘None’ as a Template and click ‘OK’. 

A pop-up box should appear entitled ‘New Presence State’, as shown below: 
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3) Type in a ‘Presence State Name’ for the new State.  

4)The Presence State Image can then be set by selecting one of the default Images or by browsing 
and selecting one the user’s own Images. 

NB: See’ Presence Image Library’ subsection for more information on how to use the user’s own 
Image.  

5) Properties and their values now need to be set for the new State.  

This allows the Presence State to detail any Properties to be set or prompted.  

The Default Properties include: 

Expiry 

Description 

Forward Calls 

Allow calendars to override state 

Enable Instant Messaging? 

Keyboard / mouse activity expected? 

Treat as ‘Available’ 

There are two ways to use Properties for a new State: ‘Set the following values:’ and ‘Ask for the 
following values:’ which are different actions. 

‘Set the following values’ allows users to place certain values as ‘true’ or false’ which will then 
automatically configure into the Presence State that is created without questioning the user for that 
particular Property (e.g. Enable Instant Messaging: True means that Instant Messaging will be enabled 
on this state, whereas Keyboard / mouse activity: False means that any movement on the mouse or 
keyboard will not be detected and will not change the Presence State.   

6) In order to add new set values to the list, click ‘New...’. 

A pop-up box entitled ‘Add Property’ should appear, as shown below: 
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7) Go down the list and select the Property which needs to be changed by selecting (true) the value or 
deselecting (false) the value where applicable, add a description or set a date/ time.  

‘Ask for the following values’ means users will be prompted by certain Properties selected when within 
that particular Presence State (e.g. When creating an ‘In a Business Meeting’ State, users that have 
selected to be asked about ‘Description’ will then have to fill out a description when selecting that 
Presence State from their main toolbar.  

8) Once all Properties have been established/ edited/ deleted where desired, click ‘OK’. 

 

How to: Add New Presence States Using Default Templates  

1) Select a State as a Template and click ‘OK’. 

A pop-up box should appear entitled ‘New Presence State’, as shown below: 

 

3) Type in a ‘Presence State Name’ for the new State. In the example above, ‘Weekly Development 
Meeting’ is used. 

4) The Presence State Image can then be set by selecting one of the default Images or by browsing 
and selecting one the user’s own Images. 

NB: See’ Presence Image Library’ subsection for more information on how to use the user’s own 
Image.  

5) Properties and their values now need to be set for the new State.  

This allows the Presence State to detail any Properties to be set or prompted.  

The Default Properties include: 

Expiry 

Description 
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Forward Calls 

Allow calendars to override state 

Enable Instant Messaging? 

Keyboard / mouse activity expected? 

Treat as ‘Available’ 

There are two ways to use Properties for a new State: ‘Set the following values:’ and ‘Ask for the 
following values:’ which are different actions. 

‘Set the following values’ allows users to place certain values as ‘true’ or false’ which will then 
automatically configure into the Presence State that is created without questioning the user for that 
particular property (e.g. Enable Instant Messaging: True means that Instant Messaging will be enabled 
on this state, whereas Keyboard / mouse activity: False means that any movement on the mouse or 
keyboard will not be detected and will not change the Presence State.   

6) In order to add new set values to the list, click ‘New...’. 

A pop-up box entitled ‘Add Property’ should appear, as shown below: 

 

7) Go down the list and select the Property which needs to be changed by selecting (true) the value or 
deselecting (false) the value where applicable, add a description or set a date/ time.  

‘Ask for the following values’ means users will be prompted by certain Properties selected when within 
that particular Presence State (e.g. When creating an ‘In a Business Meeting’ State, users that have 
selected to be asked about ‘Description’ will then have to fill out a description when selecting that 
Presence State from their main toolbar.  

8) Once all Properties have been established/ edited/ deleted where desired, click ‘OK’. 

Users can then go on to set a Current Presence State (i.e. what their current availability is).  

How to: Set Current Presence State  

1) Select the Presence State they wish to be in from the dropdown menu: 
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In this example, Business Travel was selected, opening this window: 

 

2) Duration or a fixed date/time can be set for this State. 

3) Additionally, users can supply further details as to their current State – the dropdown menu on this 
option saves the last ten notes for each user. 

4) Users can also forward their calls – with the option to forward to voicemail, number or clear any 
forward. 

PBX Administrators or above can change the rank settings for another user to become ACD Supervisor 
or higher, which will allow them to set Presence States for other users. 

How to: Set up a Presence State for other Users  

1) From the ‘Configure’ menu click ‘Presence’. 

2) Click the ‘Configure Presence Groups’ option 

3) Select the presence group that you wish to be able to set presence states of others and then click 
‘Edit’.  
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4) Click ‘User Rights’ and select the groups for which this presence group can set the states for. 

 

5) Press Ok 

6) This example has allowed the users in the Presence Group ‘Admins’ to be able to change the 
presence state for the users that are in the presence gorup ‘Everyone’ 

7) Click the ‘Create Real Time Window’ icon on the toolbar, as highlighted below:  

 

8) Down the left-hand side of the ‘Configure Real Time Parameter Windows’ box, select ‘Real Time 
Status’ and then select ‘Users’.  
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9) Click ‘Create a New User Status View’. 

10) The ‘Real Time User Status Configuration’ window should now appear. Select the Organisational 
Groups desired. In the example used below, all Organisational Groups were ticked. 

 

11) How the User Status Window will appear can then be selected, it can either be: detailed, summary 
or overview. For the example, summary was chosen.  

12) Click ‘OK’. 

13) The User Status Window should now appear on the main screen with the Organisation Groups 
that were selected, the users within those groups, their extensions and their Status (etc.). An example 
of a User Status Window is shown below: 

 

14) Right-click on the user that needs a Presence State changed and click ‘Set Presence...’. In this 
example the user Bert was selected: 
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15) The ‘Select Presence’ window will appear, allowing the selection of a Presence State for user Bert. 
Select the desired State. In the example used, Bert was chosen to be in the Presence State ‘In a 
Meeting’: 

 

Click ‘OK’. 

16) The Presence State icon for ‘In a Meeting’ should now appear next to the user Bert (as shown 
below). Bert will now appear like this to all other users. 

 

Changing State due to Detected Keyboard/ Mouse Activity  

When setting a Presence State to ‘In a Meeting’, for example, users can set a certain date/time in 
which they are ‘Expected Back’.  

If Properties within that particular State have been set to having ‘Keyboard / mouse activity: false’ and 
the user returns earlier than the date/time specified, a pop-up in the bottom right-hand corner will 
appear similar to below (if the keyboard/ mouse activity is continued for 5 seconds or more):   

 

The user can then select to ‘Go back to my default State’, ‘Stay as I am’ or ‘Select a new State’ 
depending on their Presence State at that particular time.  

This prompting is enabled just in case users have returned earlier than their ‘Expected Back’ date/ 
time interval due to: The Presence State finishing earlier than expected (select ‘Go back to my default 
State), the user needing to come back to desktop for a short period but will continue in that State 
(Stay as I am), or the State has to be changed to a different one to the default (Select a new State).    
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Notification of User Availability  

If another user’s Presence State is set to an unavailable State, users can ask for a notification when 
this user is next available.  

How to: Ask for a Notification When a User Becomes Available  

1) Find the user desired on the Extension Status Window, in this example the user Tom is used.  

  

2) Right-click the user name and go down to ‘Notify when available’ on the drop down menu, as shown 
below, and click.  

 

3) Once Tom is available, a small pop-up will appear (as shown below) on the bottom-right of the 
screen saying that Tom is now available. The user is then given the option to ‘Call them’ or ‘Dismiss’ 
the notification. Select the preferred option.  

 

Presence Image Library 

Administrators can configure the set of default Presence icons in the Image Library, allowing them to 
add or delete Images.   

How to: Manage Presence Image Library  

1) On the ‘Configure Presence’ window, click ‘Configure Presence Image Library’. 

2) If a user already has an Image saved, click ‘Add Image...’ and find the Image desired. 

Click ‘OK’ and then ‘Close’. 
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3) Users can delete the default Images and can delete their own by selecting the Image(s) and clicking 
‘Delete’ and then ‘Close’ once they have finished. 

Presence Calendars and Calendar Integrations   

A Presence Calendar is used to define regular patterns of Presence States, such as working hours. 

Administrators can configure their Presence Calendars through ‘Configure Presence Calendars’ which 
can be scheduled variations in that calendar (e.g. regular business meetings, bank holidays, staff 
training days). 

How to: Configure Presence Calendars – Administrative (System)  

1)  Go to ‘Configure’ and ‘Presence’. 

2) On System (Administrative), click ‘Configure Presence Calendars’ on the main ‘Configure Presence’ 
window. 

3) On the ‘Presence Calendars’ pop-up window, select ‘Add new Presence Calendar’. 

4) Presence Calendar Configuration pop-up window now appears, with a list of options for users to 
change: 

 

5) Type in a ‘Calendar Name’ and set a Default Presence State. The Default Presence State will apply 
outside of any working periods defined in the Calendar.  

6) Set the times and Presence States for each day.   

OR  
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7) If the user or group within the organisation work shifts, go down to ‘Add Shift Day’ where the 
Presence Calendar Configuration pop-up window will change from days into shifts: 

 

8) Type in a ‘Calendar Name’ and set a Default Presence State. The Default Presence State will apply 
outside of any working periods defined in the Calendar.  

9) Add the Shift Start/ Sync Date. 

10) Set the times and Presence States for each shift. 

NB: Sometimes when selecting an ‘Add Shift Period’, periods that have been added can overlap – if 
this occurs, users will see a message similar to this warning them that the shift period has now been 
converted into an exception period: 

 

5) A Calendar Exception can be added by clicking ‘Add Exception’. For example, this can be useful for 
when certain Groups within the organisation have a recurring meeting on a particular day. 

A small section should appear under the day/shift chosen to add an Exception to, as shown in the 
example below: 

 

 6) The time of the user’s exception can then be verified by selecting between what times the user(s) 
will be absent.  

7) The Presence State for that period can then be set. Select the appropriate State from the dropdown 
menu. 

8) Once this is done, click ‘OK’.  

Deleting Exceptions 

1) To delete the Exception, click the ‘Delete’ button directly to the right of the Presence State.  
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NB: Once Calendars have been made, these can have used as templates when going to ‘Add new 
Presence Calendar’ on the main Presence Calendars window. There is also the option to choose no 
Template (None) on the dropdown menu, as shown in the example below: 

 

Users can configure their Presence Calendars through Calendar Exceptions which can be scheduled 
variations in that calendar (e.g. Dentist or Doctor Appointments, Holidays, Training time). 

How to: Configure Presence Calendars – User (Personal) 

1)  Go to ‘Configure’ and ‘Presence’. 

2) On Personal (User), click ‘Configure My Presence Calendars’ on the main ‘Configure Presence’ 
window. 

3) A ‘Presence Calendar Exceptions’ box should appear, specifying the user’s name for which the 
calendar exceptions shall be made. In this example, the user ‘James’ is used: 

 

4) The exception date must be verified and can be extended for more than a day by selecting the ‘to’ 
button.  

5) Click ‘Add Exception Period’. 

6) The time of the user’s exception can then be verified by selecting how many minutes/ hours the 
user will be absent.  

7) The Presence State for that period can then be set. Select the appropriate State from the 
dropdown menu. 

8) Once this is done, click ‘OK’.  
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Deleting Exceptions 

There are two ways exceptions can be ‘deleted’: Firstly, by deleting the entire Exception, and secondly 
by deleting the wrong time/ Presence State set for an Exception Date. 

1) To delete the entire Exception, click the ‘Delete’ button directly to the right of the Exception Date. 

 

 2) To delete just the time/ Presence State for the Exception, click ‘Delete’ directly to the right of the 
Presence State dropdown menu.  

On the System menu, Administrators can configure Presence Calendar Integrations. Calendar 
Integration is a link to an external calendar store (e.g. extracting information from Microsoft 
Exchange).  

How to: Configure Calendar Integration – Administrative (System) 

1) Click ‘Configure Presence Calendar Integrations’.  

NB: At present, only Microsoft Exchange is configured to Presence Calendars, however, other add-ons 
will be set up in the near future.  

How to: Configure Calendar Integration for Exchange  

1) A pop-up window should appear after clicking ‘Configure Presence Calendar Integrations’, as shown 
below (this Calendar Integration has already been filled in for example purposes): 
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2) The following fields can be edited:  

                             - Calendar Integration Name 

                             - Exchange Server URL or any Email Address it hosts 

                             - Connecting User (must have Application Impersonation role) 

                             - Calendar Integration Type 

                             - Exchange Server Version 

                             - Password  

                             - Manages Users from the following Presence Groups  

                             - Conditional Presence States 

a) Calendar Integration Name: Set as ‘Exchange’. 

b) Exchange Server URL or any Email Address it hosts: Set as applicable to the server URL or email 
address that it hosts.  

c) Connecting User: To set up a connecting user, they must firstly have an ApplicationImpersonation 
role (see: http://msdn.microsoft.com/en-us/library/office/bb204095(v=exchg.140).aspx for 
guidance). 

d) Calendar Integration Type: The only calendar integration type which can currently be selected is 
the Exchange Plugin.  

e) Exchange Server Version: Select from the dropdown menu which version of Exchange is being used.  

f) Password: This is the password which was set when creating the Connecting User.  

g) Manage Users from Presence Groups: Only users in the selected groups will have their Exchange 
Calendar inspected.  

3) To test the connection to external calendars by clicking ‘Test Connection’. 

A Connectivity Report should appear when this is complete and will list all Exchange accounts to 
manage. Additionally, the report will list the Exchange Connection for the user which was specified 
and how many calendar events were found for that next month. An example of a successful report is 
shown below:  

 

If a Connectivity Report fails, the report shall state “Error connecting to Exchange: There was an error 
testing the connection to Exchange:” and may list one or several things which must be corrected. In 
the example used below, the URL was invalid: 
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4) Conditional Presence States: Can be set in the ‘Where a User has an appointment, set the Presence 
State as follows:’ box.  Common appointments (e.g. holidays, training days) can be found and their 
states can be changed accordingly if a match is found.  

 

Tokens can be included in the form (e.g. Presence State=Holiday in the Appointment subject or body).   

Conditions can also be added or deleted by clicking ‘Add Condition’ or ‘Delete Condition’ respectively.  

5) There is also a final option if Conditional States do not need to be set: ‘Else set the Presence State 
to’ where an option can be selected from the dropdown menu. This means that when the Conditional 
Presence State has been set for that particular user’s appointment, their Presence State (when they 
do not have any appointments) will refer back to this State chosen.  

6) Click ‘OK’ when complete. 

Extension and User Status Windows and the Action Button  

Extension Status Windows, User Status Windows and the Action Button are all used to see the 
availability of a particular extension and/ or user.  

(1) The Extension Status Window: Allows users to see extensions in the organisation (NB: Only the 
extensions that have been enabled for real time will be shown). For example, in image (1) below EXT 
209 can be seen as ‘In the Office’ due to the icon.    

(2) The User Status Window: Allows users to see all other users, including their Group, User Name, 
Extension, Status and Time. The icons next to the users are the Presence State they are currently in. 
For example, in image (2) below Tom’s Presence is set as ‘On Holiday’ and James’ is set to ‘In the 
Office’. 

(3) The Action Button: Allows users to configure certain extensions and/ or users onto the board, 
revealing their current Status. For example, in image (3) below, some users are seen as ‘Logged Off’ 
and some as ‘Idle’. ‘Logged Off’ means that that particular user is not connected to a telephone, 
whereas ‘Logged On’ would indicate that that user was connected to a telephone. ‘Idle’, in the case of 
image (3) below, indicates that the extension is unoccupied.  
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NB: If Presence has not been enabled on a user and the user has not been assigned into a Presence 
Group, that user will always appear without an icon to other users, and therefore contact with this 
user is diminished. 

Changing Presence through Outlook  

To use the Presence add-on on Outlook, users must firstly: 

 Have Presence enabled on their user  

 Has an email address connected to their user? 

 Be added to a Presence Group  

How to: Add an Email Address to a User  

1) Go into MyCalls and click ‘Configure’ and then ‘Organisation’ OR use the shortcut located in the 
toolbar, as indicated by the red box: 

 

2) Select ‘Create a New User’. 
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3) Once the ‘Assign the correct user role’ pop-up window has appeared, go to ‘General’ and type in 
the user’s email address. 

Click ‘OK’. 

How to: Configure Presence in Outlook  

1) To use Presence in Outlook click ‘PRESENCE’ on the main menu. 

The user should be able to see their ‘My Presence’ toolbar in the top left-hand corner of Outlook: 

 

Clicking on the dropdown menu and selecting an option allows users to change their Presence State 
at that particular time. When a user logs onto Outlook this will automatically change to their default 
State, and when there is no keyboard / mouse activity for 2 minutes, this will change to ‘Away from 
Desk’. 

2) To change any settings on Presence, click ‘Settings’. 

A pop-up box entitled ‘Presence Settings’, as shown below should appear: 
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3) To configure the Presence Sever Connection, click ‘Configure Presence Server Connection’.  

A pop-up box entitled ‘Outlook Connection: Configure Presence Server Connection’, as shown below 
should appear: 

 

This allows the users to check the Server Name or IP Address and the Presence Server Port if desired. 

4) Other Presence settings which can be configured include ‘Configure My Presence States’ and 
‘Configure My Presence Calendar’. 

NB: See ‘Presence Calendars and Calendar Integrations’ subsection for more information. 

Users can create a new appointment on their Outlook calendar. 

How to: Create a New Appointment on Outlook  

1) On the main Outlook menu under ‘Calendar’, click ‘Home’ to find the ‘New’ button on the toolbar.  

  

2) Click ‘New Appointment’. 

A pop-up box, as shown below should appear: 
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3) Type the Subject and Location (If needed) into the boxes provided. The example shows a new 
appointment being made for a user who has “Gone to the Dentist”. 

4) Add a date and time if necessary, or select the ‘All day event’ box if the new appointment requires 
so. 

5) On the right-hand side of the toolbar under ‘Presence’, users can set their Presence State for this 
appointment, along with forwarding their calls to their voicemail or a given number. In the example 
above, calls have been forwarded to voicemail.  

A description can be manually written if desired, or users can click [Subject] to use the New 
Appointment Subject Name as the description, as used in the example above. 

6) Once complete, click ‘Save & Close’. 

7) The new appointment should then appear in the user’s calendar, as shown in the example below: 

 

All users in the organisation can see the appointments set by other users. 

The Presence State will go back to the default Presence State once the appointment is End time is 
reached.  

8) Appointments can be edited or deleted by double-clicking the appointment in the calendar and 
editing where necessary OR clicking ‘Delete’ to remove the appointment.  

 

Users can also create a new meeting on their Outlook calendar. 

How to: Create a New Meeting on Outlook  

1)  On the main Outlook menu under ‘Calendar’, click ‘Home’ to find the ‘New’ button on the toolbar. 

 

2) Click ‘New Meeting’. 

A pop-up box, as shown below should appear: 
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3) Selecting the ‘To...’ button allows users to find and select other users within the organisation to 
invite them to the meeting OR the addresses can be manually typed. 

4) Type the Subject into the box provided. The example shows a new appointment being made for a 
user who has “Business Lunch Meeting”. 

5) Type in the Location of the meeting into the box provided OR use the room finder provided on the 
right-hand side to see which rooms are available to book for a meeting. 

6) Add a date and time, or select the ‘All day event’ box if the new meeting requires so. 

7) Once complete, click ‘Save & Close’. 

8) The new appointment should then appear in the user’s calendar, as shown in the example below: 

 

All users in the organisation can see the meetings set by other users and the ones users are joining. 

The Presence State will go back to the default Presence State once the appointment is End time is 
reached.  

8) Meetings can be edited or deleted by double-clicking the meeting in the calendar and editing or 
inviting other users where necessary OR clicking ‘Delete’ to remove the appointment.  
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Users can access their Outlooks and create new appointments/meetings on their phone or tablet. 

How to: Create a New Appointment on a Phone or Tablet  

1) Set up the device with Microsoft Outlook and an email address. 

NB: The device has to be set up to synchronise to the Microsoft Exchange Server that has been 
configured in the Calendar Integration (See ‘Presence Calendars and Calendar Integrations’ subsection 
for more information.) 

2) Create a New Appointment. 

3) Either in the subject or body, the following tokens can be placed to which the Presence system will 
pick up and determine which Presence State to go into: 

Presence State=” Insert Text Here” 

PresenceFWD=” Insert Text Here” 

Presence Description=” Insert Text Here”  

The example below shows how a New Appointment can be set up using tokens on a device: 

 

 

The Hierarchy of Presence States  

There lies a priority within Presence States where both Administrators and Users can set Default 
States, then override them with Appointments, and then override Appointments by setting the States 
manually. 

                                                              

 

 

 

Manual 

Appointments 

Default 



Presence 

  

 1510-002-010  Chapter 26-26   
 

An example of the priority of Presence States is shown below:  

Default 
     

 

 

 

 

 

 

 Appointments 
 

 
 

 

 

Manual 
 

 

 

 

 

 

 

 

THE DEFAULT STATE IS SET WITHIN THE 
PRESENCE GROUP EITHER ‘FROM CALENDAR’ 
OR THROUGH A ‘SPECIFIC STATE’. 

APPOINTMENTS AS WELL AS MEETINGS 
CAN BE CREATED IN OUTLOOK WHICH IS 
REACHABLE VIA DESKTOP AND MOST 
MOBILE PHONES AND TABLETS. 

PRESENCE STATES CAN BE SET MANUALLY 
BY SELECTING THE DESIRED STATE FROM 
THE DROPDOWN MENU. 

OVERRIDDEN 

OVERRIDDEN 
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Chapter 27 

Operator Console 

What is the Operator Console?  

The Operator Console is an application that allows users to efficiently handle calls in a central place 
and transfer them to their intended recipients. Typically, this application is used by ‘receptionist’ 
type staff.  Call volumes are typically high and therefore a flexible, efficient UI to facilitate this is 
essential.  

What does it look like?  

The Operator Console is divided into several windows showing current calls on the left and 
destinations for calls on the right.  At the bottom of the screen there is a set of tabs containing call 
history, unreturned calls and an address book. 
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 Name Description 

1 Toolbar and Menus Allows Operator(s) to use various toolbars and menus, 
including Call Control, Instant Messaging and Presence 
States. 

2 Default Action button Perform the most common action for the current scenario. 

3 Active Call window Shows information about the current call, including the Caller 
ID, phonebook information, and any previous handling. 

4 Calls Waiting window Shows a list of calls waiting to be delivered to an Operator. 

5 Calls being Transferred 
Window 

Shows a list of calls being transferred from any Operators. 
Includes information about including the Caller ID, 
phonebook information, and any previous handling. 

6 Calls parked or held window Shows all calls currently parked for any extension. Separate 
lists show calls parked by operators and calls parked from 
phones or voicemails. Also shows calls being held.  

7 Search window Enter name or number of recipient to dial, or transfer call to. 
Provides phonebook information. 

8 Action Buttons window Allows quick keyboard/ mouse function speed dials. 

9 Grid Bar Contains a Calls view, Unreturned Calls view and an Address 
Books view. 

How Do You Use it?  

The Default Action Button  

The operator console contains a ‘Default Action Button’.  The purpose of this button is to perform the 
most common action for the current scenario. 

e.g. When a call is delivered to the operator the most common action will be to answer the call, 
therefore the text on the button will change to ‘Answer Call’. 

 

When the call is answered the most common action will be to hang the call up, therefore the text on 
the button will change to ‘Hang Up’. 
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The default action can be performed by either clicking the ‘Default Action Button’ or pressing the 
‘Enter’ button on the keyboard.  This means that the Operator can very quickly and easily perform the 
most common actions using a minimal number of keystrokes/mouse button presses. 

Starting Up/Closing Down 

Starting Up the Operator Console 

1. Double-click the MyCalls Operator Console shortcut icon on the desktop  

 
2. Enter a valid User Name and Password 
3. Click the OK button. 
4. Select your Extension from the drop-down list. 

 
5. Click the OK button. 

Quick tips:  

An operator cannot be logged into more than one Operator Console at the same time.  

An operator cannot be logged in using the same extension that somebody else is already 
using. 
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Log in/Out of Session 

After the Operator has started the Operator Console, entered their User Name + Password + 
Extension then they will automatically be logged into a session. 

The user can log out of a session using either the ‘Toggle Between Logged in/Logged Out’ shortcut 
key (Ctrl + L) or the Log Out of Session button on the toolbar. 

 

The user can log back into a session using either: - 

 The Default Action button or its associated shortcut key (Enter). 

 The Log Out of Session button on the toolbar. 

 The ‘Toggle Between Logged in/Logged Out’ shortcut key (Ctrl + L). 

 

Closing Down the Operator Console  

1. Click the Close button (red X on the upper right edge of the Operator Console main window). 
2. The Operator Console will close down. 

Receiving Calls 

When a caller rings an operator console managed DID or Trunk, the call will be routed to one or more 
Operator Console users that are currently logged on. 

The call will appear in the Calls Waiting window.  This window shows a list of calls that are currently 
waiting to be answered by an operator. 

 

The calls are ordered by priority with the highest priority call at the top of the list.  The priority of calls 
is determined using a combination of the following: - 

 Caller priority 

 DID/Trunk priority 

 Length of time that call has been waiting 
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A call will remain in the list until it is either answered by an operator, the caller hangs up or it is routed 
to another operator or an overflow extension. 

Quick tips:  

If calls are not immediately appearing in the Calls Waiting list then check the following:- 

1. Is the DID/Trunk configured to be managed by an Operator Console? 

2. Is the DID/Trunk assigned to one of the currently logged in Operator Console user? 

3. Are there any Operator Console users available? 

4. Is the Operator Console user configured for ‘Manual’ delivery mode?  If there are multiple Operator 
Consoles in use and other operators are logged in and configured for ‘Automatic’ delivery then the 
call will be routed to them first. 

Delivering Calls 

A call must be delivered to the Operator from the ‘Calls Waiting’ list before it can be answered.  An 
operator console user can be configured to be in ‘Automatic’ or ‘Manual’ delivery mode. 

The Delivery Mode is shown on the status bar at the bottom of the application window. 

 

Automatic Delivery Mode 

If an operator console user becomes available to accept a new call, then the call at the top of the ‘Calls 
Waiting’ list is immediately delivered to the user. 

Manual Delivery Mode 

In this mode a user is able to choose which call is delivered to them from the ‘Calls Waiting’ list and 
when it is delivered. 

A call can be delivered in any of the following ways: - 

 Use the Default Action button or its associated shortcut key (Enter). 
NOTE: This will always deliver the call at the top of the list, even if another call is selected. 

 Select a call and then use the shortcut key (Ctrl + D) to deliver it.  A call can be selected by 
either: - 

o Left click using the mouse. 
o Use the shortcut key (Ctrl + Number), e.g. Ctrl + 11 will select the 11th call in the list.  

NOTE: You must hold down the Ctrl key, type the number and then release the Ctrl 
key. 

 Double click a call. 

 Right click a call and select ‘Deliver’ from the context menu. 

 Drag and drop a call into the Active Call window (above the Calls Waiting list). 

Quick tip:  

It’s not possible to switch between delivery modes within the Operator Console.  If you wish to change 
mode then:- 

1. Ask your administrator to change the mode that’s been assigned to you. 

2. Close down the Operator Console and reopen it. 
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Call Delivery 

When a call is delivered it will move from the Calls Waiting list to the Active Call window.  The call will 
be routed to the extension that the Operator is using and will no longer be available to be answered 
by any other operator.  

 

Screen Pop/Address Book 

Screen Pop/Address Book entries can be displayed when a call is delivered or answered. 

The Screen Pop/Address Book configuration can be accessed within the Configure menu. 

The operation and configuration of screen pop/address book within the Operator Console is identical 
to the Desktop and MyCalls clients. 

Answering Calls 

Auto Answer Mode 

When a call is delivered the Operator Console can be set to automatically connect the call for the 
operator. 

The currently selected Auto Answer Mode setting is shown on the toolbar and can be changed using 
the dropdown selection list. 

 

 

Quick tip:  

An Auto Answer Mode default value can be defined for an Operator Console user.  See the configuration 
section. 

When the Operator Console is started the Auto Answer Mode is set to the default value defined for the 
Operator Console user that has logged in. 
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Manually Answering a Call 

If Auto Answer Mode is switched Off, then the operator must manually answer the call. 

The call can be answered using any of the following methods: - 

 Use the Default Action button or its associated shortcut key (Enter). 

 Use the Answer Call shortcut key (F4). 

 Right click inside the Active Call window and select ‘Answer Call’ from the context menu. 

 Use the extension handset. 

 

Auto-Unavailable 

If Auto Answer Mode is switched off, then an Operator can be configured to become unavailable if a 
call delivered to them is not answered within a configured number of seconds.  See ‘No Answer 
Timeout’ settings in the configuration section. 

If the Operator becomes unavailable, then the active call is returned to the Calls Waiting list and 

becomes available for another operator to answer.  The call will contain a ‘recalled’ indicator  in 
the second column. 

 

 

The Operator can set themselves to be available again using any of the following methods: - 

 Use the Default Action button or its associated shortcut key (Enter). 

 Use the Make Available shortcut key (Ctrl + U). 

 Use the Make Available toolbar button 
 

Adding Notes to a Call  

 

When a call is delivered it becomes visible in the Active Call window and the system automatically 
adds a note. 

e.g. 

Call on DID Sales from caller David Wright 
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The system will automatically add notes to the currently active call for many different reasons (e.g. 
putting the call on hold, transferring the call, parking the call). 

The Operator is also able to add their own notes to a call at any time while it’s the currently active 
call. 

e.g. 

Parked until John Tanner ready to answer 

If a call is subsequently handled by a different operator, then the call notes are presented to them in 
the Active Call window.  The Operator can quickly view the history of the call and any notes added 
by a previous operator. 

An Operator can add their own note using any of the following methods: - 

 Use the ‘Add a Note to the Current Call’ shortcut key (Ctrl + N) and then start typing the 
note. 

 Click anywhere within the Active Call window and start typing the note. 

Quick tip:  

A note can be added anywhere within the active call window.  Multiple lines can be added and it’s even 
possible to edit/delete existing notes. 

Transferring Calls  

Double Click Transfer 

It is possible, from either an extension status action button or speed dial action button, to perform a 
transfer by double clicking that button.  
If a speed dial button is double clicked a supervised transfer is performed. 
If an extension status button is double clicked, the default transfer mechanism is performed. This is 
configured as follows: 

 Click the ‘Configure’ menu option followed by the ‘Operator Console’ menu option. Select 
‘Default Control Options’. The default transfer mode and whether or not double click 
transfer is enable can now be configured. 

               

Initiating a Blind Transfer 

The currently active call can be blind transferred to another destination.  The destination for the 
transfer can be selected in any of the following ways: - 

 Right click a destination found in the Search window or the Action Buttons window and use 
the ‘Blind Transfer’ context menu item.  
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 Drag and drop the call from the Active Call window to a destination in the Search window or 

the Action Buttons window. 

 

Another way to initiate a transfer is to use one of the following two methods: - 

 Right click within the Active Call window and use the ‘Blind Transfer’ context menu item.  

 
 

 Use the ‘Blind Transfer the Currently Active Call’ shortcut key (Ctrl + B) 

These two methods of initiating the transfer don’t actually specify the destination, therefore the 
following window will appear: - 

 

The destination for the transfer can be selected from the dropdown list. 

The transfer can be started by pressing the Start button. 
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Initiating a Supervised Transfer  

The currently active call can be transferred under supervision to another destination.  The 
destination for the transfer can be selected in the following ways: - 

 Right click a destination found in the Search window or the Action Buttons window and use 
the ‘Supervised Transfer’ context menu item.  

 
 Use the ‘Supervised Transfer to Current Search Item’ shortcut key (Ctrl + S) 

Another way to initiate a transfer is to right click within the Active Call window and use the 
‘Supervised Transfer’ context menu item. 

This method of initiating the transfer doesn’t actually specify the destination, therefore the following 
window will appear: - 

 

The destination for the transfer can be selected from the dropdown list. 

The transfer can be started by pressing the Start button. 
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Calls being transferred window 

When the transfer has been initiated the call will be moved from the Active Call window to the Calls 
being transferred window and the destination for the transfer will start ringing. 

 

Completing the Transfer 

If a blind transfer was initiated, then the transfer is completed when the destination device answers 
the call.  The call will then be removed from the Calls being transferred window. 

If a supervised transfer was initiated, then the transfer must be completed by the Operator in one of 
the following two methods (depending on how the transfer was initiated): - 

Method 1 – Using the Supervised Transfer Buttons 

The Supervised Transfer buttons will appear at the bottom right of the Operator Console main 
window after a supervised transfer has been initiated. 

When the destination device is answered, the call transfer can be completed by pressing the 
‘Complete’ button or the associated shortcut key (Return). 

 

Method 2 – Using the Supervised Transfer window 

When the destination device is answered, the call transfer can be completed by pressing the 
‘Complete’ button. 

 

Cancelling a Transfer 

A blind transferred call can be retrieved from the Calls being transferred window in one of the 
following ways: - 

 Use the Default Action button or its associated shortcut key (Enter). 

 
 Use the Cancel Transfer shortcut key (F11). 

 Right click the call and select ‘Recall Transferred Call’ from the context menu.  
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 Double click the call. 

 Drag and drop the call into the Active Call window. 

A supervised transferred call can be cancelled in one of the following ways: - 

 Press the Cancel button or the associated shortcut key (Escape). 

 Use the Cancel Transfer shortcut key (F11). 

When the supervised transfer has been cancelled the call will still be left in the ‘Calls parked or held’ 
window.  The call can be retrieved as described in the Park/Retrieve Calls section. 

Transfer Recall Time + Alert 

If a call has been left in the transferring state for too long (30 seconds by default) the call will 
automatically be recalled.  Before the call is recalled (5 seconds by default) the Operator will be 
alerted when the call begins to flash with a red background. 

 

The call will continue to flash until it’s recalled.  If the Operator that initiated the transfer is not 
available, then the call will be delivered to another Operator (if there is one available). 

The default value for the Transfer Recall time and the Show Recall Alert time can be adjusted.  
Please see the configuration section for further details about System Settings. 

Park/Retrieve Calls 

Parking a Call 

An active call may be parked using either the Managed Park or System Park method.  The difference 
between the two methods is explained in the following sections. 

Managed Park 

This parking method allows a call to be parked for a particular user/extension. 

Parking the active call can be initiated in one of the following two ways: - 

 Use the ‘Managed Park the Currently Active Call’ shortcut key (Ctrl + M). 

 Right click inside the Active Call window and select ‘Managed Park’ from the context menu. 

 

When Managed Park is initiated the following window will appear: - 
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This window allows an extension/user to be selected.  This will be the user/extension that the call 
will be parked for.  The selected user/extension will default to the Operator that is parking the call.  
The dropdown selection list can be used to select the user/extension of anybody else that is 
currently logged on using a MyCalls client and is configured for call control. 

When the OK button is pressed the call will be parked for the selected user/extension and it will 
appear in the ‘Calls parked or held’ list.  The user that the call was parked for will receive a 
notification message in the bottom left hand side of their screen. 

 

If the Retrieve button is pressed, then the parked call is retrieved for the user. 

If the Dismiss button is pressed, then the user will need to retrieve the parked call themselves. 

 

Managed Park to ‘Me Exclusively’ 

Parked calls can normally be picked up by any other Operator.  It’s also possible to park a call 
exclusively for the current Operator (by selecting ‘Me Exclusively’ from the dropdown selection list).  
This means that no other Operator will be able to see the parked call. 

SYSTEM PARK 

This parking method allows a call to be parked within one of the 64 Park Orbits that exist within the 
telephone system. 

Parking the active call can be initiated in one of the following two ways: - 

 Use the ‘System Park the Currently Active Call’ shortcut key (CTRL + Shift + P). 

 Right click inside the Active Call window and select ‘System Park’ from the context menu. 
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When System Park is initiated the following window will appear: - 

 

This window allows one of the park orbits to be selected for parking the call into. 

When the OK button is pressed the call will be parked into the selected orbit and it will appear in the 
‘Calls parked or held’ list. 

Quick tips:  

The orbit number selection list may have some numbers missing.  This is because the list only contains 
orbits that are currently empty (i.e. don’t already have a call parked in them).  

WARNING: If a call has been parked into an orbit using a handset then MyCalls will not know about it 
and the selection list will contain orbits that are already in use.  If an attempt is made to park a call into 
an orbit that’s already in use then the operation will fail. 

Retrieving a Parked Call 

The call that has been parked for the longest time may be retrieved in one of the following ways: - 

 Use the Default Action button or its associated shortcut key (Enter). 

 
 Use the ‘Recall the Longest Parked Call’ shortcut key (Ctrl + R). 

The operator can select which call to retrieve in one of the following ways: - 

 Right click the call within the ‘Calls parked or held’ window and select ‘Retrieve Parked Call’ 
from the context menu 

 
 Double click the call within the ‘Calls parked or held’ window. 

 Drag and drop the call from the ‘Calls parked or held’ window to the Active Call window. 

 Use the ‘Retrieve Parked Call’ shortcut key (Ctrl + K) to bring up the following selection 
window: - 

 

Park Alert 
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If a call has been parked for too long (30 seconds by default) then the Operator will be alerted when 
the call begins to flash with a red background. 

 

The call will continue to flash until the Operator retrieves the call. 

The default value for the Park Alert time can be adjusted.  Please see the configuration section for 
further details about System Settings. 

Hold/Recall Cal ls 

 

Placing a call on hold 

It’s possible to place the currently active call on hold using any of the following methods: - 

 Use the ‘Hold the Currently Active Call’ shortcut key (F9). 

 Right click inside the Active Call window and select ‘Hold’ from the context menu. 

 

 Use the Hold button on the Call Control Toolbar.  

 Use the Hold button on the extension handset.  

When a call is placed on hold it will move from the Active Call window to the ‘Calls parked or held’ 
window. 

 

 

Quick tips:  

1. If an Operator places a call on hold then no other new calls will be routed to them. 

2. An Operator cannot place more than one call on hold at the same time. 

3. An Operator cannot see calls that were placed on hold by other operators. 

 

 

Retrieving a held call  
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A held call can be retrieved using any of the following methods: - 

 Use the Default Action button or its associated shortcut key (Enter). 

 
 Use the ‘Recall the Held Call’ shortcut key (F10). 

 Right click the call in the ‘Calls parked or held’ window and select ‘Recall Selected Call’ from 
the context menu.  

 

 Use the Recall button on the Call Control Toolbar.  

 Use the Answer button on the extension handset.  

Hold Alert 

If a call has been left on hold for too long (30 seconds by default) then the Operator will be alerted 
when the call begins to flash with a red background. 

 

The call will continue to flash until the Operator retrieves the call. 

The default value for the Hold Alert time can be adjusted.  Please see the configuration section for 
further details about System Settings. 

Ending Calls 

The currently active call can be ended by the Operator in any of the following ways: - 

 Use the Default Action button or its associated shortcut key (Enter). 

 
 Use the Hangup Current Call shortcut key (F6). 

 Right click inside the Active Call window and select ‘Hang Up’ from the context menu.  

 
 Use the extension handset. 

 

After the call has ended it will disappear from the Active Call window and appear a short time later 
in the ‘Calls’ tab of the Call Log window. 

 

Wrapup Time 
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If an Operator is using Automatic Delivery Mode, then a wrapup time period will be entered after 
the call has ended.  This is to give the Operator some time to get ready before another call is 
automatically delivered to them. 

 

 

When the wrapup time period has ended (the default value is 30 seconds) the Operator will 
automatically be made available for accepting calls again. 

If the Operator is ready to accept a new call, then it will be possible to make an early exit from wrapup 
in any of the following ways: - 

 Use the Default Action button or its associated shortcut key (Enter). 

 Use the Exit Wrapup shortcut key (Ctrl + W). 

 Use the ‘Exit Wrap-Up’ toolbar button  
 

Find Window 
The Find Window allow the Operator to search for users, extensions, extension groups, contacts or 

callers by typing what they are looking for into the Search field.  The results of the search are shown 

as a list in the grid underneath.  The search results are updated after each character is entered into 

the search field. 

e.g. If the letter ‘C’ is entered then anything beginning with that letter will be found.  When more 

characters are types the search results will become more specific to what has been entered. 

 

The button (with a red X) can be used to quickly clear the contents of the Search field. 
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Selecting a search result 
A search result can be selected in one of the following ways: - 

 Use the shortcut key (Shift + Number), e.g. Shift + 11 will select the 11th result in the list. 
NOTE: You must hold down the Shift key, type the number and then release the Shift key. 

 Click on the required search result. 

 Set focus to the search results list and use the up/down arrow keys. 

What can you do with the search results?  
The search results can be used as the destination for transferring calls to.  Please see the 

Transferring Calls section for more details on how to do this. 

The right click context menu also allows the following functions to be performed: - 

 Make a call 

 Call Voice Mail 

 Turn Callback On/Off 

 Set/Clear DND status 

 Set/Clear Forward status 

 View/set presence status 

 Notify when available (using presence) 

 Send an email 

Action Buttons Window 

The Action buttons window allows you to configure a series of buttons and status indicators to 
simplify control and monitoring the phone system.  Action buttons can be used as the destination for 
transferring calls (as already explained in previous sections).  

 

 

Action Button View DID Associations  

The Action buttons window can be split up into multiple ‘tabbed’ panels.  The Operator can select 
which panel is currently displayed by clicking on the required tab.  The Action buttons window can 
also be configured so that panels are selected automatically when calls come in for particular DIDs. 

This can be done as follows: - 
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1. Right click on any of the tabs and select ‘Edit DID Associations…’ from the context menu. 

 

2. The ‘Action Button View Associations’ window will appear. 

 

3.  This configuration window will present a list of all DIDs in the column on the left.  The 
column on the right can be used to select an Action panel name to associate with the 
appropriate DIDs. 

Modes 

A Mode is a set of restrictions that control how and where calls are delivered, and the 
announcements they receive at differing times of day (e.g. calls may be answered by an Operator 
during the day and then be directed to an after-hours announcement at night and weekend).  

Modes can be scheduled and the Operator can also override the current mode.  Some example modes 
could be: 

 Calls are routed to the Operator Console if a Day mode exists and is active.  

 If a Night mode exists and is active, calls may go to an afterhours contact number, or be played 
an afterhours announcement with additional contact information.  

 If an Emergency mode switch exists and is active (e.g. fire alarm has sounded and there is 
evacuation of the building), calls may go to an announcement, or a mobile phone.  

A typical set-up of mode switches on Action buttons is shown below:  
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Further Information 

Everything else relating to the Actions window is described in chapter 13. 

Sending Messages  
 

The Operator is able to send messages either via email or Instant Messaging. 

Message Templates 
The Operator can write his own messages or choose from a set of predefined templates that will 

automatically create a message.  It’s possible to create shared templates that can be used by any 

operator or personal templates that can only be used by the operator that created them. 

Shared templates can be managed within the Operator Console Configuration Settings.  For further 

information, please see the System Configuration section of this chapter. 

Personal templates can be managed using the ‘Personal Message Templates’ menu item that’s 

located in the Configure menu. 

 

This will bring up the Manage Templates window. 

 

Further information about the Manage Templates window can be found in the Instant Messaging 

chapter. 

Where can messages be sent from?   
An email or Instant message can be sent to a person found using the Search window in one of the 

following ways: - 

 Use the ‘Send an Email to Current Search Item’ shortcut key (Ctrl + E). 
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 Use the ‘Email’, ‘Templated Email’ or ‘Instant Message’ right click context menu items. 

 
 

Messages can also be sent from Action buttons in the same way using context menu items. 

 

Quick tips:  

1. To send emails an email client must be installed on the Operator’s machine (e.g. Outlook) 

2. An Instant Message can only be sent to a user that is logged on and enabled for instant messaging.  

3. Users and contacts must have email addresses configured in order to receive emails.  

Stop/Start Call Recording 

The recording of calls handled by the Operator can be stopped/started in exactly the same way as 
the other MyCalls applications.  Please see the Stop/Start Recording chapter for more information. 

The View Menu 

The View menu can be used to control the visibility of various elements of the user interface. 

 

View menu item Description 

Call Player Window If enabled (ticked) then the call player window is displayed.  
This window allows the playback of recorded calls to be 
controlled.  For further details about the call player please 
see the Call Recording chapter. 
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Call Records Window When this item is selected the Call Records view is made 
into the active tab in the grid bar at the bottom of the main 
application window.  A full description of the Call Records 
view can be found in chapter 2. 

Unreturned Calls Window When this item is selected the Unreturned Calls view is 
made into the active tab in the grid bar at the bottom of the 
main application window.  A full description of the 
Unreturned Calls view can be found in chapter 2. 

Call Control Toolbar If enabled (ticked) then the toolbar relating to call control 
operations is made visible. 

Main Toolbar If enabled (ticked) then the main toolbar relating to 
operator console modes (e.g. Auto Answer mode) is made 
visible. 

Grid Bar If enabled (ticked) then the grid bar at the bottom of the 
screen is made visible.  This grid bar contains the Call 
Records view, Unreturned Calls view and the Address Books 
view. 

Status Bar If enabled (ticked) then the Status Bar at the bottom of the 
main application window is made visible.  The Status Bar 
contains the license, logged in user name and delivery mode 
information. 

 

Reporting  

 

The system contains an Operator Console Report that contains the following types of information: - 

 The number of incoming, outgoing, internal and abandoned calls 

 The number of failed over, overflow, held, parked, transfer recall calls. 

 Average and longest talk times 

 The number of long holds, long parks. 

 Longest Held, longest parked 

 The number of Operator timeouts, transfer timeouts, forced unavailable 

 DID average wait time stats for each Operator 

 DID longest wait time stats for each Operator 

 Trunk average wait time stats for each Operator 

 Trunk longest wait time stats for each Operator 

 Call stats for each Operator 

 Availability stats for each Operator 

 

See the Reporting chapter for details on how to run reports. 
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Keyboard Shortcuts  

 

Default Values 

The following table lists the default shortcuts that are defined for the Operator Console. 

Operation Shortcut 

(1) Miscellaneous 

Perform the Default Action Return 

Cancel the Pending Action Escape 

Add a Note to the Current Call Ctrl + N 

(2) Modes 

Make Available Ctrl + U 

Toggle Between Logged In/Logged Out Ctrl + L 

Exit Wrapup Ctrl + W 

(3) Navigation 

Move to the Calls Queuing List Ctrl + Q 

Move to the Transferred Calls List Ctrl + T 

Move to the Parked Calls List Ctrl + P 

Move to the Find Window Ctrl + F 

Move to the Action Buttons Window Ctrl + A 

Move to the specified tab of the Action Buttons window Ctrl + Shift + Number 

Select Call (1 to n) from Waiting Calls List Ctrl + Number 

Select Item (1 to n) from Search Results Alt + Number 

(4) Call Control  

Answer Call F4 

Hangup Current Call F6 

Deliver the Selected Waiting Call Ctrl + D 

Managed Park the Currently Active Call Ctrl + M 

Recall the Longest Parked Call Ctrl + R 

Retrieve Parked Call Ctrl + K 

Blind Transfer the Currently Active Call Ctrl + B 
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Pick up the Longest Transferred Call F8 

Hold the Currently Active Call F9 

Recall the Held Call F10 

Cancel Transfer F11 

Stop/Start Recording toggle Ctrl + Shift + R 

(5) Search View 

Send an Email to Current Search Item Ctrl + E 

Call Voice Mail for Current Search Item Ctrl + V 

Start Chat Session With Current Search Item Ctrl + I 

Supervised Transfer to Current Search Item Ctrl + S 

(6) Action Buttons 

Run the selected Action Button Space 

 

User Defined Values 

The default values for one or more shortcut keys can be replaced by user defined values. 

This can be done as follows: - 

1. Select the ‘Operator Console’ item from the Configure menu. 

 

2. The ‘Edit Operator Console Settings’ screen will appear as follows and ‘Keyboard Shortcuts’ 
will already be selected in the list on the left. 
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3. Click on the Operation in the list that a shortcut is to be defined for (e.g. Stop/Start 
Recording toggle). 

4. Click on the ‘Press new shortcut keys’ field and then type the new shortcut key combination.  
E.g. to define Ctrl + F12 hold down the Ctrl key, press the F12 key and then let go of the Ctrl 
key. 

5. If you wish the shortcut key to work even if the Operator Console application doesn’t 
currently have focus, then enable the ‘Global shortcut’ checkbox. 

6. Press the ‘Assign’ button to assign the new shortcut. 
7. Press the OK button to save any changes. 

 

Sound Configuration 

The Operator console produces a ‘ringing’ sound when there are one or more calls queued in the 
Calls Waiting window.  The Operator console also produces a ‘ringing’ sound when a call is being 
delivered.  By default, the queuing ring and the delivered ring sound are the same except that the 
queuing ring is quieter. 

The ring sounds, volume and delay between rings can all be configured as follows: - 

1. Select the ‘Operator Console’ item from the Configure menu. 

 

2. The ‘Edit Operator Console Settings’ screen will appear.  Select ‘Sounds’ from the list on the 
left. 

 
3. The ‘Enabled’ check box can be used to enable/disable the sound. 
4. The volume and delay values can be adjusted by selecting them and using a spin control.   
5. The sound file can be selected using the ‘Browse’ button. 

NOTE: The sound files must be located within the Media folder that exists within the 
folder where the application is installed. 

6. The ‘Test’ button can be used to start playing the ring sound using the configured settings.  
Playback of the ring sound test can be stopped using the stop button (contains a red square). 
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User Interface Configuration  

There are several things that can be configured in the Operator Console user interface as follows: - 

1.  Select the ‘Operator Console’ item from the Configure menu. 

 

2. The ‘Edit Operator Console Settings’ screen will appear.  Select ‘User Interface’ from the list 
on the left. 

 
3. The following settings are available: - 

 
Number of Action Button Columns 
This setting determines how many action button columns are available on each panel of the 
Action Buttons windows. 
 
Show Extension Name in Call Lists 
If this setting is enabled, then the extension name rather than the number is shown in call 
lists. 
 
Make Visible 
If this setting is enabled, then the operator console application is made visible when a new 
call arrives.  This is useful if the application window has been minimised or is hidden behind 
other windows. 
 
Make Visible Timeout 
This setting is used in combination with the ‘Make Visible’ setting.  The value of the setting 
defines the number of seconds to wait after a new call arrives before making the operator 
console visible. 
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Default Control Options  

There are several things that can be configured as Operator Console default control options as 
follows: - 

1.  Select the ‘Operator Console’ item from the Configure menu. 

 

2. The ‘Edit Operator Console Settings’ screen will appear.  Select ‘Default Control Options’ 
from the list on the left. 

 
3. The following settings are available: - 

 
Default Transfer Mode 
This setting determines how a transfer is executed if the transfer button is clicked or an 
extension status / speed dial action button is double clicked (if enabled). 
 
Enable Double Click Transfer 
If this setting is enabled, then when an extension status / speed dial action button is double 
clicked the current call is transferred according to the default transfer mode. 
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Configuration 

System Configuration  
 

Before using the Operator Console application, the following items need to be configured using the 

MyCalls application: - 

1. Operator Console System settings 

2. Create Operator Console Users 

3. Enable DIDs to be handled by the Operator Console. 

4. Enable Trunks to be handled by the Operator Console. 

5. Assign Operator Console users to DIDs, Trunks and Internal calls 

6. Assign priorities to Callers. 

How to: Configure System Settings  

From the MyCalls main screen, click Configure > Telephone System 

 

Navigate to ‘Operator Console’ by clicking the ‘+’ symbol next to PBXs, then the ‘+’ symbol next to 
Head Office. 

Click ‘Operator Console’ followed by ‘System Settings’ in the right hand panel. 
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The ‘General Operator Console Configuration Settings’ are split into several categories which can be 
selected in the panel on the left.  The settings for the selected category are shown to the right. 

 

‘Recall/Alert/Overflow Times’ category 

By default, the ‘Recall/Alert/Overflow Times’ category will be selected.  This category contains the 
following settings: - 

Hold Alert - This is a value in seconds that defines how long a call can be put on hold before alerting 
the operator.  This is to help prevent the operator leaving calls on hold for an excessive amount of 
time.  When a hold alert is triggered the call will start flashing red in the ‘Calls parked or held’ list. 

Park Alert - This is a value in seconds that defines how long a call can be parked before alerting the 
operator.  This is to help the operator to prevent leaving calls parked for an excessive amount of 
time.  When a hold alert is triggered the call will start flashing red in the ‘Calls parked or held’ list. 

Transfer Recall - This is a value in seconds that defines how long a call can be left in a transferring 
state before being recalled back to the operator.  This is to prevent leaving calls left in a transfer 
state for an excessive amount of time. 

Show Recall Alert - This check-box along with the associated time in seconds below it will cause the 
operator to be alerted when a call in the transfer state is about to be recalled.  When a transfer alert 
is triggered the call will start flashing red in the ‘Calls being transferred’ list. 

Auto Routing Overflow Time - If a DDI is mapped to one or more logged in Operators that are set to 
‘Auto’ delivery mode then this setting determines how long the system will wait for one of the 
operators to accept a call to the DDI. 

Manual Routing Overflow Time - If a DDI is mapped to one or more logged in Operators that are set 
to either ‘Manual’ or ‘Auto’ delivery mode then this setting determines how long the system will 
wait for one of the operators to accept a call to the DDI. 

Backup Routing Overflow Time – If a call to a DDI has not been answered by any Operators assigned 
to it then the call will be offered to Operators that are not assigned to it.  This setting determines 
how long the system will wait for one of the Operators to accept the call. 
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‘Routing Configuration’ category 

This group of settings relate to the extensions that the system uses for routing calls for the Operator 
Console application. 

 

Each setting requires a list of extension(s) to be specified.  The extension list may consist of 
individual items (e.g. 500,501,502,503) and/or item ranges (e.g. 500-503). 

Pre-routing Extension Pool - This is a list of extensions that are used for initially presenting DIDs to 
the Operator Console system. 

Extension Pool - This is a list of extensions that are used by the routing system while attempting 
delivery of calls to the Operator Console application. 

Managed Parking Bay Pool – This is a list of extensions that are used by the routing system to 
manage the parking of calls. 

‘Failover Configuration’ category 

This group of settings is used to determine what happens when a call fails to be answered by any of 
the Operator Console users. 
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Failover Destination for all Calls on this PBX - This is the destination that calls will be sent to if they 
fail to be answered. 

Allow failover destination to be defined for individual DIDs - If this check box is enabled then the 
‘Failover Device’ column in the ‘Manage Operator Console DIDs’ window can be used. 

If operator console user(s) assigned to a DID are not logged in then present calls for that DID to all 
other logged in operator console users – If this check box is not enabled then calls will be routed 
directly to the failover destination. 

‘Message Templates’ category 

This category allows Message Templates to be defined that can be used by any Operator console 
users when sending emails/instant messages.  The templates are defined and used in exactly the 
same way as described in the Instant Messaging chapter. 

 

‘Change History’ category 

This category shows when the Operator Console System Settings were first created and when they 
were last modified.  It also shows who made the last modification. 

 

Click OK save changes to settings or Cancel to revert any changes. 
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How To: Configure Operator Console Users  

NOTE 1: This ‘How to’ assumes that users have already been created.  See Chapter 11 for details on 
how to create users. 

NOTE 2: Operator Console settings for users can be configured using either the Create/Edit User 
windows (see Chapter 11) or the ‘Manage Operator Console Users’ window which is described as 
follows.  The advantage of using the ‘Manage Operator Console Users’ window is that settings for all 
Operator console users can be viewed/compared in a list format. 

From the MyCalls main screen, click Configure > Telephone System 

 

Navigate to ‘Operator Console’ by clicking the ‘+’ symbol next to PBXs, then the ‘+’ symbol next to 
Head Office. 

Click ‘Operator Console’ followed by ‘Manage Operator Console Users’ in the right hand panel. 

 

The ‘Manage Operator Console Users’ window by default only shows settings for users that are 
already enabled for using the Operator Console. 
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If you would like to enable a user to use the Operator Console, then uncheck the ‘Show all users’ 
check box at the bottom of the window.  The check boxes within the ‘Operator Console’ column can 
then be used to enable/disable users. 

The following settings can be made for a user: - 

Delivery Mode - This may be set to either ‘Auto’ or ‘Manual’ delivery of calls. 

Auto-Answer - This is an on/off type setting.  If setting is ON, then calls are automatically answered 
after they are delivered.  If setting is OFF, then the operator must manually choose to answer the 
call.  This setting can be overridden by the user within the operator console application. 

Wrapup Time - This is the number of seconds after the end of a call that the system will wait before 
automatically delivering another call to the operator.  This setting is only enabled if Delivery Mode is 
set to ‘Auto’. 

No Answer Timeout – If Auto-Answer is switched OFF then this timeout is enabled.  If the delivered 
call is not answered within the timeout, then the Operator is made unavailable. 

Make Visible - This is an on/off type setting.  If the setting in ON, then the operator console 
application is made visible when a new call arrives.  This is useful if the operator console application 
window has been minimised or is hidden behind other windows. 

Visible Timeout - This setting is used in combination with the ‘Make Visible’ setting.  The value of the 
setting defines the number of seconds to wait after a new call arrives before making the operator 
console visible. 

Click OK to save changes to the Operator Console Users. 

 

How to: Configure Operator Console DIDs  

NOTE 1: This ‘How to’ assumes that DIDs have already been created. 

NOTE 2: Operator Console settings for DIDs can be configured using either the Create/Edit DID 
windows (see Chapter 11) or the ‘Manage Operator Console DIDs’ window which is described as 
follows.  The advantage of using the ‘Manage Operator Console DIDs’ window is that settings for all 
Operator console managed DIDs can be viewed/compared in a list format. 

From the MyCalls main screen, click Configure > Telephone System 
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Navigate to ‘Operator Console’ by clicking the ‘+’ symbol next to PBXs, then the ‘+’ symbol next to 
Head Office. 

Click ‘Operator Console’ followed by ‘Manage Operator Console DIDs’ in the right hand panel. 

 

The ‘Manage Operator Console DIDs’ window by default only shows settings for DIDs that are 
already managed by an Operator. 
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If you would like to enable a DID to be managed by an Operator, then check the ‘Show all DIDs’ 
check box at the bottom of the window.  The check boxes within the ‘Managed by Operator’ column 
can then be used to enable/disable DIDs. 

The following settings can be made for a DID: - 

Priority - This may be set to a value between 1 (Low) and 8 (High).  The priority is used as part of a 
calculation to determine the order that calls are delivered to operator console users. 

Failover Device - If a call to a DID is not answered by an operator then it will have sent to a failover 
device.  The failover device allows the destination for the call to be defined (e.g. an extension 
number).  This setting is only enabled if ‘Allow failover destination to be defined for individual 
DIDs/Trunks’ is enabled in the Operator Console System Settings. 

Same Operator - This is an on/off type setting.  If the setting is ON, then the system will attempt to 
route calls for the DID to the same operator that previously answered it within the ‘Same Operator 
Time’ 

Same Operator Time - This is used in combination with the ‘Same Operator’ setting as described 
above. 

Click OK to save changes to the DIDs. 

 

How to: Configure Operator Console Trunks  

NOTE 1: This ‘How to’ assumes that Trunks have already been created. 

NOTE 2: Operator Console settings for Trunks can be configured using either the Create/Edit Trunk 
windows (see Chapter 11) or the ‘Manage Operator Console Trunks’ window which is described as 
follows.  The advantage of using the ‘Manage Operator Console Trunks’ window is that settings for 
all Operator console managed Trunks can be viewed/compared in a list format. 

From the MyCalls main screen, click Configure > Telephone System 

 

Navigate to ‘Operator Console’ by clicking the ‘+’ symbol next to PBXs, then the ‘+’ symbol next to 
Head Office. 

Click ‘Operator Console’ followed by ‘Manage Operator Console Trunks’ in the right hand panel. 
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The ‘Manage Operator Console Trunks’ window by default only shows settings for Trunks that are 
already managed by an Operator. 

 

If you would like to enable a trunk to be managed by an Operator, then check the ‘Show all Trunks’ 
check box at the bottom of the window.  The check boxes within the ‘Managed by Operator’ column 
can then be used to enable/disable Trunks. 

The following settings can be made for a Trunk: - 

Priority - This may be set to a value between 1 (Low) and 8 (High).  The priority is used as part of a 
calculation to determine the order that calls are delivered to operator console users. 

Failover Device - If a call to a Trunk is not answered by an operator then it will have sent to a failover 
device.  The failover device allows the destination for the call to be defined (e.g. an extension 
number).  This setting is only enabled if ‘Allow failover destination to be defined for individual 
DIDs/Trunks’ is enabled in the Operator Console System Settings. 

Same Operator - This is an on/off type setting.  If the setting is ON, then the system will attempt to 
route calls for the Trunk to the same operator that previously answered it within the ‘Same Operator 
Time’ 

Same Operator Time - This is used in combination with the ‘Same Operator’ setting as described 
above. 

Click OK to save changes to the Trunks. 
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How to: Assign Operator Console users to Devices 

NOTE 1: This ‘How to’ assumes that some Users and DIDs/Trunks have already been created and 
enabled. 

From the MyCalls main screen, click Configure > Telephone System 

 

Navigate to ‘Operator Console’ by clicking the ‘+’ symbol next to PBXs, then the ‘+’ symbol next to 
Head Office. 

Click ‘Operator Console’ followed by ‘Assign Operator Console users to DIDs’ in the right hand panel. 

 

The ‘Assign Operator Console Users to Devices’ window is split into two halves.  The left-hand half 
allows a ‘New Assignment’ to be created and the right-hand half shows assignments that already 
exist.  
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Create a new assignment 

To create one or more new assignments: - 

1. Select one or more DIDs/Trunks/Internal from ‘Operator Console Managed Devices’ list on the 
left. 

2. Select one or more Users from the ‘Operator Console Users’ list on the left. 

3. Click the ‘Assign’ button and the new assignment(s) will appear in the assignments list on the 
right. 

Remove an assignment 

To remove one or more assignments: - 

1. Select one or more assignments from the list on the right. 

2. Click the ‘Unassign’ button and the assignments will be removed from the list. 

NOTE:  

The ‘Users Assigned’ values can be used to quickly see if any Devices have not been assigned to a 
User.  If a value is 0 then it will be highlighted in red. 

In a similar way the ‘Devices Assigned’ values can be used to quickly see if any Users have not been 
assigned to a Device.  If a value is 0 then it will be highlighted in red.  

Click OK to save changes to the Device assignations. 

 

How to: Manage Caller Priorities  

NOTE 1: This ‘How to’ assumes that some Callers have already been created. 

NOTE 2: Operator Console settings for Callers can be configured using either the Create/Edit Caller 
windows or the ‘Manage Caller Priorities’ window which is described as follows.  The advantage of 
using the ‘Manage Caller Priorities’ window is that operator console related settings can be 
viewed/compared in a list format. 

From the MyCalls main screen, click Configure > Telephone System 
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Navigate to ‘Operator Console’ by clicking the ‘+’ symbol next to PBXs, then the ‘+’ symbol next to 
Head Office. 

Click ‘Operator Console’ followed by ‘Manage Caller Priorities’ in the right hand panel. 

 

The ‘Manage Caller Priorities’ window allows the priority associated with individual callers to be 
adjusted.  The priority is used as part of a calculation to determine the order that calls are delivered 
to operator console users. 
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The priority of a caller can be adjusted as follows: - 

1. Click the value in the ‘Priority’ column that corresponds to the caller. 

2. Select a value from the drop-down list.  The value can be between 1 (Low) and 8 (High). 

Click OK to save changes to the Callers. 
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Chapter 28 
Predictive Abandonment 

The Predictive Abandonment module is a powerful and adaptive tool that provides immediate 
access to call statistics as and when calls arrive. This chapter will explain the meaning behind this 
information, and demonstrate how an agent control supervisor can use it to respond effectively in a 
rapidly changing call centre environment.  

 

Pilot specific wrap-up, call and abandonment statistics are combined with overflow settings, agent 
status and the current call queue to generate a single, unambiguous value representing the risk of a 
particular call. 

What is meant by Percentage Chance of Abandonment?  

Probability is a measure of how likely an event is to occur. It is measured from 0 (impossible) to 1 
(certain). A two-sided coin toss is a common example of probability in action; when a coin is tossed, 
each side of the coin is equally likely to land facing up. For any number of coin tosses, we would 
expect half of them to be tails, and half of them to be heads. We say then that the probability of 
heads is 0.5, and that the probability of tails is also 0.5 (or one half each). There is always some 
degree of uncertainty involved with probability, however. Our ‘expected’ result is simply the single 
sum of heads and tails that is more likely than the rest, but in actual practice it would not be unusual 
to see a result that differs by some degree from our expectation.  

 

Probability of 
Abandonment 

Wrap-up Profile Overflow Settings 

Pilot Statistics Call Statistics Abandonment Statistics 
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Often, probability is expressed as a percentage. This is exactly the same scale as above, but 100 
times larger. Hence for our coin toss, the percentage chance of throwing heads will be 50%, and the 
percentage chance of throwing tails will likewise be 50%. A more intuitive way of thinking about this 
might be: “After 100 coin tosses, how many do I expect to be heads, and how many do I expect to be 
tails?” In this case our answer would be: 50 of each.  

The information generated by MyCalls is also a percentage, and so any value it gives can similarly be 
translated into: “For every 100 calls in this position, we can expect this many to eventually 
abandon.”  

 

 

An abandonment probability of 20% is shown visually on the left. 
It can be seen that while 20% is a relatively low danger of 
abandoning per call, there is still an expected 20 calls in every 100 
that will never be received. This is something that must be 
considered when determining the acceptable threshold for at-risk 
calls.  

 

 

 

Another possible way to interpret the chance of a call abandoning might be to consider its position 
on the probability scale above. A 50% chance would be like tossing a coin to decide whether or not it 
will eventually abandon, whereas as 16% chance would be like rolling a 6.  

 

Quick tip:  

At any particular second a call is unlikely to spontaneously hang up. A given percentage abandonment 
takes into account the entire life of the call; if it is highly likely to abandon, the actual point of 
abandonment could be in the next second, or the next  30. The number displayed reflects the 
unlikelihood of the call being answered in that time. 

  

x 20 

x 80 

100 Calls 

0 1 Less Likely More Likely 

0.17 - Rolling a 6 on a 
6-sided die 

0.50 – Getting ‘tails’ 
on a coin toss 

0.83 – Rolling 1-5 on a 
6-sided die 

Probability 
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How does this change over time?  

You might expect that for a given call the probability of abandoning will grow over time as a 
particular customer becomes increasingly impatient, but this is not necessarily the case.  Within a 
random sample of callers there will be patient customers, impatient customers and everything in-
between. Unless they are calling to a specialized and highly predictable pilot number, it is at first 
impossible to tell them apart.  

The graphic below shows two calls ringing on a queue: 

Sarah has been in the queue for 45 seconds, whereas Sam has been in the queue for just 5. Perhaps 
counterintuitively, Sarah will have a lower chance of abandonment than Sam. This is because Sarah 
has already been ringing for quite some time and cannot be one of the less patient customers, as she 
would otherwise have already abandoned by this point. Additionally, Sarah is first in the queue and 
must be answered before Sam; this is taken into account when calculating Sam’s abandonment 
chance. The percentage displayed for Sam is really the answer to the question: “What is the chance 
that this call will abandon before both of us are answered?” If Sarah were to abandon or be 
answered, Sam’s chance of abandoning would drop to reflect this.  

 

How does Predictive Abandonment work? 

Upon being initialized, the predictive abandonment system will scan existing call records and build a 
pilot-specific model for wrap-up, call duration, and abandonment times. When needed, it will then 
use these internal models to assess the chances of agents finishing active calls and wrapping up 
before a call abandons.  

The following information is taken into account when generating a probability of abandonment: 

 Historic wrap-up behaviour and distribution 

 Historic answered call behaviour and distribution 

 Historic abandonment behaviour and distribution 

 How the above statistics vary on a daily and sub-daily basis? 

 How the above statistics vary across pilot groups? 

 The configuration of overflow groups 

 By-the-second analysis of agents on calls or in wrap-up 

 By-the-second analysis of calls in queue 

These calculations are finally all rolled into a single number that represents the percentage chance of 
a call abandoning at some point in the future before being answered. For calls in a queue, this value 
will also include the chance of all calls higher up in the queue of being answered. 

5s 

45s 

Ring Time 

Sam 

Sarah 
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Call Type Definitions  

The predictive abandonment system has been designed to give an indication of the likelihood of a 
call abandoning if it is presented to the phone system and no agents are available to answer the call. 

To this end the following call definitions apply: 

 Queuing Call 
Predictive Abandonment defines a queuing call as a call that has been presented to the 
phone system but has not yet been presented to an agent. The figures that the predictive 
abandonment present only apply to these sort of calls. 

 Abandoned Call 
Predictive Abandonment defines an abandoned call as a call that has queued on a Pilot 
Group without ever ringing on an actual agent and then abandoned.  

 Answered Call 
Predictive Abandonment defines an answered call as a call that has actually rung on an 
agent whether it was actually connected or not.  
The reason for this is because once a call has been assigned to an agent it has been removed 
from the queue and is assumed it will actually be answered. 
Once a call has moved from being a queuing call to being an answered call, it cannot move 
back to being a queuing call again and the figures presented by the predictive abandonment 
system will not include this call. 

Start-up Mode 

If less than a week’s worth of call data is present in the database, then the predictive abandonment 
system will automatically activate ‘Start-up Mode’. In this setting, the system will attempt to build its 
internal models on the fly based on the calls it experiences as the day goes on. At least two 
answered and abandoned calls (defined above) need to have therefore taken place each day before 
the system can provide any reliable results. Once a week has passed, the system will revert to its 
regular mode of operation and produce stronger results. 

Abandon Probability and Overflow  

A given abandon probability will take into account overflow groups if they are specified in the pilot 
configuration. As a call gets closer to overflowing, the system will begin to look into the future 
overflow group for agents that may be able to answer the call; chance of abandonment may drop to 
reflect this. The overflow probability of a call will increase whilst this is taking place. 

Overflow Probability  

If a call is ringing on a queue with an overflow pilot group specified, then the predictive 
abandonment system will produce a ‘probability of overflow’ describing the risk of a particular call 
overflowing before being answered or abandoning. This will increase as a call moves closer to the 
overflow time.  
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Common Questions 

Q: Shouldn’t probability of abandonment constantly increase until the call 

finally drops?  

This is a common misinterpretation; a call does not necessarily become more likely to abandon 
purely because it has been ringing for longer.  

To understand this effect, consider a business that receives calls from equal amounts of two distinct 
groups of people: Impatient people, and patient people. They are willing to ring for 10 and 30 
seconds respectively. 

 

 

 

 

 

It cannot be known how patient a particular caller will be when they first begin ringing. If the 
average abandonment time is 20 seconds (halfway between the two possible abandonment times), 
then we say the expected abandon time is 20 seconds. 

If 11 seconds pass and the call is still ringing then we know the caller wasn’t impatient, or they would 
have already abandoned by now. We therefore don’t expect the call to abandon at 20 seconds 
anymore, as the average and only abandonment time is now at 30s.  

 

 

 

 

 

In the above diagram we can see that the expected abandonment time has increased as the call has 
been ringing. As a result, the expected time remaining on the call (the yellow bar) is almost exactly 
the same size as it was previously, despite the call having rung for 11 seconds already.  

In practice callers can hang up at any time. If the above effect is taken into account every second, 
then the expected abandonment time of a call will continually drift upwards as the call rings. By 
looking at agent states and past call history, the predictive abandonment module calculates the 
chance of the call being answered over this relatively constant ‘expected time remaining’ period. 

Q: Why do queued calls show an ‘N/A’ chance to abandon in start -up mode? 

The abandonment model computes statistics for different days of the week separately, thereby 
taking daily variation into account. At the start of each day, the system has no data on which to base 
its predictions; there must be at least two answered, two abandoned and if enabled – two wrapped 
up calls before any meaningful results can be produced. These results should grow gradually more 
reliable as the day progresses. 
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Q: Why do newer calls in the queue have a consistently higher chance of 

abandoning? 

The abandonment model assumes that for each queued call to be answered, any preceding calls 
must also be answered first. This causes abandonment probabilities to ‘stack’ along the queue. As a 
result of this, a given number of agents will correctly only be able to support a certain volume of 
queued calls before they become at risk of abandoning. An abandonment probability at the end of 
the queue basically states: “This is the probability that one or more calls at this level in the queue and 
above will abandon”. 

Q: Why are low-risk calls still abandoning?  

Any ringing call has the potential to abandon, and it is impossible to predict exactly when this will 
happen. Even if a low threshold of 20% is deemed acceptable, one in 5 calls that reach this level of 
risk are expected to abandon eventually. 

Q: Shouldn’t Calls be answered in Order of Risk Instead of Ring Time?  

As explained in the question above, calls lower in the queue have a higher chance of abandonment 
because they are further down in the queue.  Reordering the queue would simply make a different 
call carry the most risk. Instead, the highest probability of abandonment can be reduced by 
answering calls at the front of the queue via additional agents. This will cause abandonment 
probabilities to drop throughout the entire queue. 

 

Using Predictive Abandonment 

Predictive abandonment is integrated into the real time status views for pilot numbers, trunks, and 
agents. In order to generate results, a pilot group must be an ACD queue and have predictive 
abandonment enabled. 

How to: Enable a Pilot Group for Predictive Abandonment  

1) From the Configure Telephone System window, select ‘Devices’ and navigate to ‘Pilot Numbers’. 

 

2) On the right, click ‘Create or Edit a Pilot Number’. 

3) Select either ‘Add new pilot number’ or ‘Edit…’ alongside an existing pilot number.  
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4) Click ‘Enable’ in the predictive abandonment group. If the agents in the group have a wrap-up 
period associated with a finished call, select ‘Include Wrapup Time’.  

  

5) If Overflow is enabled for the pilot number then the Overflow Destination and Transfer Time will 
be taken into account when calculating predictive abandonment. 

 

 

Include Wrapup Time 

The predictive abandonment system can be set to include wrapup times for individual pilot groups. If 
enabled, the system will create a wrapup model for the pilot group based on past behaviour and 
consider the expected time agents will spend in this state when calculating probability of 
abandonment. If disabled, the system will assume an agent will be immediately ready to answer a 
new call upon finishing a previous one. 

Refresh Period 

All abandonment predictions will be refreshed when a change of state occurs (a new call arrives, an 
agent finishes a call, etc…) Depending on the nature of the pilot group, calculated abandonment 
probabilities may shift over time regardless of these changes in state. Hence, the system can be set 
to automatically refresh itself periodically. This will recalculate probabilities for every single call in 
queue, which could prove taxing for some low-spec system if this period is too low.  

How to: Create a Window Utilizing Predictive Abandonment for a Single Pilot 

Group 

1) From the ‘View’ menu, select ‘Real Time Information’. 

2) Expand the Real Time Status section and the Pilot Numbers subgroup. Select ‘Queue Status’ and 
then ‘Create a New Queue Status View’ on the right.   

 

2) From the Pilot Number drop-down menu, select the desired PBX and ACD Queue pilot.  
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3) Choose from the 4 available display options: 

Summary 

 

The summary window displays the Abandonment Probability associated with the call most at risk in 
the pilot group. The ‘Abd %’ options are only visible if the selected pilot group is an ACD Queue. If 
theses remain hidden, the pilot needs to be designated as an ACD Queue in the telephone system 
configuration window.   

 

Agent Details 
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The Agent Details window displays the abandonment probability corresponding to the call most at 
risk on the top left. The lower half of the window displays a breakdown of calls active or calling on 
the chosen pilot number.  

Call Details 

 

The Call Details window displays the abandonment probability corresponding to the call most at risk 
on the top left. The lower half of the window displays a breakdown of calls active or calling on the 
chosen pilot number. Abandonment probabilities for individual calls can be obtained by double-
clicking ‘Abd %’ in the Column Chooser menu. 

Agent Overview 

 

The Agent Overview window displays the abandonment probability corresponding to the call most at 
risk on the top left. It otherwise functions as described earlier in the manual. 

4) With the desired display option selected and any additional options chosen, click ‘OK’ to create the 
real time status window. Modifications can be made to the final window by right-clicking it and 
selecting ‘Configure’. 

How to: Create a Window Utilising Predictive Abandonment for a Selection of 

Trunks 

1) From the ‘View’ menu, select ‘Real Time Information’. 

2) Expand the Real Time Status section and select ‘Trunks’. Then, click ‘Create a New Trunk Status 
View’ on the right.   
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3) Select the desired trunks and trunk states to display in the new real time window. Only the 
‘Summary’ type view supports Predictive Abandonment value displays. Press Ok to create the new 
window. 

  

4) In the new window, open the ‘Column Chooser’ and either double-click or drag the ‘Abd %’ tag 
next to an existing column. Only calls in an ACD queue will display a value. 

 

How to: Log-on Additional Reserve Agents for At-Risk Calls  

A reserve agent is any active user within an Agent Control Group containing multiple ACD queues 
that is currently logged on to a different queue within the group (i.e. an agent that could log in to the 
queue at risk if needed). 
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1) Create an ‘Agent Details’ real time status window as described in the procedure above.  

2) Ensure that there are reserve agents available for the desired pilot number. If this still needs to be 
configured, see Chapter 18: “Creating an Agent Control Group”.  

3) Right-click on an agent within the ‘Reserve Agents’ tab and select ‘Log onto Queue’. The agent will 
answer the call first in queue and all subsequent calls will become less likely to abandon. 
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Chapter 29 

Acronyms & Glossary 

Acronyms 

ACD Automatic Call Distribution  
ACW After-Call Work  
AHT Average Handling Time  
ANI  Automatic Number Identification (also called Caller ID).  
ASA  Average Speed of Answer  
ASP  Application Service Provider  
ASR  Automatic Speech Recognition  
ATA  Average lime to Abandonment  
ATB  All Trunks Busy  
CCR  Customer-Controlled Routing  
CED  Caller-Entered Digits  
CIS  Customer Information System  
CLEC  Competitive Local Exchange Carrier/ CLI Calling Line Identity  
CLID  Calling Line Identification  
CMS  Call Management System  
CO  Central Office  
CPE  Customer Premises Equipment  
CRM  Customer Relationship Management  
CSR  Customer Service Representative  
CTI  Computer Telephony Integration  
DID  Direct Inward Dialling  
DN  Dialled Number  
DND Do not disturb 
DNIS  Dialled Number Identification Service  
DTMF  Dual-Tone-Multi-frequency  
EWT  Expected Wait Time  
FCR  First-Call Resolution  
FIFO  First in, First Out  
FTP File Transfer Protocol 
FX  Foreign Exchange Line  
GOS  Grade of Service  
IM  Instant Messaging  
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IP  Internet Protocol  
ISDN  Integrated Services Digital Network  
ISP  Internet Service Provider  
IVR  Interactive Voice Response  
IXC  Interexchange Carrier  
KM  Knowledge Management  
KPI  Key Performance Indicator  
LAN  Local Area Network  
LEC  Local Exchange Carder  
MIS  Management Information System  
NCC  Network Control Centre  
NOC  Network Operations Centre  
PABX  Private Automatic Branch Exchange  
PBX  Private Branch Exchange  
PDA  Personal Digital Assistant  
PRI  Primary Rate Interface  
PSN  Public Switched Network  
PSTN  Public Switched Telephone Network  
QOS  Quality of Service  
RNA  Ring No Answer  
ROI  Return on Investment  
SBR  Skills-Based Routing  
SL  Service Level  
SLA  Service Level Agreement  
SMS Short Message Service 
UCD  Uniform Call Distributor 
VoIP  Voice over Internet Protocol 
VPN  Virtual Private Network 
VRU  Voice Response Unit 
WAN Wide Area Network 
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Glossary 

Abandoned Call (Inbound): Also called a lost call. The caller hangs up before reaching an agent. 

Abandoned Grade of Service: The percentage of calls that are abandoned after an acceptable 
amount of time. Calls that are abandoned before the specified time are not considered. A value of 
97% is generally considered an adequate Abandoned Grade of Service. 

Account Code: Also known as Project Codes or Bill-Back Codes. Account Codes are additional digits 
dialled by the calling party that provide information about the call. If all calls come into a central 
number, then it is possible to enter an account code for each call to identify its purpose. Reports can 
then be run on specific account codes or groups to isolate those calls from all the others. 

Alarm Distribution List: Identifies who the alarm notification should be sent to. It is possible to 
specify email addresses, computer names and processes to run. 

Adherence to Schedule: A general term that refers to how well agents adhere to their schedules. 
The two terms most often associated with adherence include availability (the amount of time agents 
were available) and compliance (when they were available to take calls).  

After-Call Work (ACW): Also called wrap-up, post call processing, average work time or not ready. 
Work that is necessitated by, and immediately follows, an inbound call.  

Announcement Port: Generally used by an ACD system which periodically transfers a call to an 
announcement port and plays a reassurance message to the caller if there are no agents free. 

Auto Attendant: The auto attendant feature is used to route incoming telephone calls based on 
selections or information provided by the incoming caller. The auto attendant feature may use 
interactive voice response (IVR) to prompt the caller to select the call routing based on category 
choices or it may use the calling number identification to determine the destination (e.g. a 
telephone number for a specific sales group). 

Agent: The person who handles incoming or outgoing contacts.  

Agent Status: The mode an agent is in (e.g., talk time, after-call work, unavailable, etc.).  

All Trunks Busy (ATB): When all trunks are busy in a specified trunk group. Generally, Trunk Usage 
reports indicate the percentage of trunks busy over a period of time as a percentage of potential 
usage for the whole group over that period 

Analogue: Telephone transmission or switching that uses a fluctuating voltage signal to transmit 
information.  

Analytics: Advanced data analysis and reporting tools that enable the organisation to better 
understand customer trends and business activities.  

Announcement: A recorded verbal message played to callers.  
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Answered Call: When referring to an agent group, a call is answered when reaches an agent.  

Auto Wrap-Up: An ACD feature whereby the ACD is programmed to automatically put agents into 
after-call work after they finish talk time and disconnect calls. When they have completed any after-
call work required, they put themselves back into available.  

Automated Greeting: An agent’s pre-recorded greeting that plays automatically when a call arrives 
at his or her telephone station.  

Automatic Call Distributor (ACD): A mechanism controlled by the PBX switch or call management 
software which can distribute calls among agents in an attempt to even out the distribution of calls 
to each agent. 

Automatic Number Identification (ANI): A telephone network feature that passes the number of the 
phone the caller is using to the call centre in real-time. ANI is an American Term Calling Line Identity 
(CLI) is an alternative term used elsewhere.  

Availability: The time the agent spends handling calls or waiting for calls to arrive.  

Available State: The work state of agents who are signed on to the ACD and are waiting for calls to 
arrive.  

Average Call Value: A measure common in revenue-producing call centres. It is total revenue 
divided by total number of calls for a given period of time.  

Average Handling Time (AHT): The sum of average talk time plus average after-call work.  

Average Holding Time on Trunks (AHT): The average time inbound transactions occupy the trunks. 

Average Time to Answer (ATA or ASA): A measure that reflects the average delay of all calls 
including those that receive an immediate answer. Also called average delay.  

Average Abandonment Time (AAT): Also called average delay to abandon. The average time that 
callers wait in queue before abandoning. The calculation considers only the calls that abandon. 

Barge-In: An ACD feature that allows a supervisor or manager to join or “barge-in” on a call being 
handled by an agent.  

Blended Agent: An agent who handles both inbound and outbound calls, or who handles contacts 
from different channels (e.g., email and phone) 

Call: Also called contact, interaction or transaction. Although it most often refers to a telephone call, 
call can also refer to a video call, a Web call and other types of customer contacts  

Call Forcing: An ACD feature that automatically delivers calls to agents who are available and ready 
to take calls. This is sometimes called automatic answer.  
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Call Load: Also called workload. Call load is volume multiplied by average handling time, for a given 
period of time  

Call Recording: A type of monitoring in which the supervisor or automated system records a 
sampling of calls. The person conducting the monitoring then randomly selects calls for evaluation of 
agent performance.  

Call Time Alarms: Determines what the acceptable minimum and maximum average call times 
should be in a one-hour period. An average call time that is less than the minimum value can 
indicate that you may be rushing your calls. An average call time that is more than the maximum 
value indicates that the calls are taking too long and you may need to speed up the conversation. 

Caller Alarms: Determines if a caller has been contacted within a specified time period. 

Caller Tolerance: How patient callers will be when they encounter queues or experience busy 
signals.  

Caller-Entered Digits (CED): Digits callers enter using their telephone keypads. The ACD, IVR, or 
network can prompt for CEDs.  

Calls in Queue: A real-time report that refers to the number of calls received by the ACD system but 
not yet connected to an agent.  

Carrier: A company that provides telecommunications circuits, Carriers include both local telephone 
companies, also called local exchange carriers (LEC5), and long-distance providers, also called inter-
exchange carriers (IXCs).  

Circuit: A transmission path between two points in a network.  

Combination Values: A real-time display of a parameters shown together. For example, number of 
incoming + outgoing and abandoned calls 

Computer Telephony Integration (CTI): The software, hardware and programming necessary to 
integrate computer systems and telephone systems so they can work together seamlessly and 
intelligently.  

Contacts Per Hour: An outbound term that refers to the number of contacts divided by agent hours 
on the dialler.  

Cost Per Call: Total costs (queued and variable) divided by total calls *01 a given period of time. 

Customer Expectations: The expectations customers have of a product, service or organization. 

Delay: Also called queue time. The time a caller spends in queue waiting for an agent to become 
available. Average delay is the same thing as average speed of answer.  

Delay Announcements: Recorded announcements that encourage callers to wait for an agent to 

Delayed Call: A call which cannot be answered immediately and is placed into a queue.  
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DID: Direct Inward Dial, a service offered by telephone companies which allows the last 3 or 4 digits 
of a phone number to be transmitted to the destination PBX. A company may for example have 10 
lines but the company could publish up to 1000 numbers if 3 digit DIDs are used. Each of these 
numbers can be assigned a purpose and routed to the appropriate extension or group. 

Dialled Number (DN): The number that the caller dialled to initiate the call.  

Dialled Number Identification Service (DNIS): A string of digits that the telephone network passes to 
the ACD, IVR or other device to indicate which telephone number the caller dialled, one trunk group 
can have many 1) NIS numbers. 

Fast Clear Down: A caller who hangs up immediately after hearing a delay announcement.  

First-Call Resolution: The percentage of calls that do not require any further contacts to address the 
customer’s reason for calling. The customer does not need to contact the call centre again to seek 
resolution, nor does anyone within the organization need to follow up.  

Forecasting: The process of predicting call centre workload and other activities.  

Gateway: A server dedicated to providing access to a network.  

Grade of Service (GOS): The probability that a call will not be connected to a system because all 
trunks are busy. Grade of service is often expressed as p.O1 meaning 1 percent of calls *11 be 
blocked. Sometimes grade of service is used interchangeably with service level, but the two terms 
have different meanings.  

Handled Call: A call that is received and handed by an agent or peripheral equipment.  

Handling Time: The time an agent spends in talk time and after-call work handling a  
transaction. 

Historical Report: A report that tracks call centre and agent performance over a period of time.  

Idle Time: The time agents are available and waiting for calls.  

Instant Messaging (IM): A type of text-chat between two or more Internet users. 

Integrated Services Digital Network (ISDN): A set of international standards for digital telephone 
transmission.  

Interactive Voice Response (IVR): An IVR system responds to caller entered digits or speech 
recognition in much the same way that a conventional computer responds to keystrokes or clicks of 
a mouse. When the IVR is integrated with database computers, callers can interact with databases to 
check current information (e.g., account balances) and complete transactions (e.g. make transfers 
between accounts).  

Least Cost Routing (LCR): is an automated function which routes outgoing calls via the cheapest 
telecom operator available, usually by dialling a prefix to the telephone number 

Local Area Network (LAN): The connection of multiple computers within a building so that they can 
share information, applications and peripherals.  

Local Exchange Carrier (LEC): Telephone companies responsible for providing local connections and 
services.  
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Long Call: A call that has exceeded a specified talk time. Used to identify which calls are taking 
longer to handle. This can be used as a measure for further training of the operator or agent.  

Longest-Available Agent: Also referred to as most-idle agent. A method of distributing calls to the 
agent who has been sitting idle the longest. With a queue, longest available agent becomes next 
available agent.  

Longest Delay (Oldest Call): The longest time a caller has waited in queue, before abandoning or 
reaching an agent.  

Manual Answer: The ACD system is set up so that agents must manually answer calls.  

Manual Available: The ACD system is set up so that agents must put themselves back into the 
available mode after completing any after call work.  

Most Frequent Calls Report: Report that provides a list of the most frequent numbers dialled or 
answered. The report can be configured to include or exclude and combination of call types or 
device 

Next-Available Agent: A call distribution method that sends calls to the next agent who becomes 
available. The method seeks to maintain an equal load across skill groups or services. When there is 
no queue, next-available agent reverts to longest-available agent.  

Non ACD Calls: Inbound calls that are directed to an agent’s extension rather than to a general 
group. These may be personal calls or calls from customers who dial the agents’ extension numbers. 

Offered Call: Offered calls include all of the times that a call has been presented to an agent, either 
answered or not. 

Off-Peak: Periods of time other than the call centre’s busiest periods. Also a term used to describe 
periods of time when long-distance carriers provide lower rates.  

Overflow: Calls that flow from one group or site to another. More specifically intraflow happens 
when calls flow between agent groups and interflow is when calls flow out of the ACD to another 
site.  

Other ACD Calls: Calls routed via an ACD queue to an agent but not from the queue in which a 
supervisor may be responsible.  

Pilot Number: A number that represents an ACD or hunt group. A call can be either made directly to 
this number or routed to this number if it is an incoming call. 

PBX/ACD: A private branch exchange (PBX) that is equipped with ACD functionality.  

Peaked Call Arrival: A surge of traffic beyond random variation. It is a spike within a short period of 
time. There are two types of peaked traffic — the type you can plan for, and incidents that are 
impossible to predict.  
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Private Branch Exchange (PBX): Also called private automatic branch exchange (PA8X). A telephone 
system located at the call centre’s site that handles incoming and outgoing calls. ACD software can 
provide PBXs with ACD functionality. Many refer to a PBX as a switch.  

Queue: Queue literally means ‘line of waiting people. Holds callers until an agent becomes available. 

Queue Status Alarms: Determines the acceptable number of calls in a queue, and also the 
acceptable amount of time that a call can remain in a queue before being answered. 

Real Time Statistics: The Real Time Statistics are available on a group basis and are a summary of a 
selected set of the available Single Value parameters. 

Received Call: A call detected and seized by a trunk. Received calls will either abandon or be 
answered by an agent.  

Report Schedule: A series of configured report items that will be run together at a specified time. 

Report Template: The definition that forms the basis of an ad-hoc report or saved report item. 

Ring Delay: Also called delay before answer. An ACD feature that enables the system to adjust the 
number of rings before the system automatically answers a call.  

Service Level Alarms: Determine the minimum average and maximum average acceptable Grade of 
Service (GOS) in a one-hour period. A value below the minimum average can indicate that there are 
not enough staff available to take all of the calls. Conversely, if the value is above the maximum 
value it might indicate that there are too many people available to answer calls. 

Single Value Parameter: A real-time parameter that holds information about one statistic. For 
example, Number of Incoming Calls. 

System Alarms: Are triggered when either no data is received from the PBX for a certain period or if 
the free disk space on the disk that the database is situated on is below a specified level. 

Screen Monitoring: A system capability that enables a supervisor or manager to remotely monitor 
the activity on agent’s computer terminals.  

Screen Refresh: The rate at which real-time information is updated on a display. Screen refresh does 
not correlate with the time frame used for real-time calculations.  

Skills-Based Routing: An ACD capability that matches a caller’s specific needs with an agent that has 
the skills to handle that call, on a real-time basis.  

Talk Time: Everything from hello to goodbye in a phone call. In other words, it’s the time callers are 
connected with agents. Anything that happens during talk time, such as placing customers on hold to 
confer with supervisors, should be included in this measurement.  
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TCP/IP Trunk: A trunk that routes calls through the internet rather than the PSTN. 

Telemarketing: Generally, refers to outbound calls for the purpose of selling products or services, or 
placing informational calls to customers, prospective customers or constituents.  

Time Parameter Distribution Report: Report that list the number of calls that have either a wait, call 
or hold time within a specified time period. The time periods can start at any value, end at any value 
and each interval can be any size. 

Toll Fraud alarms: Determines whether a call is too expensive or lasts for too long or is to/from a 
specific destination. 

Trunk: Also called a line, exchange line or circuit. A telephone circuit linking two switching systems. 

Trunk Group: A collection of trunks associated with a single peripheral and usually used for a 
common purpose.  

Trunk Load: The load that trunks carry. Includes both delay and talk tine.  

Unavailable Codes: A user has made themselves unavailable to take calls from an ACD system for 
whatever reason. It is usual to supply a reason code or unavailable code when going unavailable so 
to track the reasons why this state has been entered. 

User Login/Pin code: A unique number that the user enters to associate themselves with the 
telephone system to inform them they are able to take calls, usually on one or more ACD queues. 

User Login (MyCalls): A unique username and password combination assigned to a MyCalls User to 
allow the user to use the MyCalls application. 

Wallboard: Also called reader boards, display boards or wall displays. A visual display, usually 
mounted on the wall or ceiling that provides real-time and historical information on queue 
conditions, agent status and call centre performance.  

Wide Area Network (WAN): The connection of multiple computers across a wide area.  

Wrap-Up Codes: Codes which agents enter on their phones to identify the types of calls they are 
handing. The ACD can then generate reports on call types by handling time, time of day, etc. 
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Appendix A 

MyCalls Licensing 

MyCalls uses a licensing system to control the features available within the product. Once MyCalls 
has been installed the user will be unaware of any licensing mechanisms other than the fact that 
certain features will be unavailable. 

 

There are several versions of the MyCalls Product 

 

MyCalls SV8100/SV9100 Basic 

MyCalls SV8100/SV9100 Call Manager  

MyCalls SV8100/SV9100 Call Centre 

MyCalls SV8100/SV9100 Desktop 

MyCalls SV8100/SV9100 Operator Console 

 

The default license purchased for each contains the following features. 

Feature SV8100/(SV9100) 

 MyCalls 
(SV9100) 

MyCalls Call 
Manager 
(SV9100) 

MyCalls Call 
Centre 
(SV9100) 

MyCalls 
Desktop 
(SV9100) 

MyCalls 
Operator 
(SV9100) 

Default PBXs 1 1 1 1 1 

Concurrent Users 1 1 1 1 1 

Default Extensions Unlimited(512) Unlimited(512) Unlimited(512) Unlimited(512) Unlimited(512) 

DIDs Unlimited Unlimited Unlimited Unlimited Unlimited 

Abandoned Calls  Yes Yes No Yes 

Costing  Yes Yes No No 

Performance 
Monitoring 

Yes Yes Yes No No 

Organisation/Users  Yes Yes Yes Yes 
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User Costing  Yes Yes No No 

ACD   Yes No No 

Real Time Status Yes Yes Yes No Yes 

Scheduling  Yes Yes No No 

Grade of Service  Yes Yes No No 

Callers  Yes Yes No No 

Import  Yes Yes No No 

Alarms Basic Full Full No No 

Agent Control   Optional No No 

Call Playback  Optional Optional Optional Optional 

Reporting Basic Full Full No No 

Backup/Restore  Yes Yes No Yes 

ACD Supervisors   1 No No 

Wallboard Users  Optional Optional No No 

Concurrent Agents   Optional No No 

Digital Playback 
Trunks 

 Optional Optional No No 

Analog Playback 
Trunks 

 Optional Optional No No 

Call Player Type No Optional Optional No No 

Call Playback Audit No Optional Optional No No 

Hot-Desk Users No 0 0 No 0 

Desktop Only No No No Yes No 

Call Control Users 0 0 0 1 1 

Call Control No Optional Optional Yes Yes 

Screen Pop No Optional Optional Yes Yes 

Presence No Yes Yes Yes Yes 
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